
 

 

 



 

WHATSAPP +255738656506 

 

 

Copyright(c) 2018 by Nixon Vunganai.  

 All rights reserved. 

Neither this document nor any part of it may be copied or reproduced in any form or by any 
means or translated into another language, without the prior consent of Nixon Vunganai. The 
information contained in this document is subject to change without notice. 

 

  



 

 

INTRODUCTION 5 

37.1 INTEGRATION COMPONENT FOR ARIBA NETWORK 7 

37.2 INTEGRATION WITH SAP HYBRIS CLOUD FOR CUSTOMER 27 

RSEOUT00 31 
RBDMIDOC 31 
1. ENABLE PDF GENERATION OF SALES ORDER FROM OPPORTUNITY 40 
2. Maintain Endpoints for Services 41 

DESCRIPTION IN CONFIGURATION GUIDE POSSIBLE ALTERNATIVE 41 

37.3 ADVANCED PLANNING AND OPTIMIZATION 60 

37.4 INTEGRATION WITH GOVERNANCE, RISK AND COMPLIANCE 125 

NO TEMPORARY STORAGE 132 
TEMPORARY STORAGE STATUS ON INBOUND DELIVERY 132 
HOLDING LOCATION USING CUSTOMER-SPECIFIC BADI IMPLEMENTATION 132 
NO TEMPORARY STORAGE 134 

TEMPORARY STORAGE STATUS ON INBOUND DELIVERY 134 
HOLDING LOCATION USING CUSTOMER-SPECIFIC BADI IMPLEMENTATION 134 

37.5 TRANSPORTATION MANAGEMENT 171 

SERVICE OPERATION NAVIGATION PATH 186 
COUNTRY TAX TYPE DESCRIPTION BPS SEQUENCE 195 
COUNTRY TAX AT CHARGE TYPE 195 

37.6 EXTENDED WAREHOUSE MANAGEMENT 207 

37.7 SUPPLY NETWORK COLLABORATION/INVENTORY COLLABORATION HUB 242 

37.8 DATA TRANSFER TO BUSINESS WAREHOUSE 250 

COUNTRY GROUPING  TIME-BASED ASSIGNMENT 373 

37.9 BUSINESS PACKAGES/FUNCTIONAL PACKAGES 379 

USE 416 

USE 419 
GROUP RQ SEM. ABB. SEM. ABB. VALUE TEXT 448 



 

WHATSAPP +255738656506 

 

 

  



 

 

INTRODUCTION 

This book provides system architects, technical consultants, and IT management the tools to 

design  system architectures to deploy SAP applications on SAP HANA. Explore production and 

non-production systems, deployment options, backup and recovery, data replication, high-

availability, and virtualization in detail. Dive into on-premise deployment options and data 

provisioning scenarios. Walk through scale-up and scale-out options and data partitioning 

considerations. Review the advantages and disadvantages of storage and system replication 

options and when to use each. Clarify how to leverage HANA for single node and distributed 

systems. Dive into a discussion on software and hardware virtualization. 
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37 Integration with Other SAP Components 

37.1 Integration Component for Ariba Network  
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37.1.1 Framework Settings  



 

 

37.1.1.1 Define Credentials and End Points for Ariba Network 

Use 

In this Customizing activity, you can do the following: 

- You can specify the credentials that identify your company on Ariba Network, assigning a 

password (SharedSecret) to the Ariba Network ID 

- If you use a Business Application ID on Ariba Network, you can specify this ID in your SAP 

system to use it when communicating with Ariba Network. 

- You can assign end points to Ariba Network IDs and define passwords on end-point level. 

Note: 

Instead of using passwords, you can use certificates. If you want to do so, you must maintain 

them in transaction STRUST. In this case, leave the SharedSecret field in this Customizing 

table empty. 

The Ariba Network ID is displayed to suppliers on Ariba Network. You can have one or several IDs. 

For example, each company code or purchasing organization can have a separate ID. The Network ID is 

transferred with each outbound cXML message and identifies your company as the sender. 

An Ariba Network ID can have multiple end points. An end point is a document routing placeholder that 

ensures documents from Ariba Network are sent to the required destinations (system). 

Caution:  

If you have enabled and defined end points for your buyer account on Ariba Network, you 

must assign  them here and define passwords or use certificates on end-point level. 

The credentials can be specified as follows: 

- A shared secret for each Ariba Network ID 

The shared secret is transferred with each outbound cXML message and allows the message to 

access Ariba Network. 

- A shared secret for each end point 

- A certificate for each Ariba Network ID (in transaction STRUST) 

- A certificate for each end point  (in transaction STRUST) 

Requirements 

You have received the Ariba Network ID and the shared secret from Ariba. 

Activities 

Specify Credentials Without Using End Points 

1. Choose New Entries. 

2. Enter the Ariba Network ID. 

3. Specify a SharedSecret password. If required, you can change the shared secret at a later point in 

time. 
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4. If you do not want the Network ID to be published on Ariba Network, select the Test Account 

checkbox. You can add the credentials of your live account at a later point in time. 

5. If your S/4HANA system is identified on Ariba Network by a Business Application ID and you 

want to use it for communication between S/4HANA and Ariba Network, do the following: 

a) Select System ID Enabled and press ENTER. 

b) Under System ID, specify the Business Application ID as it is known to Ariba Network. If you 

leave this field empty and the system ID is enabled, then the logical system specified in the 

client settings is used. 

6. If you want to remove an existing Ariba Network ID, select it and choose Delete. 

7. Save your entries. 

Specify Credentials on End-Point Level 

1. Choose New Entries. 

2. Enter the Ariba Network ID. 

3. If you do not want the Network ID to be published on Ariba Network, select the Test Account 

checkbox. You can add the credentials of your live account at a later point in time. 

4. If your S/4HANA system is identified on Ariba Network by a Business Application ID and you 

want to use it for communication between S/4HANA and Ariba Network, do the following: 

a) Select System ID Enabled and press ENTER. 

b) Under System ID, specify the Business Application ID as it is known to Ariba Network. If you 

leave this field empty and the system ID is enabled, then the logical system specified in the 

client settings is used. 

5. In the Enable End Points column, select Enable end points for authentication from the dropdown 

list 

6. Select the line in which you entered the Ariba Network ID and double-click End Points for Ariba 

Network  in the Dialog Structure in the left-hand screen area. 

7. In the table End Points for Ariba Network, do the following: 

a) Enter an SAP-Internal Key. You can freely define this key. 

b) Enter the Ariba End Point ID which has been defined on Ariba Network for the Ariba 

Network ID you selected. 

8. Save your entries.  



 

 

37.1.1.2 Define Basic Message Settings 

Use 

In this Customizing activity, you specify which cXML message types you want to exchange with Ariba 

Network. 

Activities 

1. Choose New Entries. 

2. For each message type that you want to exchange, select the combination of the application 

component from where the cXML messages are sent and the message type. Most other fields are 

then filled automatically. 

3. Select the cXML version that you use to exchange messages with Ariba Network. 

4. Select the mapping version that corresponds to the cXML version. The mapping version refers to 

the mapping of the dcXML to BAPI structures. 

5. Indicate whether you want the status of the message transfer to be visible to your suppliers on Ariba 

Network. Examples of possible statuses are "Sent", "Acknowledged", and "Failed". 

6. Activate those message types that you want to exchange with Ariba Network. 

Note: For inbound messages that are received via direct connectivity or via HANA Cloud 

Integration (HCI), a corresponding job is automatically scheduled in the job repository to fetch the 

messages from Ariba Network. 

37.1.1.3 Decide on Connectivity Type 

Use 

There are two ways of connecting your SAP system with Ariba Network: 

- Direct connectivity: You establish a system connection between your SAP system and Ariba 

Network without using middleware. 

- Mediated connectivity using HCI: You establish a system connection using SAP HANA Cloud 

Integration between your SAP system and Ariba Network. 

- Mediated connectivity using PI: You establish a system connection using middleware between 

your SAP system and Ariba Network. 

Depending on which connectivity type you use, you only have to make the settings under one 

of the Customizing nodes. 
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37.1.1.4 Direct Connectivity Settings 

37.1.1.4.1 Define bgRFC Supervisor Destination 

Use 

In this Customizing activity you define a supervisor destination for the background RFC 

(bgRFC). You do this on the Define Supervisor Dest. tab in transaction bgRFC Configuration 

(SBGRFCCONF). Using the supervisor destination, the system retrieves the configuration settings for 

the bgRFC scheduler and starts or stops the schedulers as required on each application server. 

Requirements 

Ensure that the following prerequisites are fulfilled: 

- In client 000 of your SAP system, you have created a bgRFC supervisor user (with the user 

type Service) in transaction User Maintenance (SU01), for example user BGRFCSUPER. You 

have assigned the Authorization Role for bgRFC Supervisor User 

(SAP_BC_BGRFC_SUPERVISOR) to the user BGRFCSUPER. 

- In transaction Configuration of RFC Connections (SM59), you have created a bgRFC 

supervisor destination, for example destination BGRFC_SUPERVISOR, with the following 

settings: 

- On the Technical Settings tab, you have left the Target Host field empty. This has the effect 

that the RFC connection is used within the system where you have created it. 

- On the Special Options tab, you have specified the transfer protocol Classic with tRFC. 

Activities 

Proceed as follows to configure the bgRFC supervisor destination: 

1. In transaction SBGRFCCONF on the Define Supervisor Destination tab, specify the supervisor 

destination that you have created. 

2. Specify the user that you have created in transaction SU01. 

3. On the Scheduler: App. Server tab, enter all application servers that exist in your system landscape. 

4. On the Define Inbound Dest. tab, specify a destination name. 

5. Save your settings. 

For more information, see SAP Help Portal at http://help.sap.com/nw70 -> Application Help 

-> Function-Oriented View -> SAP NetWeaver by Key Capability -> Application Platform by 

Key Capability -> Platform-Wide Services -> Connectivity ->  Components of SAP 

Communication Technology ->  Classical SAP Technologies (ABAP) -> RFC -> Queued Remote 

Function Call (qRFC) -> bgRFC (Background Remote Function Call) -> bgRFC Configuration -> 

Creating a Supervisor Destination and Creating Inbound Destinations. 

37.1.1.4.2 Technical Configuration of SOAP Runtime 



 

 

Use 

Execute the technical configuration of Simple Object Access Protocol (SOAP) runtime 

(transaction SRT_ADMIN). For more information, search for the keywords 

"Configuring the Web Service Runtime" in the documentation of SAP NetWeaver 

under help.sap.com and SAP Note 1043195. 

37.1.1.4.3 Maintain Certificate 

Use 

In this Customizing activity, you use the trust manager (transaction STRUST) to specify the 

authentication certificate that enables your company to access Ariba Network using a Secure Sockets 

Layer (SSL) protocol. 

For more information about the trust manager, start transaction STRUST and choose Help -> Application 

Help. 

Requirements 

You have received your authentication certificate from Ariba. 

Activities 

1. In the navigation structure, click SSL client SSL Client (Anonymous). 

2. Under Certificate, click the icon Import Certificate to upload the certificate file (format *.cer) that 

you have received from Ariba. 

3. Click Add to Certificate List. The certificate appears in the Certificate List. 

4. Save your data. 

37.1.1.4.4 Manage and Test Enterprise Services 

Use 

You can use the SOA Manager to configure Enterprise Services and Enterprise Service clients. You open 

the SOA Manager in a browser window. 

For more information about the SOA Manager, search for the keywords "Working with the SOA 

Manager" in the documentation for SAP NetWeaver. 
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37.1.1.4.5 Schedule Polling Agent 

Use 

When you activate an inbound message type under Define Basic Message Settings that is received via 

direct connectivity or via HANA Cloud Integration (HCI), a corresponding job is automatically 

scheduled in the Technical Job Repository to fetch the messages for this type from Ariba Network. 

If you prefer a more flexible handling, such as fetching messages of several types using the same job, 

you can deactivate the job definition in the Technical Job Repository and schedule the report Fetch 

cXML messages for different message types from Ariba Network 

(ARBFND_FETCH_CXML_MESSAGES_NEW) instead. This report is frequently referred to as 

Polling Agent and must be scheduled in transaction Define Background Job (TA SM36). 

37.1.1.5 Mediated Connectivity Settings for Integration Using HCI 

37.1.1.5.1 Define bgRFC Supervisor Destination 

Use 

In this Customizing activity you define a supervisor destination for the background RFC 

(bgRFC). You do this on the Define Supervisor Dest. tab in transaction bgRFC Configuration 

(SBGRFCCONF). Using the supervisor destination, the system retrieves the configuration settings for 

the bgRFC scheduler and starts or stops the schedulers as required on each application server. 

Requirements 

Ensure that the following prerequisites are fulfilled: 

- In client 000 of your SAP system, you have created a bgRFC supervisor user (with the user 

type Service) in transaction User Maintenance (SU01), for example user BGRFCSUPER. You 

have assigned the Authorization Role for bgRFC Supervisor User 

(SAP_BC_BGRFC_SUPERVISOR) to the user BGRFCSUPER. 

- In transaction Configuration of RFC Connections (SM59), you have created a bgRFC 

supervisor destination, for example destination BGRFC_SUPERVISOR, with the following 

settings: 

- On the Technical Settings tab, you have left the Target Host field empty. This has the effect 

that the RFC connection is used within the system where you have created it. 

- On the Special Options tab, you have specified the transfer protocol Classic with tRFC. 

Activities 

Proceed as follows to configure the bgRFC supervisor destination: 

1. In transaction SBGRFCCONF on the Define Supervisor Destination tab, specify the supervisor 

destination that you have created. 

2. Specify the user that you have created in transaction SU01. 

3. On the Scheduler: App. Server tab, enter all application servers that exist in your system landscape. 

4. On the Define Inbound Dest. tab, specify a destination name. 



 

 

5. Save your settings. 

For more information, see SAP Help Portal at http://help.sap.com/nw70 -> Application Help 

-> Function-Oriented View -> SAP NetWeaver by Key Capability -> Application Platform by 

Key Capability -> Platform-Wide Services -> Connectivity ->  Components of SAP 

Communication Technology ->  Classical SAP Technologies (ABAP) -> RFC -> Queued Remote 

Function Call (qRFC) -> bgRFC (Background Remote Function Call) -> bgRFC Configuration -> 

Creating a Supervisor Destination and Creating Inbound Destinations. 

37.1.1.5.2 Technical Configuration of SOAP Runtime 

Use 

Execute the technical configuration of Simple Object Access Protocol (SOAP) runtime 

(transaction SRT_ADMIN). For more information, search for the keywords 

"Configuring the Web Service Runtime" in the documentation of SAP NetWeaver 

under help.sap.com and SAP Note 1043195. 

37.1.1.5.3 Maintain Certificate 

Use 

In this Customizing activity, you use the trust manager (transaction STRUST) to specify the 

authentication certificate that enables your company to access Ariba Network using a Secure Sockets 

Layer (SSL) protocol. 

For more information about the trust manager, start transaction STRUST and choose Help -> Application 

Help. 

Requirements 

You have received your authentication certificate from Ariba. 

Activities 

1. In the navigation structure, click SSL client SSL Client (Anonymous). 

2. Under Certificate, click the icon Import Certificate to upload the certificate file (format *.cer) that 

you have received from Ariba. 

3. Click Add to Certificate List. The certificate appears in the Certificate List. 

4. Save your data. 
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37.1.1.5.4 Manage and Test Enterprise Services 

Use 

You can use the SOA Manager to configure Enterprise Services and Enterprise Service clients. You open 

the SOA Manager in a browser window. 

For more information about the SOA Manager, search for the keywords "Working with the SOA 

Manager" in the documentation for SAP NetWeaver. 

37.1.1.5.5 Schedule Polling Agent 

Use 

When you activate an inbound message type under Define Basic Message Settings that is received via 

direct connectivity or via HANA Cloud Integration (HCI), a corresponding job is automatically 

scheduled in the Technical Job Repository to fetch the messages for this type from Ariba Network. 

If you prefer a more flexible handling, such as fetching messages of several types using the same job, 

you can deactivate the job definition in the Technical Job Repository and schedule the report Fetch 

cXML messages for different message types from Ariba Network 

(ARBFND_FETCH_CXML_MESSAGES_NEW) instead. This report is frequently referred to as 

Polling Agent and must be scheduled in transaction Define Background Job (TA SM36). 

37.1.1.6 Mediated Connectivity Settings for Integration Using PI 

37.1.1.6.1 Integration Engine Administration 

Use 

In this Customizing activity, you make settings that enable the Integration Engine of SAP NetWeaver 

Process Integration (SAP NetWeaver PI) to perform the exchange of messages between your SAP ERP 

systems and Ariba Network. Note that in the list of entries displayed, only Integration Engine 

Configuration is relevant. 

Requirements 

Your SAP NetWeaver PI system has been set up and connected to all relevant SAP ERP systems. 

Activities 

1. Under Configuration, double-click Integration Engine Configuration. 

2. Verify whether the information displayed is correct. Otherwise, check the connectivity to your PI 

system. 

For more information, see Help -> Application Help. 



 

 

37.1.1.7 Map Unit of Measure Codes for cXML Messages 

Use 

With these IMG activities, you can map the ISO codes used in your SAP S/4HANA system to the unit of 

measure codes used in cXML messages, and the other way round. 

37.1.1.8 Business Add-Ins (BAdIs) 

37.1.1.8.1 BAdIs for Ariba Integration - Foundation 

37.1.1.8.1.1 Notes on Implementation 

Use 

All Business Add-Ins (BAdIs) grouped under this structure node belong to the enhancement spot 

ARBFND_INTEGRATION. 

37.1.1.8.1.2 BAdI: Notification About Communication Errors 

Use 

The Business Add-In BAdI for Ariba Integration Foundation (ARBFND_INTEGRATION) with the 

method Error Notification (NOTIFY_ABOUT_ERROR) is used in the Integration Component for Ariba 

Network. You can use this BAdI to trigger actions if errors have occurred during the communication 

between your SAP System and Ariba Network. 

Example 

You can find example implementation CL_EX_ARBFND_BADI_INTEGRATION in the BAdI Builder 

on the Enhancement Spot Element Definitions tab in the Implementation Example Classes section. This 

example implementation illustrates how you can send error notifications as e-mails. 

37.1.2 Application-Specific Settings 

37.1.2.1 Available Message Types 

Use 
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The following cXML message types are available to be exchanged with Ariba Network: 

- OrderRequest (outbound direction): For purchase orders 

- InvoiceDetailRequest (inbound direction): For invoices that are sent from the Ariba Network 

- ConfirmationRequest (inbound direction): For purchase order confirmations 

- ShipNoticeRequest (inbound direction): For inbound deliveries 

- StatusUpdateRequest (outbound direction): For example, for message processing results, or for the 

invoice payment status 

- 

37.1.2.2 Assign Ariba Network ID to Company Code 

Use 

In this Customizing activity, you can assign the Network IDs that you have received for Ariba Network 

to the company codes in your SAP System. This enables Ariba Network to clearly identify the sender of 

the cXML message. 

Note that you can use the same Network ID for more than one company code. Similarly, you can use 

several Network IDs for one company code. Normally, you assign one Network ID to one company 

code. If you want to assign more than one Network IDs to a company code, you must implement the 

Outbound Mapping BAdI to adapt the assignment of the Network ID to your requirements. For more 

information, see the documentation of the Outbound Mapping BAdI. 

Requirements 

You have entered at least one Ariba Network ID under Define Credentials for Ariba Network. 

37.1.2.3 Enable Vendors for Ariba Network 

Use 

In this Customizing activity, you enable suppliers to engage in business with you through Ariba Network. 

This activity triggers an invitation process on Ariba Network for suppliers that have not yet subscribed to 

the Network. 

Activities 

1. Select New Entries. 



 

 

2. Specify the ID that your supplier has in SAP S/4HANA. 

3. Activate quick enablement. By doing this, you create an Ariba Network account on behalf of the 

supplier. The system transfers the supplier's company information from the SAP S/4HANA system 

to Ariba Network as part of the cXML message. On the basis of this information, the account is 

created. 

37.1.2.4 Define Message Output Control 

Use 

In this Customizing activity, you have to define the output control for documents that you want to 

transfer from S/4HANA to Ariba Network. To do this, you have to carry out the following subactivities 

that are explained below: 

1. Define Business Rules for Output Determination 

2. Map Application and Output Type to cXML Message 

a) For purchase orders that were converted from a predecessor SAP ERP system, use message 

control (NAST). 

b) For purchase orders that are newly created in SAP S/4HANA, use output management. 

3. Activate Business Transaction Event to Trigger Invoice Status Message 

Define Business Rules for Output Determination (Only Relevant for Purchase Orders) 

For each supplier, you have to define XML as the output channel for purchase orders. Proceed as 

follows: 

1. Select Purchase Order as the document for which you want to determine output 

parameters. 

2. Next to Determination, select Channel. 

3. Under Maintain Business Rules, click Edit. 

4. Add a row for the supplier to whom you want to send cXML messages. 

5. Under Output Type, select Direct Value Input -> Output Type is equal to -> select 

PURCHASE_ORDER. 

6. Under Recipient, select Direct Value Input -> Receiver ID is equal to -> specify the supplier ID. 

7. Under Channel, select Direct Value Input -> Channel: select XML. 

8. Check, save, and activate your entries. 

For more information about defining business rules for output determination, see Define Business Rules 

for Output Determination. 

Important: Only for Objects Converted from SAP ERP to SAP S/4HANA 

For customers who had their SAP ERP system integrated with Ariba Network and are now converting to 

SAP S/4HANA, triggering messages using the message control NAST is still available for purchase 

orders that were created in SAP ERP and that have already been transferred using NAST. However, all 
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purchase orders that have been created in SAP S/4HANA must be transferred using the output 

management (see below). 

For objects converted from SAP ERP to SAP S/4HANA, follow the instructions described in   Mapping 

of Application and Output Type to cXML Message (For Converted Objects). 

For All Objects New in SAP S/4HANA: Map Application and Output Type to cXML 

Message (Output Management) Make the following entries: 

Application Object Type Output Type cXML Message Type Object Type 

PURCHASE_ORDER PURCHASE_ORDER ORDR BUS2012 

 SUPPLIER_INVOICE INVOICE_STATUS_UPDATE STAT BUS2081 

Activate Business Transaction Event to Trigger Invoice Status Message (Only Relevant for 

Invoice Status Update Message) 

In this Customizing activity, you have to activate a set of Business Transaction Events (BTEs) to record 

changes to invoices in SAP S/4HANA Financials if the changes are relevant for sending 

InvoiceStatusUpdate messages. 

To activate BTEs, select the checkbox Active for the given application indicator ARBERP. 

37.1.2.5 Define Document-Specific Message Customizing 

Use 

In this Customizing activity, you define whether you want to do the following: 

- Transfer Attachments with cXML Messages 

Here you define whether you want to enable the transfer of attachments with your business objects. 

You define this for inbound and for outbound messages. You can differentiate your settings for 

each inbound and outbound message type that exists in the Ariba system. If you want to enable the 

transfer, select Document Management System. If you do not make an entry, attachments are not 

transferred to AN, and incoming attachments are not stored. Note that only attachments stored in 

the Document Management System are supported. 

- Attach the cXML Message Payload to Business Objects 

You choose this if you want to store the cXML message payload from which the business object 

originates. This setting is typically used for invoices. 

37.1.2.6 Define Application-Specific Mapping Settings 

37.1.2.6.1 Define Mapping Settings for Shipping Notifications 

Use 



 

 

Shipping notifications can contain information about the carrier. In this Customizing activity, you can 

map the carrier domains and IDs used by Ariba to the carrier IDs used in SAP S/4HANA. Note that, in 

SAP S/4HANA, carriers have the business partner type Vendor. 

37.1.2.6.2 Define Mapping Settings for Invoices 

Use 

In this Customizing activity, you can define the mapping of data that is relevant for Logistics Invoice 

Verification. Using Logistics Invoice Verification is mandatory if you transfer invoices between Ariba 

Network and SAP S/4HANA. 

Related Customizing 

You can customize vendor-specific tolerances: vendor-specific tolerances. 

Mapping Activities 

Incoming Invoice: Map Tax Codes for Logistics Invoice Verification 

In this activity, you map the tax categories and country-specific values that exist on Ariba Network to the 

tax codes in your SAP S/4HANA system. You can do this for each of your vendors. 

As a prerequisite, tax categories must be configured for your Ariba Network account. 

Incoming Invoice: Map Company Codes for Logistic Invoice Verification 

In this activity, you map the company code in your SAP S/4HANA system to a billTo name in the 

incoming cXML message. You do this for each of your vendors. 

Incoming Invoice: Enter Control Parameters for Logistics Invoice Verification 

In this activity, you define the following information for incoming invoices that a vendor sends to a 

specific company code: 

- Which types of invoices and credit memos you want to create in SAP S/4HANA 

- How the system reacts if there are differences between the values received in cXML and the values 

proposed by SAP S/4HANA. 

For more information, see the Activities section below. 

Incoming Invoice: Map cXML Partner to SAP S/4HANA Invoicing Party 

In this activity, you can specify a different invoicing party for incoming cXML invoices. You do this if 

you want to post an incoming invoice to a different vendor than the vendor in the purchase order. 

To determine the invoicing party, the system uses the name that is transferred in cXML tag 

"InvoicePartner" (with role "from"), in combination with the technical sender of the cXML message 

(identified by VendorID in "From" "Credential"). 

In the column Name of Invoicing Party you have to specify the vendor ID in S/4HANA that you want to 

be the invoicing party. 

If you want outgoing documents and invoice status updates to be sent to the original vendor, select the 

Reverse Mapping checkbox. 

This Customizing is optional. By default, the invoicing party is identical with the vendor in the purchase 

order. 

If you want to overrule the logic described above, you can use the BAdI method 

INVC_INV_PARTY_DETERMINATION of the inbound mapping BAdI 

(ARBERP_INBOUND_MAPPING). 
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Activities 

Incoming Invoice: Enter Control Parameters for Logistics Invoice Verification 

To specify the control parameters necessary for Logistics Invoice Verification, proceed as follows: 

1. Select New Entries. 

2. Specify a vendor from whom you receive invoices and credit memos. 

3. Specify the company code that receives the invoices and credit memos. 

4. Under Inv.doc, select the type of invoice that you want to create in SAP S/4HANA for invoices 

coming in from Ariba Network. 

5. Under Cred.doc, select the type of credit memo that you want to create in SAP S/4HANA for credit 

memos coming in from Ariba Network. 

6. Under Logistics Invoice Verification, define how the system reacts if there are differences between 

the values received in cXML messages and the values proposed by SAP S/4HANA. To do this, you 

must specify one of the following: 

- No Error 

The invoice document is posted using the invoice data. If it contains quantity or price 

variances, the system blocks it for payment. 

- Unclarified Error: Park Invoice 

The invoice document is created with unclarified errors. It is saved with the values proposed 

by the system and the values contained in the cXML invoice. You have to manually process 

the parked invoice later. 

- Unclarified Error: Create Draft Invoice 

The invoice document is created with unclarified errors. It is saved with the values proposed 

by the system and the values contained in the cXML invoice. You have to manually process 

the draft invoice later, using the Manage Supplier Invoices app. 

7. Define whether the material numbers and units of measure in the cXML invoice are compared to 

those in the purchase order items. Note that the invoice cannot be posted if there are variances. 

8. Define whether the system additionally checks the invoice document for negative variances, in 

other words, checks for variances in favor of the invoice recipient. 

9. Under Logistics Invoice Verification - w/o order reference, define how the system reacts if in an 

invoice the order reference is missing or invalid. To do this, you must specify one of the following: 

- Do not process 

The invoice is rejected, a corresponding error message is logged in SLG1, and a 

corresponding InvoiceStatusUpdate message is sent to Ariba Network. 

- Park invoice 

The invoice document is created in S/4HANA with status "parked". You have to manually 

process the parked invoice later. 

- Create draft invoice 

The invoice document is created in S/4HANA as a draft. You have to  manually process the 

draft invoice later, using the Manage Supplier Invoices app. 



 

 

37.1.2.7 Map Texts 

Use 

In this Customizing activity, you can map cXML comments to SAP S/4HANA texts. 

Define cXML Comment Types for Text Mapping 

In this activity, you specify the cXML comment type IDs that you want to map to SAP S/4HANA texts. 

For example, you can specify the cXML comment type COMMENTS_TO_BUYER and a text that 

explains the comment type. 

Define Text Mapping for Inbound Messages 

In this activity, you specify the mapping details for cXML messages that you receive from Ariba 

Network. For more information, see the Activities section below. 

Define Text Mapping for Outbound Messages 

In this activity, you specify the mapping details for cXML messages that you send to Ariba Network. For 

more information, see the Activities section below. 

Requirements 

Text types have been defined in SAP S/4HANA. 

Activities 

Define Text Mapping for Inbound Messages 

Proceed as follows: 

1. Choose New Entries. 

2. Select a combination of cXML message type and cXML element ID. The columns for the 

corresponding object type and object node in SAP S/4HANA are then automatically filled. 

3. Select the ID of a comment type that you want to map. You have the following options: 

- Use one of the comment type IDs you have specified under "Define cXML Comment Types 

for Text Mapping". 

- Use the blank entry to map all cXML comments that have no comment type to a specific SAP 

S/4HANA text object and ID. 

- Use the wildcard (*) to map all cXML comments, independent of their comment type, to a 

specific SAP S/4HANA text object and ID. 

4. Select a combination of SAP S/4HANA text object and text ID to which you want to map the 

cXML comments. 

Define Text Mapping for Outbound Messages 

You can explicitly define which texts existing in SAP S/4HANA are transferred to Ariba Network. To do 

this, proceed as follows: 

1. Choose New Entries. 
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2. Select a combination of  the SAP S/4HANA business object type (currently only "purchase order" is 

possible) and  object node (header or item). The columns for the corresponding cXML message 

type and element ID are then automatically filled. 

3. Select a combination of SAP S/4HANA text object (EKKO for header texts, or EKPO for item 

texts) and text ID that you want to map to cXML. 

4. If you want to map the text to a specific comment type on Ariba Network, enter the corresponding 

comment type ID. If you do not enter a comment type ID, the text is nevertheless included in the 

cXML message. 

Example 

Text Mapping for Inbound Messages 

A shipping notification received from Ariba Network contains the comment type "Transport". You can 

map this comment type to the text "S/4HANA Transport Information" that you may have defined for 

business objects of the object type "Inbound Delivery". 

37.1.2.8 Adapt Mapping of Incoterms to cXML "TransportTerms" 

Use 

In this Customizing activity, for each incoterm in your SAP S/4HANA system you can define what you 

want to transfer in the cXML element "TransportTerms" as the value and as the content for the incoterm. 

You do this if the recipient of the cXML message expects the "TransportTerms" in a specific way that 

differs from the standard. 

This Customizing activity is optional. 

Example 

In your SAP S/4HANA system, the incoterm "FOB" exists, and it has the description "Free on board". 

By default, this incoterm is transferred to the Ariba Network in the cXML element "TransportTerms" 

with the value "FOB" and the content "Free on board". 

However, you want to transfer "Free on Board" as the value and "FOB" as the content. 

To reflect this, select the incoterm "FOB" and make the corresponding entries in the columns cXML 

'TransportTerms' Value and cXML 'TransportTerms' Content. 

37.1.2.9 Business Add-Ins (BAdIs) 

37.1.2.9.1 BAdI: Outbound Mapping 

Use 



 

 

This Business Add-In (BAdI) is used in the BNS-ARI-SE component. You can use this BAdI to change 

the result from the mapping of outbound SAP S/4HANA documents to Ariba cXML messages. 

Outbound SAP S/4HANA documents can be purchase orders only. 

Methods Relevant for all  Outbound cXML Message Types 

DEFINE_CUST_SPEC_MAPPING 

With this method, you can freely define your own mapping. You can analyze the outgoing documents. 

You can implement a logic that decides, based on the results of the analysis, whether a document should 

undergo the standard mapping or not.  Set the parameter cv_proceed_with_appl_proc for documents that 

should undergo the standard mapping. 

ASSIGN_SENDER_ANID 

You can overwrite the standard assignment of an Ariba Network ID (ANID) to the sender of an outbound 

document. By default, the ANID is assigned on company code level.  You can use this BAdI, for 

example, to assign ANIDs on a lower level, such as the level of purchasing organizations. 

ASSIGN_SENDER_ENDPOINT 

You must implement this method if you have assigned more than one end point to one Ariba Network 

ID. In this case, use this method to define unique end points for outbound documents. 

Methods Relevant for Specific Processes 

- Send purchase orders to Ariba Network with cXML OrderRequest Message Method 

MAP_BUS2012_TO_ORDR_OUT: 

You can enrich or (partially) overwrite the cXML message after the standard mapping has been 

performed. 

- Send invoice status updates to Ariba Network with cXML StatusUpdateRequest Message Method 

MAP_BUS2081_TO_STAT_OUT: 

You can enrich or (partially) overwrite the cXML message after the standard mapping has been 

performed. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

Example 

You can find an example implementation in the BAdI Builder on the Enhancement Spot Element 

Definitions tab in the Implementation Example Classes section. 

- CL_EX_ARBERP_BADI_OUTBOUND_MAP 

This is an example implementation for outbound purchase orders. It enriches the resulting Ariba 

cXML message with information about purchasing groups and purchasing group texts on header 

level, and with information about product types, product type texts, and customer part numbers on 

item level. 

37.1.2.9.2 BAdI: Inbound Mapping 

Use 
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This Business Add-In (BAdI) is used in the BNS-ARI-SE component. You can use this BAdI to change 

the mapping of Ariba cXML message elements to SAP S/4HANA application interface structures. 

Inbound Ariba cXML messages can be invoice messages only. 

The following are possible use cases for this BAdI: 

1. You want to freely define your own mapping. 

2. You want to implement your own processing logic. 

3. Ariba cXML messages contain field types that are not considered in the standard mapping, for 

example, if cXML messages have been enhanced with extrinsic elements. In this case, you can use 

the BAdI to include additional fields into the mapping. 

4. You want to map one or more cXML elements to ABAP fields different from those assigned in the 

standard mapping. In this case, you can modify the standard mapping. 

5. You want to perform additional functions, for example, an own attachment handling, after the 

application interface processing. At this point in time, the business object is created, but not yet 

persisted. 

Note: 

You must not trigger "Commit Work" within this BAdI. 

6. For invoices, you want to change the standard company code determination, or the standard tax 

code determination, or you want to define how multiple tax codes on header level are to be assigned 

to the items. 

For use cases 1 and 2, the method DEFINE_CUST_SPEC_PROCESSING is available. It is called for all 

incoming cXML messages. 

You can analyze the incoming messages. You can implement a logic that decides,  based on the results of 

the analysis, whether a message should undergo the standard mapping and processing logic or not. Set 

the parameter cv_proceed_with_appl_proc for messages that should undergo the standard mapping and 

processing logic.  

If you want to define your own mapping, but you want to apply the standard processing logic to call the 

application interface, you can use the parameter cv_skip_stmap_and_call_appl_if. 

For use case 3 and 4, the BAdI includes one method per document type. These methods are called before 

the application interface is called (pre-methods), but after the standard mapping has been performed: 

- MAP_INVC_TO_BUS2081_IN_PRE 

- MAP_SHIP_TO_BUS2015_IN_PRE 

- MAP_CONF_TO_BUS2012_IN_PRE 

For use case 5, the BAdI contains one post-method per document type. Post methods are called after the 

business object has been created. The following post-methods are available: 

- MAP_INVC_TO_BUS2081_IN_POST 

- MAP_SHIP_TO_BUS2015_IN_POST 

- MAP_CONF_TO_BUS2012_IN_POST 

Three methods are available for the use cases described under 6. They are called during the standard 

mapping and can be used specifically for invoices: 

- INVC_COMPANYCODE_DETERMINATION 

- INVC_INV_PARTY_DETERMINATION 

- INVC_TAXCODE_DETERMINATION 



 

 

- INVC_ITM_TAXCODE_DETERMINATION 

You can use this method for inbound messages where more than one tax code is assigned on header 

level. The method is called for each item that is mapped to the SAP S/4HANA interface structures 

and determines the correct tax code to be used for the item. You can use this method only if no tax 

jurisdiction is active. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

37.2 Integration with SAP Hybris Cloud for Customer 

37.2.1 Download S/4HANA Customizing Information for Code Lists 

Use 

In this Customizing activity, you can download code list mapping from the SAP S/4HANA system to a 

Microsoft Excel® file. The automatic configuration of code lists in SAP Hybris Cloud for Customer, 

avoids manual maintenance of code list mapping for each of the code lists. 

Automatic configuration of code lists involves the following steps: 

1. Downloading code lists in SAP Hybris Cloud for Customer 

2. Downloading mapping information from SAP S/4HANA, as performed in this activity 

3. Reviewing the mapping information (.CSV files) for the proposed suggestions on code lists and the 

mappings 

4. Uploading the mapping information in SAP Hybris Cloud for Customer. 

Note: SAP recommends using the automatic configuration during initial load and manual maintenance 

during updates. 

Requirements 

- You have downloaded the code lists in a Microsoft Excel® file from the SAP Hybris Cloud for 

Customer system. 

- You know the code list mapping group ID and the delimiter, which were specified while 

downloading the code lists. 

Activities 

1. Enter the code list mapping group ID as the Group Code ID. 

2. Specify the path where the mapping information from ERP should be saved. 

3. Ensure that the CSV Delimiter that is specified here is the same as the delimiter that you had 

specified while downloading the code lists in SAP Hybris Cloud for Customer. 
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4. Specify the path to the Microsoft Excel® file downloaded from SAP Hybris Cloud for Customer. 

5. Check Consider C4C code list mapping, if you do not want to change the existing mapping 

information. Only those ERP/CRM codes that do not occur in the existing mapping are added. This 

is preferred during an upgrade. 

6. Uncheck Consider C4C code list mapping, like during an initial load, if you want only the code lists 

to be considered, and all existing mappings to be overwritten. 

7. If you want to download the code lists in additional languages, select the required languages. Code 

lists in all the selected languages will be downloaded, which can be further used to upload to SAP 

Hybris Cloud for Customer. If a description already exists in Cloud in the selected additional 

language, the description is not updated. 

8. Execute the report. 

The delta changes to the code lists and the mappings will be downloaded to the archive file in the 

specified directory. 

37.2.2 Communication Setup 

37.2.2.1 Check E2E Connectivity from S/4HANA to C4C 

Use 

To check the end to end connectivity from S/4 HANA to CFC system. 

Standard settings 

You can now check if a technical connection has been successfully established between your SAP on-

premise and SAP Hybris Cloud for Customer systems. A successful connection ensures that the data is 

flowing between the two systems via the SAP PI or SAP HCI middleware. 

In the Cloud system, you can click the Test Connection button in the Communication Arrangement 

wizard to check if the data is successfully reaching the SAP on-premise system. 

When you execute the report, call is made to the middleware system with the information maintained in 

the logical port of the consumer proxy. If the authentication and authorization with the middleware 

system is successful, middleware system forwards the call to the SAP Hybris Cloud for Customer 

system. If the authentication and authorization between the middleware system and SAP Hybris Cloud 

for Customer system is successful then the report returns a success message for end to end connectivity, 

else the report captures the exceptions and failures wherever it occurs and returns it as an application log. 

Activities 

Check report documentation for technical details. 

37.2.2.2 Automatically Generate Integration Settings for Data Exchange 



 

 

Use 

The report RCOD_CREATE_CONNECTIVITY_SIMPL automates the steps of configuring the 

following: 

- Create RFC destinations 

- Create port definition 

- Create partner profiles 

- Maintain distribution model 

- Activate a service 

- Maintain endpoints for services 

- Jobs for IDoc inbound and outbound processing 

- Send IDocs from S/4 HANA to SAP Hybris Cloud for Customer 

- Create variants of the RBDMIDOC Report 

- Process IDocs sent from SAP Hybris Cloud for Customer 

Activities 

1. Generate Integration Settings: Step 1: Select the middleware used to integrate SAP Hybris Cloud 

for Customer with SAP S/4 HANA, and click Next. 

2. Generate Integration Settings: Step 2: Select the scope of integration exactly as scoped in the SAP 

Hybris Cloud for Customer solution. 

3. Generate Integration Settings: Step 3: Perform the following: 

 Logical System Do one of the following: 

->Enter the logical system of the S/4 HANA 

system or 

->Click Create Logical System to create one. The 

logical system ID the same as the system ID of your 

SAP Hybris Cloud for Customer 

solution. 

Note:  

To find the system ID, login to the SAP Hybris 

Cloud for 

Customer system, and navigate to Administrator 

work center-> 

Communication Arrangements. Open any 

communication arrangement, say Business Partner Replication from External System. 

You will find the ID in the field My System ID. 

Job Schedule Interval Enter the frequency with which the inbound and outbound IDocs should be 

processed in the S/4 HANA system. 

Job User Enter the user for whom the jobs to process inbound and outbound IDocs are created. 

4. Generate Integration Settings: Step 4: Enter the connection information about the selected 

middleware to generate the RFC destinations. 

- If you had selected the middleware as SAP HANA Cloud Integration: 

Runtime URL URL to the HCI tenant 
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Proxy details of the 

reverse proxy. 

Host name, service name and the access details 

Authentication (basic or certificate) 

credentials. 

Either import the certificate or enter the user 

- If you had selected the middleware as SAP  PI (Dual Stack): 

Target Host and system number Host name and the system number of the PI system. 

 Gateway information The Gateway Host and Gateway Service exactly 

as maintained for inboundRA resource adapter in NWA of PI system, under Configuration ' 

Infrastructure ' Application Resources. 

 Logon details to PI The user credentials to the PI system. 

- If you had selected the middleware as SAP  PI (Java-only stack), enter the Program ID, 

Gateway Host and Gateway Service exactly as maintained for inboundRA resource adapter in 

NWA of PI system, under Configuration ' Infrastructure ' Application Resources. 

5. Consumer Proxy Settings: Step 5/6: If you have selected any scenario which has a 

consumer proxy associated with it (for e.g Business Partner replication) then this 

additional screen will be shown. 

6. In this screen you have to enter the following 

- Logical Port - Name of the logical port in SOA Management for the consumer proxy used for 

checking E2E connectivity. 

- URL Access Path - Middleware service path URL for webservice call. This is unique for each 

scenario 

- In case of SAP NetWeaver Process integration (PI) the service path can be obtained from 

sender agreement which should be of format :- 

/XISOAPAdapter/MessageServlet?senderParty=&senderService=<S/4 HANA Business 

System Name>&receiverParty=& 

receiverService=&interface=ConnectivityCheckConsumer&interfaceNamespace=http%3A 

%2F%2Fsap.com%2Fxi%2FCODERINT 

- In case of HCI :- /cxf/CRM/COD/SimpleConnect 

- Computer Name - Name of  computer of above PI / HCI system. 

- URL Port - Port number of the URL. For PI the port can be obtained from SMICM or ICM 

admin. For HCI it can be set to 443. 

- URL Protocol - Protocol for webservice call. For example HTTP/HTTPS. 

- Proxy Host - Name of proxy host if a proxy is used for the http connection (optional) 

- Proxy Port - Port number of proxy host if a proxy is used for the http connection (optional) 

- Proxy User - Name of user if a proxy is used for the http connection (optional) 

- Proxy - Password - Password for the user if a proxy is used for the http connection (optional) 

- 

7. Generate Integration Settings: Step 5/6: Review the displayed summary. You can change any 

settings by navigating to the previous steps. Once you have reviewed, click Generate and OK to 

start the generation of the relevant connectivity entities. 

The log screen displays all the carried out activities in a log. 

Note: You can access the log in the transaction SLG1, and view the activities. For example, specify the 

user who triggered the log and click execute. 



 

 

Important reports scheduled as jobs when this report is executed 

RSEOUT00 

You send the previously created IDocs from SAP S/4 HANA to the cloud solution. 

A variant of the report RSEOUT00 for the following message types is created 

 - MATMAS_CFS 

Caution 

It is important that DEBMAS_CFS and ADRMAS/ADR3MAS are sent by separate runs of RSEOUT00 

and that DEBMAS_CFS is sent first. 

RBDMIDOC 

A variant of the report RBDMIDOC is created for each of the following message types: 

 - MATMAS_CFS 

37.2.2.3 Manually Adjust Integration Settings for Data Exchange 

37.2.2.3.1 ALE setting for the HTTP inbound 

Activities 

In the SAP note 1510812 - IDoc communication with SAP Business ByDesign, refer to topic IDoc 

processing for HTTP inbound processing. 

The automatic setup report creates the XML HTTP port with content type Application/x-sap.idoc instead 

of Text/XML. Since IDoc packaging is not supported with the content type Application/x-sap.idoc, the 

routing conditions are modified to work with Text/XML only. Hence, for each of the XML HTTP ports 

generated by the report change the content type to Text/XML. 

1. Go to transaction OYEA. 

2. In the Global Parameters for IDoc Interface screen, under IDoc Inbox HTTP, set Start W/O Event 

Linkage. 

While processing incoming HTTP IDocs immediately, this step ensures that the user is not switched from 

the remote user to WF-BATCH. You should do this if you do not rely on this user switch; for example, if 

you are not already using the HTTP inbound in other scenarios. 

37.2.2.3.2 Define Logical System 

Use 

In this step, you can define the logical systems in your distributed system. A logical system must be 

configured once per SAP S/4 HANA system as client-independent Customizing. From a business 

perspective, the communication partner for SAP S/4 HANA is neither SAP PI nor SAP HCI, but SAP 
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Cloud for Customer solution. In other words, objects are exchanged with SAP Hybris Cloud for 

Customer, and not with PI or HCI, which is only a technical communication partner. The logical system 

defined for the SAP Cloud for Customer solution will be linked to the RFC destination of PI or HTTP 

destination of HCI. 

Caution 

Logical systems defined in BD54 are available across all clients in the S/4 HANA system. 

Requirements 

SAP recommends using the system ID of the SAP Hybris Cloud for Customer system as the Logical 

System ID. 

Note: 

To find the system ID of the SAP Hybris Cloud for Customer system: 

In the SAP Hybris Cloud for Customer system, navigate to Administrator work center ' Communication 

Arrangements, and open any communication arrangement, say Business Partner Replication from 

External System. You will find the ID in the field My System ID. 

Activities 

1. Click New Entries. 

2. Enter the system ID of the SAP Hybris Cloud for Customer solution as logical system, and enter a 

name. 

3. Save the entry, and assign a transport request subsequently. 

37.2.2.3.3 Define RFC Destinations 

Use 

RFC destination contains technical information that enables the S/4 HANA system to locate an external 

system such as an SAP PI system. This destination is required for IDoc communication from an SAP S/4 

HANA to an SAP PI system. 

SAP recommends that you use the logical system ID of the PI system as the RFC destination name, as 

follows: <PI System>CLNT<PI Client>. 

Requirements 

You have created an RFC logon user in the S/4 HANA system. 

Activities 

If you have a HCI system, create the following destinations provided you want to integrate the 

mentioned scenario between S/4 HANA and SAP Hybris Cloud for Customer: 

- A HTTP destination for material. 



 

 

- A HTTP destination for quote and opportunity confirmation. 

- A HTTP destination for service ticket conformation request. 

To create a HTTP destination: 

1. Select HTTP Connections to External Server, and click Create. 

2. In the RFC Destination screen, enter the following details: 

- RFC Destination : <system ID of the cloud server>_<message type> 

- Connection Type : G (HTTP Connection to External Serv) 

- Description 1 : Enter the object for which you are creating a HTTP destination, for example HCI 

destination for relationships between business partners 

- Description 2 : Enter a detailed description, for example, Replication of relationships between 

accounts, contacts, competitors, prospects and employees. 

3. In the Technical Settings tab, enter the technical settings of the HCI Cloud integration tenant. 

- Target Host Name: <Host name of the HCI tenant> 

- Service No.: 443 

- Path Prefix: Enter the path based on the HTTP destination you are creating: 

- For a HTTP destination for material - /cxf/ERP/COD/MATMAS_CFS.MATMAS05 

- For a HTTP destination for Quote and Opportunity Confirmation - 

/cxf/ERP/COD/COD_OPPT_CONF.ORDERS05 

- For a HTTP destination for Service ticket confirmationRequest - 

/cxf/ERP/COD/COD_OPPT_CONF.ORDERS05 

 4. In the Logon & Security tab, enter the HCI user's login and security information. 

- Under Logon with User, select the option of Basic Authentication, and enter 

- user  : <technical user for Cloud Integration Tenant> 

- password  : <password for Cloud Integration Tenant> 

- Under Security Options, select SSL as Active 

- SSL Certificate as DFAULT SSL Client (Standard) 

5. Save your entry. 

6. To test the connection, choose Remote Logon. 

The connection is established as soon as the required system automatically opens. 

If you have a dual-stack PI system: 

7. Select ABAP Connections, and click Create. 

8. In the RFC Destination screen, enter the following details: 

- RFC Destination : <PI System>CLNT<PI Client> 

- Connection Type : 3 (ABAP Connection) 

- Description : PI System for SAP S/4 HANA Integration with SAP Hybris Cloud for 

Customer 
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9. In the Technical Settings tab, enter the technical settings of the PI system such as the host name and 

system number of the PI server, and press ENTER. The IP address appears. 

To find the host name of the PI server: 

a) In the SAP Logon window, select the PI system. 

b) Right-click and select Properties. 

c) The Connection tab displays the Message Server (host name). 

10. In the Logon & Security tab, enter the PI integration server user's login and security information. 

Note 

The PI user should have the role SAP_XI_APPL_SERV_USER. For more information, see help.sap.com 

> Technology > SAP NetWeaver Platform > SAP NetWeaver 7.0 including Enhancement Package 3 > 

Technology Consultant's Guide > Configuration Wizard > Business 

Suite Connectivity Configuration - Overview > Basic Configuration for Connecting SAP PI and 

SAP ABAP Systems > Creating RFC Destinations in the ABAP Environment of PI System (Type 3) 

The user name entered here must also be created in the SAP Hybris Cloud for Customer system with the 

corresponding authorization and password. 

11. Save your entry. 

12. To test the connection, choose Remote Logon. 

The connection is established as soon as the required system automatically opens. 

If you have a JAVA-only PI system: 

13. Select TCP/IP Connections, and click Create. 

14. In the RFC Destination screen, enter the following details: 

- RFC Destination : IDOC_AAE_<name of the PI System> 

- Connection Type : T (TCP/IP Connection) 

- Description : PI System for SAP ERP Integration with SAP Hybris Cloud for Customer 

 15. In the Technical Settings tab: 

- Choose Registered Server Program. 

- Enter the Program ID of the PI system, and press ENTER. 

- Enter the Gateway Host and Service where the program ID is registered. 

Caution: 

The Program ID, Gateway Host and Gateway Service should exactly match the values maintained for 

inboundRA resource adapter in NWA of the SAP PI system, under Configuration ' Infrastructure ' 

Application Resources. 

For more information, see the chapter Resource Adapter (InboundRA) Configuration for 

IDOC_AAE Adapter in the integration guide SAP S/4 HANA and SAP Hybris Cloud for Customer via 

SAP PI available on Service Marketplace (http://service.sap.com/cloud4customer). 

16. In the MDMP & Unicode tab, select the Communication Type with Target System as Unicode. 

17. Save your entry. 



 

 

37.2.2.3.4 Maintain port definition 

Activities 

1. Select Transactional RFC as port type in the tree of ports and click Create. 

2. Select own port name, enter a Name, for example, PI_CODINTE, and click Continue. 

3. Select IDoc record types SAP Release 4.x, and then select the RFC destination you just created. 

4. Click Save. 

37.2.2.3.5 Maintain Distribution Model 

Use 

The distribution model is the central point of control to determine and dispatch IDocs to the correct 

system. 

Activities 

1. Click on Switch between Display and Edit Mode. 

              A model view is for grouping purpose only, and has no functional meaning. 

2. Click on Create model view to create a new entry for each message type. 

3. In the Create Model View dialog, enter the following: 

a) Short Text, for example, S/4 HANA - C4C Integration via PI or HCI. 

b) Technical Name, for example, S/4 HANA-PI/HCI. 

c) Click on Continue. 

              The view appears in the Model views tree. 

4. Select the view you just created, and choose Add Message Type. 

5. In the Add Message Type dialog, do the following: 

a) Sender: Select the logical system of the SAP S/4 HANA system. 

b) Receiver: Select the logical system of the SAP Hybris Cloud for Customer system. 

c) Message Type: Choose the appropriate message type. 

d) Save your entries. 

                   Repeat the above steps for the message types 

- MATMAS_CFS 

- COD_OPPT_CONF 

- COD_Service_request_conf 

- DEBMAS_CFS 

- COD_ERP_SD_ORGS_SAVE 
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- HRMD_A_CFS 

6. Select the model view you just created, and choose Add BAPI and enter the following details: 

a) a. Sender: Select the logical system of the SAP S/4 HANA system. 

b) b. Receiver: Select the logical system of the SAP Hybris Cloud for Customer system. 

c) c. Object name/interface : AddressOrg 

d) d. Method : SaveReplica 

7. Repeat the previous step with the object name AddressContPart, and Method SaveReplica. 

  Note 

To ensure that only the addresses of those customers, which are sent to the cloud solution, are distributed, 

carry out the following steps: 

- Underneath the BAPI AddressOrg.SaveReplica double click on the entry Receiver 

determination: no filter. 

- In the Change Filter dialog box, choose Create filter group. 

- Expand the node and mark the checkbox Dependent distribution for the message 

DEBMAS_CFS for the technical name Address owner object ID. 

- For BAPI AddressOrg-SaveReplica please add also the filter value 0001 for technical name 

Address semantics and the filter value KNA1 technical name Address owner object type. 

- For BAPI AddressContPart-SaveReplica please add also the filter value 0005 for technical 

name Address semantics, the filter value KNA1 for technical name Address owner object type 

(first entry) and filter value BUS1006001 for technical name Address owner object type 

(second entry) . 

- Choose Continue. 

- Repeat these steps for the BAPI AddressContPart-SaveReplica. 

- Add filter objects to the DEBMAS_CFS entry according to your distribution needs. 

- Add filter objects to the MATMAS_CFS entry according to your distribution needs. 

To distribute the address IDocs ADRMAS (BAPI AddressOrg-SaveReplica and ADR3MAS (BAPI 

AddressContPart-SaveReplica) according to the customer master Idocs, carry out the steps mentioned in 

the SAP Note 1675599 (http://service.sap.com/sap/support/notes/1675599). 

37.2.2.3.6 Register Service for IDoc Inbound 

Use 

The registration of the IDoc inbound service is required when sending IDocs to S/4 HANA via 

SOAP/HTTPS, 

e.g. when you connect to C4C via HANA Cloud Integration (HCI). 

You can use transaction /nSICF to check if the service /sap/bc/srt/idoc is active. If yes, there is nothing 

to do. Otherwise please execute this activity. 

Activities 



 

 

1. Select the Register Service checkbox. 

2. In the Service Attributes section, enter the following parameters: o URI SOAP Application - 

urn:sap-com:soap:runtime:application:idoc o Name of Web Service Definition - GENERIC o

 Call Address (ICF Path) - /sap/bc/srt/idoc 

3. Choose Execute. 

37.2.2.3.7 Maintain IDoc Partner Profile 

Use 

To enable ALE communication, the partner systems must be defined with inbound or outbound 

parameters. 

Requirements 

You know the name of the logical system of the S/4 HANA system. 

Activities 

Create a partner profile 

1. In the Partner Profiles tree, select Partner Type LS, and choose Create. 

2. Enter the details as follows: 

- Partner No.       : Logical system ID, same as the system ID of the SAP Hybris 

Cloud for Customer solution 

- Partner Type    : LS (Logical system) 

- Agent type (Ty.): Organizational Unit (O) or User (US) 

- Agent     : Enter the job (person or group of persons) to be notified in case of error, for 

example, the <user ID> 

- Language         : EN 

3. Save your entries. 

Add an outbound parameter for each of the outbound IDoc message types 

4. To add a parameter, click the plus icon in the Outbound parmtrs. section. 

5. Enter the appropriate information into the fields using the following table. The description column 

just explains the message type. 

6. Make sure you either select the option Transfer IDoc Immediately or schedule the corresponding 

job for sending the collected Idocs for the respective IDoc type. 

7. Save your entries. You will receive a confirmation that the packet size is set to 1. 

8. Repeat steps 4-7 for each message type. 

Message Type: MATMAS_CFS 
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- Receiver Port: Choose the XML HTTP port that you created while creating a port definition 

- Basic Type: MATMAS05 

- Output Mode: Transfer IDoc Immed. 

Message Type: COD_SERVICE_REQUEST_CONF 

- Receiver Port: Choose the XML HTTP port that you created while creating a port definition 

- Basic Type: ORDERS05 

- Output Mode: Transfer Idoc Immed. 

- In the Message control tab, create 2 entries: Application V1, message type ZCO1, process code 

ZCOD_REPLICATE_SALES_ORDER. Check the change indicator for one of the entries. 

Message Type: COD_OPPT_CONF 

- Receiver Port: Choose the XML HTTP port that you created while creating a port definition 

- Basic Type: ORDER05 

- Output Mode: Transfer Idoc Immed. 

- In the Message control tab, create 2 entries: Application V1, message type COD1, process code 

COD_OPPT_CONF. Check the change indicator for one of the entries. 

Add an inbound parameter for each of the inbound IDoc message types 

9. To add a parameter, click the plus icon in the Inbound parmtrs. section. 

10. Enter the appropriate information into the fields using the following table. The description column 

just explains the message type. 

11. Make sure you either select the option Transfer IDoc Immediately or schedule the corresponding 

job for sending the collected Idocs for the respective IDoc type. 

12. Save your entries. You will receive a confirmation that the packet size is set to 1. 

13. Repeat steps 11 - 14 for each message type. 

Message Type: INQUIRY_CREATEFROMDATA2 

- Process Code: BAPI 

- Processing By Function Module: Trigger Immediately 

Message Type: SALESORDER_CREATEFROMDAT2 

- Process Code: COD_SALESORDER_CREATEFROMDAT2 

- Processing By Function Module: Trigger Immediately 

Message Type: COD_SERVICE_CONFIRMATION 

- Process Code: APLI 

- Processing By Function Module: Trigger Immediately 

Message Type: COD_SALESORDER_CONFIRMATION 

- Process Code: COD_SALESORDER_CONFIRMATION 

- Message Variant: CNF 



 

 

- Processing By Function Module: Trigger Immediately 

37.2.2.3.8 Setup ICF Nodes 

Use 

The Internet Communication Framework (ICF) supplies the environment for handling HTTP requests in 

the work process of an SAP System (server and client). 

When the SAP Web Application Server is installed with a release >=6.20 or there is  an upgrade of a 

release <6.20 to a release >=6.20, all ICF services must be set to inactive for the time being - for security 

reasons. 

Therefore, you cannot access these services from your browser. 

Using the following activity (transaction SICF), you can configure HTTP services and activate them 

individually (independently of the application assignment). 

Activities 

If you wish to use the ICF, activate all the required services. 

- If you wish to activated services in bundled form (for each application), use the step Activate HTTP 

Services for Each Application. 

More Information 

- For more information on configuration of services, refer to the SAP library under: 

SAP NetWeaver -> Key Areas of SAP NetWeaver -> Application Platform -> Platform 

Services -> Connectivity ->  Components of SAP Communication Technology -> 

Communication between ABAP and Non-ABAP Technologies -> Internet Communication 

Framework -> Development > Development of Server-Side ->  Creating and Configuring ICF 

Services. 

- For more information on Activation of services, refer to the SAP library under: 

SAP NetWeaver -> Key Areas of SAP NetWeaver -> Application Platform -> Platform 

Services -> Connectivity ->  Components of SAP Communication Technology -> 

Communication Between ABAP and Non-ABAP Technologies -> Internet Communication 

Framework -> Development > Development of Server Side ->  Creating and Configuring ICF 

Services -> Activating and Deactivating ICF Services. 

37.2.2.3.9 Configuration in SOA Management 

Use 
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In SOA Management, you need to perform the following activities: 

- Configuration to generate PDF files of sales orders or quotes in an opportunity. 

- Maintain end points for services. 

- Configuration to send attachments from SAP CRM to SAP Hybris Cloud for Customer. 

- Configuration to send attachments from SAP Hybris Cloud for Customer to SAP CRM. 

Activities 

1. Enable PDF Generation of Sales Order from Opportunity 

The final quote or order confirmation that was sent out to the customer is of particular interest to a sales 

representative using SAP Hybris Cloud for Customer. These documents can be called up in PDF format 

directly in SAP Hybris Cloud for Customer, without leaving the context of an opportunity. This section 

describes how to enable the generation of PDF files of sales documents (orders/quotes) directly from an 

opportunity. 

PRECONDITIONS 

- You have activated the LOG_SD_SIMP_02 switch in Customizing for SAP S/4 HANA under 

Activate Business Functions. For setting up the web service call, a technical user is required. 

The existing technical user (used for the IDoc communication) can also be used in this 

scenario. However, you have to make sure that the technical user has the following 

authorization objects assigned: 

- S_Service RC=0 

- S_RFC RC=0 

- S_SPO_DEV RC=0 

- An output device is required for formatting purposes. The output device can be assigned on 

transaction level (Sales Order/Quote) or to the communication user. You have implemented 

SAP Note 1919135 so that the web service SalesDocumentPrintPreviewQuery is available. 

You need to create an endpoint for web service SalesDocumentPrintPreviewQuery. 

1. In SOAMANAGER, under Web Service Configuration, select the object type as Service Definition. 

2. Search for the service definition you created for the print preview. 

3. Click Apply Selection to open the service definition. 

4. On the Configuration tab, choose Create and fill in the required fields, and click Apply Settings. 

5. On the Provider Security tab, make the following settings: 

a) Under Communication Security, select SSL (HTTPS, Transport Channel Security). 

b) Under Transport Channel Authentication, select User ID/Password. 

6. Save your entries. 

  Note 

When you have saved your settings, the system displays the calculated endpoint URL on the Transport 

Settings tab. This URL will be used for the creation of the communication arrangement in SAP Hybris 

Cloud for Customer. 



 

 

Next Steps 

Step 1: Maintain Output Type 

The web service implementation in SAP S/4 HANA relies on the output determination. As a prerequisite, 

it is therefore necessary that at least one printable output type is configured for sales quotes/orders and 

inquiries in SAP S/4 HANA, and that these output types are also determined successfully in the 

documents. 

If more than one printable output types are determined in the S/4 HANA sales document, you can do one 

of the following: 

- Map the code of the relevant output type to the field IV_KSCHL in PI 

- Implement BAdI COD_SLS_SE_GET_OUTPUT_TYPE and return the relevant output type in the 

method GET_OUTPUT_TYPE. 

Step 2: Maintain this end point in SAP Hybris Cloud for Customer 

Mention this end point in the communication arrangement Opportunity with Print Preview of Sales 

Documents in S/4 HANA in SAP Hybris Cloud for Customer, and perform service and connection 

checks. 

2. Maintain Endpoints for Services 

Purpose 

The access URL of the endpoint is required during the configuration of the cloud solution to establish 

synchronous requests. 

  Note 

Depending on your SAP S/4 HANA release, the texts on the user interface in the transaction 

SOAMANGER might differ from the texts in section Procedure below. See the table below for 

differences that might occur between different releases. 

 Description in Configuration Guide Possible Alternative 

 Service Administration Application and Scenario Communication 

SSL (HTTPS, Transport Channel Security) SSL over HTTP (Transport Channel Security) or User ID 

password 

Procedure 

7. In SOAMANAGER, on the Service Administration tab, choose Simplified Web Service 

Configuration. 

8. Enter SalesOrderPricingInformationQueryResponse_In into the Search Pattern field and choose Go. 

9. Mark the line containing this service and choose Apply Selection. 

10. On the Configurations tab page, choose Create Service. 

11. In the SOA Management dialog box, enter a service name, description and binding name.   Note 

For example, copy the first part of the service name (here: SalesOrderPricing) into the service name field, 

enter a meaningful description, such as Sales Order Pricing into the description field and simply enter 

binding into the binding name field. 

12. Choose Apply Settings. 

13. To maintain the endpoint, make the following settings in the Provider Security tab page: 

Screen Area User Action 
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Communication Security Channel 

Security) 

Select the checkbox SSL (HTTPS, Transport 

Transport Channel Authentication Select the checkbox SSL Client Certificate 

14. Save your entries. 

15. Repeat these steps for the following services: 

- SalesOrderERPBasicDataByElementsQueryResponse_In 

- CustomerQuoteERPBasicDataByElementsQueryResponse_In 

- SalesDocumentPrintPreviewQuery 

  Note 

For the SalesDocumentPrintPreviewQuery maintain the entries: 

Screen Area User Action 

Communication Security Channel 

Security) 

Select the checkbox SSL (HTTPS, Transport 

Transport Channel Authentication Select the checkbox User ID/Password 

Additionally, the following prerequisites exist for SalesDocumentPrintPreviewQuery: 

- Verify that LOG_SD_SIMP_02 switch in Customizing for SAP ERP under Activate Business 

Functions. 

- Navigate to the IMG or go directly to transaction code SFW5. 

- Search for LOG_SD_SIMP_02. Ensure it is active (the light is on). 

- For setting up the web service call, a technical user is required. The existing technical user (used for 

the IDoc communication) can also be used in this scenario. However, you have to make sure that 

the technical user has the following authorization objects assigned: 

- S_Service RC=0 

- S_RFC RC=0 

- S_SPO_DEV RC=0 

- In addition to this, an output device is required for formatting purposes. The output device can be 

assigned on transaction level (Sales Order/Quote) or it can be assigned to the communication user. 

- You have implemented SAP Note 1919135 so that the web service 

SalesDocumentPrintPreviewQuery is available. 

3. Configuration to send Sales Order attachments from SAP ERP to SAP Cloud for Customer 

16. In SOA Management, under Service Administration, click Web Service Configuration. 

17. Specify the following criteria and click Search: 

a) Object Type and the value as Consumer Proxy 

b) Object Type and the value as object name CO_CODERINT_ATTACHMENT_FOLDER. 

18. Open the consumer proxy. 

19. To create a logical port: 

a) In the Configuration tab, choose Create ' Manual Configuration. 

b) In the guided activity that appears, enter the logical port name (the CRM Logical System 

name), description, and check Logical Port as Default. Click Next. 



 

 

c) Select the authentication method, and provide the authentication details, and click Next. 

d) Enter the URL Access Path obtained from the WSDL of the Sender Agreement, which is 

configured in PI and represents the endpoint on PI. Example: 

/XISOAPAdapter/MessageServlet?senderParty=&senderService=<Business System for SAP 

CRM in SAP  PI >_400&receiverParty=& receiverService=& 

interface=AttachmentFolderReplicationRequest_Out&interfaceNamespace=http%3A%2F% 

2Fsap.com%2Fxi%2FCRMPCD01 

Note: You can get the path, from the Integration Flows spreadsheet on SAP Service Marketplace. 

e) Choose HTTPS as the URL protocol Information and click Next. 

f) Select the RM Protocol as SAP RM, Message ID Protocol as SAP Message ID, and Data 

transfer scope as Basic Data Transfer. 

g) Click Next and then Finish. 

The logical port is now displayed in the Configurations tab. 

4. Configuration to send attachments from SAP Cloud for Customer to SAP ERP 20. In 

SOA Management, under Service Administration, click Web Service Configuration. 

 21. Specify the following criteria and click Search: 

a) Object Type and the value as Service Definition 

b) Object Type and the value as object name II_SLS_ATTACHMENT_FOLDER_REPLI. 

22. Open the service definition. 

23. To create a logical port: 

a) In the Configurations tab, choose Create ' Create Service. 

b) In the guided activity that appears, enter a service name, service description, binding name and 

click Next. 

c) Select the Transport Level Security and the Transport Channel Authentication, and click Next. 

d) Enter the Calculated Access URL, which is the Target URL in the PI Receiver Agreement. 

e) Choose HTTPS as the Calculated Protocol and click Finish. 

f) Select the RM Protocol as SAP RM, Message ID Protocol as SAP Message ID, and Data 

transfer scope as Basic Data Transfer. 

g) Click Next and then Finish. 

The service definition and the binding are generated and displayed in the Configurations tab. 

37.2.2.3.10 Create Communication Users 

Use 
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This section describes how to create a user in SAP S/4 HANA that can be used by the Cloud solution for 

authentication against SAP S/4 HANA. You can enter this user when you configure outbound 

communication arrangements in the Cloud solution. 

Activities 

1. In the User field, enter the name of the user you want to create, for example 

CODINTEG. 

2. Select Create. 

3. On the Maintain User screen, enter the following data: 

a) Address tab: Enter the name and address details. 

b) Logon data tab: Enter the User type as C Communications Data or B Dialog and a password. 

The Communications user type is used for non-interactive communication between systems, 

while the Dialog user is interactive but should have limited authorizations. 

 4. Save your entries. 

Note: This communication user should be assigned to a role/profile that has necessary authorization to 

carry out configuration in S/4 HANA. 

37.2.2.3.11 Maintain Authorization Profile for a Role 

Use 

You need to maintain an authorization profile for one of the following roles: 

· SAP_SD_COD_INTEGRATION: This role contains the required authorization objects if the 

processing is done through IDoc/ALE technology in background (workflow). 

· SAP_SD_COD_INTEGRATION_EXT: This role contains the required authorization objects if the 

processing is done through IDoc/ALE technology synchronously (without workflow). 

Detailed information on the role can be found in transaction PFCG in the role itself on the Description 

tab page. 

Caution 

Make sure to restrict authorizations, for example for sales areas or document types, depending on your 

needs and authorization concept. 

Activities 

1. Go to transaction PFCG, and open a role. 

2. On the Authorizations tab page, choose Change Authorization Data. 

3. Expand the node Check at Start of External Services. 

4. Next to the entry Program, transaction or function, choose Change. 

5. In the Define Values dialog box, add the following entries: 

Field Entry 



 

 

Serv. Type WS 

Service ECC_SALESORDER009QR and 

ECC_CUSTOMERQUOTE006QR 

6. Choose Copy. 

7. Expand the node Sales and Distribution. 

8. For each of the entries Sales Document: Authorization for Sales Document Types and Sales 

Document: Authorization for Sales Areas, make the following changes: 

- Next to the entry Activity, choose Change. 

- In the Define Values dialog box, mark the 03- Display checkbox. 

9. Make sure to generate the profile after you have maintained the necessary authorizations. For more 

information about Generating Authorization Profiles, see SAP Library for SAP S/4 HANA under ' SAP 

S/4 HANA Central Component ' Identity Management User and Role Administration of AS ABAP ' 

Configuration of User and Role Administration ' Role Administration ' Role Administration Functions ' 

Generating Authorization Profiles. 

37.2.2.3.12 Maintain Certificate to User Mapping 

Activities 

If you use HCI as the middleware, then in the SAP on-premise system, the client certificate (public key) 

should be mapped to the communication user used for integration. The certificate is signed by the 

Certification Authority SAP Passport CA. Therefore SAP Passport CA must be trusted in the on-premise 

system in transaction STRUST in the folder SSL Client (Standard). You can download the SAP Passport 

CA certificate here: SAP Trust Center Services Download Area   Root Certificates. 

1. In SAP on-premise system, go to transaction SM30 

2. Enter the view VUSREXTID in the Table/View field and choose Maintain. 

3. In the External ID type field enter DN. 

4. Choose New Entries. 

5. Next to the External ID field, choose Import. 

6. Import the client certificate you have downloaded from the cloud system. 

7. In the User field, enter the SAP on-premise user details. 

For more information about mapping certificates in the S/4 HANA system, see SAP Help Portal at: 

- Configuring the System for Using X.509 Client Certificates. 

SAP NetWeaver   User Authentication and Single Sign-On   Authentication on the AS 

ABAP   Configuring the System for Using X.509 Client Certificates 

- Logon with Client Certificates 

SAP NetWeaver   Components of SAP Communication Technology   Communication 

Between ABAP and Non-ABAP Technologies   Internet Communication Framework 

Development   Server-Side Development   Creating and Configuring an ICF Service 

Creating a Service   Defining the Logon Procedure   Logon with Client Certificate 
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37.2.2.4 BAdIs 

37.2.2.4.1 IDoc: Inbound Mapping  



 

 

37.2.2.4.2 IDoc: Adding additional segments  
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37.2.2.4.3 IDoc: Creation check  



 

 

37.2.2.4.4 Reduce Change Pointers for Message Type 

The process of determining and distributing changes using the SMD tool (ALE Shared Master Data) can 

be speeded up by using Business Add-in BDCP_BEFORE_WRITE. This reduces the scope of change 

pointers to be written to changes relevant to the distribution. 

Use 

In Customizing you can set the writing of change pointers altogether and for each message type. 

Whereas, if you are developing, you set the fields in change documents and the message types for which 

change pointers are written. 

- You would like to implement a filter that reduces the scope of the change pointers still further. 

- You would like to update further data when change pointers are written. 

Requirements 

Change pointers are created in the following interfaces: 

- The change document interface calls the change pointer function module 

CHANGE_POINTERS_CREATE. 

- The application program calls the ALE interface CHANGE_POINTERS_CREATE_DIRECT. 

Standard settings 

In the standard system no filter has been set up. The standard functions therefore do not change the 

behavior of the change pointer interface. 

Activities 

Execute the function in the Implementation Guide. 

1. Enter an implementation name and choose Further. The initial screen for implementations appears. 

2. Create a short text for your implementation. 

3. Under filter types select the message types that you want to filter out. 

4. Save your entries. 

Example 

Many application cases show that the granularity of change document field and message type does not 

always match the application requirements, when the change pointers are written. 

Unnecessary change pointers are often written. 

- Usually only change pointers for application objects that are actually distributed should be written. 

If materials with material numbers in a certain range only are distributed, only change pointers 

specifically for these need to be written. 

- In an initial data transfer large datasets are imported into several systems. If changes are made, the 

data is maintained centrally and then distributed using the SMD tool. If the inital data transfer takes 

place when the system is in operation, change pointers cannot be written altogether because data 

changes would not be recognized and therefore not distributed. However, because the initial data 

transfer is usually carried out with specific user contexts, you should deactivate the writing of 

change pointers for specific users. 
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Examples of code for BADI BDCP_BEFORE_WRITE can be found in the BADI Builder under the 

menu path "Goto -> Example Code -> Display.  



 

 

37.2.3 Application-Specific Settings 

37.2.3.1 Business Partner 

37.2.3.1.1 Data Replication  
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37.2.3.1.2 Activate Function Modules 

Use 

In this IMG activity you activate the function module for data distribution. 

Below you can find a description of which entries you must activate so that the central Business Partner 

data can be distributed using ALE or XI. 

Note 

If you want to distribute Business Partner extensions (e.g. FI or CRM data), or use another distribution 

technology than ALE or XI, other entries have to be activated accordingly. 

Activities 

Activate the following entries if you want to distribute data for Business Partner or Business Partner 

Relationships using ALE: 

Event Object Function Module 

BPOUT 

N 

BUPA BUPA_OUTBOUND_ALE_MAI 

BPOUT BUPR BUPA_OUTBOUND_ALE_REL 

Activate the following entries if you want to distribute data for Business Partner or Business Partner 

Relationships using XI: 

Event Object Function Module 

BPOUT BUPA BUPA_OUTBOUND_MAIN 

BPOUT BUPR BUPA_OUTBOUND_REL 

PXYIN BUPA BUPA_INBOUND 

37.2.3.2 Sales Processing 

37.2.3.2.1 Setup: Sales Documents 

37.2.3.2.1.1 Define Sales Document Type 

Use 

To define sales document type request for customer quote and sales order. 

Activities 

Define Sales Document Type Request for Customer Quote 

The customizing entry described in this step is contained within the Business Configuration Set (BC Set) 

COD_BYD_ERP_INT. If you have activated this BC Set, you can skip this step. 

1. Mark the entry IN (Inquiry) and choose Copy As# (F6). 

2. Adapt the copied sales document type RQQ, as shown below: 

Field: Sales Document Type 

Value: RQQ 

Field: Description 



 

 

Value: Req. for Quote 

3. Choose Enter on your keyboard. 

4. Confirm the dialog box Is this entry also relevant for copying control with Yes. 

5. In transaction VTAA, switch to edit mode. 

6. Delete the sales document types that should not be allowed as direct follow-up documents for RQQ 

from Copy Control, as shown below: 

Tgr: OR 

Source: RQQ 

Note 

Note:  If the Specify objects to be deleted dialog box occurs, choose all entries. If you only allow specific 

sales order types for your sales areas, you must allocate the new sales document type to the relevant sales 

are group. 

In ERP Customizing, follow the path: Sales and Distribution '->Sales -> Sales Documents -> Sales 

Document Header -> Assign Sales Area To Sales Document Types. 

Define Sales Document Type Request for Sales Order 

The customizing entry described in this step is contained within the Business Configuration Set (BC Set) 

COD_BYD_ERP_INT. If you have activated this BC Set, you can skip this step. 

7. Mark the entry IN (Inquiry) and choose Copy As# (F6). 

8. Adapt the copied sales document type RQO, as shown below: 

Field: Sales Document Type 

Value: RQO 

Field: Description 

Value: Req. for Order 

9. Choose Enter on your keyboard. 

10. Confirm the dialog box Is this entry also relevant for copying control with Yes. 

11. In transaction VTAA, switch to edit mode. 

12. Delete the sales document types that should not be allowed as direct follow-up documents for RQO 

from Copy Control, as shown below: 

Tgr: OR 

Source: RQO 

37.2.3.2.1.2 Assign Item Categories 
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Activities 

Create new item category determination for the new sales document types, as shown in the following 

table: 

SaTy ItCGr Usg. HLevItCa DfItC MItCa 

RQQ  TEXT  AFTX  

RQQ 0002   AFC  

RQQ BANS   AFN  

RQQ DIEN   AFX  

RQQ DIEN  AFN AFX 

RQQ LEIC   AFX 

RQQ LEIC  AFN AFX 

RQQ LEIS   AFX 

RQQ LEIS  AFN AFX 

RQQ NLAG   AFX 

RQQ NLAG  AFN AFX 

RQQ NORM   AFN 

RQQ NORM  AFN AFNN 

RQO  TEXT  AFTX 

RQO 0002   AFC 

RQO BANS   AFN 

RQO DIEN   AFX 

RQO DIEN  AFN AFX 

RQO LEIC   AFX 

RQO LEIC  AFN AFX 

RQO LEIS   AFX 

RQO LEIS  AFN AFX 

RQO NLAG   AFX 

RQO NLAG  AFN AFX 

RQO NORM   AFN 

RQO NORM  AFN AFNN 

37.2.3.2.2 Setup: Sales Document Confirmation 

37.2.3.2.2.1 Maintain ALE Outbound Process Code 



 

 

Use 

The customizing entry described in this step is contained within the Business Configuration Set (BC Set) 

COD_BYD_ERP_INT. If you activated this BC Set, you can skip this step. 

Activities 

1. Switch to edit mode, and choose New Entries. 

2. Enter the following data: 

Field Value 

Process code COD_OPPT_CONF 

Description Output processing for opportunity confirmation 

Function module IDOC_OUTPUT_COD_OPPT_CONF 

3. Make sure that the following radio buttons are selected: 

- Processing with ALE service - Processing 

with function module version 3.0 

4. Save your entries and return to the process code overview. 

5. Mark the newly created outbound process code and click Logical message within the navigation 

area. 

6. Assign the message type COD_OPPT_CONF. This message type is used for opportunity and sales 

quote integration. 

7. Repeat steps with the following data: 

Field Value 

Process code COD_SERVICE_REQUEST_CONF 

Description Output processing for opportunity confirmation 

Function module IDOC_OUT_COD_SLSORD_CNF_EXTDOC 

8. Assign the message type COD_SERVICE_REQUEST_CONF. This message type is used to 

confirm the creation of sales order for a service ticket in ERP. 

37.2.3.2.3 BAdIs 

37.2.3.2.3.1 Pricing Request Service: Inbound and Outbound Mapping 

37.2.3.2.3.2 Print Preview Service: Output Type Retrieval  
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37.2.3.2.3.3 S/4HANA Document flow in C4C: Output mapping 

Use 

This enhancement will be used by the function module 'COD_ERP_GET_DOC_FLOW' .This can be 

used for any type of changes to a document flow which will be sent to an external system from an SAP 

S/4HANA system. 

Example 

Below is a sample code for skipping all the deliveries from the document Flow. DATA: 

lv_fromlevel     TYPE int4,         lv_tolevel       TYPE int4,         lv_next          TYPE 

int4,         lv_delivery_doc  TYPE char100. 

  FIELD-SYMBOLS:  <ls_relationships>  TYPE cod_s_relationships, 

                  <ls_relationships1> TYPE cod_s_relationships, 

                  <ls_docflowdata>    TYPE cod_s_docflowdata,                   <ls_finaldata>      

TYPE cod_s_anchorid. 

* Skip all deliveries from doc flow. 

  LOOP AT ct_docflowdata ASSIGNING <ls_finaldata>. 

    LOOP AT <ls_finaldata>-data ASSIGNING <ls_docflowdata>. 

      LOOP AT <ls_docflowdata>-relationship ASSIGNING <ls_relationships>. 

        IF <ls_relationships>-to_doc-obj_type_code EQ '73'.           lv_delivery_doc = 

<ls_relationships>-to_doc-objectid.           lv_fromlevel    = <ls_relationships>-from_doc-

ordinal_num_value .           lv_tolevel      = <ls_relationships>-to_doc-ordinal_num_value. 

          READ TABLE <ls_docflowdata>-relationship ASSIGNING <ls_relationships1> WITH KEY 

to_doc-ordinal_num_value = lv_fromlevel. 

          DELETE TABLE <ls_docflowdata>-relationship FROM <ls_relationships>. 

        ELSEIF <ls_relationships>-from_doc-objectid = lv_delivery_doc. 

          <ls_relationships>-from_doc-objectid            = <ls_relationships1>-from_doc-objectid.           

<ls_relationships>-from_doc-formatted_id        = <ls_relationships1>-from_doc-formatted_id. 

          <ls_relationships>-from_doc-obj_type_code       = <ls_relationships1>-from_doc-obj_type_code. 

          <ls_relationships>-from_doc-obj_node_type_code  = <ls_relationships1>-from_doc-

obj_node_type_code. 

          <ls_relationships>-from_doc-rel_role_code       = <ls_relationships1>-from_doc-rel_role_code. 

          <ls_relationships>-from_doc-ordinal_num_value   = lv_fromlevel. 

          <ls_relationships>-to_doc-ordinal_num_value     = lv_fromlevel + 1. 

          <ls_relationships>-from_doc-properties          = 

<ls_relationships1>-from_doc-properties.           lv_next = 

lv_fromlevel + 1. 



 

 

        ELSEIF lv_delivery_doc IS NOT INITIAL. 

          <ls_relationships>-from_doc-ordinal_num_value   = lv_next.           

<ls_relationships>-to_doc-ordinal_num_value     = lv_next + 1.           lv_next = 

<ls_relationships>-from_doc-ordinal_num_value. 

        ENDIF. 

      ENDLOOP. 

    ENDLOOP. 

  ENDLOOP. 

37.2.3.3 Service Processing 

37.2.3.3.1 Time Sheet Integration 

37.2.3.3.1.1 Assign Data Entry Profile 

Use 

In this IMG activity, you state the data entry profile, which should be used for the transfer of 

confirmation items from Cloud for Customer to the cross-application time sheet (CATS) in SAP S/4 

HANA. 

Requirements 

You must have defined the data entry profile in Customizing under Cross-Application Components ' 

Time Sheet ' Define Data Entry Profile. 

37.2.3.3.1.2 Define Derivation of Activity Type 

Use 

In this IMG activity, you define the activity type for a service material, which should be used when 

transferring confirmation items with a service from the Cloud system to the time sheet in the S/4 HANA 

system. 

Requirements 

- In the S/4 HANA system, you must define the activity types you want to use. 

37.2.3.3.2 Controlling Integration 

37.2.3.3.2.1 Create and Change Controlling Scenario 
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Use 

In this IMG activity, you create a controlling scenario. If you have specified controlling type and single-

object controlling for a transaction type in the IMG activity and Controlling Scenarios, assign one of the 

controlling scenarios created here. 

Requirements 

To make the settings for the period-end close, you can select the costing sheets, results analysis keys, and 

so on provided by SAP, or create your own. The customizing settings for these objects are located in the 

ECC standard IMG in the following locations: 

- Controlling -> Internal Orders -> Planning -> Manual Planning -> Define Costing Variants 

- Controlling -> Internal Orders -> Actual Postings -> Overhead 

- Controlling -> Internal Orders -> Actual Postings -> Template Allocation 

- Controlling -> Internal Orders -> Actual Postings -> Settlement -> Maintain Settlement Profiles 

- Controlling -> Product Cost Controlling -> Cost Object Controlling -> Product Cost by Sales Order 

-> Period-End Closing 

Standard settings 

The supplied scenario COD is only an example. 

Activities 

1. Choose New Entries. 

2. Enter a name and description for the scenario. 

3. Enter the required data. 

If you want to create standard cost estimates, you must select the costing variant with the input help. 

Once you have selected a costing variant, the standard cost estimates are created automatically. 

If you want to use accounting indicators, perform the following steps: 

- Enter a settlement profile to which a source structure is assigned. 

- Double-click on Assign Settlement Receiver and choose New Entries. 

- Enter a company code and use the input help to select a source assignment and an account 

assignment category. The available source assignments are based on the source structure assigned to 

the selected settlement profile. The available account assignment categories are based on the 

allowed receivers defined in the selected settlement profile and that match the receivers allowed for 

the business scenario CRM Service. 

- Enter a settlement receiver. 

 4. Save your entries. 

37.2.3.3.2.2 Establish Controlling Type and Controlling Scenarios 



 

 

Use 

In this IMG activity, you specify the controlling type for a transaction type. If you selected single-object 

controlling as the controlling type, you also specify the controlling scenario. 

Requirements 

The internal order is created with the order type SAPS. This exists in client 000 in standard Customizing. 

Make sure that this order type is available in all clients in which internal orders will be created, such as 

test and production clients. 

Note the following with single-object controlling: You must have created a controlling scenario under 

Settings for Single-Object Controlling. 

Activities 

1. Choose New Entries. 

2. Enter the required data and choose a controlling type. 

3. If you chose single-object controlling as the controlling type, enter a controlling scenario. 

4. Save your entries. 

37.2.3.3.3 Logistics Integration 

37.2.3.3.3.1 Assign Plant to Service Organisational Units 

Use 

As cloud for customer does not have any plant information and a plant is necessary for processes in S/4 

HANA, in this IMG activity you define how the plant and other logistic relevant information are 

determined. This can be done based on the service organization, the service team and the service 

technician. 

- For the internal order this is used to determine the plant. 

- The plant and movement type are used for the withdrawal of the spare parts from the technician's 

consignment stock. 

37.2.3.3.4 BAdIs 

37.2.3.3.4.1 BAdI: Enhancements for Service Processing 
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37.3 Advanced Planning and Optimization  



 

 

37.3.1 Basic Settings for Setting Up the System Landscape  
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37.3.1.1 Name Logical System 

In this step, you can define the logical systems in your distributed system. 

Caution 

Logical systems are defined cross-client. 

Activities 

1. To create a logical system, choose Edit -> New Entries. 

2. Enter a name for the logical system that you want to create. 

3. Enter a description of the logical system. 

If you want to change this entry: 

a) Select the appropriate line. 

b) Choose Edit -> Change field contents. 

c) Enter the new text. 

d) Choose Replace. 

4. Save your entries. 

Further notes 

To enable the transfer of data via APO Core Interface (CIF), you need to name both the ERP system in 

which you are working and the SAP APO system to which you want to transfer data as logical systems. 

Note that you also have to carry out these steps in SAP APO. The names of the logical systems need to 

correspond in the ERP system and in SAP APO (that is, the name that is defined for SAP APO in SAP 

APO must be specified as the logical target system in the ERP system, and the name defined for ERP in 

the ERP system must be specified as the logical target system in SAP APO). 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.3.1.2 Assign Logical System to a Client 

In this work step, you assign a client to each logical system. 

Actions 

1. Select one line. 

2. Choose: Goto -> Details. 

The 'Client Details' screen appears. 

3. In the field Logical system, enter the name of the logical system to which you want to assign the 

selected client. 



 

 

4. Save your entries. 

Notes on the transport 

These settings cannot be transported. When a new system is being set up, these settings must be made 

after the system installation has been completed. 

Note that you also have to carry out these steps in SAP APO. The names of the logical systems need to 

correspond in the ERP system and in SAP APO (that is, the name that is defined for SAP APO in SAP 

APO must be specified as the logical target system in the ERP system, and the name defined for ERP in 

the ERP system must be specified as the logical target system in SAP APO). 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.3.1.3 Specify SAP APO Release 

Use 

In this IMG activity, you specify the release level of the SAP APO system that is defined as the target 

system. 

Requirements 

The target system must be defined under Name Logical Systems. 

Activities 

1. Under LogSystem, enter the target system defined under Name Logical System (for example, 

AP4CLNT000). 

2. Under System Type, enter SAP_APO. 

3. Under Release, use input help to choose the relevant release. 

Further notes 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.3.1.4 Set Up RFC Destination 

Use 

In this IMG activity, you create the connection to SAP APO. The name of the RFC destination has to 

match exactly the name of the logical target system that was already specified. 

Requirements 

The target system must have been defined under Name Logical Systems. 
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Activities 

1. Open the ABAP Connection node. 

2. Choose Create. The RFC Destination screen is displayed. 

3. Enter the following: 

- RFC Destination: Enter the name of the logical target system specified in the IMG activity 

Name Logical Systems. 

- Connection Type: Use the input help to choose the relevant connection type. In most cases, 

choose connection type 3. 

- Enter a description. 

4. Enter the following information on the Technical Settings tab page: 

- Load Distribution: Choose the required setting. 

- Target Machine: You can determine the destination of the target machine as follows: 

Call SAPlogon from the Start menu. 

Choose Server. 

Copy the server ID from the Message Server entry field. 

- System Number: You can determine the system number of your target system as follows: 

Call SAPlogon from the Start menu. 

Select your target system. 

Choose Properties. You see a dialog screen in which the system number is specified. 

5. Enter the following information on the Logon/Security tab page: 

- Under Logon, define the security options. 

- Language: Optional 

- Client: Use the input help to select the relevant client. The client to be configured depends on 

the current authorization profile of the user (Customizing). 

- User: User-defined. The user entered here must also be created in the target system (SAP 

APO) with the corresponding authorization profile. If you want to perform cross-system 

debugging, the relevant user must be created in the target system as a dialog user with 

debugging authorization. 

- Password: User-defined: Default setting at delivery: initial. 

6. Specify how you want to communicate with the target system on the MDPM & Unicode tab page. 

7. Choose your options on the Special Options tab page: 

- Trace: Optional 

- Slow RFC Connection: Optional 

- qRFC Version: Choose Classic qRFC Version. 

8. In the menu under Edit, choose the option tRFC Options. Under Connection Attempts Until Stop 

enter a value less than or equal to 10. In the Time Between 2 Attempts [Min] field, enter the value 2. 

Confirm the entry with Continue. 

9. The connection test is optional. 

Further notes 



 

 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.3.1.5 Assign RFC Destinations to Different Application Cases 

Use 

The integration via APO Core Interface (CIF) is mostly based upon data transfers between the systems 

that run in the background without user interaction. However, in some application cases (for example, 

the availability check), it may be necessary for the user to access data in the target system using a 

synchronous remote function call (RFC). In these application cases, it is beneficial to use different RFC 

destinations with different user authorizations. By doing this, you can restrict user authorizations for 

executing certain actions in the logical target system to certain application cases. 

You make the assignment in this IMG activity. 

Note that the setting(s) that you make in this IMG activity depends on the relevant target system. For this 

reason, there is no transport to the production system. Therefore, you must also carry out this step in the 

production system for the relevant target system. 

Requirements 

The target system must be defined under Name Logical System. 

The RFC destination must be created under Set Up RFC Destination. 

Activities 

- Use input help to choose an application case for the logical system specified. 

- Assign this application case to the required RFC Destination. 

37.3.1.6 Set Target System and Queue Type 

Use 

In this IMG activity, you add the target system that you have already defined to the definition of the 

RFC destination for the transfer. The data transfer using the APO Core Interface is made with queued 

remote function call (qRFC) technology. This means that the data is stored temporarily in queues. The 

queue type (inbound or outbound) determines whether the queues processing is controlled by the 

sending or receiving system. In this step, you can set the queue type for the target system specified. 

Requirements 

- Your own system and target system must be defined under Name Logical Systems. 

- The RFC destination must be defined. 



 

WHATSAPP +255738656506 

 

Activities 

1. Under LogSystem, enter the target system for the transfer. To identify the target system, enter the 

name that you entered earlier as the RFC destination. 

2. The current operating mode is automatically determined by the system. 

3. Set a queue type for the data transfer to the target system. Use input help to choose between 

inbound and outbound queues. The system chooses outbound queues by default. 

Further notes 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.3.1.7 Settings for qRFC Communication 

37.3.1.7.1 Configure qRFC Communication 

Use 

You can use the scheduler settings for inbound and outbound queues to configure communication using 

queued remote function call (qRFC) and therefore control the management and monitored processing of 

qRFCs. 

qRFC communication allows asynchronous communication with transactional security and a serialization 

of calls. qRFC communication is used intensively in the SAP APO Core Interface to transfer logistical 

data online and thus retain the transactionality and sequence. 

Inbound qRFCs are processed using the QIN scheduler, outbound ones by the QOUT scheduler. 

The asynchronous transfer to SAP APO of logistical data relevant to planning is based on qRFC 

communication. If this is not configured correctly, processing does not take place. This means that 

planning data is not exchanged and consistent planning is no longer possible. 

Requirements 

To avoid problem situations, we recommend that you use the current qRFC version. For more 

information, see SAP Note 438015. 

The qRFC is delivered as part of SAP Basis or implemented in Support Packages. An update is also 

possible using a special transport. For more information, see SAP Notes 481278 and 438015. 

Activities 

You make the settings for the necessary profile parameters in transaction RZ12. 

- Call transaction RZ12. 

- Double-click on a server group. A dialog window is displayed in which you can set the 

following parameters (as of SAP R/3 4.5B): 

- Activated (0 or 1): 1 

- Max. requests in queue: 5 



 

 

- Max. number of logons: 90 

- Max. number of own logons: 25 

- Max. number of WPs (work processes) used: 75 

- Min. number of free WPs: 1 

- Max. number of comm. entries: 90 

- Max. wait time : 10 (as of SAP R/3 4.6C) 

Use SAP Note 74141 to fill the parameters for the system concerned. Note that all entries apart 

from Activated and Min. number of free WPs must be in percent. The number of work 

processes (WPs), that may be used by qRFC is determined using the following formula: 

- (Number of all dialog WPs - minimum number of free WPs) x maximum number of WPs used 

/ 100. 

If this figure is too small, it is not possible to use communication via qRFC. 

Example 1: 

There are a total of 7 dialog WPs in a system, the minimum number of free WPs is 2, and 

the maximum number of WPs used is 6. The number of WPs that can be used is calculated 

as follows: (7-2) x 6/100 = 0.3. In this case, communication using qRFC is not possible. 

Example 2: 

There are a total of 10 dialog WPs in a system, the minimum number of free WPs is 2, and 

the maximum number of WPs used is 75. The number of WPs that can be used is 

calculated as follows: (10-2) x 75/100 = 6. In this case, communication using qRFC is 

possible. 

Other profile parameters 

Note that qRFC calls are processed in work processes of the type DIALOG (exception: inbound queues). 

As a result, the DIALOG restriction for processing a dialog step (standard 300 seconds, system profile 

parameter rdisp/max_wprun_time) also applies to these RFC calls. On every sever that is available for 

processing parallel RFCs, more dialog work processes must be configured than non-dialog work 

processes. For more information, see SAP Note 74141. 

37.3.1.7.2 Set QOUT Scheduler 

Use 

The data transfer via APO Core Interface (CIF) occurs using queued Remote Function Calls (qRFC). 

Outbound qRFCs (outbound queues) are processed by the QOUT scheduler. 

The QOUT scheduler is called using transaction SMQS. The destinations to which the outbound qRFCs 

are to be sent are registered in the QOUT scheduler. As of version 6.20.45 this occurs automatically. 

There are the following options for a registered destination: 

- Type 

- R: The destination is registered; that is, it is started using the QOUT scheduler. 

- U: The destination is not registered; that is, it is not processed. 

- N: The destination is not registered using the QOUT scheduler, it is sent at the time of the 

COMMIT WORK. 

- Max. Connections: Number of connections used to send the qRFC. The default value for ABAP 

connections is 10, for TCP/IP connections it is 1. 
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- Max. Runtime: Time that a destination is processed by the QOUT scheduler. The default value is 60 

seconds. 

- The destination NONE leads to processing at the local system and should not be registered until 

version 6.20.45, supplement 8 inclusive. As of supplement 9, NONE may be registered and the 

without tRFC option set. 

Requirements 

qRFC communication must be configured. For more information, see Configure qRFC Communication. 

37.3.1.7.3 Set QIN Scheduler 

Use 

The data transfer via APO Core Interface (CIF) occurs using queued Remote Function Calls (qRFC). 

If you are working with inbound queues, incoming qRFCs are processed by the QIN scheduler. 

The QIN scheduler is called using transaction SMQR. In contrast to the QOUT scheduler, only queue 

names are registered in the QIN scheduler, not destinations. The registration is not made automatically; 

have to do this yourself. If a queue is not registered, it is not processed (that is, there is no transfer). 

Requirements 

qRFC communication has to be configured. For more information, see Configure qRFC Communication. 

Activities 

- Call transaction SMQR and choose Registration. 

- Enter the queue name CF* and make the required settings. 

- EXEMODE: Execution mode (D - Dialog work process; B - Batch work process) 

- MAXTIME: Maximum runtime that the QIN scheduler uses for activating a destination; default 

value: 60 seconds 

- USERDEST: RFC destination with LOGON data. Entry of a logical destination with own language 

on a local system. With this, the burden of integration can be distributed to a server group. 

- NRETRY: Number of repetitions for failed calls, default value: 30 

- RDELAY: Wait time between individual calls, default value: 300 



 

 

37.3.1.7.4 Set Up qRFC Administration for CIF Queue Display 

Use 

If faulty queue entries occur in the data transfer via APO Core Interface (CIF), you can use CIF queue 

display to view the contents of the queues and carry out follow-up processing for the objects affected. 

In this IMG activity, you set up qRFC administration in such a way that you can call CIF queue display 

from the qRFC monitor. To do this, you have to register the program CIFQEV02 as the display program 

for CF* queues. 

Requirements 

If you are working with outbound queues and want to navigate from the queue contents display to the 

relevant application log entries in the target system, you need to enter a dialog user in the RFC 

destination in user maintenance (transaction SU01) or you can use a flexible RFC destination with a 

dialog user. For more information, see Assign RFC Destination to Different Application Cases. 

Activities 

- Call transaction SMQE. 

- Choose Edit and Register Display Program. 

- Enter CF* as the queue name and CIFQEV02 as the program name. 

37.3.1.7.5 Configure CIF Queue Display on a User-Specific Basis 

Use 

In CIF queue display, an individual list is generated for each table to be transferred (that is, for each 

interface parameter). 

In this IMG activity, you set how many lists are displayed on each page for a certain user. This setting 

influences the performance of CIF queue display. 

Requirements 

For more information on CIF queue display, see Set Up qRFC Administration for CIF Queue Display. 

STANDARD_SETUP& 

The value 10 is set as standard. 

Activities 

- Enter the name of a user and choose Change. 

- Choose the Parameters register card. 

- Enter the parameter CF8 and enter the required number of lists for each page as a value. You can 

enter values between 1 and 19. If you enter an invalid value, the system chooses the default value 

10. 
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37.3.2 Basic Settings for the Data Transfer 

37.3.2.1 Set User Parameters 

Use 

In this IMG activity, you can make user-specific entries for the following parameters: 

- RFC mode (activate/deactivate transfer on a user-specific basis) 

- Logging (configure application log on a user-specific basis) 

- Debug (activate/deactivate debugging on a user-specific basis) 

Requirements 

The settings for setting up the system landscape must already have been made. 

Activities 

1. Enter the user name specified in the user master. 

2. Use input help to make the relevant settings for this user. 

37.3.2.2 Configure Application Log 

Use 

Every data transfer via APO Core Interface (CIF) is recorded in a transfer log. The transfer log is 

analyzed in the ERP system in the CIF application log by using transaction CFG1. 

In this IMG activity, you configure the CIF application log so that only the object types you select 

containing the most important statistics are logged (individual tables of an object type and individual 

fields for the corresponding tables). By restricting the logging process in this way, you can improve 

system performance. 

In particular, we recommend that you restrict the number of object types to be logged if you have 

selected the Detailed Logging option under Logging in the Set User Parameters IMG activity. 

Requirements 

In the IMG activity Set User Parameters, Detailed Logging must be set under Logging for the relevant 

user. 

Standard settings 

The interface parameters needed most often in the CIF application log are already set by default. 

Activities 



 

 

1. Select the object type for which you want to make the field selection and navigate to the associated 

interface parameters. 

2. Select a parameter and navigate to field selection. 

3. Select the fields that are to be displayed in the application log. 

4. Save your entries. 

37.3.2.3 Reorganize Entries in the Application Log 

37.3.2.3.1 Define Variant 

Use 

In this IMG activity, you define a variant for the program RDELALOG. 

We recommend that you delete entries in the application log at regular intervals for performance reasons. 

You can do this by using transaction CFGD or by scheduling a regular job for program RDELALOG, 

upon which the transaction is based. To do this, you first need to save a variant of the RDELALOG 

program. 

Standard settings 

By default, no variants are created. 

Activities 

- Call the RDELALOG program and choose Execute. - Fill the entry fields according to your 

requirements. 

- Under Goto, choose the option Variants and click on Save as Variant.... 

- Enter a name for the variant and choose Save. 

Notes 

If you do not specify a date and the time remains blank, the system deletes all entries in the application 

log that are older than seven days. 

You can set the logging for the data records that are transferred by using Set Application Log on User-

Dependent Basis. You make these settings in the Set User Parameters IMG activity. 

37.3.2.3.2 Schedule Job 

Use 

In this IMG activity, you schedule a job for the regular archiving (deletion) of entries in the application 

log. 

For more information on usage, see Define variant. 
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Requirements 

You have created a variant for the program DELALOG. 

Standard settings 

By default, a job is not planned. 

Activities 

- Define a job with the step RDELALOG and the variant you have maintained. 

- Schedule the job as a periodic job. For this, the periods have to be adjusted to your requirements 

(for example, hourly, daily). 

- Save the job. 

- Create a job for each previously defined variant. 

37.3.2.4 Initial Data Transfer 

37.3.2.4.1 Determine Number Ranges for Parallelization 

Use 

In this IMG activity, you define the number range for parallelized initial data transfer (number range 

object CIF_LOAD). 

You can activate parallelized transfer under Activate integration model. 

If you start several initial data transfer runs in parallel, the system identifies the individual transfer runs 

using one unique, four-figure number that is part of the queue name. 

Example 

Queue names for parallelized initial data transfer. 

CFLDQW8CLNT150_1234ORD01: This refers to a parallelized initial data transfer for orders (ORD) 

from system QW8, client 150. The transfer run was allocated the number 1234 from the number range 

interval for parallelized initial data transfer runs. 

Activities 

Make sure that number range 1 has been created for the parallelized initial data transfer. Note that this is 

an interval with internal number assignment. 

We recommend that you set number range 1 as large as possible (for example, '0001' to 

'9999'). 

Further notes 

This is a rolling number range object. As a result, a transport to the production system is not critical. 

You can transport number range objects as follows: 

On the initial screen, choose Interval - Transport. 



 

 

Note that all intervals for the selected number range object are first deleted in the target system so that 

only the intervals that have been exported exist after the import. The current numbers are exported using 

the value that they possess at the time of the export. 

Dependent tables are not transported or converted. 

37.3.2.4.2 Set Filter and Selection Block Size 

Use 

You can make the following settings in this IMG activity: 

- Under FilterBlSz, you determine the number of filter objects that are processed in one block in the 

APO Core Interface. 

- Under SelectBlSz, you determine the number of data objects that are transferred to SAP APO in a 

remote function call (RFC) at the initial data transfer. 

You can use these settings to improve system performance during the initial data transfer. The optimum 

values for improved performance vary from case to case and are largely dependent upon the current data 

situation. Therefore, you are recommended to experiment with the settings in individual cases in your 

system. 

For more information, see the field help for the relevant columns. 

Activities 

1. Choose New Entries. 

2. Use input help to select the object type for which the settings are to apply. The system automatically 

adds the relevant text. 

3. Enter the number of objects of this type that are to be processed in each block. 

4. Enter the number of data object that are to be selected per block for each filter object of this type. 

Special Case - Master Data: 
If the data to be selected is master data, only one data object is ever selected for the corresponding 

filter object. This means that the block size for filter objects corresponds to the block size for data 

selection. If you make a different entry here, it is ignored by the system. 

37.3.2.4.3 Generate Integration Models 

Use 

In this step, you generate an integration model for the transfer of data via APO Core Interface 

(CIF). In general, you do not need all the master data and transaction data that exists in the ERP system 

to be able to carry out planning in SAP APO. You use the integration model to specify in the ERP system 

which data objects are to be selected from the total amount of data for the transfer to SAP APO. 

We recommend that you create a separate integration model for each object type, where possible. Master 

data and transaction data should always be handled separately. 

Requirements 

The basic settings for setting up the system landscape must have been made in the systems connected via 

CIF. 

Activities 
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1. Call the Create Integration Model screen. 

- Choose Logistics -> Central Functions -> Supply Chain Planning Interface -> Core 

Interface Advanced Planner and Optimizer -> Integration Model -> Create. 

- You can also call this screen using transaction CFM1. 

2. Define the integration model by making the following entries: 

- Model Name: User-defined 

- Logical System: Target system - the name should be identical with the RFC destination 

- APO Application: User-defined naming component to enable you to distinguish between 

integration models with the same model name 

3. In the left column, select the object types that you want to select (for example, material masters). 

4. Restrict the number of objects to be transferred for this object type by entering values under 

General Selection Options for Materials. These selection options are evaluated first by the 

system. 

5. You can use additional selection options to further restrict individual object types. These options are 

shown in the left screen section for each relevant object type. These selection options are only 

evaluated in second place by the system. 

Note that performance is better when the general selection options are being evaluated. If you 

restrict a selection by material and plant, you are therefore recommended to use the general 

selection options. 

6. Choose Execute. You see a list of the filter objects contained in this integration model. CIF uses 

the these filter objects as a basis to select the data objects to be transferred to SAP APO when the 

integration model is activated. 

- Choose Consistency Check if you want to check the consistency of your integration model 

(for example, whether the relevant plants have also been selected of the material masters 

specified). 

- Choose Detail to display all objects for an object type. 

- Choose Generate IM to generate your integration model. During the generation, CIF selects 

the filter objects for preparing the actual transfer. 

7. Leave the screen using Back and save the integration model as a variant, as required. 

For more information and recommendations on how to structure an integration model, see the online 

documentation for CIF integration. 

Notes 

We recommend you schedule generation of the integration model as background processing along with 

activation and, if necessary, deletion. For more information on this, see Scheduling generation and 

activation as jobs. 

37.3.2.4.4 Activate and Deactivate Integration Models 

Use 



 

 

In this step, you activate the integration models that you have already generated. When you carry out this 

activation, the system selects the data objects that match the filter objects contained in the integration 

model and transfers them to SAP APO. When you activate the integration models, you trigger the initial 

data transfer of master and transaction data to SAP APO and make the online transfer of transaction data 

possible. 

Activities 

1. Choose Logistics -> Central Functions -> Supply Chain Planning Interface -> Core Interface 

Advanced Planning and Optimizer -> Integration Model -> Activate. You can also call this 

screen using transaction CFM2. 

2. Select the integration model to be activated using the input fields Model, Logical System, and 

APO Application. 

If you only enter the name of the integration model, all integration models with the same 

name are returned in the results list (that is, all versions of this model are displayed). Only one 

version may be active at one time. 

3. Make the following settings, as required: 

- Log Deactivated Material Masters 

- Do Not Issue Warning in the Case of Parallel CIF Load 

- You can use the Parallelized Transfer input fields to influence the performance of the 

transfer. Make the relevant settings by using the input help (F4). Note that you need to define 

a number range for parallelized transfer. For more information about this, see Defining 

number ranges for parallelization. 

- Create Planned Orders as SNP Planned Orders 

- Create Business Partners 

4. Choose Execute to get to the results screen. 

You can use Detail to show columns with information about the individual filter objects. You can 

use the Hide Empty Columns icon to restrict the columns to those that contain entries. 

5. Set the required integration model to active by using Active/Inactive or by clicking New Status. 

You can set active integration models to inactive in the same way. 

6. Start the actual activation, in other words, data transfer, by using Start. The system displays the 

status of each integration model before the activation or deactivation in the Prev. Status column. 

7. The system transfers the selected data to SAP APO. 

Further notes 

Check material master data for APO indicators 

In general, all material master data that is transferred to SAP APO when an integration model is activated 

contains the indicator for SAP APO relevance. However, it may occur that material master data that you 

have included in an integration model is locked during activation (for example, because it is currently 
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being processed in the ERP system). This data no longer has an APO indicator after the activation. If the 

activation was made in dialog mode, you receive a message informing you of the material/plant 

combination affected. If the activation was made in the background, you can find a corresponding entry 

in the application log. To ensure that these materials also receive the indicator for SAP APO relevance, 

you need to run the program RAPOKZFX for the affected material/plant combinations. For more 

information, see Define variants for checking the APO indicator. 

Runtime version of the active integration models 

To improve the performance during online transfer, you can generate a runtime version from all active 

integration models for an object type and target system. For more information, see Define variant for 

generating the runtime version. 

Deactivate and delete integration models 

Note that the deactivation of integration models does not mean that the corresponding objects in 

SAP APO are deactivated or deleted. The exception to this is deactivated material masters (see above). 

You should delete inactive integration models or versions of an integration model on a regular bases. For 

more information, see Schedule generation and activation as a job. 

37.3.2.4.5 Schedule Regular Jobs 

37.3.2.4.5.1 Schedule Generation and Activation as a Job 

Use 

Master data is constantly being changed in the ERP system. For this reason you should regularly update 

your integration model to the newest status and transfer the changes to SAP APO. You should also delete 

the old versions of the integration model on a regular basis because these can hinder performance. To do 

this, we recommend you create the following programs as periodic jobs: 

a) Generate new versions of the integration model (RIMODGEN) 

b) Activate the newest versions (RIMODAC2) 

c) Optional: Delete the old versions (RIMODEL) This procedure offers the following 

advantages: 

- Master data that has been newly created and that corresponds to the filter objects in existing 

integration models is included in those integration models and transferred to SAP 

APO. 

- Master data that was changed in such a way that it no longer corresponds to the filter objects of the 

integration model is excluded from the transfer. 

- Master data (materials, customers, vendors, sources of supply, and planning product assignment) 

that has been changed since the last transfer is updated to the most recent status and transferred to 

SAP APO. 

Recommendation 



 

 

We recommend the following sequence of activities to prevent data inconsistencies that may arise if 

APO-relevant master data is created during the generation and activation of a related integration model: 

Generation 

1. Integration model for transaction data (for example, planned orders) 

2. Integration model for master data with dependent objects (for example, production process models) 3. 

Integration model for master data (for example, material, plant) 

Activation 

1. Integration model for master data 

2. Integration model for master data with dependent objects 

3. Integration model for transaction data 

Activities 

1. Create a variant for the relevant program: 

- Use transaction SE38 to call the ABAP/4 Editor. 

- Enter the name of the report for which you want to create a variant. 

- Under Subobjects choose the option Variants and then Create. 

- Enter a name for the variant and choose Create. 

- Fill the entry fields as required. 

- Save your entries. 

- Enter the attributes for the variant. 

- Save the variant. 

2. Schedule the program as a job: 

- Define a job using the program name and the variant you have maintained. 

- Schedule the job as a periodic job. 

- Save the job. 

- Create a job for each variant that you have previously defined. 

Further notes 

We recommend that you schedule this sequence of jobs for each integration model for which ALE 

change pointers are written for the objects. These objects include: 

- Material masters 

- Vendors 

- Customers 

- Planning product assignment 

- Sources of supply 

Note that for changes to conversion factors for currencies, all sources of supply have to be 

retransferred if you want to use cost optimization in SAP APO. To do this, you use program 

RIMODINI. 

For more information, see  Scheduling periodic transfers with change pointers. 

37.3.2.4.5.2 Check Material Master Data for APO Indicators 
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37.3.2.4.5.2.1 Define Variant 

Use 

You can use program RAPOKZFX to ensure that the materials contained in an integration model have 

received the indicator for APO relevance during the activation of the integration model. For more 

information, see Activating and Deactivating Integration Models. 

We recommend that you run this program as background processing. For this, you first have to define a 

variant and then schedule this as a background job. 

Standard settings 

No variants are created as standard. 

Activities 

- Choose Execute. 

- Fill the entry fields according to your requirements. 

- Under Goto, choose the options Variants and  Save as Variant.... 

- Enter a name for the variant and choose Save. 

37.3.2.4.5.2.2 Schedule Job 

Use 

In this IMG activity, you schedule a regular job for the variant of program RAPOKZFX that you have 

already created. For more information, see Schedule a Variant. 

Requirements 

A variant must have been created for program RAPOKZFX. 

Standard settings 

A job is not scheduled by default. 

Activities 

- Define a job with the step RAPOKZFX and the variant that you have already maintained. 

- Schedule this job as a periodic job and adjust the time periods to meet your requirements (for 

example, hourly, daily). 

- Save the job. 

- Create a job for each variant that you have previously defined. 



 

 

37.3.2.4.5.3 Generate Runtime Version for Active Integration Models 

37.3.2.4.5.3.1 Define Variant 

Use 

The runtime version of the active integration model is generated using program RCIFIMAX and is used 

to improve performance. 

In this IMG activity, you define a variant of program RCIFIMAX with the Consistency Check indicator. 

You can then use this variant to schedule the consistency check as background processing. In this way, 

you ensure data consistency between the active integration models and the runtime version of this 

integration model. 

Standard settings 

No variants are created as standard. 

Activities 

- Choose Execute. 

- Under Goto, choose the options Variants and Save as Variant.... 

- Enter a name for the variant. 

- Fill the entry fields according to your requirements. 

- Save the variant. 

37.3.2.4.5.3.2 Schedule Job 

Use 

In this IMG activity you schedule as a regular job the variant of program RCIFIMAX that you have 

already created. For more information, see Define Variant. 

Requirements 

A variant must have been created for the program RCIFIMAX. 

Activities 

- Define a job with the step RCIFIMAX and the variant you have maintained. 

- Schedule the job as a periodic job and adjust the time periods to suit your requirements (for 

example, hourly or daily). 

- Save the job. 

- Create a job for each variant you have previously defined. 
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37.3.2.5 Change Transfer 

37.3.2.5.1 Change Transfer for Master Data 

37.3.2.5.1.1 Configure Change Transfer for Master Data 

Use 

In this IMG activity, you set how changes to master data are transferred to SAP APO. If you do not make 

a setting here, master data changes are not transferred to SAP APO. 

You have three options: 

- The system does not transfer changes. 

- The system transfers the changes periodically using ALE change pointers. 

- The system transfers the changes to SAP APO immediately (online transfer) using business 

transaction events (BTE). 

You can make these settings individually for material, customer, and vendor data, as well as for setup 

groups. 

For information about the initial and change transfer for resources, see Set Up the Transfer of Resources 

to SAP APO. 

Requirements 

To be able to transfer master data changes using ALE change pointers, you have to activate ALE change 

pointers generally. 

To be able to transfer master data changes using BTE, you have to have activated online transfer using 

BTE. 

Activities 

Use input help to choose the relevant setting and save this setting. 

Further notes 

This screen contains several target-system-independent settings for the APO Core Interface (CIF). 

For information about the Re-Read Stock indicator, see Read Stock Values Before the Transfer to SAP 

APO. 

For information about the Filter Obj. Req. Reduc. indicator, see Evaluate the Requirements Reduction 

Filter Object Type. 

For information about the Update Logic for Manuf. Orders and Update Logic for Networks fields, 

see Activate Cross-System Update Logic. 

37.3.2.5.1.2 Schedule Periodic Transfer Using ALE Change Pointers 



 

 

Use 

The change transfer for master data with the APO Core Interface (CIF) usually takes place using ALE 

change pointers. ALE technology is used to write and evaluate change pointers for the objects that are 

changed. 

- Transaction CFP1 

- Activate the relevant integration model 

The objects that have been changed are completely retransferred to SAP APO. 

We recommend that you schedule a change transfer using ALE change pointers as a periodic job. For 

more information, see Schedule Generation and Activation as a Job. This replaces transaction CFP1. 

Requirements 

To be able to work with change pointers, the following settings must have been made: 

1. The relevant indicator must be set in the Activate Change Pointers Generally IMG activity. 

2. The transfer of ALE change pointers must be set in the Configure Change Transfer for Master Data 

IMG activity. 

3. The transfer must be set up for the relevant message type in the Activate ALE Change Pointers for 

Message Types IMG activity. 

37.3.2.5.1.3 Activate ALE Change Pointers Generally 

Use 

In this IMG activity, you fulfill the prerequisites for transferring changes to master data with change 

pointers. 

Requirements 

Under Activate ALE Change Pointers for Message Types, you also have to specify for which message 

types change pointers should be written. 

Activities 

Set the indicator to active. 
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37.3.2.5.1.4 Activate ALE Change Pointers for Message Types 

Use 

ALE change pointers are automatically activated for the following message types if you have set up ALE 

change pointers in the Configure Change Pointers for Master Data IMG activity: CIFMAT (material 

master), CIFCUS (customer), CIFVEN (vendor), and CIFPPR (planning product). 

In this IMG activity, you specify for which additional message types ALE change pointers should also be 

written. By default, there are the following additional message types: 

- CIFSRC for the change transfer of sources of supply 

- CIFMTMRPA for the change transfer of MRP areas 

Requirements 

ALE change pointers must be activated generally. For more information, see Activate ALE Change 

Pointers Generally. 

Activities 

Use input help to select the required message type and set the Active indicator. 

Further notes 

In transaction BD52 (Change document items for message type), you can influence the change transfer 

for a message type on a field basis. By default, ALE change pointers are written for all fields relevant to 

APO. 

37.3.2.5.1.5 Reorganize ALE Change Pointers 

37.3.2.5.1.5.1 Define Variant 

Use 

ALE change pointers are not deleted in the ERP system after the change transfer, they are marked as 

processed. To prevent a reduction in performance, we recommend that you delete the ALE change 

pointers regularly. You can do this using transaction BD22 or by scheduling program RBDCPCLR as 

background processing. 

In this IMG activity, you create a variant of program RBDCPCLR that can be scheduled as a regular job. 

Standard settings 

No variants are created as standard. 

Activities 



 

 

- Execute the IMG function. On the Delete Change Pointers screen, use input help to make the 

settings you require. 

- Under Goto, choose Variants then Save as Variant.... 

- Enter a name for the variant. 

- Fill the entry fields according to your requirements. 

- Save the variant. 

37.3.2.5.1.5.2 Schedule Job 

Use 

In this IMG activity, you schedule a job for the regular deletion of ALE change pointers. 

For more information on its use, see Define Variant. 

Requirements 

A variant must be created for the program RBDCPCLR. 

Standard settings 

A job is not scheduled as standard. 

Activities 

- Define a job using the step RBDCPCLR and the variant you have defined. 

- Schedule this as a periodic job and adjust the periods to your requirements (for example, hourly, 

daily). 

- Save the job. 

- Create a job for each variant that has already been defined. 

37.3.2.5.1.6 Activate Change Pointers for Production Process Models 

Use 

In this IMG activity, you set that change pointers are written for production process models (PPMs). 

This is a prerequisite for ensuring that changes to BOMs, production versions, routings, and master 

recipes in the ERP system lead to a corresponding adjustment of the PPM in SAP APO. 

Report RSPPMCHG (transaction CFP3) can be used to evaluate change pointers and retransfer the PPMs 

affected to SAP APO. 

Report RSPPMDEL (transaction CFP4) can be used to delete the change pointers (for example, if they 

are not relevant to SAP APO). 

Activities 

Make the following entries in table TCHTR (the first column contains the object type, the second 

contains the name of the function module): 
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BOM          CIF_BOM_CHANGED (change to BOM) 

PRODVER      CIF_MKAL_CHANGED (change to production version) 

ROUTING      CIF_ROUTING_CHANGED (change of routing/master recipe) 

Further notes 

Note the following restrictions: 

- Change pointers are not written for changes to the BOMs of phantom assemblies 

- Change pointers are not written for the routing for changes to a reference operation set that 

references a standard routing. 

- Change pointers are not written for changes to referenced objects (for example, component scrap in 

the material master). 

- Change pointers are not written for routing changes or recipe changes when changes are made at the 

operation using classification with code OPCA. 

37.3.2.5.1.7 Enhancements 

37.3.2.5.1.7.1 Create Integration Models Automatically 

Use 

You can use enhancement CIFIMO01 (CIFIMO-zero-one) to influence the automatic creation of 

integration models beyond the possibilities available as standard. 

For more information, see the documentation for enhancement CIFIMO01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.2.5.2 Change Transfer for Transaction Data 

37.3.2.5.2.1 Activate Online Transfer Using BTE 



 

 

Use 

The transfer of transaction data to SAP APO is generally made as an online transfer. An online transfer 

may also be useful for the transfer of master data changes in some cases. To be able to use online 

transfer, business transaction events (BTEs) have to be active for the integration with SAP APO. 

In this IMG activity, you activate BTE for the integration with SAP APO and so fulfill the prerequisite 

for the online transfer of both transaction data changes and - in exceptional cases master data changes. 

Activities 

Set the ND-APO (New Dimension Plug-In APO) and NDI (New Dimension Integration) application 

indicators to active. 

37.3.2.5.2.2 Activate Transfer of Purchase Order Changes 

Use 

You can use this IMG activity to define whether changes to purchase orders are to be transferred from 

SAP SRM to SAP SCM or not. In other words, you can activate or deactivate the transfer. 

37.3.2.5.2.3 Activate Cross-System Update Logic 

Use 

In this IMG activity, you activate cross-system update logic for manufacturing orders or networks. Cross-

system update logic means that changes to orders made in the ERP system are assigned a higher priority 

than parallel order changes in SAP APO. This enables you to avoid data inconsistencies that are caused 

by parallel changes in an integrated system landscape. 

For more information, see 

- Cross-System Update Logic for Manufacturing Orders 

- Cross-System Update Logic for Networks 

Standard settings 

Cross-system update logic is not set as standard. 
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37.3.2.6 Enhancement for the CIF Comparison/Reconciliation 

37.3.2.6.1 Compare Sales Orders and Purchase Orders/Requisitions 

Use 

You use the compare/reconcile function (started in SAP APO) to identify and rectify data inconsistencies 

between SAP APO and the ERP system. 

You can use enhancement CIFCID3 to influence the amount of sales orders, purchase orders, 

confirmations, and purchase requisitions that are selected in the ERP system for the comparison. 

For more information, see the documentation for enhancement CIFCID3. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3 Application-Specific Settings and Enhancements 

37.3.3.1 Enhancements for Equipment 

37.3.3.1.1 BAdI: CIF - Transfer Equipment to TM as Resources 

Use 

You can use this Business Add-In (BAdI) to change data for TM resources based on ERP equipment 

before the transfer to SAP TM via Core Interface (CIF). You can, for example, change the TM resource 

data or downtimes for SAP TM on a customer-specific basis. 

Standard settings 

The BAdI is not active in the standard system. 



 

 

The BAdI is designed for multiple uses. 

The BAdI is not filter-dependent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

Example 

This BAdI uses the method IF_EX_BADI_CIF_EQUIPMENT~CHANGE_OUTBOUND_DATA. 

For more information, see the signature of the method. 

37.3.3.2 Enhancements for Functional Location 

37.3.3.2.1 BAdI: CIF - Transfer Functional Locations to TM as Resources 

Use 

You can use this Business Add-In (BAdI) to change data for TM resources based on ERP functional 

locations before the transfer to SAP TM via Core Interface (CIF). You can, for example, change the TM 

resource data or downtimes for SAP TM on a customer-specific basis. 

Standard settings 

The BAdI is not active in the standard system. 

The BAdI is designed for multiple uses. 

The BAdI is not filter-dependent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

Example 

This BAdI uses the method IF_EX_BADI_CIF_FUNCLOC~CHANGE_OUTBOUND_DATA. 

For more information, see the signature of the method. 

37.3.3.3 Enhancements for Plant, Vendor, Customer, and Shipping Point 

37.3.3.3.1 Influence Data Before Transfer to SAP APO on a User-Specific 

Basis 
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Use 

You can use enhancement CIFLOC01 to influence the mapping of plant, vendor, and customer master 

data to APO location interface data as well as the determination of the location type in SAP APO on a 

customer-specific basis. 

For more information, see the documentation for enhancement CIFLOC01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.3.2 Restructure Storage Location MRP Areas 

Use 

This IMG activity supports you if you are already working with storage location MRP areas in an 

integrated system landscape and you want to restructure these. You can find information about this 

process in the documentation for SAP Advanced Planning and Optimization under Integration via APO 

Core Interface (CIF) -> Integration of Master Data and 

Transaction Data -> Integration of Master Data -> Integration of Locations -> Integration of 

Storage Location MRP Areas -> Restructuring of Storage Location MRP Areas in SAP R/3. 

37.3.3.3.3 BAdI: Change Shipping Point Data Before Sending to SAP APO 



 

 

Use 

You can use this Business Add-In (BAdI) to change data for shipping points before the transfer to SAP 

APO via APO Core Interface (CIF). You can, for example, adjust the address data or names of shipping 

points for SAP APO on a customer-specific basis. 

Standard settings 

The BAdI is not active in the standard system. 

The BAdI is designed for multiple uses. 

The BAdI is not filter-dependent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also: 

This BAdI uses the method IF_CIF_ENHANCED CHANGE_SHPPNT_OUT. For more information, see 

the documentation for this method. 

37.3.3.4 Enhancements for Materials 37.3.3.4.1 Influence Data Before Transfer 

to SAP APO on a User-Specific 

Basis 

Use 

You can use enhancement CIFMAT01 to influence the mapping of material master data to APO product 

interface data on a customer-specific basis. 

For more information, see the documentation for enhancement CIFMAT01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 
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In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.4.2 Transfer Deactivated Materials to SAP APO 

Use 

You can use enhancement CIFMAT02 to transfer information to SAP APO about which materials were 

contained in integration models that used to be active, but that have since been deactivated. 

For more information, see the documentation for enhancement CIFMAT02. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.5 Settings for Resources 

37.3.3.5.1 Set the Transfer of Resources to SAP APO 

Use 

In this IMG activity, you make the settings for the initial data transfer and change transfer of resources in 

SAP APO (capacities in the ERP system): 

- For the initial data transfer, specify the resource type single resource and resource type 

multiresource. 

The resource type cannot usually be changed in SAP APO. Therefore if is not possible to make a 

later change to the resource type by using an initial data transfer. 

- For the change transfer specify: 

- Whether the change transfer is made immediately at each change or periodically. 

- For which resources the change transfer applies. 



 

 

- If you use external capacity in SAP APO, you need to specify: 

- To which resources the external capacity should be assigned. 

- For how many days in the past and the future the external capacity should be generated. 

Requirements 

If you want to transfer the changes immediately to the header data of the resource, you have to activate 

online transfer using BTE. 

If you want to transfer the changes periodically to the header data of the resource using ALE change 

pointers, you have to activate ALE change pointers generally. 

37.3.3.6 Enhancements for Transportation Lanes 

37.3.3.6.1 BAdI: Influence Data Before it Is Sent to SAP APO 

Use 

You can use this Business Add-In (BAdI) to change data for supply relationships that are transferred via 

the APO Core Interface (CIF) and created in SAP APO transportation lanes. 

The BAdI contains the method /ISDFPS/IF_CIF_ENHANCE CHANGE_TLANES. For more 

information, see the  documentation for the BAdI method /ISDFPS/IF_CIF_ENHANCE 

CHANGE_TLANES. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.3.3.7 Settings and Enhancements for Stocks 

37.3.3.7.1 Read Stock Values Before the Transfer to SAP APO 

Use 

For performance reasons and to allow parallel stock postings, it may be useful to process stock postings 

in SAP R/3 without exclusive locks. If this is the case, the situation may occur that a transaction is 

holding a stock value in its memory which has already been changed in the database by a different stock 

posting. If the value that is now obsolete is transferred to SAP APO, this can lead to inconsistencies 

between SAP APO and SAP R/3. 
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In this IMG activity, you can ensure that the system re-reads the value immediately before transferring 

the stock values to SAP APO. In this way, the most up-to-date stock values are transferred to SAP APO 

even if there are later locks in SAP R/3. 

Standard settings 

The Re-Read Stock indicator is not active as standard. 

Activities 

Set the Re-Read Stock indicator. 

Further notes 

Several target-system-dependent settings for the APO Core Interface (CIF) are contained on this screen. 

For information on the settings under Change Transfer for Master Data, see Configure Change 

Transfer for Master Data. 

For information on the Filter Obj. Req. Reduc., see Evaluate the Requirements Reduction Filter Object 

Type. 

37.3.3.7.2 Set Up Transfer of Inspection Lots to SAP APO 

Use 

By default, inspection lots from the ERP system are transferred to SAP APO as stock in quality 

inspection. In this IMG activity, you fulfill the prerequisites for the transfer of inspection lots that meet 

the relevant criteria outlined below to an SAP APO target system. 

Inspection lot integration is then activated when you activate an integration model for inspection lots. If 

the Inspection Lots Allowed indicator is not set, you cannot activate this integration model. 

For more information, see the integration documentation under Integration of Inspection Lots. 

Requirements 

- The target system specified is SAP APO 4.0 or higher. 

An inspection lot that is to be included in integration must meet all the following relevancy criteria: 

- The inspection lot has the status SPRQ (stock posting required). 

- The quantity to be posted for the inspection lot is greater than zero. 

- The inspection lot quantity was posted to the stock in quality inspection when the inspection lot was 

opened. That is, the Insp. Stock indicator is set on the Inspection Lot Quantities tab page. 

Standard settings 

Inspection lot integration is not set as standard. 



 

 

Activities 

Set the Inspection Lots Allowed indicator. 

37.3.3.7.3 Activate Fixed Pegging for Stocks 

Use 

In this IMG activity you specify that the material document is also transferred to SAP APO when a stock 

is posted. 

Requirements 

You work in SAP APO with fixed pegging. 

Activities 

- Select the SAP APO system for which you want to activate fixed pegging for stocks. 

- Choose Details. The screen Display View "Fixed Pegging": Details appears. 

- Set the relevant indicator. 

37.3.3.7.4 Influence Data Before Transfer to SAP APO on a User-Specific Basis 

Use 

You can use enhancement CIFSTK01 to influence the mapping of stock data to APO stock interface data 

on a customer-specific basis. 

For more information, see the documentation for enhancement CIFSTK01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 
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In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.8 Settings and Enhancements for Inspection Lots 

37.3.3.8.1 Set Up Transfer of Inspection Lots to SAP APO 

Use 

By default, inspection lots from the ERP system are transferred to SAP APO as stock in quality 

inspection. In this IMG activity, you fulfill the prerequisites for the transfer of inspection lots that meet 

the relevant criteria outlined below to an SAP APO target system. 

Inspection lot integration is then activated when you activate an integration model for inspection lots. If 

the Inspection Lots Allowed indicator is not set, you cannot activate this integration model. 

For more information, see the integration documentation under Integration of Inspection Lots. 

Requirements 

- The target system specified is SAP APO 4.0 or higher. 

An inspection lot that is to be included in integration must meet all the following relevancy criteria: 

- The inspection lot has the status SPRQ (stock posting required). 

- The quantity to be posted for the inspection lot is greater than zero. 

- The inspection lot quantity was posted to the stock in quality inspection when the inspection lot was 

opened. That is, the Insp. Stock indicator is set on the Inspection Lot Quantities tab page. 

Standard settings 

Inspection lot integration is not set as standard. 

Activities 

Set the Inspection Lots Allowed indicator. 

37.3.3.8.2 Activate Fixed Pegging for Inspection Lots 

Use 

In this IMG activity you specify that the preceding document for an inspection lot is also transferred to 

SAP APO. 

Requirements 



 

 

You work in SAP APO with fixed pegging. 

Activities 

- Select the SAP APO system for which you want to activate fixed pegging for inspection lots. 

- Choose Details. The screen Display View "Fixed Pegging": Details appears. 

- Set the relevant indicator. 

37.3.3.8.3 Transfer Inspection Lots with Quantity of Zero to SAP APO 

Use 

You can use enhancement QAPO0001 to specify that inspection lots with a quantity to be posted of zero 

are also taken into account for the transfer of inspection lots to APO. 

For more information, see the documentation for enhancement QAPO0001. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.8.4 Change Data on a Customer-Specific Basis Before Transfer to SAP 

APO 

Use 

You can use enhancement QAPO0002 to change in a customer-specific way inspection lots that are to be 

transferred to SAP APO before they are converted to SAP APO format. 

For more information, see the documentation for enhancement QAPO0002. 
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Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.8.5 Change Times Before Transfer to SAP APO 

Use 

You can use enhancement QAPO0003 to modify the start and end time of an inspection lot that is 

automatically set to 00:00 for the transfer to APO. 

For more information, see the documentation for enhancement QAPO0003. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.9 Settings and Enhancements for Requirement Reduction 

37.3.3.9.1 Evaluate the Requirements Reduction Filter Object Type 

Use 

In this IMG activity, you can control the transfer of requirements reduction to SAP APO. 

There are the following options: 



 

 

1. The requirements reduction is transferred for all materials contained in an active integration model 

for material masters with a suitable material-plant combination. In this case, you do not set the 

Filter Obj. Req. Reduc. indicator. 

2. The requirements reduction is only transferred for materials contained in an active integration 

model for requirements reduction with a suitable material-plant combination. In this case, you need 

to create an integration model for requirements reduction and activate 

it. You also need to set the Filter Obj. Req. Reduc. indicator so that the requirements reduction 

filter object is evaluated. 

For more information, see Use Own Filter Object Type for Requirements Reduction. 

Standard settings 

The Filter Obj. Req. Reduc. indicator is not set as standard. 

Activities 

Use input help for the Filter Obj. Req. Reduc. indicator to make the required setting. 

Further notes 

Several target-system-dependent settings in the APO Core Interface (CIF) are contained on this 

screen. 

For information about the settings under Change Transfer for Master Data, see Configure Change 

Transfer for Master Data. 

For information on the Re-Read Stock indicator, see Read Stock Values Before Transfer to SAP APO. 

37.3.3.9.2 Influence Requirement Reduction Data Before Transfer to SAP 

APO 

Use 

You can use enhancement CIFIRQ01 to influence data for a requirements reduction at the transfer to 

SAP APO. 

For more information, see the documentation for enhancement CIFIRQ01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 
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2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.10 Enhancements for Reservations 

37.3.3.10.1 Change Inbound Reservations 

Use 

You can use enhancement CIFRSV02 to influence inbound manual reservations in the ERP system that 

were created in SAP APO before they are processed in the ERP system. 

For more information, see the documentation for enhancement CIFRSV02. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.11 Enhancements for the Production Process Model 

37.3.3.11.1 Influence PPM Data 

Use 



 

 

You can use enhancement CIFPPM01 to influence from the ERP system the transfer of certain PPM data 

in SAP APO. 

For more information, see the documentation for enhancement CIFPPM01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.12 Enhancements for Production Data Structure 

37.3.3.12.1 Change Production Data Structure 

Use 

You use this BAdI to adjust PP/DS runtime objects that were generated from SAP master data. 

The associated interface contains two groups of methods: 

- The first group enables you to influence the contents of a PP/DS runtime object and contains 

the following methods: 

- CHANGE_EWB_STRUCTURES 

- CHANGE_CIF_STRUCTURES 

- CHANGE_OPERATION 

- The second group enables you to influence the transfer of the PP/DS runtime object to SAP 

APO and contains the following methods: 

- TRANSFER_ALLOWED - TRANSFER_FINISHED 

Activities 
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After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

37.3.3.13 Enhancements for Integrated Product and Process Engineering 

(iPPE) 

37.3.3.13.1 BAdI: iPPE Data Transfer  



 

 

37.3.3.14 Settings and Enhancements for Shipments  
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37.3.3.14.1 Assign Vendor Account Group to APO Location Type 

Use 

In this IMG activity, you assign the account group to the APO location type. This is necessary to map the 

freight forwarder in the ERP system as the transportation service provider (TSP) in SAP Advanced 

Planning and Optimization (SAP APO). 

Activities 

- Choose an account group. You can use the predefined account group 0005 (Freight Forwarder). 

Alternatively, you can define your own account groups. 

- Choose TSP (1020) as the location type for SAP APO.  



 

 

37.3.3.14.2 Influence Shipment Cost Calculation 

Use 

You can use enhancement V56I0030 to influence shipment cost calculation in SAP APO. 

For more information, see the Documentation for enhancement V56I0030. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.14.3 Determine Attributes for Transportation Scheduling in SAP APO 

Use 

You can use enhancement LESHPSC to determine additional attributes in the ERP system for 

transportation scheduling in SAP APO. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 
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For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.15 Settings and Enhancements for Sales Orders 

37.3.3.15.1 Influence Inbound Sales Order Data 

Use 

You can use enhancement CIFSLS02 to influence inbound sales-order-specific data from SAP APO 

before it is processed. 

For more information, see the documentation for enhancement CIFSLS02. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.15.2 Influence Sales Order Data Before the Transfer 

Use 

You can use enhancement CIFSLS03 to influence sales-order-specific data directly before it is sent to 

SAP APO. 

For more information, see the documentation for enhancement CIFSLS03. 

Activities 



 

 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.15.3 Settings for Vendor Managed Inventory (VMI) 

37.3.3.15.3.1 Assign Sales Area and Order Type to Ordering Party/Plant 

Use 

In this IMG activity, you assign a sales area and (optionally) an order category within the VMI process 

for an ordering party/plant combination. When a VMI order is transferred from SAP APO, the VMI sales 

order is created in the ERP system using the sales area and order category specified in this IMG activity. 

If an order category is not specified, the VMI sales order is created as a standard order (order category 

TA). 

37.3.3.15.3.2 Execute Initial Data Transfer for Stock in Transit 

Use 

This IMG activity is used for the initial data transfer to SAP APO of stock in transit for the VMI scenario 

using report RLOADVMI. You can call this report to rebuild the VMI stock in transit data after 

liveCache has been initialized in SAP APO, for example. 

For more information, see the documentation for report RLOADVMI. 

37.3.3.15.4 Set the Transfer of Returns to SAP APO 

Use 

In this IMG activity, you activate the transfer of returns and the associated return deliveries to 

SAP APO. This enables you to take returns and return deliveries into account in SAP APO 

Transportation Planning/Vehicle Scheduling (TP/VS). You can then map the return delivery of empties 

without having to enter the customer as a vendor (which must be done for purchase orders), for example. 
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Requirements 

An active integration model must exist for sales orders. The transfer of returns is only made for 

materials/plants that are contained in an active integration model for sales orders. 

Standard settings 

As standard, the system is set so that returns and return deliveries are not transferred to SAP 

APO. 

Activities 

Set the Returns indicator. 

If you activate the transfer of returns in a productive system, you have to reactivate the integration model 

for sales orders. This means you need to trigger an initial data transfer so that all returns that already 

exist in the ERP system are transferred to SAP APO. 

37.3.3.16 Enhancements for Sales Scheduling Agreements 

37.3.3.16.1 Inbound Processing of Sales Scheduling Agreements 

37.3.3.16.1.1 Process Customer-Specific Structures 

Use 

This Business Add-In (BAdI) is used in the component Sales Scheduling Agreement Processing 

(SCM-APO-PPS-CDS). 

You use this BAdI to enhance or change customer-specific data for confirmations (such as scheduling 

agreement item, scheduling agreement release header, schedule lines, texts, and partners) that are 

transferred from SAP APO to the connected ERP system using the APO Core Interface (CIF). 

Note 

The quantities confirmed in SAP APO are displayed as schedule lines in the JIT/forecast delivery 

schedule in the sales scheduling agreement in the ERP system. 

The BAdI is called in function module CIF_SCOCONF_INBOUND. 

The data is formatted here for further processing using the business application programming interface 

(BAPI) BAPI_SALES_DEL_SCHEDULE_CREATE. Processing occurs on a document by document 

basis. 

You can use this BAdI to enhance or change data: - Before the 

confirmations transferred are updated in the BAPI - After the 

confirmations transferred are updated in the BAPI. 

Implementing this BAdI does not have an effect on other IMG activities. 

Requirements 

You can use the BAdI /SAPAPO/SMOY_PUB_APP APO Publication BAdI for Populating 

Enhancement Structures in APO and its method APPENDCONFSCHEDAGRMT Enhance 

Confirmation for Scheduling Agreement in SAP APO to transfer customer-specific data from SAP 

APO to the ERP system. 



 

 

You have to create identical or compatible structures in both systems. 

The BAdI is called in function module /SAPAPO/DM_CP_PROCESS. 

Standard settings 

The BAdI is not active in the standard delivery. 

The BAdI can be used on multiple occasions. 

Activities 

After you call the IMG activity, you first see a dialog screen in which you enter a name for the 

implementation. 

If implementations have already been created for this BAdI, you see a dialog window in which the existing 

implementations are displayed. Choose Create in this dialog window and proceed as follows: 

1. In the Implementation field, enter a name for the BAdI implementation and choose Create. 

The entry screen for creating BAdI Implementations is displayed. 

2. In the entry screen, enter a short text for the implementation in the Short Text for Implementation 

field. 

3. Choose the Interface tab page. 

The Name of the Implementing Class is automatically filled on this tab page. This is because the 

system automatically assigns a class name on the basis of the name of your implementation. 

4. Save your entries and make the assignment to a package. 

5. Position the cursor on a method and double-click to navigate to method processing. 

6. Enter the coding you require for the implementation between the instructions method 

<Interface-Name>~<Method Name> and endmethod. 

7. Save and activate your coding and navigate to the Change Implementation screen. 

8. Save on the Change Implementation screen. 

Note: It is also possible to create an implementation for a BAdI and then activate it at a later point 

in time. If you want to do this, you should stop now (before activation). 

9. Choose Activate. 

When the application program is executed, the coding you added to the method runs. 

See also: 

Documentation for method  Processing of Customer-Specific Data Before Posting for confirmations/sales 

scheduling agreement releases (SCOCONF_BEFORE_POSTING) 

Documentation for method  Processing of Customer-Specific Data After Posting for confirmations/sales 

scheduling agreement releases (SCOCONF_AFTER_POSTING) 

Documentation for interface IF_EX_BADI_SCOCONF 

37.3.3.16.2 Outbound Processing of Sales Scheduling Agreement 

37.3.3.16.2.1 Transfer Sales Scheduling Agreement Items 

Use 
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You can use the Business Add-In (CIF_SDLSE_001) to change pre-selected sales scheduling agreement 

data or to add information to a sales scheduling agreement before the initial data transfer to SAP APO. 

This BAdI is called up in the function module CIF_SDLS_TPSCO_MAP. If you want to add information 

to a sales scheduling agreement you must add the relevant fields to the include CI_SDLSCUS within the 

database structure CIFSDLSCUS. 

Requirements 

To activate the Business Add-In, you must create an active implementation. To do this, choose the 

following path in the SAP Menu: Tools -> ABAP Workbench -> Utilities -> Business 

Add-Ins -> Implementation 

Standard settings 

The Business Add-In is not active in the standard. 

The Business Add-In is not multiple-use. 

The Business Add-In is not filter-dependent. 

Activities 

For more information about this procedure, see the SAP Library under 

-  Basis Components -> ABAP Workbench -> Changing the SAP Standard -> Business 

Add-Ins -> Implementing Business Add-Ins. 

Example 

If you want to store further specific information to the selected scheduling agreement then you create the 

corresponding fields for recording this information in the include CI_SDLSCUS which is located in the 

database structure CIFSDLSCUS. The scheduling agreement information can then be formatted and 

stored within the BAdI. 

37.3.3.16.2.2 Influence Selection of Sales Scheduling Agreements 

Use 

You can use this Business Add-In (CIF_SDLSE_002) to implement your own restrictions for selecting 

materials and the connected plants. The BAdI is called up in the function module 

SDLS_KEY_SELECTION. Within this function module the BAdI follows the module 

CIF_MATERIAL_KEY_SELECTION. This allows you to use the BAdI to re-select and carry out a 

specific selection of materials which have already been selected using the module 

CIF_MATERIAL_KEY_SELECTION. 

Requirements 

To activate the Business Add-In, you must create an active implementation. To do this, choose the 

following path in the SAP Menu: Tools -> ABAP Workbench -> Utilities -> Business 

Add-Ins -> Implementation 



 

 

Standard settings 

The Business Add-In is not active in the standard. 

The Business Add-In is not multiple-use. 

The Business Add-In is not filter-dependent. 

Activities 

For more information about this procedure, see the SAP Library under 

-  Basis Components -> ABAP Workbench -> Changing the SAP Standard -> Business 

Add-Ins -> Implementing Business Add-Ins. 

Example 

If a scheduling agreemeent that you want to transfer via the CIF contains multiple items with different 

materials and you want do not want to transfer all the materials then you can use this BAdI to filter out 

the materials that you do not want to transfer. 

37.3.3.17 Settings and Enhancements for In-House Production 

37.3.3.17.1 General Settings for Manufacturing Orders 

37.3.3.17.1.1 Assign Components to an Operation Segment 

Use 

The ERP system determines the requirements date of the component using the first operation segment of 

the assigned operation. In the ERP production order, this is the Start Setup date. For receipt elements 

(co/by-products), the system adopts the end date of the assigned operation. However, in SAP APO you 

can assign a component to any desired activity. An assignment to the Setup activity when you are using 

setup matrices or sequence-dependent setup activities leads to a significant reduction in performance 

when optimizing the setup time. Also, the components in production are usually only required for the 

first time at the Start Processing date. 

You can use this IMG activity for the integration of production orders to control from which operation 

segment (Setup, Process, or Teardown) the requirements date of the associated components of an 

order is determined (that is, to which activity of an operation in SAP APO the components are assigned). 

You can avoid a strictly defined assignment to the Setup operation segment, as well as enabling a 

uniform component assignment in both systems and a significant increase in performance for setup time 

optimization in SAP APO. 

For the integration of the production process model (PPM), this setting determines to which activity of 

the operation the components are assigned when the PPM is generated. 

These settings only relate to requirement elements (reservations) of a production order or of the assigned 

PPM. They do not relate to the receipt elements or to process orders. 

Requirements 

In ERP Customizing for scheduling, it is defined that an operation date should be used as the 

requirements date of the components. 
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Activities 

Double-click the relevant entry and make the required settings. 

37.3.3.17.2 Inbound Processing of Planned Orders and Manufacturing Orders 

37.3.3.17.2.1 Change Order Data 

Use 

You can use enhancement CIFORD03 to change orders in ERP inbound that are transferred 

from SAP APO to the ERP system. 

For more information, see the documentation for enhancement CIFORD03. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.2.2 Change Object Type and Order Data 

Use 

You can use enhancement CIFORD01 to change order data in ERP inbound that was transferred from 

SAP APO to the ERP system and is already in ERP format. 

For more information, see the documentation for enhancement CIFORD01. 



 

 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.3 Outbound Processing of Planned Orders and Manufacturing Orders 

37.3.3.17.3.1 Influence the Transfer of Customer-Specific Fields 

Use 

In enhancement CIFORD02, you can change or add your own data to manufacturing orders (and, in part, 

planned orders) that are to be transferred to SAP APO. 

For more information, see the documentation for enhancement CIFORD02. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.4 Inbound Processing of Manufacturing Orders 

37.3.3.17.4.1 Influence Order Data After the Transfer from SAP APO 
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Use 

You can use enhancement PPAPO002 to influence the transfer of data that was transferred for a 

manufacturing order from SAP APO before it is added to the ERP manufacturing order. 

For more information, see the documentation for enhancement PPAPO002. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.4.2 Override Order Type for Planned Order Conversion 

Use 

You can use enhancement PPAPO008 to manually influence the order category of a manufacturing order 

that was generated by the conversion from SAP APO. 

For more information, see the documentation for enhancement PPAPO008. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 



 

 

37.3.3.17.4.3 Re-Explode BOMs for Planned Order Conversion 

Use 

You can use enhancement PPAPO004 to force the re-explosion of a BOM. 

For more information, see the documentation for enhancement PPAPO004. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.4.4 Add Components and Items 

Use 

You can use enhancement PPAPO009 to run your own tests when adding components to a manufacturing 

order from SAP APO. 

For more information, see the documentation for enhancement PPAPO009. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 



 

WHATSAPP +255738656506 

 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.4.5 Override Checkbox Fields for Manufacturing Orders 

Use 

You can use enhancement PPAPO007 to override checkbox fields for manufacturing orders for the 

transfer from SAP APO. 

For more information, see the documentation for enhancement PPAPO007. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.5 Outbound Processing of Manufacturing Orders 

37.3.3.17.5.1 Influence Initial Data Transfer of Manufacturing Orders 

Use 

You can use enhancement PPAPO006 to influence the initial data transfer of manufacturing orders in the 

integration model. 

For more information, see the documentation for enhancement PPAPO006. 

Activities 



 

 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.5.2 Check APO-Relevance of Operations 

Use 

You can use enhancement PPAPO003 to filter out operations when sending manufacturing orders to SAP 

APO. 

For more information, see the documentation for enhancement PPAPO003. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.5.3 Change Confirmations to SAP APO on Customer-Specific Basis 

Use 

You can use enhancement CIFCNF01 to change confirmations on a user-specific basis for production 

and process orders that are sent to SAP APO. 
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For more information, see the documentation for enhancement CIFCNF01. 

Note that this enhancement is obsolete as of SAP APO 3.1. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.5.4 Enhance Relationships in Process Orders 

Use 

Relationships in the process order are automatically reassigned when phases are filtered out by the APO 

Core Interface (CIF). 

You can use enhancement PPAPO005 to influence the properties of these relationships. 

For more information, see the documentation for enhancement PPAPO005. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 



 

 

37.3.3.17.5.5 Determine Rework Operations and Triggering Operation 

Use 

You can use enhancment CIFORD04 to transfer information to SAP APO about: 

- Which rework operations are determined for an operation that initiates rework 

- Which operation that initiates rework is determined for a rework operation when there is a 

confirmation 

For more information, see the documentation for enhancement CIFORD04. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.17.5.6 Set Quantity Adjustment After Confirmation 

Use 

In this IMG activity you can use the enhancement for the relevant production scheduling profile in APO 

CIF to set how the system behaves when a confirmation is made for production orders. You can set the 

following indicators for a production scheduling profile: 

- Quantity adjustment after confirmation 

- Rescheduling after quantity adjustment 

Activities 

1. Place the cursor on the relevant production scheduling profile and choose Detail. 

2. Set the indicator required by using input help. 
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37.3.3.17.5.7 Filter Components from Quantity Propagation 

Use 

You can use enhancement PPAPO010 to exclude components from quantity adjustment by confirmation 

in the APO Core Interface. 

For more information, see the documentation for enhancement PPAPO010. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.18 Enhancements for Networks 

37.3.3.18.1 BAdI: Integrate Networks 

Use 

You can use this Business Add-In (BAdI) to create SAP-APO project orders from SAP R/3 networks. 

This BAdI provides the following functions: 

- Change to network header data after it has been selected from the database 

- Change to network data before it is converted to SAP-APO format 

- Change to project order data after the network has been converted to SAP-APO format 

Standard settings 

The BAdI is not active in the standard system. 

Activities 



 

 

Apart from the implementation, the BAdI does not require any particular activities. 

For more information, go to application help under Changing the SAP Standard (BC) -> Business 

Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI contains the following methods: 

CHANGE_NETWORK_HEADERS 

CHANGE_NETWORK_DATA 

CHANGE_OUTBOUND_DATA 

For more information, see the documentation on the individual BAdI methods. Proceed as follows: 

1. Choose the tab page Interface 

2. Double-click the appropriate method 

3. Right-click and choose Component Documentation  

37.3.3.18.2 BAdI: Receive networks from SAP APO 

Use 

You can use this Business Add-In (BAdI) to modify SAP-APO project orders that are sent from SAP 

APO to SAP R/3. 

This BAdI changes project order data after it has been received from SAP APO and before the 

corresponding network is updated in SAP R/3. 

Standard settings 

The BAdI is not active in the standard. 

Activities 

Apart from the implementation the BAdI does not require any particular activities. 

For more information, go to application help under Changing the SAP Standard (BC) -> Business 

Add-Ins -> Implementing a Business Add-In. 

See also: 

The BAdI contains the following method: 

CHANGE_NETWORK_INBOUND 

For more information, see the documentation on the individual BAdI methods. 

Proceed as follows: 

1. Choose the tab page Interface 

2. Double click on the appropriate method 
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3. Right click and choose Component Documentation  

Example 

To display the sample code, choose Goto -> Sample Code -> Display. 

37.3.3.19 Enhancements for Maintenance Orders 

37.3.3.19.1 BAdI: Integrate Maintenance Orders 

You can use this Business Add-In (BAdI) to transfer SAP R/3 maintenance orders to SAP APO. 

This BAdI provides the following functions: 

- Change of maintenance order header data, after it has been selected from the database 

- Change to maintenance order data before it is converted to SAP APO format 

- Change of maintenance order after it has been converted to SAP APO format 

Standard settings 

The BAdI is not active in the standard. 

Activities 

Apart from implementation, the BAdI does not require any particular activities. 

For more information, go to application help under Changing the SAP Standard (BC) -> Business 

Add-Ins -> Implementing a Business Add-In. 

Further notes 

The BAdI contains the following methods: 

CHANGE_PMORDER_HEADERS 

CHANGE_PMORDER_DATA 

CHANGE_OUTBOUND_DATA 

For more information, see the documentation about the individual BAdI-Methoden. Proceed as follows: 

1. Choose the tab page Interface. 

2. Double click on the appropriate method. 

3. Right click and select Component documentation  

37.3.3.20 Settings and Enhancements for External Procurement 

37.3.3.20.1 Outbound Processing of Sources of Supply 

37.3.3.20.1.1 Transfer Customer-Specific Source of Supply Data 

Use 



 

 

You can use enhancement CIFSRC01 to control which data for scheduling agreements, contracts, and 

purchasing info records is transferred to SAP APO. 

For more information, see the documentation for enhancement CIFSRC01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.20.1.2 Suppress Quota Arrangement Information 

Use 

You can use enhancement CIFPUR41 to prevent goods receipt data being transferred to SAP APO for 

quota arrangement updates. 

For more information, see the documentation for enhancement CIFPUR41. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 



 

WHATSAPP +255738656506 

 

37.3.3.20.2 Inbound Processing of Purchasing Data 37.3.3.20.2.1 

Activate/Deactivate Source of Supply Determination/Source 

List Integration 

Use 

In this IMG activity, you can make the following settings: 

- Deactivate source of supply determination 

Automatic source of supply determination is set by default and has the effect that a source of supply is 

automatically assigned during the transfer from SAP APO for purchase requisitions that do not already 

have a source of supply assigned. 

If you deactivate source of supply determination, the purchase requisition transferred from SAP APO 

does not contain a source of supply. You can then assign a source of supply manually in the ERP system. 

- Integrate source list 

For more information, see the F1 help for this field. 

37.3.3.20.2.2 Change and Enhance Purchase Order Data 

Use 

You can use enhancement CIFPUR02 to change purchase order data that was transferred by SAP APO 

before a purchase order or purchase requisition is created in the ERP system. 

For more information, see the documentation for enhancement CIFPUR02. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 



 

 

37.3.3.20.3 Outbound Processing of Purchasing Data 37.3.3.20.3.1 Suppress 

Rescheduling of Stock Transport Orders in Target 

System 

Use 

When you transfer stock transport orders to the target system, the target system reschedules them. This 

can lead to inconsistencies in the dates/times for stock transport orders in the source system and target 

system. 

In this IMG activity, you can define that the target system does not reschedule the stock transport orders 

transferred from the source system, but that it adopts the dates/times from the source system instead. In 

this way, you have consistent dates/times in the source system and in the target system. 

Requirements 

The stock transport orders are contained in an active integration model for purchase orders/purchase 

requisitions. 

Standard settings 

By default, the indicator is not set, in other words, the target system performs rescheduling after the stock 

transport order has been transferred from the source system. 

Activities 

Set the No Rescheduling indicator. 

37.3.3.20.3.2 Transfer Customer-Specific Purchasing Data 

Use 

You can use enhancement CIFPUR01 to transfer purchase requisitions, purchase orders, and 

confirmations to SAP APO or to change existing data. 

For more information, see the documentation for enhancement CIFPUR41. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 
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In contrast to modifications, system enhancements are generally not affected by a change in 

release. This is because they were not made in the original SAP namespace, but rather in a namespace 

that is reserved for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.3.3.21 Settings for MRP-Based Detailed Scheduling 

37.3.3.21.1 Activate MRP-Based Detailed Scheduling 

Use 

In this IMG activity, you activate the function MRP-based Detailed Scheduling. This means production 

planning is done in Enterprise Resource Planning (ERP) whereas the detailed scheduling is done in 

Advanced Planning and Optimization (APO). 

This is a part of the SCM-APO-INT-MDS component. 

Activities 

1. Select a row in the table MRP DS: Customizing to Activate MRP-based DS. 

2. Choose Details. 

The Change View "MRP DS: Customizing to Activate MRP-based DS" screen is displayed. 

3. You can now set any of the following indicators: 

- Transfer Collective Orders 

- Transfer Direct Procurement Orders 

- Transfer Planned Orders with Operations 

- Transfer Alternative Sequences as Modes 

- No Purchase Requisition Creation from APO 

See also 

For more information about MRP-based DS, see SAP Library under Documentation -> mySAP Business 

Suite -> SAP Supply Chain Management (SAP SCM) -> SAP Advanced Planning and Optimization -> 

Production Planning and Detailed Scheduling. 

37.3.3.21.2 Influence MRP-Based Detailed Scheduling 

Use 

This enhancement spot is used in the MRP-based detailed scheduling (SCM-APO-INT-MDS) 

component. It modifies the buffer time values in Enterprise Resource Planning (ERP). 

This enhancement spot uses the interface IF_EX_CIF_MRPDS. 



 

 

Requirements 

You have set the following indicators: 

- Transfer collective orders 

- Transfer planned orders with operations 

For more information, see the Implementation Guide (IMG) for MRP-based detailed scheduling under 

Integration with Other SAP Components -> Advanced Planning and Optimization -> Application-

Specific Settings and Enhancements -> Settings for MRP-Based Detailed Scheduling -> Activate MRP-

Based Detailed Scheduling. 

Standard settings 

The enhancement spot is: 

- Not active in the standard system 

- Intended for multiple use. The enhancement spot can be used more than once, so all active 

implementations are called and run. 

Activities 

To activate the enhancement spot, you must create an active implementation in Customizing. 

1. Create the enhancement. 

Either create a new project or use an existing project for the enhancement. 

2. Activate the project. 

You must activate the project in order for your enhancement to take effect. 

See also 

Method 

 Influence Buffer Time Calculation for Collective Orders 

(BUFFER_TIME_CHANGE) 

37.4 Integration with Governance, Risk and Compliance 

37.4.1 SAP Global Trade Services (Plug-In) 

37.4.1.1 Overview 

In this section, you can configure the system communication with an external SAP GTS system. Once 

the system is configured, the following features will be available: 

Compliance Management 

- Sanctioned-party list screening 

- Legal control - export 

- Legal control - import 

Customs Management 

- Transit procedure 

- Customs processing 
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- Printing of trade documents 

- Communication with customs authorities 

Risk Management 

- Preference processing 

- Letter of credit processing 

- Restitution 

37.4.1.2 Control Data for Transfer to SAP Global Trade Services 

37.4.1.2.1 Technical Activation of Document Transfer 

37.4.1.2.1.1 Activate Transfer of Purchasing Documents (MM0A) 

Use 

With the business add-in SLL_PI_MM0A_TRANSFER, the system can integrate the ordering process 

with SAP Global Trade Services. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_MM0A_TRANSFER of this BAdI. Otherwise, the application level MM0A cannot be 

integrated with SAP Global Trade Services. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 



 

 

37.4.1.2.1.2 Activate Transfer of Inbound Deliveries (MM0B) 

Use 

With the business add-in SLL_PI_MM0B_TRANSFER, the system can integrate the inbound delivery 

process with SAP Global Trade Services. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_MM0B_TRANSFER of this BAdI. Otherwise, the application level MM0B cannot be 

integrated with SAP Global Trade Services. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.2.1.3 Activate Transfer of Material Documents (MM0C) 

Use 

With the business add-in SLL_PI_MM0C_TRANSFER, the system can integrate goods movements with 

SAP Global Trade Services. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_MM0C_TRANSFER of this BAdI. Otherwise, you cannot integrate the application level 

MM0C with SAP Global Trade Services. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 



 

WHATSAPP +255738656506 

 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.2.1.4 Activate Transfer of Sales Documents (SD0A) 

Use 

With the business add-in SLL_PI_SD0A_TRANSFER, the system can integrate the sales process with 

SAP Global Trade Services. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_SD0A_TRANSFER of this BAdI. Othwise, you cannot integrate the application level 

SD0A with SAP Global Trade Services. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.2.1.5 Activate Transfer of Outbound Deliveries (SD0B) 

Use 

With the business add-in SLL_PI_SD0B_TRANSFER, the system can integrate the outbound delivery 

process with SAP Global Trade Services. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_SD0B_TRANSFER of this BAdI. Otherwise, the application level SD0B cannot be 

integrated with SAP Global Trade Services. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 



 

 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.2.1.6 Activate Transfer of Billing Documents (SD0C) 

Use 

With the business add-in SLL_PI_SD0C_TRANSFER, the system can integrate the billing process with 

SAP Global Trade Services. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_SD0C_TRANSFER of this BAdI. Otherwise, you cannot integrate the application level 

SD0C with SAP Global Trade Services. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.2.2 Configure Control Settings for Document Transfer 

Use 

In this Customizing activity, you make the settings for transferring documents to the SAP GTS system. 

37.4.1.2.3 Control Transfer of Bills of Material for Preference and Re-Export 
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Use 

In this Customizing activity, you make the settings to control the transfer of bills of material (BOMs) 

from your feeder system to SAP Global Trade Services  (SAP GTS). 

You need to transfer BOMs for Risk Management - Preference Processing. You transfer the BOMs 

using either the report program /SAPSLL/BOMMAT_DISTRIBUTE_R3 or transaction 

/SAPSLL/BOMMAT_DIRR3. Here you enter the products whose BOMs you wish to transfer to SAP 

GTS. Note that if you transfer the BOMs to SAP GTS in a batch report, you can see the results of the 

transfer in the job log. 

You must make settings for the transfer of BOMs at the following three levels: 

- Global 

- Country(ies) 

- Plant(s) 

In special one-off cases, you can trigger the transfer of BOMs manually in the Plug-In (transaction 

/SAPSLL/MENU_LEGALR3) in the Master Data tab page. 

Requirements 

- You have created BOMs in your feeder system. 

- You have defined RFC destinations for SAP GTS in your feeder system. 

- You have also defined the control parameters for transferring BOMs to SAP GTS in the relevant 

IMG activity in your feeder system. 

- You have also transferred all the materials to which the BOMs refer from your feeder system to 

SAP GTS. 

Activities 

You must always begin by setting the control parameters first at global level, as the settings on the other 

levels in the hierarchy are based on these global settings. The system uses the data you select at global 

level to propose the data at country and/or plant level. 

1. Global-Level Transfer 

a) BOM Usage 

Here you set the global selection parameters to transfer the BOMs you require in SAP GTS. 

First, select the BOM category. The category determines whether the BOM is static or 

configurable. Next, select the BOM application; for example, production or sales. As on 

option, you can specify whether the preference model applies to all plants or one specific 

plant. 

b) Alternative 

Here you can enter the name of any alternative BOMs you want to transfer. 

c) Excluded Material Types 

Here you can select the type of materials from your feeder system that you want to exclude 

from the transfer, for example, packaging materials. 

The following hierarchical settings are similar, although the data is proposed by the system. 

You can still make changes to the proposed data. Whichever data selections you make at 

country level override those you made at global level. 

2. Country-Level Transfer (see explanation for global settings) 



 

 

a) BOM Usage 

b) BOM Alternative 

c) Excluded Material Types 

The following hierarchical settings are similar, although the data is proposed by the system. 

You can still make changes to the proposed data. Whichever data selections you make at plant 

level override those you made at global and at country level. 

3. Plant-Level Transfer (see explanation for global settings) 

a) BOM Usage 

b) BOM Alternative 

c) Excluded Material Types 

37.4.1.3 Temporary Storage: Choose Method of Temporary Storage 

Use 

In this IMG activity, you select the type of temporary storage you want to use for the products you 

import or export. 

Requirements 

You have: 

- Defined work areas 

- Defined shipping/receiving points 

- Defined preliminary document types 

Standard settings 

The methods of temporary storage are delivered as part of the standard Customizing settings. 

Activities 

1. Select the country to define the work area. 

2. If you want to add more countries to the area, choose Further select. cond. 

3. Enter the following data using the input help: 

a) Shipping point/receiving point 

For more information, see the field help. 

b) Type of preliminary document (for example, international bill of lading or T1 transit 

document) 

For more information, see the field help. 

c) Select the method of temporary storage from the dropdown list: 
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No Temporary Storage 

The products delivered are not kept in temporary storage but are available immediately for 

further processing. 

Temporary Storage Status on Inbound Delivery 

The goods are placed into temporary storage before placement into another customs status or 

another logistics procedure. The inbound delivery cannot be processed until the temporary 

storage period in SAP GTS is finished. 

Holding Location Using Customer-Specific BAdI Implementation 

This allows you to define the temporary storage and goods processing according to your 

business requirements. For more information, see the BAdI documentation. 

For more information on the data you are required to enter, see the field help and the Business Scenario 

Configuration Guides for SAP GTS in SAP Service Marketplace at www.service.sap.com/instguides. 

37.4.1.4 Customs: Activate Safekeeping with Delivery Status 

Use 

With the business add-in SLL_PI_TEMP_STORAGE, the system can specifically integrate the delivery 

process with SAP Global Trade Services to process the temporary storage procedure if this takes place 

using the method for the storage status in the delivery. 

If you are using SAP Global Trade Services, you should activate the standard implementation 

/SAPSLL/PI_TEMP_STORAGE of this BAdI. 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.5 Define Preliminary Document Types 



 

 

In this IMG activity, you can define preliminary document types. 

Notes 

The "classification of foreign trade documents" field represents the link to print control if a document is 

printed and updated. 

Use 

The preliminary document type uniquely identifies the document that is assigned to the relevant 

transaction. The SAP system differentiates between export declarations, T documents (export) and 

preliminary documents (import). 

Example 

An example for a preliminary document for import is the T1 shipping document. 

Standard settings 

In the standard system, this table is empty. 

Activities 

Enter the key and a description for a preliminary document type. 

Further notes 

Later, during purchase order processing, you can assign the preliminary documents that you have defined 

to the purchase order, either at header or item level. Further specifications for the preliminary document 

include country, authority, and date of issue. 

37.4.1.6 Temporary Storage: Choose Method of Temporary Storage 

Use 

In this IMG activity, you select the type of temporary storage you want to use for the products you 

import or export. 

Requirements 

You have: 

- Defined work areas 

- Defined shipping/receiving points 

- Defined preliminary document types 

Standard settings 

The methods of temporary storage are delivered as part of the standard Customizing settings. 

Activities 
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1. Select the country to define the work area. 

2. If you want to add more countries to the area, choose Further select. cond. 

3. Enter the following data using the input help: 

a) Shipping point/receiving point 

For more information, see the field help. 

b) Type of preliminary document (for example, international bill of lading or T1 transit 

document) 

For more information, see the field help. 

c) Select the method of temporary storage from the dropdown list: 

No Temporary Storage 

The products delivered are not kept in temporary storage but are available immediately for 

further processing. 

Temporary Storage Status on Inbound Delivery 

The goods are placed into temporary storage before placement into another customs status or 

another logistics procedure. The inbound delivery cannot be processed until the temporary 

storage period in SAP GTS is finished. 

Holding Location Using Customer-Specific BAdI Implementation 

This allows you to define the temporary storage and goods processing according to your 

business requirements. For more information, see the BAdI documentation. 

For more information on the data you are required to enter, see the field help and the Business Scenario 

Configuration Guides for SAP GTS in SAP Service Marketplace at www.service.sap.com/instguides. 

37.4.1.7 Activate Dialog for Reference Number for Scrapping in Customs 

Warehouse 

Use 

With the business add-in MB_MIGO_BADI, the system can integrate with SAP Global Trade Services, 

the goods movements that are processed in the MIGO transaction. 

If you are using SAP Global Trade Services, you must activate the standard implementation 

/SAPSLL/PI_MB_MIGO_BADI of this BAdI. In particular, goods in a bonded warehouse cannot be 

scrapped unless the implementation has been activated. 

Requirements 

You can only activate this implementation if you are using SAP Global Trade Services. 

Standard settings 

The standard implementation of this Business Add-In is not active. 



 

 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the BAdI for 

transfer. If you have activated the implementation before, the system asks you in a dialog if you want to 

cancel the activation. 

37.4.1.8 Activate Additional Check for Customs Warehouse-Relevant Goods 

Movements 

Use 

With the business add-in MB_MIGO_ITEM_BADI , the system can integrate with SAP Global Trade 

Services, the goods movements that are processed in the MIGO transaction. 

If you are using SAP Global Trade Services, you must activate the standard implementation 

/SAPSLL/PI_MB_MIGO_BADI of this BAdI. This ensures that additional checks are performed when 

goods movements are being processed with the MIGO transaction. These checks ensure the integrity of 

data for bonded warehousing in SAP Global Trade Services. 

Requirements 

You can only activate this implementation if you are using SAP Global Trade Services. 

Standard settings 

The standard implementation of this Business Add-In is not active. 

Activities 

To activate the standard implementation of this BAdI, perform this IMG activity. 

Note: In a dialog, the system asks you whether you want to activate the implementation of the 

BAdI for transfer. If you have activated the implementation before, the system asks you in a 

dialog if you want to cancel the activation. 

37.4.1.9 Activate Additional Check for Goods Issues for Transfers in Customs 

Wareh. 

Use 

You can use this Business Add-In (BAdI) to activate a check for goods receipt posting, which checks for 

the following requirements in the event of a stock transfer from one customs warehouse to another: 
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- If the plant - storage location combination of the delivery item is assigned to a customs warehouse, 

a storage location must be specified for customs warehouse materials in the stock transfer order. If 

no storage location is specified, the system stops the goods issue posting. 

- The customs warehouse in the stock transfer order must be the same as that specified in the goods 

issue, in other words, they must have the same customs ID. 

If you use SAP Global Trade Services, you should activate the standard implementation of this BAdI. 

Standard settings 

You can only use this BAdI if you run SAP Global Trade Services. 

Activities 

To activate the standard implementation of this BAdI, execute this IMG activity and confirm the system 

message. 

Note: The system queries in a dialog whether you want to activate the BAdI implementation. If you have 

already activated the BAdI implementation, the system queries whether you want to undo the activation. 

37.4.1.10 Activate Hold of GI Posting If Export License Missing 

Use 

Activate this Business Add-In (BAdI) to stop goods issue postings for consignees in third countries in 

SAP S/4HANA until the goods in question have been released by the customs authorities. Although you 

have already sent a customs export declaration to the customs authorities with SAP Customs 

Management, the goods from the customs export declaration cannot leave the shipping area until the 

customs authorities send an export permission - in the form of a release message - as an answer to the 

customs declaration to SAP Customs Management. 

When you activate this BAdI implementation, you set a general temporary block for goods issue postings 

after outbound deliveries. To control this block for individual documents, you can set the corresponding 

flags in the control settings for document transfer. For more detailed control of the processes between the 

release message from the customs authorities (as the export permission) and the temporary hold of the 

goods issue posting, you can use the BAdI to Control Interface Calls from Outbound Deliveries. In this 

BAdI, you can make the hold of the goods issue posting dependent on the organizational unit, for 

example. 

Requirements 

You must use SAP Global Trade Services to activate this implementation. 

Standard settings 

The standard implementation of this Business Add-In is not active. 

Activities 

To activate the standard implementation of the BAdI, carry out this IMG activity. 



 

 

Note: The system displays a dialog asking you whether you want to activate the implementation of the 

BAdI to hold goods issue postings. If you have already activated the implementation in the past, the 

system asks you if you want to cancel the activation. 

37.4.1.11 Activate Hold of GR Posting from Inb. Delivery if No Unloading 

Permission 

Use 

Activate this Business Add-In (BAdI) if you want to hold goods receipt postings from inbound 

deliveries in SAP S/4HANA from third countries in the transit procedure until you receive an official 

release for these goods in the form of the unloading permission. Until they send you the unloading 

permission, the customs authorities reserve the right to inspect the goods on site, to check teh goods that 

were transported duty-unpaid in the transit procedure. At the time of this inspection, the goods must be 

located on the means of transport used to convey them within the customs area. Accordingly, a goods 

receipt or further use of the delivered goods are prohibited until you receive the unloading permission. 

When you activate this BAdI implementation, you activate a general temporary block for goods issue 

postings from inbound deliveries. To control this block for the individual document types, you can set 

the appropriate flags in the control settings for document transfer.For detailed control of the processes 

between unloading permission from the customs authorities and the temporary hold of the goods issue 

posting, you can use the BAdI for the control settings for document transfer. You can make the hold of 

the goods receipt posting dependent on the organizational unit, for example. 

Requirements 

You have to use SAP Global Trade Services to activate this implementation. 

Standard settings 

The standard implementation of this Business Add-In is not active. 

Activities 

To activate the standard implementation of the BAdI, carry out this IMG activity. 

Note: The system displays a dialog asking you whether you want to activate the implementation of the 

BAdI to hold goods receipt postings. If you have already activated the implementation in the past, the 

system asks you if you want to cancel the activation. 

37.4.1.12 Activate Summarization of Goods Issues for Customs Warehouse 

Processing 

Use 

With the business add-in /SAPSLL/MM0C_COLL_R3 you can activate the collecting of goods 

movements for transfer to SAP Global Trade Services. 

When goods movements are collected, the system does not compile a communication with the relevant 

system for SAP Global Trade Services in every goods movement posting. The collected goods 

movements can then be transferred in the background with report /SAPSLL/CUWL_TRANSFER_R3. 



 

WHATSAPP +255738656506 

 

Requirements 

You can only use this BAdI if you have implemented SAP Global Trade Services. 

Standard settings 

This business add-in is an internal SAP BAdI and is not active. 

Activities 

To activate the standard implementation of this BAdI, you perform this IMG activity. 

37.4.1.13 Retail: Retransfer Calculation Results from SAP GTS 

Use 

Customs: Retail: Retransfer calculation results from SAP GTS 

Requirements 

You have to use SAP Global Trade Services in order to activate this implementation. 

Standard settings 

The standard implementation of this Business Add-In is not active. 

Activities 

To activate the standard implementation of this BAdI, carry out this IMG activity and confirm the system 

message. 

Note: The system displays a dialog in which you can activate the BAdI implementation. If you have 

already activated the implementation at an earlier time, the system dialog asks if you want to cancel the 

activation. 

37.4.1.14 Retail: Delete Buffer for Retransfer of Calculation Results 

Use 

Customs: Retail: Delete buffer for the retransfer of calculation results 

Requirements 

You have to use SAP Global Trade Services in order to activate this implementation. 

Standard settings 

The standard implementation of this Business Add-In is not active. 



 

 

Activities 

To activate the standard implementation of this BAdI, carry out this IMG activity. 

Note: The system displays a dialog in which you can activate the BAdI implementation to prevent the 

goods issue posting. If you have already activated the implementation at an earlier time, the system 

dialog asks if you want to cancel the activation. 

37.4.1.15 Customs Procedures with Economic Impact - Define Customs ID 

Use 

In this Customizing activity, you define the customs IDs you want to use for customs procedures with 

economic impact. 

A customs ID indicates those products that you consider relevant for a customs procedure with economic 

impact in SAP Global Trade Services. The customs ID also identifies an area or division of your 

company. 

Customs IDs can represent different spatial areas at your company for different customs procedures with 

economic impact, depending on the authorizations you have been granted by the customs authorities. 

Activities 

Define the necessary customs IDs. 

In another step, you assign the customs IDs for the customs procedures with economic impact 

accordingly in one or both of the following IMG activities: 

- Customs Procedures with Economic Impact - Assign Customs ID 

- Customs Procedures with Economic Impact (OP) - Assign Customs ID 

37.4.1.16 Customs Procedures with Economic Impact - Assign Customs ID 

Use 

In this Customizing activity, you assign a customs ID to the areas  or divisions of your company. This 

establishes the link between the organizational unit in your feeder system and its signficance for a 

customs procedure with economic impact. The following customs procedures are available: 

- Customs Warehousing 

- Inward Processing 

- Processing Trade 

- Foreign-Trade Zone 
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Requirements 

You have defined the necessary customs IDs. 

Activities 

Define the combination of plant and storage location for which the customs procedure is approved in the 

authorization. 

Assign the customs ID. 

37.4.1.17 Customs Procedures with Economic Impact (OP) - Assign Customs 

ID 

Use 

In this Customizing activity, you assign to a customs ID the area or division in your company that is 

authorized for outward processing. This establishes the link between the organizational unit in your 

feeder system and its significance for outward processing. 

Requirements 

You have defined the necessary  customs IDs. 

Activities 

Determine the plant for which outward processing is approved in the authorization. 

Assign the customs ID. 

37.4.1.18 Calculate Statistical Values 

Use 

Statistical values are needed for Intrastat declarations and for data transmission to the SAP GTS system. 

The condition type GRWR has been configured for this purpose in the standard system. It calculates the 

statistical value and places it in the field KOMP-GKWRT. The statistical value is determined in pricing 

and is stored in the respective billing or purchasing documents. 

SAP GTS then takes the data and transfers it to the Intrastat declaration or to customs processing. 

General import and export processing. 

Condition type GRWR has the following controls in pricing for MM Purchasing and SD Sales. 

To define condition type GRWR, start Customizing and choose Sales and Distribution -> Basic 

Functions -> Pricing -> Pricing Control. 

1. Control in condition type GRWR for MM-Purchasing and SD-Sales: 

a) Price condition 



 

 

b) Percent calculation 

2. MM import control in pricing procedure RM0000: 

a) Requirement 8 (only in the case of export) 

b) Statistical condition 

c) Subtotal C (place value in item field KOMP-GKWRT) 

3. Control using access sequence GRWR 

4. Access with the Incoterms field to condition records that you created 

Note 

For stock transfer orders, a new condition table has been added for the access sequence GRWR. It 

allows you to maintain GRWR condition records with the key combination of supplying plant and 

destination country. 

5. SD export control in pricing procedure RVAA01: 

a) Base formula 2 (reference to net value) 

b) Requirement 8 (exports only) 

c) Statistical condition 

d) Subtotal C (place value in item field KOMP-GKWRT) 

6. Control using access sequence K033 

7. Access with the Incoterms field to the condition records created. 

Note 

For additional information on making settings in pricing, see the pricing section in Basic 

Functions. 

37.4.1.19 Business Add-Ins for Global Trade Services 

37.4.1.19.1 BAdI: Change RFC Destination for Calling SAP GTS 

Use 

SAP Global Trade Services (SAP GTS) is supplied with logistics data such as sales, delivery and 

purchasing document data, from feeder systems. The feeder systems may be SAP systems or third-party 

systems. Remote Function Calls (RFCs) are required to facilitate the communication between separate 

systems. You have to define RFC destinations in the Plug-In (transaction 

/SAPSLL/MENU_LEGALR3) and you dalso efine here which document data you want to have 

replicated in SAP GTS. 
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This Business Add-In (BAdI) enables you to override the standard settings you made for transferring 

document data in the plug-in for the following feeder system documents: 

- Sales orders 

- Outbound deliveries 

- Billing documents 

- Purchase orders 

- Inbound deliveries 

- Inbound deliveries (temporary storage) 

- Goods movements 

Requirements 

You have installed and configured SAP GTS in accordance with the sections on System 

Communication and Data Replication in the Business Scenario Configuration Guide in SAP Service 

Marketplace at http://service.sap.com/instguides -> SAP Components -> SAP Global Trade 

Services -> Using SAP GTS 7.0. 

Activities 

The BAdI consists of the following methods: 

- CHANGE_RFC_DEST_SD0A 

This method allows you to overwrite the standard logic for RFC destinations for sales orders. You 

can use the following parameters to do this: 

Importing: 

- IS_HEADER 

Sales order: header data 

- IT_PARTNER 

Table for structure VBPAVB 

- IT_BUSINESS_DATA 

Table for structure VBKDVB 

- IT_ITEM 

Table for structure VBAPVB 

Changing: 

- CV_RFC_DEST 

Logical destination (provided in function call) 

- CHANGE_RFC_DEST_SD0B 

This method allows you to overwrite the standard logic for RFC destinations for outbound 

deliveries. You can use the following parameters to do this: 

Importing: 

- IS_HEADER 

S&D inbound delivery document: header data 

- IT_PARTNER 

Table type for partner (structureVBPAVB, standard key) 

- IT_ITEM 

Inbound deliver item (upward compatibility) 

Changing: 



 

 

- CV_RFC_DEST 

Logical destination (provided in function call) 

- CHANGE_RFC_DEST_SD0C 

This method allows you to overwrite the standard logic for RFC destinations for billing documents. 

You can use the following parameters to do this: 

Importing: 

- IS_HEADER 

Billing document: header data 

- IT_PARTNER 

Table for structure VBPAVB 

- IT_ITEM 

Billing document: item data 

Changing: 

- CV_RFC_DEST 

Logical destination (provided in function call) 

- CHANGE_RFC_DEST_MM0A 

This method allows you to overwrite the standard logic for RFC destinations for purchase orders. 

You can use the following parameters to do this: 

Importing: 

- IS_HEADER 

Purchasing document: header data 

- IT_ITEM 

Table type BEKPO 

Changing: 

- CV_RFC_DEST 

Logical destination (provided in function call) 

- CHANGE_RFC_DEST _MM0B 

This method allows you to overwrite the standard logic for RFC destinations for inbound deliveries. 

You can use the following parameters to do this: 

Importing: 

- IS_HEADER 

S&D document: Outbound delivery: header data 

- IT_ITEM 

Outbound delivery item (upward compatability) 

Changing: 

- CV_RFC_DEST 

Logical destination (provided in function call) 
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CHANGE_RFC_DEST_MM0B_SK 

This method allows you to overwrite the standard logic for RFC destinations for inbound deliveries 

(temporary storage). You can use the following parameters to do this: 

Importing: 

- IS_HEADER 

S&D document: Inbound delivery: header data 

- IT_LIPS 

Inbound delivery item (upward compatability) 

- IT_MSEG 

Inbound delivery interface structure for material document 

Changing: 

- CV_RFC_DEST 

Logical destination (provided in function call) 

- CHANGE_RFC_DEST_MM0C 

This method allows you to overwrite the standard logic for RFC destinations for goods movements. 

You can use the following parameters to do this: 

Importing: 

- IT_XMKPF- IT_XMSEG 

- IT_XVM07M 

Changing: 

- CV_RFC_DEST 

Logical destination (provided in function call) 

37.4.1.19.2 BAdI: Transfer of MM and SD Documents to Check for Archivability 

Use 

With SAP Global Trade Services (SAP GTS), you can archive the following objects by choosing from the 

SAP GTS Area Menu GTS: Basis -> Archiving: 

- Customs documents 

- Sanctioned party list data 

- Application logs 

- Business partners 

- Preference determination data 

For more information on the objects you can archive, see the input help. 

However, this Business Add-In (BAdI) allows you to control the customs documents that you archive. 



______________________________________________________________

SAP System 

- 

______________________________________________________________ 

SAP AG 145 

Activities 

This BAdI consists of the following methods: 

- SALES_ORDER_CHECK 

With this method you can control the logic of the check the system performs on sales order 

documents that you select for archiving. The following parameters are available for this: 

Importing: 

- IT_VBAK 

Table type for structure VBAK 

- IT_VBAP 

Table type for structure VBAP 

- IT_VBUK 

S&D document: Header status and administrative data 

- IT_LIKP 

Table type S&D document: Delivery: header data 

- IT_LIPS 

Table type S&D document: Delivery: item data 

- IV_VBELN 

S&D document number 

Changing: 

- CV_FLDRA 

Document cannot be archived 

OUTBOUND_DELIVERY_CHECK 

With this method you can control the logic of the check the system performs on outbound delivery 

documents that you select for archiving. The following parameters are available for this: 

Importing: 

- IT_LIKP 

Table type S&D document: Delivery: header data 

- IT_VBUK 

S&D document: Header status and administrative data 

- IV_VBELN 

S&D document number 

Changing: 

- CV_FLDRA 

Document cannot be archived 

- PURCHASE_ORDER_CHECK 

With this method you can control the logic of the check the system performs on purchase order 

documents that you select for archiving. The following parameters are available for this: 

Importing: 
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- IT_EKKO 

Table type for purchasing document headers 

- IT_EKPO 

Table type for purchasing document items 

- IV_EBELN 

Document number of purchasing document 

Changing: 

- CV_FLDRA 

Document cannot be archived 

37.4.1.19.3 BAdI: Preference: Configurable Materials 

Use 

With the business add-in /SAPSLL/KMAT in KMAT processing for GTS, you can perform your own 

checks and influence other processing steps. 

Standard settings 

The business add-in is not active in the standard system. 

Further notes 

Documentation for the BAdi interface /SAPSLL/IF_EX_KMAT 

37.4.1.19.4 BAdI: Customs - Safekeeping via Storage Location 

Use 

With SAP Global Trade Services (SAP GTS) you can map your customs procedures seamlessly with your 

logistics processes. You can map the customs procedure, bonded warehousing, using SAP GTS by 

transferring storage locations to SAP GTS, where they are known as temporary storage locations for the 

purposes of bonded warehousing. These temporary storage locations are used to prevent you having to 

pay import or export duties on products that you are perhaps re-exporting in a short period of time or for 

which duties have already been paid. 

This Business Add-In (BAdI) enables you to overwrite the system logic for the purposes of bonded 

warehousing with SAP GTS. 

Requirements 
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You have installed and configured SAP GTS in accordance with the sections on System Communication 

and Data Replication in the Business Scenario Configuration Guide for SAP GTS in SAP Service 

Marketplace at http://service.sap.com/instguides -> SAP Components -> SAP Global Trade 

Services -> Using SAP GTS 7.0. 

Activities 

This BAdI consists of the following method: 

- CHANGE_STOR_LOC_GTS 

With this method you can change the logic with which the system checks and changes the storage 

locations that are transferred to SAP GTS and back to the SAP system again. The method contains 

the following parameters: 

Importing: 

- MKPF 

Material document header 

- MSEG 

Document segment material 

- DM07M 

Fields for dialog controls: module poolS APMM07M 

- VM07M 

Fields for posting controls: module pool SAPMM07M 

- Exporting: - LGORT 

Storage location 

37.4.1.19.5 BAdI: Customs - Determine SAP GTS Relevance for Stock 

Separation 

Use 

Business Add-In /SAPSLL/CUS_PRO_DET enables the system to integrate the receiving process and 

billing document generation with bonded warehouse processing in SAP Global Trade Services when 

stock is separated by its customs status. If you use processes with this type of stock separation, you have 

to implement this BAdI to enable the system to determine whether goods movements are relevant for 

GTS inventory management. 

Requirements 

To use this BAdI, you have to have SAP Global Trade Services (Release 7.0 or later). The BAdI is only 

called when stock separation by customs status is active in GTS for the item currently being processes. 

Standard settings 
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This Business Add-In is not active in the standard system. 

This Business Add-In does not support multiple use. This 

Business Add-In is not filter-dependent. 

Further notes 

Documentation of the BAdI interface: /SAPSLL/IF_EX_CUS_PRO_DET 

37.4.1.19.6 BAdI: Customs - Check Document Reference for Customs 

Management 

Use 

This Business Add-In (BAdI) for flagging document items in goods receipts that you create from inbound 

deliveries is used in the Customs Management area of the system for Global Trade Services (GTS). 

This BAdI lets you define in the feeder system when you consider document items from goods receipts 

with reference to inbound deliveries to be complete, and release the corresponding goods receipt for 

inclusion in the customs declaration. As a result, for example, you can define a time interval after which 

the system automatically assumes delivery items are complete. 

In the standard system, when a goods receipt is posted, the system transfers all items to the GTS system 

as complete, where they can be included directly in a customs declaration. If you make subsequent 

changes to the inbound delivery, you have to make the subsequent corrections manually, because the 

existing goods receipt items are already in a customs declaration. If you created a customs shipment 

based on the inbound delivery, the system updates this customs shipment automatically. 

As an alternative, however, you can define goods receipt items with reference to inbound deliveries in 

Customizing of the GTS system that they remain incomplete until one of the following two situations 

occurs: 

- The feeder system transfers the completeness indicator for items in the goods receipt, which you 

determing using this BAdI. This procedure is possible in addition to the settings in Customizing for 

the GTS system. As a result, you can use information from the feeder system to help you determine 

completeness, for example. 

- You have defined a time interval in Customizing for the GTS system after which the GTS system 

flags the items of the goods receipts with inbound delivery reference as complete, independently of 

any information received from the feeder system. You can define this interval in the definition of the 

communication process at the level of the process template for customs import processing. 

Standard settings 

- There is no BAdI implementation in the standard system. 

- The BAdI supports multiple use. All active implementations are called and executed. 
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- The BAdI is filter-independent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

See also: 

The BAdI uses interface /SAPSLL/IF_EX_CUS_REF_CHK. For more information, display the interface 

in the Class Builder. 

37.4.1.19.7 BAdI: Customs - Additional Stock ID for Stock Separation for CWH 

and OP 

Use 

This Business Add-In (BAdI) for determining the additional stock identification is relevant for the 

Customs Management area of SAP Global Trade Services (SAP GTS). 

This BAdI lets you make available the additional identifiers for products in inventory management for the 

customs warehouse or inward processing that you can use to split stocks in the feeder system, for 

example the country of origin by batch formation. This means you can use the batch identification as an 

additional stock identification. You can transfer these additional stock identifers to SAP GTS in this 

BAdI, and the system saves them in the product master. If you use inventory management for inward 

processing in SAP Global Trade Services, the system uses the additional stock separation ID that you 

already defined for the customs warehouse. Identification verification is relevant for all feeder system 

activities that affect customs 
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processing for special customs procedures. These include 

- Inbound deliveries and material documents 

- Sales documents used to create customs declarations that change the customs warehouse stock 

- Initial transfer of duty-paid stock to SAP GTS when postings that cause changes in stocks are made 

in the customs warehouse 

Requirements 

The system only calls the BAdI if the following conditions apply: 

- You have flagged a product as relevant for processing of a special customs procedure in the product 

master in SAP GTS 

- You have set a flag in a product master in SAP GTS that requires inventory management to use an 

additional stock identifier 

********************************************************************* 

Standard settings 

There is no active BAdI implementation in the standard system. 

The BAdI does not support multiple use. 

The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See Also 

The BAdI uses interface /SAPSLL/IF_EX_CUS_IMID_DET. To see more information, display the 

interface in the Class Builder. 

Example 

********************************************************************* 

37.4.1.19.8 BAdI: Intrastat - Maintain Data from Extractors for Intrastat 

Declaration 

Use 

This Business Add-In (BAdI) influences the document selection and document data for transfer from the 

feeder system and is relevant for SAP Electronic Compliance Reporting (SAP ECR). 
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The BAdI lets you exclude logistics documents that would normally be selected from SAP S/4HANA 

from the transfer to SAP ECR, to ensure that only the relevant logistics documents are included in 

Intrastat declarations for dispatches and receipts in SAP ECR. You can also modify the data records for 

your logistics documents to meet your specific needs. 

Requirements 

You have configured the transfer of logistics documents to SAP ECR. The functions for configuring the 

document transfer are located under transaction code 

/SAPSLL/MENU_LEGALR3, Documents-> SAP Electronic Compliance Reporting. 

Standard settings 

- No BAdI implementation is active in the standard system. 

- The BAdI does not support multiple use. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See Also 

The BAdI uses interface /SAPSLL/IF_EX_ECR_EXTRACT. To see more information, display the 

interface in the Class Builder. 

37.4.1.19.9 BAdI: Letter of Credit - Find Letters of Credit in Sales Documents 

Use 

This Business Add-In (BAdI) for determining the necessary letter of credit in sales documents in the 

feeder system is relevant for the SAP Risk Management - Letter of Credit Processing area of SAP Global 

Trade Services (SAP GTS). 

YOu can configure the connection between the logistics processes in the feeder system and SAP GTS 

such that a direct connection exists between the two systems, to integrate letter of credit processing in 

SAP GTS with the sales documents in the feeder system. This integration gives you the following options 

based on the sales document data: 

- You can select the relevant letters of credit from the input help in sales documents and add them to 

the document. 

- When you enter a letter of credit directly in a sales document, the system checks that the letter of 

credit is valid for the document data. 
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This BAdI lets you influence the criteria that the system uses to determine the letters of credit that you 

can select in the input help in sales documents, as well as those used for the letter of credit check. Under 

the default settings, the letters of credit are determined based on the last confirmed delivery date, to 

calculate the validity period of a letter of credit. This BAdI lets you use other date information from 

documents or future dates as the foundation for determining letters of credit and their validity. 

Requirements 

- You have configured system communication correctly. 

- You have configured the sales documents for letter of credit processing in SAP GTS. 

Standard settings 

- This BAdI is not implemented in the standard system. 

- The BAdI is intended for one-time use. The activated implementation is called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

This BAdI uses the interface /SAPSLL/IF_EX_PI_SD0A_LOC. If you would like more information, 

display the interface in the Class Builder. 

37.4.1.19.10 Edit Control of Document Transfer 37.4.1.19.10.1 BAdI: Control 

Interface Calls from Purchasing Documents 

(MM0A) 

Use 

The Business Add-In (BAdI) that controls the transfer of purchasing documents is used in the 

Compliance Management area of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to specify settings for the transfer of purchasing documents that lead to the 

structures of the standard interface between enterprise resource planning as feeder system and SAP GTS 

being filled. In this way, you can adapt document transfer for purchasing documents to meet your 

requirements and restrict the data volume to the minimum required. 
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If you use the Preference Processing service of SAP Risk Management in SAP GTS, you must be aware 

that restricting document transfer impacts the setup of the worklist of long-term supplier declarations on 

the supplier side. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for transfer of purchasing document. 

Standard settings 

- In the standard SAP system, the BAdI implementation is not active. 

- The BAdI is intended for using multiple times. All activated implementations are called and 

executed 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also: 

The BAdI uses the interface /SAPSLL/IF_EX_CTRL_MM0A_R3. For more information, display the 

interface in the Class Builder. 

Note 

The BAdIs to control the transfer of documents comprise the functional scope of function module 

EXIT_SAPLSLL_LEG_CDPIR3_001 from user exit enhancement project SLLLEG01 ab. Because the 

BAdIs will replace the user exits, we recommend converting to the BAdI technology in the medium term. 

37.4.1.19.10.2 BAdI: Control Interface Calls from Inbound Deliveries (MM0B) 

Use 

The Business Add-In (BAdI) that controls the transfer of inbound deliveries is used in the areas Customs 

Management and Compliance Management of SAP Global Trade Services (SAP GTS). 

With the BAdI you can specify settings for the transfer of inbound deliveries that lead to the structures of 

the standard interface between enterprise resource planning as the feeder system and SAP GTS being 

filled. In this way, you can adapt document transfer for inbound deliveries to meet your requirements and 

restrict the data to the minimum required. 

Requirements 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 155 

- You have set up system communication correctly. 

- You have set up the technical activation for transfer of inbound deliveries. 

Standard settings 

- In the standard SAP system, the BAdI implementation is not active. 

- The BAdI is intended for multiple use. All activated implementations are called and executed. 

- The BAdI is filter-independent. 

Activities 

********************************************************************* 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also: 

The BAdI uses the interface /SAPSLL/IF_EX_CTRL_MM0B_R3. For more information, display the 

interface in the Class Builder. 

Note 

********************************************************************* 

The BAdIs to control the transfer of documents comprise the functional scope of function module 

EXIT_SAPLSLL_LEG_CDPIR3_001 from user exit enhancement project SLLLEG01 ab. Because the 

BAdIs will replace the user exits, we recommend converting to the BAdI technology in the medium term. 

37.4.1.19.10.3 BAdI: Control Interface Calls from Material Documents (MM0C) 

Use 

The Business Add-In (BAdI) for controlling the transfer of material documents is used in the areas SAP 

Customs Management and SAP Compliance Management of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to specify settings for the transfer of material documents for goods movement. 

These settings lead to the structures of the standard interface between enterprise resource planning as 

feeder system and SAP GTS being filled. In this way, you can adapt document transfer for material 

documents to suit your requirements and reduce data volume to a minimum. 

If you use the Preference Processing service of SAP Risk Management in SAP GTS, you should be 

aware that restricting document transfer impacts the setup of the worklist for long-term supplier 

declarations on the supplier side. 

Requirements 

- You have set up system communication correctly. 
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- You have set up the technical activation for transfer of purchasing documents. 

Standard settings 

- In the standard system, there is no active BAdI implementation. 

- The BAdI is intended for use multiple times. All active implementations will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_CTRL_MM0C_R3. For more information, display the 

interface in the Class Builder. 

Note 

The BAdIs to control the transfer of documents comprise the functional scope of function module 

EXIT_SAPLSLL_LEG_CDPIR3_001 from user exit enhancement project SLLLEG01 ab. Because the 

BAdIs will replace the user exits, we recommend converting to the BAdI technology in the medium term. 

37.4.1.19.10.4 BAdI: Control Interface Calls from Sales Documents (SD0A) 

Use 

The Business Add-In (BAdI) for controlling the transfer of orders is used in the SAP Compliance 

Management area of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to specify settings for the transfer of orders. These settings lead to the structures of 

the standard interface between enterprise resource planning as feeder system and SAP GTS being filled. 

In this way, you can adapt document transfer for orders to suit your requirements and reduce data volume 

to a minimum. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of orders. 
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Standard settings 

- In the standard system, there is no active BAdI implementation. - The BAdI is intended for use 

multiple times. All active implementations - will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_CTRL_SD0A_R3. For more information, display the 

interface in the Class Builder. 

Note 

The BAdIs to control the transfer of documents comprise the functional scope of function module 

EXIT_SAPLSLL_LEG_CDPIR3_001 from user exit enhancement project SLLLEG01 ab. Because the 

BAdIs will replace the user exits, we recommend converting to the BAdI technology in the medium term. 

37.4.1.19.10.5 BAdI: Control Interface Calls from Outbound Deliveries (SD0B) 

Use 

The Business Add-In (BAdI) for controlling the transfer of deliveries is used in the SAP Compliance 

Management area of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to specify settings for the transfer of deliveries. These settings lead to the 

structures of the standard interface between enterprise resource planning as feeder system and SAP GTS 

being filled. In this way, you can adapt document transfer for deliveries to suit your requirements and 

reduce data volume to a minimum. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of deliveries. 

Standard settings 
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- In the standard system, there is no active BAdI implementation. - The BAdI is intended for use 

multiple times. All active implementations - will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_CTRL_SD0B_R3. For more information, display 

the interface in the Class Builder. 

Note 

The BAdIs to control the transfer of documents comprise the functional scope of function module 

EXIT_SAPLSLL_LEG_CDPIR3_001 from user exit enhancement project SLLLEG01 ab. Because the 

BAdIs will replace the user exits, we recommend converting to the BAdI technology in the medium term. 

37.4.1.19.10.6 BAdI: Control Interface Calls from Billing Documents (SD0C) 

Use 

The Business Add-In (BAdI) for controlling the transfer of billing documents is used in the areas SAP 

Customs Management and SAP Compliance Management of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to specify settings for the transfer of billing documents. These settings lead to the 

structures of the standard interface between enterprise resource planning as feeder system and SAP GTS 

being filled. In this way, you can adapt document transfer for billing documents to suit your requirements 

and reduce data volume to a minimum. 

Bear in mind that SAP GTS uses the billing document as the basic document for various services SAP 

GTS and that your filter settings affect all activated services in SAP GTS. For example, customs 

processing in SAP Customs Management or preference processing in SAP Risk Management are based 

on the billing document. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for transfer of billing documents. 
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Standard settings 

- In the standard system, there is no active BAdI implementation. 

- The BAdI is intended for use multiple times. All active implementations will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_CTRL_SD0C_R3. For more information, display the 

interface in the Class Builder. 

Note 

The BAdIs to control the transfer of documents comprise the functional scope of function module 

EXIT_SAPLSLL_LEG_CDPIR3_001 from user exit enhancement project SLLLEG01 ab. Because the 

BAdIs will replace the user exits, we recommend converting to the BAdI technology in the medium term. 

37.4.1.19.11 Change and Supplement Document Data for Transfer 37.4.1.19.11.1 

BAdI: Mapping and Enrichment of Data from Purchasing 

Documents (MM0A) 

Use 

The Business Add-In (BAdI) for adjusting purchasing document data is relevant for the areas SAP 

Compliance Management and SAP Risk Management - Preference Processing of SAP Global Trade 

Services (SAP GTS). 

You can use the BAdI to edit the result of the standard mapping of purchasing documents before they are 

transferred to the interface. For areas based on the customs document of SAP GTS, you can also transfer 

customer-specific data to the enhanced interface. In this way, you can enhance the customs document in 

SAP GTS. 

Requirements 

- You have set up system communication correctly. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 160 

- You have set up the technical activation for the transfer of purchasing documents and the transfer 

control options for purchasing documents. 

Standard settings 

- In the standard system there is no active BAdI implementation. 

- The BAdI is intended for use multiple times. All activated implementations will be called and 

executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

There are BAdIs available in the Implementation Guide of SAP GTS to enable you to receive and use 

customer-specific data in SAP GTS. For SAP Compliance Management, you can find the relevant BAdI 

under SAP Compliance Management -> Business Add-Ins for SAP Compliance Management and then 

under the enhancement spot -> Transfer External Data to Customs Document. 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_IFEX_MM0A_R3. For more information, display the 

interface in the Class Builder. 

Note 

The BAdIs for editing the mapping for document transfer comprise the functional scope of function 

module EXIT_SAPLSLL_LEG_CDPIR3_002 from user exit enhancement project SLLLEG01, and also 

offer extended structures for customer data. Because the BAdIs will replace the user exits, we 

recommend converting to the BAdI technology in the medium term. 

37.4.1.19.11.2 BAdI: Mapping and Enrichment of Data from Inbound 

Deliveries (MM0B) 

Use 

The Business Add-In (BAdI) for adjusting deliveries or SD returns is relevant for the area SAP Customs 

Management of SAP Global Trade Services (SAP GTS). 
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You can use the BAdI to edit the result of the standard mapping of deliveries before they are transferred 

to the interface. In addition, you can transfer customer-specific data to the enhanced interface. You can 

enhance the documents in SAP GTS in the following cases: 

- Creation and change of customs shipments for termination of a shipment procedure 

- Creation and change of a customs declaration in a worklist after temporary storage, which was 

triggered by setting the status in the delivery 

- Creation and change of a preliminary document for the process of customs declaration before goods 

receipt (border customs clearance), to which you can make enhancements either manually of IDoc-

based. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of deliveries and the transfer control options 

for deliveries . 

Standard settings 

- In the standard system there is no active BAdI implementation. 

- The BAdI is intended for use multiple times. All activated implementations will be called and 

executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

There are BAdIs available in the Implementation Guide of SAP GTS to enable you to receive and use 

customer-specific data in SAP GTS. For SAP Customs Management, you can find the relevant BAdI 

under SAP Customs Management -> Business Add-Ins for SAP Customs Management and then under the 

enhancement spot -> Transfer External Data to Customs Declarations and Customs Shipments. 

-> Transfer External Data to Customs Worklist 

-> Connect External Applications to Customs Declarations and Customs Shipments. 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_IFEX_MM0B_R3. For more information, display the 

interface in the Class Builder. 

Note 
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The BAdIs for editing the mapping for document transfer comprise the functional scope of function 

module EXIT_SAPLSLL_LEG_CDPIR3_002 from user exit enhancement project SLLLEG01, and also 

offer extended structures for customer data. Because the BAdIs will replace the user exits, we 

recommend converting to the BAdI technology in the medium term. 

37.4.1.19.11.3 BAdI: Mapping and Enrichment of Data from Material 

Documents (MM0C) 

Use 

The Business Add-In (BAdI) for adjusting material documents for goods movements is relevant for the 

area SAP Customs Management of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to edit the result of the standard mapping of material documents before they are 

transferred to the interface. In addition, you can transfer customer-specific data to the enhanced interface. 

You can enhance the documents in SAP GTS in the following cases: 

- Material documents with delivery and order reference create entries in the relevant customs worklist 

in SAP GTS 

- Material documents without order reference or with reference to outbound deliveries generate 

entries in the relevant customs worklist in SAP GTS 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of deliveries and the transfer control options 

for material documents. 

Standard settings 

- In the standard system there is no active BAdI implementation. 

- The BAdI supports multiple use. All activated implementations will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

There are BAdIs available in the Implementation Guide of SAP GTS to enable you to receive and use 

customer-specific data in SAP GTS. For SAP Customs Management, you can find the relevant BAdI 

under SAP Customs Management -> Business Add-Ins for SAP Customs Management and then under the 

enhancement spot -> Transfer External Data to Customs Worklist. 
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-> Transfer External Data to Customs Worklist 

-> Connect External Applications to Customs Declarations and Customs Shipments. 
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The BAdI uses the interface /SAPSLL/IF_EX_IFEX_MM0C_R3. For more information, display the 

interface in the Class Builder. 

37.4.1.19.11.4 BAdI: Mapping and Enrichment of Data from Sales Documents 

(SD0A) 

Use 

The Business Add-In (BAdI) for adjusting purchasing documents is relevant for the area SAP 

Compliance Management of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to edit the result of the standard mapping of purchasing documents before they are 

transferred to the interface. In addition, you can transfer customer-specific data to the enhanced interface, 

with which you can enhance the customs document in SAP GTS. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of purchasing documents and the transfer 

control options for purchasing documents. 

Standard settings 

- In the standard system there is no active BAdI implementation. 

- The BAdI supports multiple use. All activated implementations will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

There are BAdIs available in the Implementation Guide of SAP GTS to enable you to receive and use 

customer-specific data in SAP GTS. For SAP Compliance Management, you can find the relevant BAdI 

under SAP Compliance Management -> Business Add-Ins for SAP Compliance Management and then 

under the enhancement spot -> Transfer External Data to Customs Document. 

The BAdI uses the interface /SAPSLL/IF_EX_IFEX_SD0A_R3. For more information, display the 

interface in the Class Builder. 
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37.4.1.19.11.5 BAdI: Mapping and Enrichment of Data from Outbound Deliveries 

(SD0B) 

Use 

The Business Add-In (BAdI) for adjusting deliveries is relevant for the SAP Compliance Management 

area of SAP Global Trade Services (SAP GTS). 

You can use the BAdI to edit the result of the standard mapping of deliveries before they are transferred 

to the interface. In addition, you can transfer customer-specific data to the enhanced interface, with which 

you can enhance the customs document in SAP GTS. 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of deliveries and the transfer control options 

for deliveries. 

Standard settings 

- In the standard system there is no active BAdI implementation. 

- The BAdI supports multiple use. All activated implementations will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

There are BAdIs available in the Implementation Guide of SAP GTS to enable you to receive and use 

customer-specific data in SAP GTS. For SAP Compliance Management, you can find the relevant BAdI 

under SAP Compliance Management -> Business Add-Ins for SAP Compliance Management and then 

under the enhancement spot -> Transfer External Data to Customs Document. 

The BAdI uses the interface /SAPSLL/IF_EX_IFEX_SD0B_R3. For more information, display the 

interface in the Class Builder. 

37.4.1.19.11.6 BAdI: Mapping and Enrichment of Data from Billing 

Documents (SD0C) 
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Use 

The Business Add-In (BAdI) for adjusting billing document data is relevant for the SAP Customs 

Management and SAP Risk Management - Preference Processing in SAP Global Trade Services (SAP 

GTS). 

You can use this BADI to edit the result of the standard mapping of billing documents before they are 

transferred to the interface. In the areas based on documents from SAP Customs Management in SAP 

GTS, you can also transfer customer data to the enhanced interface. You can use it to extend the 

documents in SAP GST in the following cases: 

- Create and change customs shipments to open the dispatch procedure 

- Create and change a customs declaration 

Requirements 

- You have set up system communication correctly. 

- You have set up the technical activation for the transfer of billing documents and the transfer control 

options for billing documents. 

Standard settings 

- In the standard system there is no active BAdI implementation. 

- The BAdI supports multiple use. All activated implementations will be called and executed. 

- The BAdI is filter-independent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

There are BAdIs available in the Implementation Guide of SAP GTS to enable you to receive and use 

customer-specific data in SAP GTS. 

For SAP Customs Management you can find the relevant BAdI under SAP Compliance 
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Management -> Business Add-Ins for SAP Customs Management, under the following enhancement spots 

-> 

- Transfer External Data to Customs Declarations and Customs Shipments 

- Connect External Application to Customs Declarations and Customs Shipments 

See also 

The BAdI uses the interface /SAPSLL/IF_EX_IFEX_SD0C_R3. For more information, display the 

interface in the Class Builder. 

37.4.1.20 User Exits for SAP Global Trade Services 

37.4.1.20.1 Master Data Transfer: Suppliers/Customers (Enhancement Project 

SLLLEG05) 

Use 

With this user exit you can control which customers and suppliers you include in the standard initial 

transfer of master data from your feeder system to SAP Global Trade Services (SAP GTS). This enables 

you to filter out, for exmaple, suppliers for whom you do not need to perform any compliance checks. 

37.4.1.20.2 Master Data Transfer: Material Masters (Enhancement Project 

SLLLEG04) 
Use 

This user exit is available to enable you to control which material master data you transfer from your 

feeder system to SAP GTS. For more information, see the Data Replication section of the Business 

Scenario Configuration Guides for SAP GTS in SAP Service Marketplace at 

service.sap.com/instguides --> SAP Components --> SAP Global Trade Services. 

37.4.1.20.3 Preference Processing (Enhancement Project SLLLEG03) 

Use 

This user exit is available to enable you to control the transfer of preference-relevant from your feeder 

system to SAP GTS . For more information, see the Data Replication section of the Business Scenario 
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Configuration Guides for SAP GTS in SAP Service Marketplace at service.sap.com/instguides --> 

SAP Components --> SAP Global Trade Services. 

37.4.1.20.4 Master Data Transfer: BOMs (Enhancement Project SLLLEG02) 

Use 

This user exit enables you to influence which bills of material (BOMs) you transfer to SAP GTS. There 

are also user exits to allow you to modify the data before it is written to the database in SAP GTS. You 

need to transfer BOMs to SAP GTS if you use SAP Risk Management - Preference Processing. 

You can access this user exit using transaction /cmod. 

37.4.1.20.5 Transfer of MM and SD Documents (Enhancement Project 

SLLLEG01) 

Use 

This user exit is available in the plug-in to enable you to influence which Materials Management and 

which Sales & Distribution document data you transfer to SAP Global Trade Services (SAP GTS). 

This user exit is available for following processes: 

- Transferring documents 

- Override transfer settings 
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- Modify data after mapping 

- Determine document status 

- Create a worklist for supplier-based long-term supplier declarations based on 

- Purchase orders 

- Goods receipts 

- Transfer the preference status of a good to the feeder system based on 

- Sales order 

- Billing document 

You can access these user exits in the plug-in using transaction /cmod. 

Requirements 

- You have set up the system communication correctly. 

- You have activated your change pointers and reduced message types. 

- You have maintenance authorization for transaction /sm30. 

For more information, see the sections on System Communication and Data Replication in the Business 

Scenario Configuration Guides for SAP GTS in SAP Service Marketplace at 

http://service.sap.com/instguides -> SAP Components -> SAP Global Trade Services -> 
Using SAP GTS 7.0. 

Activities 

When you set up a batch job to transfer new or changed document data at regular intervals in the 

background, you can implement the user exit below to filter the data you require in SAP GTS. The 

detailed selection criteria limit the amount of data that needs to be transferred and filter the data irrelevant 

for SAP GTS. To ensure the same procedure for the initial and delta data transfer, you need to use the user 

exit. 

The transfer of documents into the SAP GTS is defined by means of the document types in combination 

with the corresponding application level. In addition, you can define on this level whether the system 

displays a message if the transferred document was locked in SAP GTS. 

Implement this user exit (SLLLEG01) to override the settings defined on document type level and 

initiate the following actions: 

- Stop the transfer 

- Carry out the transfer 

- Suppress the display of a message 

- Activate the display of a message 
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37.4.2 SAP Fraud Management (Plug-In) 

37.4.2.1 Integration in the Payment Run 

37.4.2.1.1 Activate the Integration Scenario 

Use 

In this Customizing activity, you can activate the Integration in the Payment Run integration scenario. 

In this scenario, SAP Fraud Management is optionally integrated in the creditor and debtor payment runs 

(transaction F110 and the Schedule Payment Proposals app). SAP Fraud Management checks the items 

in a payment proposal for irregularities or potential fraud. When you use the Schedule Payment Proposals 

app, if a problem is found, SAP Fraud Management applies a payment block to the problematic item. 

SAP Fraud Management can also optionally apply a payment block to the underlying FI invoice 

document. Investigators can review the SAP Fraud Management alert on the problem and either release 

the payment or confirm that there is a problem. See the integration scenario documentation of S/4HANA 

or SAP Fraud Management for more information on this integration scenario. 

Requirements 

In this integration scenario, SAP Fraud Management must be co-deployed with SAP S/4HANA. Check 

the installation and configuration documentation of SAP S/4HANA and SAP Assurance and Compliance 

Software (Solution SAP Fraud Management) for more information. You can find the documentation for 

SAP S/4HANA on the SAP Help Portal at http://help.sap.com/s4hana and that for SAP Fraud 

Management at http://help.sap.com/fra. 

Activities 

In each client that you want to activate this integration scenario, select the Activate the Integration 

Scenario checkbox. The scenario is then active only in the client in which you are logged on. 

Optionally, in the Payment Block Used by SAP Fraud Management field, specify a block that you 

want to apply to the FI invoice that underlies an item in the payment run. If there is a problem with an 

item that derives from the underlying FI invoice, then SAP Fraud Management applies the block to the 

invoice document. This prevents another payment run from trying once again to pay the items in the 

invoice. Once the alert is cleared, both the block on the invoice and on the payment run are removed. 

37.4.2.1.2 Business Add-Ins (BAdIs) 

37.4.2.1.2.1 Schedule Report After Payment Run 

Use 
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This Business Add-In (BAdI) is used in the Accounts Payable (FI-AP) component. With this BAdI you 

can add logic after the proposal or payment run and before the creation of payment media and lists. 

BAdI Implementation for SAP Fraud Management 

You activate the implementation of this BAdI to submit payment runs to SAP Fraud Management for 

examination for potential fraud or irregularities. Activating the BAdI is required for using the Integration 

in the Payment Run integration scenario. 

See also the Customizing activity Activate the Integration Scenario. 

Standard settings 

A standard BAdI implementation is delivered with your system. You need only to activate this 

implementation of the BAdI. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.5 Transportation Management 

37.5.1 Logistics Integration 

37.5.1.1 Define Control Keys for Document Transfer 

Use 

In this Customizing activity, you define control keys that determine which documents in a document 

chain are to be transferred to SAP TM using the corresponding enterprise services. You can define as 

many control keys as required, with different combinations of relevant documents. For sales orders, you 

can also specify whether sales order scheduling is to take place in SAP TM. 

The following documents can be transferred to SAP TM: sales orders, purchase orders, stock transport 

orders, returns orders (for example, sales returns, vendor returns, and store returns), outbound deliveries, 

and inbound deliveries. 

37.5.1.2 Activate Transfer of Sales Documents 
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Use 

In this Customizing activity, you activate the transfer of sales documents to SAP TM by assigning a 

control key to the required sales document types. The sales documents can be sales orders, sales 

scheduling agreements or returns orders. The control key determines whether a sales document and the 

corresponding outbound delivery are to be transferred to SAP TM. It also determines whether sales order 

scheduling is to be carried out in SAP ERP or in SAP 

TM. 

When you create a sales document for which the transfer has been activated, the system assigns the 

control key to the sales document (parameter TM_CONTROL_KEY) and to all relevant documents in the 

document chain (for example, the outbound delivery). This is a fixed parameter that cannot be changed 

subsequently in the sales document. 

Requirements 

You have defined the required control keys in the Customizing activity Define Control Keys for 

Document Transfer. 

Activities 

Define which sales documents you want to transfer by entering one or more parameters (for example, 

sales organization, distribution channel, and sales order type), and assign the required control key to the 

set of parameters. 

Note that to transfer sales documents, you also have to make the following settings: 

- You have to set up output determination for sales documents in the Customizing activity Maintain 

Output Determination Procedure. 

For all sales order types except customer returns, assign output type TRS0 and requirement routine 

27 to the relevant procedure (that is, the procedure assigned to the sales document types that are to 

be transferred to SAP TM). For customer returns, assign output type TRR0 and requirement routine 

28 to the relevant procedure. 

- You have to create a condition record for each sales document type that is to be transferred to SAP 

TM, using output type TRS0 for sales orders and TRR0 for customer returns. To create condition 

records, on the SAP Easy Access screen, choose Logistics -> Sales and Distribution -> Master 

Data -> Output -> Sales Document -> Create. 

37.5.1.3 Activate Transfer of Purchasing Documents 

Use 

In this Customizing activity, you activate the transfer of purchasing documents (including MM 

scheduling agreements) to SAP TM by assigning a control key to the required document types. The 
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control key determines whether a purchasing document and the corresponding inbound delivery or 

outbound delivery are to be transferred to SAP TM. 

When you create a purchasing document for which the transfer has been activated, the system assigns the 

control key to the purchase order (parameter TM_CONTROL_KEY) and to all relevant documents in the 

document chain (for example, the inbound delivery). This is a fixed parameter that cannot be changed 

subsequently in the purchasing document. 

Requirements 

You have defined the required control keys in the Customizing activity Define Control Keys for 

Document Transfer. 

Activities 

Define which purchasing documents you want to transfer by entering one or more parameters (for 

example, purchasing organization, purchasing group, and purchase order type), and assign the required 

control key to the set of parameters. 

Note that to transfer purchasing documents, you also have to set up the workflow as follows: 

- In transactionSWETYPV, you have to create an event type linkage for the events CREATED and 

CHANGED. Make the following entries for each event: 

Object Category: ABAP Class 

Object Type: CL_SE_PUR_PO_WF_OUT 

Receiver Type: WS53800008 

Receiver Call: Function Module 

Receiver Function Module: SWW_WI_CREATE_VIA_EVENT_IBF 

Event Delivery: Using tRFC (Default) 

Linkage Activated: Select this checkbox 

Behavior Upon Error Feedback: System defaults 

Receiver Status: No errors 

- You have to define the service output by adding the following entries to view V_T175SOA in 

transaction  SM30: 

Context Service ID 

Purchase Order Created/Changed CL_SE_PUR_TRQSUITEREQUEST 

Purchase Order Created/Changed CL_SE_PUR_TRQCANCELREQUES 

37.5.1.4 Activate Transfer of Delivery Documents 

Use 

In this Customizing activity, you can activate the transfer of delivery documents to SAP TM by assigning 

a control key to the relevant delivery types. The control key is a fixed parameter (TM_CONTROL_KEY) 

that cannot be changed subsequently in the delivery document. 

Note that you can also activate the transfer of the delivery using the control key assigned to the preceding 

document in the document chain (for example, a sales order or a purchase order). In this case, the delivery 

inherits the control key from the preceding document and the system ignores any settings that you make 

in this Customizing activity. 

Requirements 
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You have defined the required control keys in the Customizing activity Define Control Keys for 

Document Transfer. 

Activities 

Define which delivery documents you want to transfer by entering one or more parameters (for example, 

shipping point, delivery type, and shipping conditions), and assign the required control key to the set of 

parameters. 

Note that to transfer deliveries, you also have to make the following settings: 

- You have to set up output determination for deliveries as follows: 

- In the Customizing activity Maintain Output Determination Procedure for outbound deliveries, 

assign output type TRD0 and requirement routine 440 to the relevant procedure (that is, the 

procedure assigned to the delivery types that are to be transferred to SAP TM). 

- In the Customizing activity Maintain Output Determination Procedure for inbound deliveries, assign 

output type TRD0 and requirement routine 441 to the relevant procedure. 

- You have to create a condition record with output type TRD0 for each delivery type that is to be 

transferred to SAP TM. To create condition records, on the SAP Easy Access screen, choose 

Logistics -> Sales and Distribution -> Master Data -> Output -> Shipping -> Create. 

37.5.1.5 Define Settings for Sales Scheduling Agreements Integration 

Use 

In this Customizing activity, you define settings for the integration of sales scheduling agreements to SAP 

Transportation Management (SAP TM). You can restrict schedule lines of scheduling agreements for the 

transfer from SAP ERP to SAP TM by specifying a time horizon in days # the system transfers only 

schedule items that are scheduled with the number of days that you have specified. 

The following attributes are available for customizing: 

- Sales Document Type 

- Sales Organization 

- Distribution Channel 

- Division 

- Delivering Plant 

You can define settings for the following combinations of the five attributes: 

- all five attributes (none is left blank) 
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- sales document type, sales organization, distribution channel and division (delivering plant is blank) 

- sales document type, sales organization and distribution channel(division and delivering plant are 

blank) 

- sales document type and sales organization (distribution channel, division, and delivering plant are 

blank) 

- sales document type and delivering plant (sales organization, distribution channel, and division are 

blank) 

- sales document type only (delivering plant, sales organization, distribution channel, and division are 

blank) 

Requirements 

You have activated the business function Integration of Scheduling Agreements with TM 

(LOG_TM_SAG_INT_I). 

Activities 

Define the sales scheduling agreements you want to create settings for by entering one or more 

parameters (for example sales document type, sales organization, distribution channel, and division), and 

assign the required settings to the set of parameters. The system evaluates the parameters in the 

following order: 

1. check for a valid entry for a combination of all five attributes 

2. check for a valid entry in each of the following 

a) sales document type 

b) sales organization 

c) distribution channel 

d) division 

3. check for a valid entry in each of the following: 

a) sales document type 

b) sales organization 

c) distribution channel 

4. check for a valid entry in each of the following: 

a) sales document type 

b) sales organization 

5. check for a valid entry in each of the following: 

a) sales document type 
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b) delivering plant 

6. check for a valid entry in sales document type only. 

37.5.1.6 Define Settings for MM Scheduling Agreements Integration 

Use 

In this customizing activity, you define settings for the integration of MM scheduling agreements to SAP 

TM. You can restrict schedule lines of scheduling agreements for the transfer from SAP ERP to SAP TM 

by specifying a time horizon in days # the system transfers only schedule items that are scheduled with 

the number of days that you have specified. The calculation always starts from the current date. 

You can also specify relevant scheduling agreement release types. You can configure the system to 

transfer either JIT delivery schedules or FRC delivery schedules or both to SAP TM. 

The following attributes are available for customizing: 

- Purchasing Document Type 

- Purchasing Organization 

- Purchasing Group 

- Receiving Plant 

You can define settings for the following combinations of the four attributes: 

- all four attributes (none is left blank) 

- purchasing document type, purchasing organization, and purchasing group (receiving plant is blank) 

- purchasing document type and purchasing organization (purchasing group and receiving plant are 

blank) 

- purchasing document type and receiving plant (purchasing group and purchasing organization are 

blank) 

- a purchasing document type (the other three attributes are left blank) 

Requirements 

You have activated the business function Integration of Scheduling Agreements with TM 

(LOG_TM_SAG_INT_I). 

Activities 

Define the MM scheduling agreements you want to create settings for by entering one or more parameters 

(for example purchasing document type, purchasing organization, purchasing group and receiving plant), 

and assign the required settings to the set of parameters. 
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The system evaluates the parameters in the following order: 

1. check for a valid entry for a combination of all four attributes 

2. check for a valid entry in each of the following 

a) purchasing document type 

b) purchasing organization 

c) purchasing group 

 3. check for a valid entry in each of the following: 

a) purchasing document type 

b) purchasing organization 

 4. check for a valid entry in each of the following: 

a) purchasing document type 

b) receiving plant 

 5. check for a valid entry in purchasing document type only 

37.5.1.7 Business Add-Ins (BAdIs) 

37.5.1.7.1 BAdI: Sales Document Integration with TM 

Use 

This Business Add-In (BAdI) is used in the Transportation Management Integration (LO-TM) 

component. You can use this BAdI to change the control key and the technical transportation 

management number assigned to the sales document types in the Customizing activity Activate Transfer 

of Sales Documents. This BAdI is called when a sales document is saved for the first time. 

The following methods are available: 

- CHANGE_TM_CTRL_KEY: You can use this BAdI method to change the control key assigned to 

the sales document types. 

- CHANGE_LOG_TM_NR: You can use this BAdI method to change the technical transportation 

management number assigned to the sales document types. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enh. Spot 

Element Definitions tab in the BAdI Builder (transaction SE18). 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 178 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.5.1.7.2 BAdI: Purchasing Document Integration with TM 

Use 

This Business Add-In (BAdI) is used in the Transportation Management Integration (LO-TM) 

component. You can use this BAdI to change the control key and the technical transportation 

management number assigned to the purchasing document types in the Customizing activity Activate 

Transfer of Purchasing Documents. This BAdI is called when a purchasing document is saved for the first 

time. 

The following methods are available: 

- CHANGE_TM_CTRL_KEY: You can use this BAdI method to change the control key assigned to 

the purchasing document types. 

- CHANGE_LOG_TM_NR: You can use this BAdI method to change the technical transportation 

management number assigned to the purchasing document types. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enh. Spot 

Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP 

Library for SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.5.1.7.3 BAdI: Delivery Integration with TM 

Use 

This Business Add-In (BAdI) is used in the Transportation Management Integration (LO-TM) 

component. You can use this BAdI to change the control key and the technical transportation 
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management number assigned to the delivery types in the Customizing activity Activate Transfer of 

Delivery Documents. This BAdI is called when a delivery is saved for the first time. 

The following methods are available: 

- CHANGE_TM_CTRL_KEY: You can use this BAdI method to change the control key assigned to 

the delivery types. 

- CHANGE_LOG_TM_NR: You can use this BAdI method to change the technical transportation 

management number assigned to the delivery types. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enh. Spot 

Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.5.2 Invoice Integration 

37.5.2.1 Billing 

37.5.2.1.1 Definition for Transportation Charge Types 

37.5.2.1.1.1 Define Category Codes 

Use 

In this Customizing activity, you can define codes for transportation charge item category codes. 

37.5.2.1.1.2 Define Subcategory Codes 

Use 

In this Customizing activity, you can define codes for transportation charge item subcategory codes. 
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37.5.2.1.1.3 Define Charge Types 

Use 

In this Customizing activity, you can define codes for transportation charge type codes. 

37.5.2.1.2 Definition of Transportation Management Role Codes 

37.5.2.1.2.1 Define Role Codes (Currency) 

Use 

In this Customizing activity, you can define role codes for transportation management. 

37.5.2.1.2.2 Define Role Codes (Amount) 

Use 

In this Customizing activity, you can define role codes for transportation management. 

37.5.2.1.3 Assignment of Transportation Charge Types 

37.5.2.1.3.1 Assign Condition Types 

Use 

In this Customizing activity, you can assign transportation charge element categories, transportation 

charge element subcategories, and transportation charge elements to condition types. 
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37.5.2.1.4 Mapping of Organizational Units 

37.5.2.1.4.1 Assign Organizational Units for Sales and Distribution 

Use 

In this Customizing activity, you can assign the sales and distribution business areas from SAP Transportation 

Management (SAP TM) to the organizational units in sales and distribution in the ERP system. 

37.5.2.1.4.2 Define Credit Segment 

Use 

In this IMG activity you can define the credit segments that are to be used in Accounts Receivable 

Accounting (FI-AR) and Sales and Distribution (SD). 

Credit segments are required for the determination of the credit limit. 

Activities 

Define the credit segments relevant for your company that can be used in this system. This is the 

prerequisite that enables you to assign the credit segments to the credit control areas. 

37.5.2.1.4.3 Assign Credit Segment to Credit Control Area 

Use 

In this Customizing activity, you specify the credit segment that the SAP Transportation Management 

(SAP TM) system uses and assign the credit segment to the credit control area used in Accounts 

Receivable Accounting (FI-AR). 

The SAP TM system uses the credit segment to access the credit management functionality in the SAP 

Credit Management application. Credit segments are required for the credit limit determination from SAP 
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TM to SAP Credit Management. The credit segment ID used in the mapping should be the same as the 

credit segment defined in the SAP TM system. 

The mapped credit control area is saved in the accounting document. During FI posting, the credit control 

area is used to update SAP Credit Management (FIN-FSCM-CR). 

Note 

In SAP Credit Management (FIN-FSCM-CR), you assign the credit control areas to the credit segments. 

To pass the credit control area to accounting, SD document and FI document creation must occur 

simultaneously for the SAP TM documents. 

Requirements 

- In SAP ERP, you have defined the credit control area in the Customizing activity Define Credit 

Control Area. 

- In SAP ERP, you have defined the credit segment in the Customizing activity Define Credit 

Segment. 

- You have enabled the credit management functionality in SAP TM and SAP ERP. 

- You have defined the business partner information for the relevant credit segments in SAP Credit 

Management. 

- You have not maintained a posting block in the billing document type. 

More Information 

For more information about defining the relevant information in SAP Credit Management, see SAP note 

1617011. 

37.5.2.1.4.4 Assign TM Sales Org. Unit to Internal Order/Cost Center 

Use 

In this Customizing activity, you can assign a sales organization unit in SAP Transportation Management 

(SAP TM) to an internal order/cost center in SAP ERP. 

This setting can be made when for example a Logistic service provider wants to use an internal order or 

cost center to collect any of the following: 

1. The customer billing amount 

2. Internal costs due to Intercompany settlement process 

3. Internal costs due to Intra company settlement process. 
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In this case of internal settlement the internal order or cost center associated with the Sales organization 

are the cost receivers. 

This customizing setting is mandatory when doing an intra company settlement process. 

Requirements 

You have defined the internal order/cost center in the SAP ERP system. 

37.5.2.1.5 Assign SAP TM Credit Memo Reason Code to Order Reason Code 

Use 

In this Customizing activity, you assign the credit memo reason code from the SAP Transportation 

Management (SAP TM) system to the order reason code in SAP ERP. 

When you create a credit memo in SAP TM, SAP TM includes the credit memo reason code in the credit 

memo information that it sends to SAP ERP. When SAP ERP creates the corresponding credit memo, it 

maps the credit memo reason code to the order reason. You must enter an order reason when you create 

a credit memo in SAP ERP. 

37.5.2.1.6 Intracompany Settlement 

37.5.2.1.6.1 Assign Transportation Charges to Cost Elements 

Use 

In this Customizing activity, you can assign a transportation charge type in SAP Transportation 

Management (SAP TM) to a primary cost element mapping for intra company settlement processing in 

SAP ERP. This setting is mandatory when the Logistic service provider wants to use an intra company 

settlement. The primary cost element is used when the intra company settlement document is processed in 

SAP ERP. 

Requirements 
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You have created the primary cost element in the SAP ERP system. 

You have defined the TM charge type in SAP ERP in Customizing for Integration with Other 

mySAP.com Components under Transportation management -> Invoice Integration -> Billing -> 

Definition for Transportation Charge Elements. 

37.5.2.1.7 Business Add-Ins (BAdIs) 

37.5.2.1.7.1 BAdI: Invoice Print Preview Integration with TM 

Use 

This Business Add-In (BAdI) is used in the Billing (SD-BIL) component. You can use this BAdI to create 

rules that determine the output type of the printing program, for example as follows. 

- If the country is US then set the output type to TM00. 

- If the country is GE then set the output type to SB65. 

The following methods are available: 

- CHANGE_OUTPUT_TYPE: You can use this BAdI method to change the output type for example 

from the recommended TM00 to a customer value such as SB65. 

- CHANGE_INVOICE_SIM_DATA: You can use this BAdI method to change the output parameters 

ES_HEADER and ET_ITEMS that determine the content of the invoice print preview display. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enh.Spot 

Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 
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37.5.2.1.7.2 BAdI: Inbound Processing of Forwarding Settlement Documents 

from SAP TM 

Use 

This Business Add-In (BAdI) is used in the components Forwarding Settlement (TM-FWS) and ERP 

Billing (TM-FWS-BIL). You can use this BAdI to change or extend the data the system transfers from 

SAP Transportation Management (SAP TM) to SAP ERP in the following SAP ERP service operations: 

- Maintain Customer Invoice based on Customer Freight Invoice Request Request_V1 

(CustomerFreightInvoiceRequestSUITERequest_In_V1) under the Transportation Processing In 

service interface 

- Confirm Customer Freight Invoice Request_V1 

(CustomerFreightInvoiceRequestSUITEConfirmation_Out_V1) under the Transportation 

Processing Out service interface 

The system calls the service operation when you transfer a forwarding settlement document from 

SAP TM to SAP ERP. The operation requests that SAP ERP creates a new Sales and Distribution (SD) 

billing document or a controlling document, or updates an existing SD billing document or a controlling 

document. 

Note: 

If you implement this BAdI and you need to print the information that you change or extend in this 

BAdI, you must implement BAdI: Previewing of Sales and Distribution Billing. This gives you 

consistent results for both the SD billing document and the invoice preview of the SD billing 

document in SAP TM. 

For example, in this BAdI you implement your own logic to include additional information such as 

route executed. You want to print the route executed information in the invoice. You implement the 

BAdI: Previewing of Sales and Distribution Billing to generate the print document. To ensure 

consistency when you execute the print preview, you must also include the route executed 

information in the BAdI: Previewing of Sales and Distribution Billing. 

SAP TM displays the route executed information in the invoice preview in the forwarding 

settlement document and credit memo. 

For more information on the service operations, see SAP Library for SAP ERP on SAP Help 

Portal at http://help.sap.com/erp. In SAP Library, choose SAP ERP Cross Application Functions -> 

Enterprise Services in SAP ERP -> Enterprise Services in Logistics -> Customer Invoice Processing -> 

Customer Invoice. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

See also 

BADI method documentation: 

- INBOUND_PROCESSING 
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- OUTBOUND_PROCESSING 

- APPLICATION_PROCESSING 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

37.5.2.1.7.3 BAdI: Previewing of Sales and Distribution Billing Documents 

Use 

This BAdI is used in the components Forwarding Settlement (TM-FWS) and ERP Billing (TM-FWS-

BIL). You can use this BAdI to change or extend the information that you transfer in the Simulate 

Customer Freight Invoice Request 

(CustomerFreightInvoiceRequestSUITESimulate_In) service operation from SAP ERP to SAP 

Transportation Management (SAP TM). 

The Simulate Customer Freight Invoice Request 

(CustomerFreightInvoiceRequestSUITESimulate_Out) outbound operation sends a new or changed 

forwarding settlement document or credit memo from SAP SAP TM to SAP ERP. It also requests that 

SAP ERP transfers the information that SAP TM needs to preview the invoice in a forwarding settlement 

document or credit memo. 

The following table describes how you can get more information on the service operations: 

 Service Operation Navigation Path 

 Simulate Customer Freight Invoice Request (in SAP ERP) SAP Library for SAP ERP on 

SAP Help Portal at http://help.sap.com/erp. In SAP Library, choose SAP ERP Cross 

Application Functions -> Enterprise Services in SAP ERP -> Enterprise Services in 

Logistics -> Customer Invoice Processing -> Customer Invoice -> Customer Freight Invoicing In 

 Simulate Customer Freight Invoice Request (in SAP TM) SAP Library for SAP TM on 

SAP Help Portal at http://help.sap.com/tm. In SAP Library, choose SAP Transportation 

Management (SAP TM) -> Enterprise Services and ESR Content -> Enterprise Services -> Customer 

Freight Invoice Request Processing -> Customer Freight Invoice Request -> Customer Freight 

Invoicing Out. 

Note: 

You implement BAdI: Inbound Processing of Forwarding Settlement Documents from SAP TM to 

change or extend forwarding settlement document information that the system transfers from SAP 

TM to SAP ERP. SAP ERP creates a new Sales and Distribution (SD) billing document. 

If you need to print the SD billing information, you must implement this BAdI: Previewing of Sales 

and Distribution Billing Documents to ensure that you have consistency in both the SD billing 

document in SAP ERP and the invoice preview of the SD billing document in SAP TM. 

For example, in this BAdI you implement your own logic to include additional information such as 

route executed. You want to print the route executed information in the invoice. You implement 

this BAdI to generate the print document. To ensure consistency when you execute the print 

preview, you must also include the route executed information in the BAdI: Inbound Processing of 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 187 

Forwarding Settlement Documents from SAP TM. SAP TM displays the route executed 

information in the invoice preview in the forwarding settlement document and credit memo. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

See also 

BAdI method documentation: 

 - INBOUND_PROCESSING 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

37.5.2.2 Invoicing 

37.5.2.2.1 Definition for Transportation Charge Types 

37.5.2.2.1.1 Define Category Codes 

Use 

In this Customizing activity, you can define codes for transportation charge item category codes. 

37.5.2.2.1.2 Define Subcategory Codes 

Use 

In this Customizing activity, you can define codes for transportation charge item subcategory codes. 
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37.5.2.2.1.3 Define Charge Types 

Use 

In this Customizing activity, you can define codes for transportation charge type codes. 

37.5.2.2.2 Definition of Transportation Management Role Codes 

37.5.2.2.2.1 Define Role Codes (Currency) 

Use 

In this Customizing activity, you can define role codes for transportation management. 

37.5.2.2.2.2 Define Role Codes (Amount) 

Use 

In this Customizing activity, you can define role codes for transportation management. 

37.5.2.2.3 Assignment of Transportation Charge Types 37.5.2.2.3.1 Assign 

Service Master Record and Account Assignment Category 

Use 

In this Customizing activity, you can assign transportation charge item categories, transportation charge 

item subcategories, and transportation charge items to service master data records and account 

assignment categories. 
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37.5.2.2.4 Mapping of Organizational Units 

37.5.2.2.4.1 Assign Organizational Units for Purchasing 

Use 

In this Customizing activity, you can assign the purchasing business areas from SAP 

Transportation Management (SAP TM) to the organizational units in purchasing in the ERP system. 

37.5.2.2.4.2 Assign TM Purchase Org. Unit to Internal Order/Cost Center 

Use 

In this Customizing activity, you can assign a Purchase organization unit in SAP Transportation 

Management (SAP TM) to an internal order/cost center account in SAP ERP. 

This setting is required when the Logistic service provider wants to use an internal order or cost center to 

collect the freight costs associated with the TM freight settlement document (FSD) or internal settlement 

documents. The three purposes for which you would use this are as follows. 

1. The freight cost associated with the FSD for the Purchasing organization 

2. Internal costs due to Intercompany settlement process 

3. Internal costs due to Intra company settlement process. 

For internal settlement, the internal order or cost center associated with the purchase organization are the 

cost senders. 

This customizing setting is mandatory when doing an intra company settlement process. 

Requirements 

You have defined the internal order/cost center in the SAP ERP system. 
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37.5.2.2.5 Business Add-Ins (BAdIs) 

37.5.2.2.5.1 BAdI: Inbound/Outbound Processing for FO Invoicing Prep. 

Use 

This Business Add-In (BAdI) is used in the ERP Invoice Verification Preparation (TM-FRS-IP) 

component. You can use the BAdI to change the attributes in the information that you send between SAP 

Transportation Management (SAP TM) and SAP ERP when you transfer a new freight settlement 

document from SAP TM. You can use this BAdI in the following business situations: 

- When SAP TM passes a request to SAP ERP to create a freight settlement document and the 

associated purchase order and service entry sheet (SES) in SAP ERP 

- When SAP ERP passes a confirmation message to SAP TM, confirming that it has created a 

purchase order and SES 

The system uses the Request Transportation Order Invoicing Preparation service operation to transfer 

freight settlement document creation information from SAP TM to SAP ERP. The system uses this 

service operation to transfer purchase order and SES information from SAP ERP to SAP TM. 

You can use the following methods: 

- INBOUND_PROCESSING 

You can use this method to process the information you receive from SAP TM. You can change the 

attributes and add additional information. You can change the following attributes: 

- Settlement date 

- Resource information, such as truck and trailer IDs 

- Item information, such as stage-level information for settlements that contain stage-level 

calculation 

- Product information, such as product ID 

For example, you use this BAdI to override the standard system behavior. You change the line item 

description in a purchase order, the tax code, the service quantity, and the amount. You also add a 

partner function and move data from your extended structures when you create a purchase order and 

SES. 

- OUTBOUND_PROCESSING 

You can use this method to process the information you send from SAP ERP to SAP TM. You can 

include changed attributes in the information. For example, you can change attributes when you 

send the confirmation message from SAP ERP to SAP TM, in response to the processing of the 

incoming freight settlement document in SAP ERP. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 
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See also 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

For more information about the service operation, see SAP Library for SAP Transportation 

Management on SAP Help Portal at http://help.sap.com/tm. In SAP Library, choose SAP 

Transportation Management (SAP TM) -> Enterprise Services and ESR Content -> Enterprise Services -

> Transportation Order Processing -> Transportation Order -> Transportation Order Invoicing 

Preparation Out -> Request Transportation Order Invoicing Preparation. 

37.5.2.2.5.2 BAdI: Inbound/Outbound Processing for FO Invoicing Prep. CNC 

Use 

This Business Add-In (BAdI) is used in the ERP Invoice Verification Preparation (TM-FRS-IP) 

component. You can use this BAdI to change the attributes in the message structure that transfers 

cancellation information for a freight settlement document between SAP Transportation Management 

(SAP TM) and SAP ERP. You can use this BAdI in the following business situations: 

- When SAP TM passes a cancellation request to SAP ERP to cancel a freight settlement document 

and the associated purchase order and service entry sheet (SES) in SAP ERP 

- When SAP ERP passes a confirmation message to SAP TM, confirming that it has cancelled the 

purchase order and SES 

The system uses the Request Transportation Order Invoicing Preparation Cancellation service operation 

to transfer freight settlement document cancellation information from SAP TM to SAP ERP. The system 

uses the Request Transportation Order Invoicing Preparation Cancellation service operation to transfer 

purchase order and SES information from SAP ERP to SAP TM. 

You can use the following methods: 

- INBOUND_PROCESSING 

The system calls the INBOUND_PROCESSING method from this BAdI when you trigger the 

service operation. You can use the method to include a changed attribute, such as a different 

settlement date, in the service operation message. You can also include an additional value in the 

information. 

- OUTBOUND_PROCESSING 

The system calls the OUTBOUND_PROCESSING method from this BAdI when you trigger the 

service operation. You can include the attribute you changed on the inbound side, and add an 

additional attribute, such as the financial document ID, to the cancellation message that SAP ERP 

sends to SAP TM. 

Standard settings 
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For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

See also 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

For more information about the service operation, see SAP Library for SAP Transportation 

Management on SAP Help Portal at http://help.sap.com/tm. In SAP Library, choose SAP 

Transportation Management (SAP TM) -> Enterprise Services and ESR Content -> Enterprise 

Services -> Transportation Order Processing -> Transportation Order -> Transportation Order 

Invoicing Preparation Out -> Request Transportation Order Invoicing Preparation Cancellation. 

37.5.2.2.5.3 BAdI: Freight Order Invoicing Preparation: Data Modify 

Use 

This Business Add-In (BAdI) is used in the ERP Invoice Verification Preparation (TM-FRS-IP) 

component. You can use this BAdI to change the account assignment in SAP ERP. You can change the 

account assignment when SAP Transportation Management (SAP TM) passes a message to SAP ERP to 

create or change a freight settlement document and the associated purchase order and service entry sheet 

(SES) in SAP ERP. 

The system uses the Request Transportation Order Invoicing Preparation service operation to transfer 

information on a new or changed freight settlement document from SAP TM to SAP ERP. 

You can use the ACCOUNT_ASSIGNMENT_MODIFY method to change the account assignment. The 

system calls the method when you trigger the service operation. For example, you can change the 

following account assignments: 

- Cost center 

- General ledger (G/L) 

- Internal order 

You can use this BAdI to create your own logic to override the default account assignment information. 

For example, you can use information from the freight settlement document to change the default cost 

center. You can also deselect the flag EV_DEFAULT_ACC, to indicate you have changed the account 

assignment in the BAdI. 

Alternatively, in a shipper scenario, you can use this BAdI to include the cost split from a cost 

distribution in a service line of a service entry sheet (SES). This enables you to create a multiple account 

assignment in an SES. You take the following steps: 
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1. Build the logic in this BAdI to extract the cost distribution information from the input deep structure 

IS_TCM_INV_PREP. 

You summarize the cost distribution information by each charge type and delivery item. 

2. Extract other relevant information from the delivery, for example, accounting information such as 

cost center and profit center. 

3. Loop at each charge element in internal table IT_TCM_ELEMENT and build the split of the 

accounting posting in internal table ET_TCM_ELEMENT_ACC. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

See also 

For information about implementing BAdIs as part of the enhancement framework, see SAP Library for 

SAP NetWeaver Platform on SAP Help Portal at http://help.sap.com/nw_platform. 

Choose a release and then Application Help. In SAP Library, choose SAP NetWeaver Library: Function-

Oriented View -> Application Server -> Application Server ABAP -> Application Development on AS 

ABAP -> ABAP Customer Development -> Enhancement Framework. 

For more information about the service operation, see SAP Library for SAP Transportation 

Management on SAP Help Portal at http://help.sap.com/tm. In SAP Library, choose SAP 

Transportation Management (SAP TM) -> Enterprise Services and ESR Content -> Enterprise Services -

> Transportation Order Processing -> Transportation Order -> Transportation Order Invoicing 

Preparation Out -> Request Transportation Order Invoicing Preparation. 

37.5.2.3 Tax 

37.5.2.3.1 Map SAP TM Tax Settings 

Use 

In this Customizing activity, you can use the tax classification feature in SAP ERP to influence how SAP 

ERP determines tax. You can map the tax type and tax group information you receive from SAP 

Transportation Management (SAP TM) to tax category and tax classification information in SAP ERP. 

In SAP TM you can have multiple charge types in a charge item. As standard, SAP ERP creates a billing 

item for a charge item, and applies tax to the billing item. In some countries, you may need to calculate 

tax for each charge type contained in each individual charge line in a charge item. To facilitate this, SAP 

ERP creates a billing item for each charge line in a settlement document when you enable tax for a 

country in SAP TM. 
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You use the pricing control conditions in SAP ERP to specify the criteria that SAP ERP uses to apply the 

tax influencers from SAP TM. You also specify the tax rate that the system applies in the conditions. 

You must manually enter the tax types and tax groups from the SAP TM system. SAP ERP does not 

validate the SAP TM types and groups. 

Requirements 

In SAP ERP, you have specified the following pricing control settings: 

- A condition table that uses the customer tax classification and the material tax classification as a 

basis for determining tax in Customizing for Sales and Distribution under Basic Functions -> Pricing 

-> Pricing Control -> Define Condition Tables (SIMG_CFMENUOLSDFP3). 

- An access sequence to specify the order in which the system searches for the condition records that 

are valid for a condition type in Customizing for Sales and Distribution under Basic Functions -> 

Pricing -> Pricing Control -> Define Access Sequences 

(SIMG_CFMENUOLSDVOKX). 

- A condition type to which you have assigned the access sequence in Customizing for Sales and 

Distribution under Basic Functions -> Pricing -> Pricing Control -> Define Condition Types 

(SIMG_CFMENUOLSDVOK0). 

- A pricing procedure to which you have assigned the condition type in Customizing for 

Sales and Distribution under Basic Functions -> Pricing -> Pricing Control -> Define 

And Assign Pricing Procedures (SIMG_CFMENUOLSDFP4) 

- A tax code in Customizing for Financial Accounting (New) under Financial Accounting Global 

Settings (New) -> Tax on Sales/Purchases -> Calculation -> Define Tax Codes for Sales and 

Purchases. 

- A condition record that the system uses to determine the tax percentage rate in SAP Menu under 

sales and distribution, under Logistics -> Sales and Distribution -> Master Data -> Conditions -> 

Select Using Condition Type -> VK11 # Create. 

In SAP ERP, you have specified the following tax settings 

- Tax categories with an access sequence in Customizing for Sales and Distribution under 

Basic Functions -> Taxes -> Define Tax Determination Rules (SIMG_CFMENUOLSDFS1). 

- Relevance of a tax category for use in taxes in Customizing for Sales and Distribution under Basic 

Functions -> Taxes -> Define Tax Relevancy of Master Records (SIMG_CFMENUOLSDOVK3). 

In SAP TM, you have specified the following settings: 

- Tax types and tax groups for a country in Customizing for Cross Application Components under 

SAP Business Partner -> Business Partner -> Basic Settings -> Tax Types and Tax Groups -> 

Define Tax Types and Tax Groups. 

- Tax type and tax group settings for a business partner under SAP User Menu -> SAP Transportation 

Management -> Transportation Management -> Master Data -> BP Maintain Business Partner -> 

Control. 
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- Countries in which you apply tax at charge type level in Customizing for Transportation 

Management under Settlement -> Tax -> Define Tax at Charge Type Level for Countries. 

- Tax types and tax groups for a country and charge type combination in Customizing for 

Transportation Management under Settlement -> Define Tax for Charges. 

Example 

You have a forwarding order in place to transport goods between country A and country B. You have 

charge types in the forwarding order for base freight and demurrage. 

According to the tax rules in country A, base freight is taxed for cargo movements between country A and 

country B, and demurrage is exempt from tax. You have 2 customers, CUSTOMER1 and CUSTOMER2, 

both based in country A. CUSTOMER2 has a special export permit and does not pay tax for base freight. 

In SAP TM, you specify CUSTOMER2 as a business partner, set an appropriate tax type and the tax 

group, and indicate that CUSTOMER2 is exempt from tax. 

You use these settings to specify whether or not SAP ERP applies tax to the business partner. You use the 

mapping for the charge type to specify that base freight is included in tax and demurrage is exempt. 

To achieve this in the system, in Customizing for Cross Application Components under SAP Business 

Partner -> Business Partner -> Basic Settings -> Tax Types and Tax Groups, you specify the following 

settings: 

 - In the Define Tax Types view: 

 Country Tax Type Description BPs Sequence 

 A MWST European VAT X 1 

- in the Assign Business Partner Tax Groups view: 

Country Tax Type Tax Group Description 

A MWST FULL Full tax applicable 

A MWST NONE No tax applicable -  exempt 

You can enable your tax settings at charge category level, charge subcategory level, or charge type level. 

You decide to enable your tax settings at charge type level, to enable you to manage individual tax types 

at a detailed level. In Customizing for Transportation Management under Settlement -> Tax -> Define 

Tax at Charge Type Level for Countries, you specify the following settings: 

- In the Choose Country for Tax Definition view: 

 Country Tax at Charge Type 

 A YES 

 - In the Assign Tax Settings to Charge Types view: 

 Country Charge TypeDescription of Charge type Tax Type Direction Tax Group 

 A FB00 Base Freight MWST ExportFULL 

 A DEMU Demurrage or waiting charges MWST ExportNONE 
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In this Map SAP TM Tax Settings Customizing activity in SAP ERP, you specify the following settings: 

- In the Assign Tax Settings for Business Partners view 

 Country Tax Type Tax Group 

Classification 

Tax Category Tax 

 A MWST FULL MWST 1 

 A MWST NONE MWST 0 

- In the Assign Tax Settings for Charge Types view   

 Country Tax Type Tax Group 

Classification 

Tax Category Tax 

 A MWST FULL MWST 1 

 A MWST NONE MWST 0 

When you transfer a forwarding settlement document from SAP TM to SAP ERP, SAP ERP uses this 

information to map the tax type and tax group in SAP TM to the tax category and tax classification in 

SAP ERP. SAP TM transfers the following information to the KOMFKGN communication table in SAP 

ERP: 

- Business partner information to fields TAXK1 to TAXK9 in the structure KOMK. SAP ERP uses 

these fields for the tax classification information for the customer. 

- Charge type information to fields TAXM1 to TAXM9 in the structure KOMP. SAP ERP uses these 

fields for the tax classification information for a material. 

37.5.2.3.2 Activate BAdI Implementation for Mapping Organization Country for 

Creation 

Use 

Activate this BAdI implementation to automatically use the country of the sales organization or the 

company for tax determination. 

When you transfer a forwarding settlement document from the SAP Transportation Management (SAP 

TM) system, the system automatically maps the country key of the sales organization to the ALAND field 

in the business add-in (BAdI) Creation of SD Billing Document. To access the BAdI, go to transaction 

se18, and specify a BAdI name of TCM_SE_CFIRSUITE_RQ. The implementation automatically uses 

the country key. 

Requirements 

- You are using SAP Transportation Management 9.1 or above. 

- You are using tax determination on SAP ERP Sales and Distribution for performing tax 

determination on the SD Billing document. 
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37.5.2.3.3 Activate BAdI Implementation for Mapping Org. Country for 

Simulation 

Use 

Activate this BAdI implementation to automatically use the country of the sales organization or the 

company for print preview for tax determination. 

When you preview a print in a forwarding settlement document in the SAP Transportation Management 

(SAP TM) system, the system automatically maps the country key of the sales organization to the 

ALAND field in the business add-in (BAdI) definition 

TCM_SE_CFIRSUITE_SIMRQ. To access the BAdI, go to transaction se18 and specify a BAdI name of 

TCM_SE_CFIRSUITE_SIMRQ. The implementation automatically uses the country key. 

Requirements 

- You are using SAP Transportation Management 9.1 or above. 

- You are using tax determination on SAP ERP Sales and Distribution for performing tax 

determination on the SD Billing document. 

37.5.2.4 Mapping for Cost Distribution 

37.5.2.4.1 Assign SAP TM Charge Types to SAP ERP Condition Types 

Use 

In this Customizing activity, you can assign a transportation charge type in SAP Transportation 

Management (SAP TM) to a condition type in SAP ERP for cost distribution. This setting is needed for 

shipper scenarios in SAP TM where the freight cost distribution is activated with the TM freight 

settlement document (FSD) to SAP ERP item. The SAP ERP system uses this assignment/mapping when 

processing the Agency business document for processing the distributed freight cost posting to 

Financials. 

Requirements 

You have defined the condition types in the SAP ERP system in Customizing for Logistics General under 

Agency Business -> Basic Settings -> Define Price Determination Process -> Define condition Type. 

37.5.2.4.2 Assign TM Sales Org. Unit to Internal Order/Cost Center 

Use 
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In this Customizing activity, you can assign a sales organization unit in SAP Transportation Management 

(SAP TM) to an internal order/cost center in SAP ERP. 

This setting can be made when for example a Logistic service provider wants to use an internal order or 

cost center to collect any of the following: 

1. The customer billing amount 

2. Internal costs due to Intercompany settlement process 

3. Internal costs due to Intra company settlement process. 

In this case of internal settlement the internal order or cost center associated with the Sales organization 

are the cost receivers. 

This customizing setting is mandatory when doing an intra company settlement process. 

Requirements 

You have defined the internal order/cost center in the SAP ERP system. 

37.5.2.4.3 Posting via Settlement Management 

37.5.2.4.3.1 Define Application and Posting Type 

Use 

Each application that needs to use the posting engine of Settlement Management must first create an 

application. The application is used to separate different users of the tool from each other. All Business 

Add-Ins (BAdIs) use the application as a filter value. SAP applications that use the posting engine 

deliver applications. The namespaces X*, Y* and Z* are reserved for partners and customers that use the 

posting engine in their own projects. 

For each application, posting types can be defined. They allow detailed control of the customizing used to 

create Settlement Management documents. 

37.5.2.4.3.2 Basic Settings for Creation of Settlement Management Documents 
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Use 

Here you can specify the customizing used for creation of Settlement Management documents. You have 

to specify settlement process types and settlement document types. If you input calculation procedures, 

the procedure determination in Settlement Management is overruled. Some of the keys of this table are 

set in BAdI Determine Fields That Control Settlement Management Document Creation. See the 

documentation of this BAdI for more details. 

37.5.2.4.3.3 Business Add-Ins (BAdIs) 37.5.2.4.3.3.1 BAdI: Determine Fields 

That Control Settlement Management 

Document Creation 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to set fields that control the creation of 

Settlement Management documents via the posting engine. Based on a posting item the implementation 

must specify: 

- Whether pricing is used on the sales side or purchase side, by setting field KAPPL of the control 

structure to IF_WZRE_POSTING_CONST=>KAPPL-PURCHASE or 

IF_WZRE_POSTING_CONST=>KAPPL-SALES. 

- The Use Case Type used by Settlement Management to perform the postings, by setting a value in 

field USE_CASE. 

- The Document Category (invoice or settlement) by setting field AB_DOC_CAT to 

IF_WZRE_POSTING_CONST=>AGENCY_DOC_CATEGORY-INVOICE or 

IF_WZRE_POSTING_CONST=>AGENCY_DOC_CATEGORY-SETTLEMENT. 

- A Posting Type, by setting field EXT_POST_TYPE to a value defined in customizing table Posting 

Types for this application (optional). 

If SAP itself is using the posting engine, it delivers an implementation of this BAdI. You can still provide 

an additional implementation (by specifying the BADI Implementation Owner customer or partner) that is 

called after the SAP implementation. You are free to change the SAP result provided in table 

CT_AB_CONTROL_FIELDS. If you use the posting engine with your own application in a project, you 

must implement this BAdI. 

Normally, table CT_AB_CONTROL_FIELDS is filled with one entry. We provide a table here to support 

creation of multiple Settlement Management document items for one posting item. If you have, for 

example, the requirement to create an invoice and a settlement item for one posting item, you just have to 

fill table CT_AB_CONTROL_FIELDS with two entries, using the document categories invoice and 

settlement. 

Standard settings 
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In the standard system, there are activated BAdI implementations for the filter value application delivered 

by SAP. The BAdI is designed for multiple use. 

The system calls up and executes all active implementations with matching filter values. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

 IF_WZRE_DET_CONTR_FIELDS_BADI ~DETERMINE_AB_CONTROL_FIELDS 

37.5.2.4.3.3.2 BAdI:Map External Condition Description to Condition Type 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. This BAdI enables you to determine the condition type from an 

external representation. An external application may use a structure to identify a condition type. The 

mapping from external to internal representation must be provided in this BAdI, by each relevant 

application. If you just use an SAP application that uses the posting engine itself, you do not need to 

implement this BAdI. In this case, the mapping from external to internal representation has already been 

provided by SAP. Since this is a single-use BAdI with application as a filter value, an error would occur. 

Only in cases where you define your own application (X*,Y*, and Z* namespaces) do you have to 

implement it. An exception is if the external representation is identical to the internal one. Then it is not 

necessary to implement the BAdI, since we provide a fallback class that just copies the condition type. 

Standard settings 

The BAdI is designed for single use. 

The system calls up and executes the one active implementation with a matching filter value. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

 IF_WZRE_MAP_COND_TYPE_BADI ~MAP 
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37.5.2.4.3.3.3 BAdI:Map Partner From External to Internal Representation 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. This BAdI enables you to determine a partner from an external 

representation. Partner function, partner type, and partner can be specified in an external format. If the 

internal and external format are identical, a BAdI implementation is not necessary since we provide a 

fallback class for this case. If you just use an SAP application that uses the posting engine itself and 

supports partners, you do not need to implement this BAdI. In this case, the mapping from external to 

internal representation has already been provided by SAP. Since this is a single-use BAdI with 

application as a filter value, an error would occur if you tried to implement it. Only in cases where you 

define your own application (X*, Y*, and Z* namespaces) do you have to implement it. 

Standard settings 

The BAdI is designed for single use. 

The system calls up and executes the one active implementation with a matching filter value. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

 IF_WZRE_MAP_PARTNER_BADI ~MAP 

37.5.2.4.3.3.4 BAdI:MapText Identificator 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. This BAdI enables you to determine a text ID from an external 

representation. If the internal and external format are identical, a BAdI implementation is not necessary 

since we provide a fallback class for this case. If you just use an SAP application that uses the posting 

engine itself and supports texts, you do not have to implement this BAdI. In this case, the mapping from 

external to internal representation has already been provided by SAP. Only in cases where you define 

your own application (X*, Y*, and Z* namespaces) do you have to implement it. 

Standard settings 

The BAdI is designed for single use. 

The system calls up and executes the one active implementation with a matching filter value. 
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Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

 IF_WZRE_MAP_TEXT_ID_BADI ~MAP 

37.5.2.4.3.3.5 BAdI:Infer Posting Item Fields 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to set fields in the header and item input 

structures used by Settlement Management, based on data that was passed to the engine. Normally it is 

not necessary to implement transfers in this BADI. The transfer of the input fields to the input structures 

in Settlement Management is handled by the posting engine. 

This BAdI gives you the opportunity to set additional fields, or change settings made by the posting 

engine. If you need additional input fields in the input structure 

WZRE_S_POSTING_ITEM_INPUT (posting data provided as input) you can add them via append to 

structure WZRE_S_HEADER_ENH for header fields, and to structure WZRE_S_ITEM_ENH for item 

fields. If you add the fields with the same name and type as specified in WZRE_S_HEADER_FIELDS 

for header fields and WZRE_S_ITEM_FIELDS for 

item fields, it is not necessary to use this BAdI to transfer data. The posting engine transfers data via 

MOVE-CORRESPONDING from the customer add-on structures into the input structures in Settlement 

Management. 

Standard settings 

The BAdI is designed for multiple use. 

The system calls up and executes all active implementations with matching filter values. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 
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See also 

IF_WZRE_INFER_ITEM_FIELDS_BADI~INFER_FIELDS 

37.5.2.4.3.3.6 BAdI:Infer Condition Fields 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to set fields in the condition input 

structure used by Settlement Management, based on condition data that was passed to the engine. 

Normally it is not necessary to implement transfers in this BADI. The transfer of the condition input 

fields to the input structure in Settlement Management is handled by the posting engine. This BAdI gives 

you the opportunity to set additional fields, or change settings made by the posting engine. 

Standard settings 

The BAdI is designed for multiple use. 

The system calls up and executes all active implementations with matching filter values. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

IF_WZRE_INFER_COND_FIELDS_BADI~INFER_FIELDS 

37.5.2.4.3.3.7 BAdI:Transfer Purchase Order Data 

Use 
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You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to transfer purchase order data to the 

header structure and to the item structure. 

Standard settings 

The BAdI is designed for multiple use. 

The system calls up and executes all active implementations with matching filter values. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

IF_WZRE_TRANSFER_PO_DATA_BADI~TRANSFER 

37.5.2.4.3.3.8 BAdI:Transfer Sales Order Data 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to transfer sales order data to the header 

structure and to the item structure. 

Standard settings 

The BAdI is designed for multiple use. 

The system calls up and executes all active implementations with matching filter values. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

IF_WZRE_TRANSFER_SO_DATA_BADI~TRANSFER 
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37.5.2.4.3.3.9 BAdI:Transfer Delivery Data 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to transfer delivery data to the header 

structure and to the item structure. 

Standard settings 

The BAdI is designed for multiple use. 

The system calls up and executes all active implementations with matching filter values. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

IF_WZRE_TRANSFER_OD_DATA_BADI~TRANSFER 

37.5.2.4.3.3.10 BAdI:IV adjustment BAdI 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine. The BAdI enables you to influence the value of correction 
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Settlement Management documents that are created if the invoice verification value differs from the 

purchase order value. 

Standard settings 

The BAdI is designed for single use. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also 

IF_WZRE_IV_ADJUSTMENT_BADI~ADJUST 

37.5.2.4.3.3.11 BAdI: Assign A Condition Type to a Service Item 

Use 

You can use this Business Add-In (BAdI) of component Settlement Management (LO-AB) for 

components that use the posting engine for the transportation management integration. The BAdI is called 

when an invoice verification is created for a transportation management created service purchase order on 

service package item level. The BAdI enables you to set a condition type for a service package line. If 

you set it, correction postings triggered by the invoice verification differences, will only copy conditions 

with the specified condition type. This algorithm is meant for cases, where the system is setup in a way 

that each service package line represents one cost factor that is assigned to one condition type. The BAdI 

has as input values the purchase order header and item, service package header and service package line. 

The return value is the condition type. 

Standard settings 

The BAdI is designed for single use. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 
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37.5.2.4.4 Activate BAdI Implementation for Invoice Verification Correction 

Postings 

Use 

Activate this BAdI implementation to enable correction postings from invoice verifications for service 

purchase orders created by the Transportation Management integration. It corrects postings in Settlement 

Management triggered from the service purchase order in the case of invoice differences. 

37.6 Extended Warehouse Management 

37.6.1 Basic Settings for Setting Up the System Landscape 

37.6.1.1 Name Logical System 

In this step, you can define the logical systems in your distributed system. 

Caution 

Logical systems are defined cross-client. 

Activities 

1. To create a logical system, choose Edit -> New Entries. 

2. Enter a name for the logical system that you want to create. 

3. Enter a description of the logical system. 

If you want to change this entry: 

a) Select the appropriate line. 

b) Choose Edit -> Change field contents. 

c) Enter the new text. 

d) Choose Replace. 

4. Save your entries. 
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Further notes 

To enable the transfer of data via APO Core Interface (CIF), you need to name both the ERP system in 

which you are working and the SAP APO system to which you want to transfer data as logical systems. 

Note that you also have to carry out these steps in SAP APO. The names of the logical systems need to 

correspond in the ERP system and in SAP APO (that is, the name that is defined for SAP APO in SAP 

APO must be specified as the logical target system in the ERP system, and the name defined for ERP in 

the ERP system must be specified as the logical target system in SAP APO). 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.6.1.2 Assign Logical System to a Client 

In this work step, you assign a client to each logical system. 

Actions 

1. Select one line. 

2. Choose: Goto -> Details. 

The 'Client Details' screen appears. 

3. In the field Logical system, enter the name of the logical system to which you want to assign the 

selected client. 

4. Save your entries. 

Notes on the transport 

These settings cannot be transported. When a new system is being set up, these settings must be made 

after the system installation has been completed. 

Note that you also have to carry out these steps in SAP APO. The names of the logical systems need to 

correspond in the ERP system and in SAP APO (that is, the name that is defined for SAP APO in SAP 

APO must be specified as the logical target system in the ERP system, and the name defined for ERP in 

the ERP system must be specified as the logical target system in SAP APO). 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.6.1.3 Specify SAP APO Release 

Use 
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In this IMG activity, you specify the release level of the SAP APO system that is defined as the target 

system. 

Requirements 

The target system must be defined under Name Logical Systems. 

Activities 

1. Under LogSystem, enter the target system defined under Name Logical System (for example, 

AP4CLNT000). 

2. Under System Type, enter SAP_APO. 

3. Under Release, use input help to choose the relevant release. 

Further notes 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.6.1.4 Set Up RFC Destination 

Use 

In this IMG activity, you create the connection to SAP APO. The name of the RFC destination has to 

match exactly the name of the logical target system that was already specified. 

Requirements 

The target system must have been defined under Name Logical Systems. 

Activities 

1. Open the ABAP Connection node. 

2. Choose Create. The RFC Destination screen is displayed. 

3. Enter the following: 

- RFC Destination: Enter the name of the logical target system specified in the IMG activity 

Name Logical Systems. 

- Connection Type: Use the input help to choose the relevant connection type. In most cases, 

choose connection type 3. 

- Enter a description. 

4. Enter the following information on the Technical Settings tab page: 

- Load Distribution: Choose the required setting. 

- Target Machine: You can determine the destination of the target machine as follows: 
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Call SAPlogon from the Start menu. 

Choose Server. 

Copy the server ID from the Message Server entry field. 

- System Number: You can determine the system number of your target system as follows: 

Call SAPlogon from the Start menu. 

Select your target system. 

Choose Properties. You see a dialog screen in which the system number is specified. 

5. Enter the following information on the Logon/Security tab page: 

- Under Logon, define the security options. 

- Language: Optional 

- Client: Use the input help to select the relevant client. The client to be configured depends on 

the current authorization profile of the user (Customizing). 

- User: User-defined. The user entered here must also be created in the target system (SAP 

APO) with the corresponding authorization profile. If you want to perform cross-system 

debugging, the relevant user must be created in the target system as a dialog user with 

debugging authorization. 

- Password: User-defined: Default setting at delivery: initial. 

6. Specify how you want to communicate with the target system on the MDPM & Unicode tab page. 

7. Choose your options on the Special Options tab page: 

- Trace: Optional 

- Slow RFC Connection: Optional 

- qRFC Version: Choose Classic qRFC Version. 

8. In the menu under Edit, choose the option tRFC Options. Under Connection Attempts Until Stop 

enter a value less than or equal to 10. In the Time Between 2 Attempts [Min] field, enter the value 2. 

Confirm the entry with Continue. 

9. The connection test is optional. 

Further notes 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.6.1.5 Assign RFC Destinations to Different Application Cases 

Use 
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The integration via APO Core Interface (CIF) is mostly based upon data transfers between the systems 

that run in the background without user interaction. However, in some application cases (for example, the 

availability check), it may be necessary for the user to access data in the target system using a 

synchronous remote function call (RFC). In these application cases, it is beneficial to use different RFC 

destinations with different user authorizations. By doing this, you can restrict user authorizations for 

executing certain actions in the logical target system to certain application cases. 

You make the assignment in this IMG activity. 

Note that the setting(s) that you make in this IMG activity depends on the relevant target system. For this 

reason, there is no transport to the production system. Therefore, you must also carry out this step in the 

production system for the relevant target system. 

Requirements 

The target system must be defined under Name Logical System. 

The RFC destination must be created under Set Up RFC Destination. 

Activities 

- Use input help to choose an application case for the logical system specified. 

- Assign this application case to the required RFC Destination. 

37.6.1.6 Set Target System and Queue Type 

Use 

In this IMG activity, you add the target system that you have already defined to the definition of the RFC 

destination for the transfer. The data transfer using the APO Core Interface is made with queued remote 

function call (qRFC) technology. This means that the data is stored temporarily in queues. The queue 

type (inbound or outbound) determines whether the queues processing is controlled by the sending or 

receiving system. In this step, you can set the queue type for the target system specified. 

Requirements 

- Your own system and target system must be defined under Name Logical Systems. 

- The RFC destination must be defined. 

Activities 

1. Under LogSystem, enter the target system for the transfer. To identify the target system, enter the 

name that you entered earlier as the RFC destination. 

2. The current operating mode is automatically determined by the system. 
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3. Set a queue type for the data transfer to the target system. Use input help to choose between inbound 

and outbound queues. The system chooses outbound queues by default. 

Further notes 

Note that the setting(s) that you make in this IMG activity are dependent upon the target system 

concerned. For this reason, there is no transport to the production system. As a result, you need to also 

make the settings for the relevant target system in the production system. 

37.6.1.7 Settings for qRFC Communication 

37.6.1.7.1 Configure qRFC Communication 

Use 

You can use the scheduler settings for inbound and outbound queues to configure communication using 

queued remote function call (qRFC) and therefore control the management and monitored processing of 

qRFCs. 

qRFC communication allows asynchronous communication with transactional security and a serialization 

of calls. qRFC communication is used intensively in the SAP APO Core Interface to transfer logistical 

data online and thus retain the transactionality and sequence. 

Inbound qRFCs are processed using the QIN scheduler, outbound ones by the QOUT scheduler. 

The asynchronous transfer to SAP APO of logistical data relevant to planning is based on qRFC 

communication. If this is not configured correctly, processing does not take place. This means that 

planning data is not exchanged and consistent planning is no longer possible. 

Requirements 

To avoid problem situations, we recommend that you use the current qRFC version. For more 

information, see SAP Note 438015. 

The qRFC is delivered as part of SAP Basis or implemented in Support Packages. An update is also 

possible using a special transport. For more information, see SAP Notes 481278 and 438015. 

Activities 

You make the settings for the necessary profile parameters in transaction RZ12. 

- Call transaction RZ12. 

- Double-click on a server group. A dialog window is displayed in which you can set the 

following parameters (as of SAP R/3 4.5B): 

- Activated (0 or 1): 1 

- Max. requests in queue: 5 

- Max. number of logons: 90 
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- Max. number of own logons: 25 

- Max. number of WPs (work processes) used: 75 

- Min. number of free WPs: 1 

- Max. number of comm. entries: 90 

- Max. wait time : 10 (as of SAP R/3 4.6C) 

Use SAP Note 74141 to fill the parameters for the system concerned. Note that all entries apart 

from Activated and Min. number of free WPs must be in percent. The number of work processes 

(WPs), that may be used by qRFC is determined using the following formula: 

- (Number of all dialog WPs - minimum number of free WPs) x maximum number of WPs used 

/ 100. 

If this figure is too small, it is not possible to use communication via qRFC. 

Example 1: 

There are a total of 7 dialog WPs in a system, the minimum number of free WPs is 2, and 

the maximum number of WPs used is 6. The number of WPs that can be used is calculated 

as follows: (7-2) x 6/100 = 0.3. In this case, communication using qRFC is not possible. 

Example 2: 

There are a total of 10 dialog WPs in a system, the minimum number of free WPs is 2, and 

the maximum number of WPs used is 75. The number of WPs that can be used is calculated 

as follows: (10-2) x 75/100 = 6. In this case, communication using qRFC is possible. 

Other profile parameters 

Note that qRFC calls are processed in work processes of the type DIALOG (exception: inbound queues). 

As a result, the DIALOG restriction for processing a dialog step (standard 300 seconds, system profile 

parameter rdisp/max_wprun_time) also applies to these RFC calls. On every sever that is available for 

processing parallel RFCs, more dialog work processes must be configured than non-dialog work 

processes. For more information, see SAP Note 74141. 

37.6.1.7.2 Set QOUT Scheduler 

Use 

The data transfer via APO Core Interface (CIF) occurs using queued Remote Function Calls (qRFC). 

Outbound qRFCs (outbound queues) are processed by the QOUT scheduler. 

The QOUT scheduler is called using transaction SMQS. The destinations to which the outbound qRFCs 

are to be sent are registered in the QOUT scheduler. As of version 6.20.45 this occurs automatically. 

There are the following options for a registered destination: 

- Type 

- R: The destination is registered; that is, it is started using the QOUT scheduler. 

- U: The destination is not registered; that is, it is not processed. 
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- N: The destination is not registered using the QOUT scheduler, it is sent at the time of the COMMIT 

WORK. 

- Max. Connections: Number of connections used to send the qRFC. The default value for ABAP 

connections is 10, for TCP/IP connections it is 1. 

- Max. Runtime: Time that a destination is processed by the QOUT scheduler. The default value is 60 

seconds. 

- The destination NONE leads to processing at the local system and should not be registered until 

version 6.20.45, supplement 8 inclusive. As of supplement 9, NONE may be registered and the 

without tRFC option set. 

Requirements 

qRFC communication must be configured. For more information, see Configure qRFC Communication. 

37.6.1.7.3 Set QIN Scheduler 

Use 

The data transfer via APO Core Interface (CIF) occurs using queued Remote Function Calls (qRFC). 

If you are working with inbound queues, incoming qRFCs are processed by the QIN scheduler. 

The QIN scheduler is called using transaction SMQR. In contrast to the QOUT scheduler, only queue 

names are registered in the QIN scheduler, not destinations. The registration is not made automatically; 

have to do this yourself. If a queue is not registered, it is not processed (that is, there is no transfer). 

Requirements 

qRFC communication has to be configured. For more information, see Configure qRFC Communication. 

Activities 

- Call transaction SMQR and choose Registration. 

- Enter the queue name CF* and make the required settings. 

- EXEMODE: Execution mode (D - Dialog work process; B - Batch work process) 
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- MAXTIME: Maximum runtime that the QIN scheduler uses for activating a destination; default 

value: 60 seconds 

- USERDEST: RFC destination with LOGON data. Entry of a logical destination with own language 

on a local system. With this, the burden of integration can be distributed to a server group. 

- NRETRY: Number of repetitions for failed calls, default value: 30 

- RDELAY: Wait time between individual calls, default value: 300 

37.6.1.7.4 Set Up qRFC Administration for CIF Queue Display 

Use 

If faulty queue entries occur in the data transfer via APO Core Interface (CIF), you can use CIF queue 

display to view the contents of the queues and carry out follow-up processing for the objects affected. 

In this IMG activity, you set up qRFC administration in such a way that you can call CIF queue display 

from the qRFC monitor. To do this, you have to register the program CIFQEV02 as the display program 

for CF* queues. 

Requirements 

If you are working with outbound queues and want to navigate from the queue contents display to the 

relevant application log entries in the target system, you need to enter a dialog user in the RFC destination 

in user maintenance (transaction SU01) or you can use a flexible RFC destination with a dialog user. For 

more information, see Assign RFC Destination to Different Application Cases. 

Activities 

- Call transaction SMQE. 

- Choose Edit and Register Display Program. 

- Enter CF* as the queue name and CIFQEV02 as the program name. 

37.6.1.7.5 Configure CIF Queue Display on a User-Specific Basis 

Use 

In CIF queue display, an individual list is generated for each table to be transferred (that is, for each 

interface parameter). 
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In this IMG activity, you set how many lists are displayed on each page for a certain user. This setting 

influences the performance of CIF queue display. 

Requirements 

For more information on CIF queue display, see Set Up qRFC Administration for CIF Queue Display. 

STANDARD_SETUP& 

The value 10 is set as standard. 

Activities 

- Enter the name of a user and choose Change. 

- Choose the Parameters register card. 

- Enter the parameter CF8 and enter the required number of lists for each page as a value. You can 

enter values between 1 and 19. If you enter an invalid value, the system chooses the default value 

10. 

37.6.2 Basic Settings for Data Transfer 

37.6.2.1 Set User Parameters 

Use 

In this IMG activity, you can make user-specific entries for the following parameters: 

- RFC mode (activate/deactivate transfer on a user-specific basis) 

- Logging (configure application log on a user-specific basis) 

- Debug (activate/deactivate debugging on a user-specific basis) 

Requirements 

The settings for setting up the system landscape must already have been made. 

Activities 

1. Enter the user name specified in the user master. 

2. Use input help to make the relevant settings for this user. 

37.6.2.2 Configure Application Log 
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Use 

Every data transfer via APO Core Interface (CIF) is recorded in a transfer log. The transfer log is 

analyzed in the ERP system in the CIF application log by using transaction CFG1. 

In this IMG activity, you configure the CIF application log so that only the object types you select 

containing the most important statistics are logged (individual tables of an object type and individual 

fields for the corresponding tables). By restricting the logging process in this way, you can improve 

system performance. 

In particular, we recommend that you restrict the number of object types to be logged if you have selected 

the Detailed Logging option under Logging in the Set User Parameters IMG activity. 

Requirements 

In the IMG activity Set User Parameters, Detailed Logging must be set under Logging for the relevant 

user. 

Standard settings 

The interface parameters needed most often in the CIF application log are already set by default. 

Activities 

1. Select the object type for which you want to make the field selection and navigate to the associated 

interface parameters. 

2. Select a parameter and navigate to field selection. 

3. Select the fields that are to be displayed in the application log. 

4. Save your entries. 

37.6.2.3 Specify Destination SAP EWM Systems for Batches on Plant 

Use 

In this Customizing activity, you specify the SAP Extended Warehouse Management (SAP 

EWM) systems to which you want the Core Interface (CIF) to transfer the classification data of batches at 

plant level. 

Note 
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You can use this Customizing activity only for SAP EWM systems 9.4 and higher that do not run any 

other SCM applications in the same system. 

Requirements 

- You are using SAP EWM 9.4 and higher. 

- You have entered the SAP EWM destination systems in the Customizing activity Specify SAP APO 

Release. 

- You have activated the enhancement implementation CIF Transfer of Batches at Plant Level to SAP 

EWM. 

37.6.2.4 Configure Entries in Application Log 

37.6.2.4.1 Define Variant 

Use 

In this IMG activity, you define a variant for the program RDELALOG. 

We recommend that you delete entries in the application log at regular intervals for performance reasons. 

You can do this by using transaction CFGD or by scheduling a regular job for program RDELALOG, 

upon which the transaction is based. To do this, you first need to save a variant of the RDELALOG 

program. 

Standard settings 

By default, no variants are created. 

Activities 

- Call the RDELALOG program and choose Execute. - Fill the entry fields according to your 

requirements. 

- Under Goto, choose the option Variants and click on Save as Variant.... 

- Enter a name for the variant and choose Save. 

Notes 

If you do not specify a date and the time remains blank, the system deletes all entries in the application 

log that are older than seven days. 
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You can set the logging for the data records that are transferred by using Set Application Log on User-

Dependent Basis. You make these settings in the Set User Parameters IMG activity. 

37.6.2.4.2 Schedule Job 

Use 

In this IMG activity, you schedule a job for the regular archiving (deletion) of entries in the application 

log. 

For more information on usage, see Define variant. 

Requirements 

You have created a variant for the program DELALOG. 

Standard settings 

By default, a job is not planned. 

Activities 

- Define a job with the step RDELALOG and the variant you have maintained. 

- Schedule the job as a periodic job. For this, the periods have to be adjusted to your requirements (for 

example, hourly, daily). 

- Save the job. 

- Create a job for each previously defined variant. 

37.6.2.5 Initial Data Transfer 

37.6.2.5.1 Determine Number Ranges for Parallelization 

Use 

In this IMG activity, you define the number range for parallelized initial data transfer (number range 

object CIF_LOAD). 

You can activate parallelized transfer under Activate integration model. 

If you start several initial data transfer runs in parallel, the system identifies the individual transfer runs 

using one unique, four-figure number that is part of the queue name. 

Example 
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Queue names for parallelized initial data transfer. 

CFLDQW8CLNT150_1234ORD01: This refers to a parallelized initial data transfer for orders (ORD) 

from system QW8, client 150. The transfer run was allocated the number 1234 from the number range 

interval for parallelized initial data transfer runs. 

Activities 

Make sure that number range 1 has been created for the parallelized initial data transfer. Note that this is 

an interval with internal number assignment. 

We recommend that you set number range 1 as large as possible (for example, '0001' to '9999'). 

Further notes 

This is a rolling number range object. As a result, a transport to the production system is not critical. 

You can transport number range objects as follows: 

On the initial screen, choose Interval - Transport. 

Note that all intervals for the selected number range object are first deleted in the target system so that 

only the intervals that have been exported exist after the import. The current numbers are exported using 

the value that they possess at the time of the export. 

Dependent tables are not transported or converted. 

37.6.2.5.2 Set Filter and Selection Block Size 

Use 

You can make the following settings in this IMG activity: 

- Under FilterBlSz, you determine the number of filter objects that are processed in one block in the 

APO Core Interface. 

- Under SelectBlSz, you determine the number of data objects that are transferred to SAP APO in a 

remote function call (RFC) at the initial data transfer. 

You can use these settings to improve system performance during the initial data transfer. The optimum 

values for improved performance vary from case to case and are largely dependent upon the current data 

situation. Therefore, you are recommended to experiment with the settings in individual cases in your 

system. 

For more information, see the field help for the relevant columns. 

Activities 

1. Choose New Entries. 

2. Use input help to select the object type for which the settings are to apply. The system automatically 

adds the relevant text. 
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3. Enter the number of objects of this type that are to be processed in each block. 

4. Enter the number of data object that are to be selected per block for each filter object of this type. 

Special Case - Master Data: 
If the data to be selected is master data, only one data object is ever selected for the corresponding 

filter object. This means that the block size for filter objects corresponds to the block size for data 

selection. If you make a different entry here, it is ignored by the system. 

37.6.2.5.3 Generate Integration Models 

Use 

In this step, you generate an integration model for the transfer of data via APO Core Interface 

(CIF). In general, you do not need all the master data and transaction data that exists in the ERP system to 

be able to carry out planning in SAP APO. You use the integration model to specify in the ERP system 

which data objects are to be selected from the total amount of data for the transfer to SAP APO. 

We recommend that you create a separate integration model for each object type, where possible. Master 

data and transaction data should always be handled separately. 

Requirements 

The basic settings for setting up the system landscape must have been made in the systems connected via 

CIF. 

Activities 

1. Call the Create Integration Model screen. 

- Choose Logistics -> Central Functions -> Supply Chain Planning Interface -> Core 

Interface Advanced Planner and Optimizer -> Integration Model -> Create. 

- You can also call this screen using transaction CFM1. 

2. Define the integration model by making the following entries: 

- Model Name: User-defined 

- Logical System: Target system - the name should be identical with the RFC destination 

- APO Application: User-defined naming component to enable you to distinguish between 

integration models with the same model name 

3. In the left column, select the object types that you want to select (for example, material masters). 

4. Restrict the number of objects to be transferred for this object type by entering values under 

General Selection Options for Materials. These selection options are evaluated first by the 

system. 

5. You can use additional selection options to further restrict individual object types. These options are 

shown in the left screen section for each relevant object type. These selection options are only 

evaluated in second place by the system. 
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Note that performance is better when the general selection options are being evaluated. If you 

restrict a selection by material and plant, you are therefore recommended to use the general 

selection options. 

6. Choose Execute. You see a list of the filter objects contained in this integration model. CIF uses the 

these filter objects as a basis to select the data objects to be transferred to SAP APO when the 

integration model is activated. 

- Choose Consistency Check if you want to check the consistency of your integration model 

(for example, whether the relevant plants have also been selected of the material masters 

specified). 

- Choose Detail to display all objects for an object type. 

- Choose Generate IM to generate your integration model. During the generation, CIF selects 

the filter objects for preparing the actual transfer. 

7. Leave the screen using Back and save the integration model as a variant, as required. 

For more information and recommendations on how to structure an integration model, see the online 

documentation for CIF integration. 

Notes 

We recommend you schedule generation of the integration model as background processing along with 

activation and, if necessary, deletion. For more information on this, see Scheduling generation and 

activation as jobs. 

37.6.2.5.4 Activate and Deactivate Integration Models 

Use 

In this step, you activate the integration models that you have already generated. When you carry out this 

activation, the system selects the data objects that match the filter objects contained in the integration 

model and transfers them to SAP APO. When you activate the integration models, you trigger the initial 

data transfer of master and transaction data to SAP APO and make the online transfer of transaction data 

possible. 

Activities 

1. Choose Logistics -> Central Functions -> Supply Chain Planning Interface -> Core Interface 

Advanced Planning and Optimizer -> Integration Model -> Activate. You can also call this 

screen using transaction CFM2. 
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2. Select the integration model to be activated using the input fields Model, Logical System, and 

APO Application. 

If you only enter the name of the integration model, all integration models with the same name are 

returned in the results list (that is, all versions of this model are displayed). Only one version may 

be active at one time. 

3. Make the following settings, as required: 

- Log Deactivated Material Masters 

- Do Not Issue Warning in the Case of Parallel CIF Load 

- You can use the Parallelized Transfer input fields to influence the performance of the 

transfer. Make the relevant settings by using the input help (F4). Note that you need to define a 

number range for parallelized transfer. For more information about this, see Defining number 

ranges for parallelization. 

- Create Planned Orders as SNP Planned Orders 

- Create Business Partners 

4. Choose Execute to get to the results screen. 

You can use Detail to show columns with information about the individual filter objects. You can 

use the Hide Empty Columns icon to restrict the columns to those that contain entries. 

5. Set the required integration model to active by using Active/Inactive or by clicking New Status. 

You can set active integration models to inactive in the same way. 

6. Start the actual activation, in other words, data transfer, by using Start. The system displays the 

status of each integration model before the activation or deactivation in the Prev. Status column. 

7. The system transfers the selected data to SAP APO. 

Further notes 

Check material master data for APO indicators 

In general, all material master data that is transferred to SAP APO when an integration model is activated 

contains the indicator for SAP APO relevance. However, it may occur that material master data that you 

have included in an integration model is locked during activation (for example, because it is currently 

being processed in the ERP system). This data no longer has an APO indicator after the activation. If the 

activation was made in dialog mode, you receive a message informing you of the material/plant 

combination affected. If the activation was made in the background, you can find a corresponding entry 

in the application log. To ensure that these materials also receive the indicator for SAP APO relevance, 

you need to run the program RAPOKZFX for the affected material/plant combinations. For more 

information, see Define variants for checking the APO indicator. 

Runtime version of the active integration models 

To improve the performance during online transfer, you can generate a runtime version from all active 

integration models for an object type and target system. For more information, see Define variant for 

generating the runtime version. 

Deactivate and delete integration models 
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Note that the deactivation of integration models does not mean that the corresponding objects in SAP 

APO are deactivated or deleted. The exception to this is deactivated material masters (see above). 

You should delete inactive integration models or versions of an integration model on a regular bases. For 

more information, see Schedule generation and activation as a job. 

37.6.2.5.5 Schedule Regular Jobs 

37.6.2.5.5.1 Schedule Generation and Activation as a Job 

Use 

Master data is constantly being changed in the ERP system. For this reason you should regularly update 

your integration model to the newest status and transfer the changes to SAP APO. You should also delete 

the old versions of the integration model on a regular basis because these can hinder performance. To do 

this, we recommend you create the following programs as periodic jobs: 

a) Generate new versions of the integration model (RIMODGEN) 

b) Activate the newest versions (RIMODAC2) 

c) Optional: Delete the old versions (RIMODEL) This procedure offers the following 

advantages: 

- Master data that has been newly created and that corresponds to the filter objects in existing 

integration models is included in those integration models and transferred to SAP 

APO. 

- Master data that was changed in such a way that it no longer corresponds to the filter objects of the 

integration model is excluded from the transfer. 

- Master data (materials, customers, vendors, sources of supply, and planning product assignment) 

that has been changed since the last transfer is updated to the most recent status and transferred to 

SAP APO. 

Recommendation 

We recommend the following sequence of activities to prevent data inconsistencies that may arise if 

APO-relevant master data is created during the generation and activation of a related integration model: 

Generation 

1. Integration model for transaction data (for example, planned orders) 

2. Integration model for master data with dependent objects (for example, production process models) 3. 

Integration model for master data (for example, material, plant) 
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Activation 

1. Integration model for master data 

2. Integration model for master data with dependent objects 

3. Integration model for transaction data 

Activities 

1. Create a variant for the relevant program: 

- Use transaction SE38 to call the ABAP/4 Editor. 

- Enter the name of the report for which you want to create a variant. 

- Under Subobjects choose the option Variants and then Create. 

- Enter a name for the variant and choose Create. 

- Fill the entry fields as required. 

- Save your entries. 

- Enter the attributes for the variant. 

- Save the variant. 

2. Schedule the program as a job: 

- Define a job using the program name and the variant you have maintained. 

- Schedule the job as a periodic job. 

- Save the job. 

- Create a job for each variant that you have previously defined. 

Further notes 

We recommend that you schedule this sequence of jobs for each integration model for which ALE change 

pointers are written for the objects. These objects include: 

- Material masters 

- Vendors 

- Customers 

- Planning product assignment 

- Sources of supply 

Note that for changes to conversion factors for currencies, all sources of supply have to be 

retransferred if you want to use cost optimization in SAP APO. To do this, you use program 

RIMODINI. 

For more information, see  Scheduling periodic transfers with change pointers. 
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37.6.2.5.5.2 Check Material Master Data for APO Indicators 

37.6.2.5.5.2.1 Define Variant 

Use 

You can use program RAPOKZFX to ensure that the materials contained in an integration model have 

received the indicator for APO relevance during the activation of the integration model. For more 

information, see Activating and Deactivating Integration Models. 

We recommend that you run this program as background processing. For this, you first have to define a 

variant and then schedule this as a background job. 

Standard settings 

No variants are created as standard. 

Activities 

- Choose Execute. 

- Fill the entry fields according to your requirements. 

- Under Goto, choose the options Variants and  Save as Variant.... 

- Enter a name for the variant and choose Save. 

37.6.2.5.5.2.2 Schedule Job 

Use 

In this IMG activity, you schedule a regular job for the variant of program RAPOKZFX that you have 

already created. For more information, see Schedule a Variant. 

Requirements 

A variant must have been created for program RAPOKZFX. 

Standard settings 

A job is not scheduled by default. 

Activities 

- Define a job with the step RAPOKZFX and the variant that you have already maintained. 

- Schedule this job as a periodic job and adjust the time periods to meet your requirements (for 

example, hourly, daily). 

- Save the job. 

- Create a job for each variant that you have previously defined. 
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37.6.2.5.5.3 Generate Runtime Version for Active Integration Models 

37.6.2.5.5.3.1 Define Variant 

Use 

The runtime version of the active integration model is generated using program RCIFIMAX and is used 

to improve performance. 

In this IMG activity, you define a variant of program RCIFIMAX with the Consistency Check indicator. 

You can then use this variant to schedule the consistency check as background processing. In this way, 

you ensure data consistency between the active integration models and the runtime version of this 

integration model. 

Standard settings No variants 

are created as standard. 

Activities 

- Choose Execute. 

- Under Goto, choose the options Variants and Save as Variant.... 

- Enter a name for the variant. 

- Fill the entry fields according to your requirements. 

- Save the variant. 

37.6.2.5.5.3.2 Schedule Job 

Use 

In this IMG activity you schedule as a regular job the variant of program RCIFIMAX that you have 

already created. For more information, see Define Variant. 

Requirements 

A variant must have been created for the program RCIFIMAX. 

Activities 

- Define a job with the step RCIFIMAX and the variant you have maintained. 

- Schedule the job as a periodic job and adjust the time periods to suit your requirements (for 

example, hourly or daily). 
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- Save the job. 

- Create a job for each variant you have previously defined. 

37.6.2.6 Change Transfer for Master Data 

37.6.2.6.1 Configure Change Transfer for Master Data 

Use 

In this IMG activity, you set how changes to master data are transferred to SAP APO. If you do not make 

a setting here, master data changes are not transferred to SAP APO. 

You have three options: 

- The system does not transfer changes. 

- The system transfers the changes periodically using ALE change pointers. 

- The system transfers the changes to SAP APO immediately (online transfer) using business 

transaction events (BTE). 

You can make these settings individually for material, customer, and vendor data, as well as for setup 

groups. 

For information about the initial and change transfer for resources, see Set Up the Transfer of Resources 

to SAP APO. 

Requirements 

To be able to transfer master data changes using ALE change pointers, you have to activate ALE change 

pointers generally. 

To be able to transfer master data changes using BTE, you have to have activated online transfer using 

BTE. 

Activities 

Use input help to choose the relevant setting and save this setting. 

Further notes 
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This screen contains several target-system-independent settings for the APO Core Interface (CIF). 

For information about the Re-Read Stock indicator, see Read Stock Values Before the Transfer to SAP 

APO. 

For information about the Filter Obj. Req. Reduc. indicator, see Evaluate the Requirements Reduction 

Filter Object Type. 

For information about the Update Logic for Manuf. Orders and Update Logic for Networks fields, 

see Activate Cross-System Update Logic. 

37.6.2.6.2 Schedule Periodic Transfer Using ALE Change Pointers 

Use 

The change transfer for master data with the APO Core Interface (CIF) usually takes place using ALE 

change pointers. ALE technology is used to write and evaluate change pointers for the objects that are 

changed. 

- Transaction CFP1 

- Activate the relevant integration model 

The objects that have been changed are completely retransferred to SAP APO. 

We recommend that you schedule a change transfer using ALE change pointers as a periodic job. For 

more information, see Schedule Generation and Activation as a Job. This replaces transaction CFP1. 

Requirements 

To be able to work with change pointers, the following settings must have been made: 

1. The relevant indicator must be set in the Activate Change Pointers Generally IMG activity. 

2. The transfer of ALE change pointers must be set in the Configure Change Transfer for Master Data 

IMG activity. 

3. The transfer must be set up for the relevant message type in the Activate ALE Change Pointers for 

Message Types IMG activity. 

37.6.2.6.3 Activate ALE Change Pointers Generally 
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Use 

In this IMG activity, you fulfill the prerequisites for transferring changes to master data with change 

pointers. 

Requirements 

Under Activate ALE Change Pointers for Message Types, you also have to specify for which message 

types change pointers should be written. 

Activities Set the 

indicator to active. 

37.6.2.6.4 Activate ALE Change Pointers for Message Types 

Use 

ALE change pointers are automatically activated for the following message types if you have set up ALE 

change pointers in the Configure Change Pointers for Master Data IMG activity: CIFMAT (material 

master), CIFCUS (customer), CIFVEN (vendor), and CIFPPR (planning product). 

In this IMG activity, you specify for which additional message types ALE change pointers should also be 

written. By default, there are the following additional message types: 

- CIFSRC for the change transfer of sources of supply 

- CIFMTMRPA for the change transfer of MRP areas 

Requirements 

ALE change pointers must be activated generally. For more information, see Activate ALE Change 

Pointers Generally. 

Activities 

Use input help to select the required message type and set the Active indicator. 

Further notes 
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In transaction BD52 (Change document items for message type), you can influence the change transfer 

for a message type on a field basis. By default, ALE change pointers are written for all fields relevant to 

APO. 

37.6.2.6.5 Reorganize ALE Change Pointers 

37.6.2.6.5.1 Define Variant 

Use 

ALE change pointers are not deleted in the ERP system after the change transfer, they are 

marked as processed. To prevent a reduction in performance, we recommend that you delete the ALE 

change pointers regularly. You can do this using transaction BD22 or by scheduling program 

RBDCPCLR as background processing. 

In this IMG activity, you create a variant of program RBDCPCLR that can be scheduled as a regular job. 

Standard settings 

No variants are created as standard. 

Activities 

- Execute the IMG function. On the Delete Change Pointers screen, use input help to make the 

settings you require. 

- Under Goto, choose Variants then Save as Variant.... 

- Enter a name for the variant. 

- Fill the entry fields according to your requirements. 

- Save the variant. 

37.6.2.6.5.2 Schedule Job 

Use 

In this IMG activity, you schedule a job for the regular deletion of ALE change pointers. 

For more information on its use, see Define Variant. 

Requirements 

A variant must be created for the program RBDCPCLR. 
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Standard settings 

A job is not scheduled as standard. 

Activities 

- Define a job using the step RBDCPCLR and the variant you have defined. 

- Schedule this as a periodic job and adjust the periods to your requirements (for example, hourly, 

daily). 

- Save the job. 

- Create a job for each variant that has already been defined. 

37.6.2.6.6 Activate Change Pointers for Production Process Models 

Use 

In this IMG activity, you set that change pointers are written for production process models (PPMs). This 

is a prerequisite for ensuring that changes to BOMs, production versions, routings, and master recipes in 

the ERP system lead to a corresponding adjustment of the PPM in SAP APO. 

Report RSPPMCHG (transaction CFP3) can be used to evaluate change pointers and retransfer the PPMs 

affected to SAP APO. 

Report RSPPMDEL (transaction CFP4) can be used to delete the change pointers (for example, if they are 

not relevant to SAP APO). 

Activities 

Make the following entries in table TCHTR (the first column contains the object type, the second contains 

the name of the function module): 

BOM          CIF_BOM_CHANGED (change to BOM) 

PRODVER      CIF_MKAL_CHANGED (change to production version) 

ROUTING      CIF_ROUTING_CHANGED (change of routing/master recipe) 

Further notes 

Note the following restrictions: 

- Change pointers are not written for changes to the BOMs of phantom assemblies 
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- Change pointers are not written for the routing for changes to a reference operation set that 

references a standard routing. 

- Change pointers are not written for changes to referenced objects (for example, component scrap in 

the material master). 

- Change pointers are not written for routing changes or recipe changes when changes are made at the 

operation using classification with code OPCA. 

37.6.2.6.7 Enhancements 

37.6.2.6.7.1 Create Integration Models Automatically 

Use 

You can use enhancement CIFIMO01 (CIFIMO-zero-one) to influence the automatic creation of 

integration models beyond the possibilities available as standard. 

For more information, see the documentation for enhancement CIFIMO01. 

Activities 

1. Create the enhancement. 

For this, either create a new project or use an existing project. 

2. Activate the project. 

Your enhancement only becomes effective when you activate the project. 

Further notes 

In contrast to modifications, system enhancements are generally not affected by a change in release. This 

is because they were not made in the original SAP namespace, but rather in a namespace that is reserved 

for the customer. 

For more information on creating system enhancements, see under Online Manual in the enhancement 

transaction. 

37.6.2.7 Enhancement for Material Selection 

37.6.2.7.1 BAdI: Restrict Material Selection in Integration Model 

Use 
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This Business Add-In (BAdI) is used in the component Cross-Application Components (CA). The BAdI 

is invoked during material selection when an integration model is created if the materials are selected via 

a warehouse number. In this selection, all storage location/plant combinations that lead to the specified 

warehouse number are selected. Via the plants, all materials for which a plant view has been maintained 

are selected. 

Requirements 

The selection of the materials is effected in the integration model via the warehouse number. 

Standard settings 

This Business Add-In is not active in the standard system. 

This Business Add-In is not filter-dependent. 

This Business Add-In cannot be used multiple times. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Method 

Filter Plants 
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37.6.3 Additional Material Attributes 

37.6.3.1 Generate Additional Material Master Fields 

Use 

In this IMG activity, you activate additional material master fields for Supply Chain Management (SCM) 

in the database. This allows you to maintain the attributes of these fields centrally in the ERP system 

instead of locally in the SCM systems. 

37.6.3.2 Define Structure of Data Screens for Each Screen Sequence 

In this IMG activity, you have the following navigation levels: 

- Screen sequences 

This overview appears when you access the IMG activity. It contains all existing screen sequences. 

You have the following options: 

- Creating screen sequences by copying existing screen sequences 

You can create a new screen sequence by selecting an existing screen sequence and choosing 

Copy as. You are required to enter a new screen sequence ID and description, and to choose 

Enter. The system copies the screen sequence selected, the data screens, the subscreen 

assignments, and the order of the data screens. 

- Deleting screen sequences 

You can delete screen sequence(s) by selecting them as required and choosing Delete. The 

system deletes the screen sequence selected, the relevant data screens, and the subscreen 

assignments (not the subscreens themselves). 

- Transporting screen sequences and data screens 

You can transport screen sequences and/or data screens from the test system to the production 

system by selecting the screen sequence(s) and/or data screen(s) required and transporting 

them in the usual way. 

- Data screens 

This overview appears after you have selected a screen sequence and double-clicked Data screens. 

It contains all existing data screens for the screen sequence selected, with the exception of initial 

screens since they cannot be configured. One of the following screen types is assigned to each data 

screen: 

- Main screen 1 

The number of main screens in a screen sequence must not exceed 43. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 236 

- Secondary screen 2 

You have the following options: 

- Creating data screens new 

You can include new data screens in the screen sequence by choosing New entries. New main 

screens appear last in the screen order. Be sure to check the screen order in the activity 

Maintain Order of Main and Additional Screens, where you can change it if necessary. 

- Creating data screens by copying 

You can create a new data screen with the same parameters by selecting a data screen and 

choosing Copy as. After you have changed at least the screen ID and chosen Enter, the 

system copies the data screen selected and the subscreen assignments. 

- Changing existing data screens 

You do this by assigning different subscreens to the data screen, and/or by deleting the 

assignment of subscreens to the data screen (see under Subscreens below). 

- Deleting data screens 

You can delete data screens by selecting them as required and choosing Delete. The system 

deletes the data screen(s) selected and the subscreen assignments (not the subscreens 

themselves). 

Points to Consider when Maintaining Data Screens 

- Field placement 

Make sure that at least the base unit of measure and the material description can be maintained 

in Create mode. Since the base unit of measure must be maintained before all other units of 

measure, position it accordingly on the data screens. 

Make sure that each field cannot be maintained more than once on the data screen, that is, the 

same field must not occur on two different subscreens of the same data screen. 

If you move the Descriptions subscreen (appears on an additional screen in the standard SAP 

system) to a main screen, the Description field in the header subscreen of the main screen 

must not allow an entry. For this reason, descriptions subscreens must have screen numbers 

between 8000 and 8010. 

Always position the MRP type before all other MRP fields, and the forecast model before all 

other forecasting fields. 

- Configuring data screens 

The Classification screen must be a separate screen. 

You can configure consumption values and forecast values only as additional screens, not as 

main screens. 

- Configuring data screens as tab pages 

If you want to configure a main screen or additional screen as a tab page, note the following: 

A data screen with 7, 8, or 9 subscreens can be replaced only by a tab page with 10 or more 

subscreens, and a data screen with 12 subscreens can be replaced only by a tab page with 19 

subscreens. There are different tab pages for main screens and additional screens. 

It is recommended that you use GUI statuses without Goto or Extras menus since the 

navigation provided by these menus is replaced by the tab pages. Instead of these menus, the 

GUI statuses DATE00 and DATELT00 for the main screens contain an Extras pushbutton. 
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It is not possible to configure special screens such as Status Information and special 

additional screens (recognizable by GUI status DIALxxxx or by no GUI status and subscreen 

container 0001) as tab pages. 

- Accessing secondary screens 

Define whether new secondary screens are to be accessed as an additional screen or by 

pushbutton. You do this in the activity Assign Secondary Screens. 

- Preventing runtime errors 

Choose the maintenance status of a screen in accordance with the fields on the screen (on all 

subscreens); that is, each field on the screen must have at least one of the maintenance statuses 

that the screen itself has. If they do not, an abend will occur when maintaining data on the 

nonconforming screen. For example, if you include field MARA-BSTME (order unit) on the 

Basic Data screen, you must also assign status E (purchasing) to this screen. You can view 

the maintenance status(es) assigned to a field in Customizing for the Material Master in the 

activity Assign Fields to Field Selection Groups. 

For all screens, use only the GUI statuses maintained for the main program (SAPLMGMM for 

industry, SAPLMGMW for retail). 

- Subscreens 

This overview appears after you have selected a data screen and double-clicked Subscreens. It 

contains all the subscreens assigned to the data screen for a particular screen sequence. You have 

the following options: 

- Including new subscreens on a data screen 

You do this by selecting the subscreen above which you want to insert the new subscreen, and 

choosing New entries. However, this is possible only if the subscreen container contains at 

least one blank subscreen (a subscreen with the number 0001). 

- Shifting subscreens on a data screen 

- Deleting subscreen assignments 

You can delete the assignment of a subscreen to a data screen by selecting the subscreen and 

choosing Delete. The system replaces the deleted subscreen assignment with a blank 

subscreen. 

- Viewing the data screen 

Simulates the data screen as it appears in the material master. 

- Viewing the subscreen 

You can simulate an individual subscreen as it appears on the respective data screen in the 

material master by selecting it and choosing View subscreen. 

Points to Consider when Maintaining Subscreens 

- Treatment of blank subscreen areas 

Fill any blank subscreen areas in subscreen containers with a blank subscreen. The blank 

subscreen must have the screen number 0001 and, for performance reasons, should belong to 

the same program as the other subscreens on the data screen. 

- Performance considerations 
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To improve performance, choose the subscreens of a data screen from one program where 

possible. 

- Subscreens for maintaining long texts 

Do not assign more than one long text maintenance subscreen to a single data screen. 

Activities 

After configuring the material master, be sure to test it using the following functions: 

- Create material 

- Change material - Display material 

You must be able to save your data without an error message. 

Note on Transport 

After changing a screen sequence or data screen, transport the screen sequence. 

37.6.3.3 Assign Screen Sequences to User/Material Type/Transaction/Industry 

Sector 

In this IMG activity, you can assign a screen sequence to a combination of one or more transactions, 

users, material types, or industry sectors. As a result, this screen sequence appears automatically for the 

respective user(s) when the transaction, material type, or industry sector is chosen. 

At screen sequence control level, you have the following options: 

- Assigning a different screen sequence to an existing combination of transactions, users, 

material types, and/or industry sectors 

Example 

You want to replace standard screen sequence 21 (valid for all users, material types, and industry 

sectors) with a screen sequence of your own, for example, Z1. You do this by locating the following 

combination at screen sequence control level and overtyping screen sequence 21 with Z1. 

     Transaction User Material type Industry sector Screen sequence 

     01 * * * 21 

- Assigning a screen sequence to one or more new combinations of transactions, users, material 

types, and/or industry sectors by choosing New entries 

This requires you to first create groups of transactions, users, material types, or industry sectors by 

assigning them to a transaction screen reference, user screen reference, material type screen 

reference, or industry sector screen reference as required. The screen reference is a freely definable 

ID. When assigning users to a user screen reference, you can include new users by choosing New 

entries. 
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When assigning a screen sequence to a new combination of transactions, users, material types, 

and/or industry sectors, only the following combinations are allowed. You do not necessarily have 

to enter a specific screen reference for user, material type, or industry sector. In this case, enter * 

instead. The combination is not then restricted to a specific screen reference. Also indicated is the 

priority of the combination (1 = highest, 5 = lowest). 

     Priority Transaction User Material type Industry sector 

    1 x x x x     2 x x

 * *     3 x * x x     4 x

 * x * 

     5 x * * * 

Key 

x = Replace with a specific screen reference * = 

No specific screen reference 

Note (retail only) 

When configuring the retail material master, enter * as the industry sector. 

Example 

You want to assign a specific screen sequence, for example, ZY, to users Kirk, Scott, and 

McKoy. This requires you to first assign these users to the same screen reference, say GR. At 

screen sequence control level, you then choose New entries and enter the following combination: 

     Transaction User Material type Industry sector Screen sequence 

     01 GR * * ZY 

37.6.3.4 Attribute Values for Additional Material Master Fields 

37.6.3.4.1 Define Handling Unit Type 

Use 

In this IMG activity, you define handling unit types (HU types) for the additionally-defined material 

master attribute. You need HU types in Extended Warehouse Management to classify packaging 

materials and handling units with the same physical properties. 

If you transfer the material to the decentralized SCM system, the HU types is automatically transferred 

too. You have to transfer the relevant check tables separately. 

37.6.3.4.2 Define Warehouse Storage Condition 

Use 
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In this IMG activity, you define warehouse storage conditions for the additionally-defined material master 

attribute. You need warehouse storage conditions in Extended Warehouse Management to specify that a 

material should only be stored under particular storage conditions; for example, at a specific temperature. 

If you transfer the material to the decentralized SCM system, the warehouse storage condition is 

automatically transferred too. You have to transfer the relevant check tables separately. 

37.6.3.4.3 Define Warehouse Material Group 

Use 

In this IMG activity, you define warehouse material groups for the additionally-defined material master 

attribute. You need warehouse material groups in Extended Warehouse Management to specify that 

particular materials should be stored in the same way. 

If you transfer the material to the decentralized SCM system, the warehouse material group is 

automatically transferred too. You have to transfer the relevant check tables separately. 

37.6.3.4.4 Define Handling Indicator 

Use 

In this IMG activity, you define handling indicators for the additionally-defined material master attribute. 

You need handling indicators in Extended Warehouse Management to specify how particular materials 

should be handled within a warehouse. A handling indicator could be Fragile, for example. 

If you transfer the material to the decentralized SCM system, the handling indicator is automatically 

transferred too. You have to transfer the relevant check tables separately. 

37.6.3.4.5 Define Serial Number Profile 

Use 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 241 

You must assign a serial number profile to each material that is to be serialized by making the appropriate 

entry in its master record. In this IMG activity, you create a serial number profile. You can transfer this to 

SAP SCM and use it in Extended Warehouse Management (EWM). 

When you transfer the material to the SCM system, the assignment to the serial number profile is 

automatically transferred as well. You must transfer the relevant check tables separately. 

Activities 

- Create a serial number profile. 

- Enter a name for the serial number profile. 

- Enter a prefix that EWM applies in automatic number assignment (optional). 

- If numbers of the same number range are to be assigned to different products in automatic 

serial number assignment in EWM, enter a number range object name with number range 

interval (optional). 

- Set Numbering if you do not use a number range interval but want to use automatic serial 

number assignment (optional). 

- Choose Serial Number Requirement. 

- Enter an integral (whole-number) unit of measure (usually piece (pc)) for which serialization is 

to be carried out. The unit of measure must be entered as the base unit of measure in the 

material master data for the material to which you want to assign this serial number profile. 

37.6.3.4.6 Define Quality Inspection Group 

Use 

In this IMG activity, you define quality inspection groups. 

You can use quality inspection groups to group materials that are to be inspected or tested in similar 

fashion. These groups should later simplify the maintenance of inspection rules in Extended Warehouse 

Management (EWM). 

When you transfer the material to the SCM system, the quality inspection group is automatically 

transferred as well. You must transfer the relevant checking tables separately. 

Example 
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Quality inspection group "breaking test": quality inspection group for all materials that have to pass a 

breaking test carried out using the same apparatus. 

37.6.4 Assign Warehouse Number to Warehouse Number of Decentralized SCM 

System 

Use 

In this IMG activity, you assign the warehouse number of the decentralized SCM system to the 

warehouse number of the ERP system. You need this assignment to select the materials required in 

Extended Warehouse Management during distribution of the material master data. 

37.7 Supply Network Collaboration/Inventory Collaboration Hub 

37.7.1 Business Add-Ins (BAdIs) 

37.7.1.1 BAdI: Report RSMIPROACT 

Use 

This Business Add-In (BAdI) is used in the  Cross-Application Components (CA) component. You can 

use this BAdI to adjust the material selection for the RSMIPROACT report specifically to the customer. 

The BAdI is called before the system selects a material for the RSMIPROACT report. 

Standard settings 

The BAdI is not active in the standard system. When you activate the BAdI, you must implement your 

own coding. The BAdI is not filter-dependent and is not multiple use. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 
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3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

See also: 

Methods 

Method for Selecting Sources of Supply 

Method for Determining Selection Filters for Demand Selection 

37.7.1.2 BAdI: Report RSMIPROACT(IDoc DELVRY03) 

Use 

This Business Add-In (BAdI) is used in the Cross-Application Components (CA) Component. This BAdI 

enables you to change the IDoc DELVRY03 before you send it from your ERP system to SAP Exchange 

Infrastructure or to an EDI system. 

The system writes data with the report RSMIPROACT into the IDoc. You can use the BAdI to change the 

data as follows: 

- Insert additional data into the IDoc 

- Change existing data in the IDoc, for example, qualifiers 

Standard settings 

In the standard system, the BAdI is not activated. When you activate the BAdI without modifying it, 

only the standard code for the report RSMIPROACT will be executed, without any changes from the 

BAdI. 
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The BAdI is not reusable. The BAdI is not filter-dependent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

See also: 

Methods 

Final changes before sending IDoc DELVRY03 

37.7.1.3 BAdI: Report RSMIPROACT (IDoc PROACT01) 

Use 
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This Business Add-In (BAdI) is used in the Cross-Application Components (CA) component. This BAdI 

enables you to change the IDoc PROACT01 before your ERP system sends it to an SAP Exchange 

Infrastructure system or an EDI system. 

The system writes material data (header, items) with the report RSMIPROACT into the IDoc 

PROACT01. You can use the BAdI to change the data as follows: 

- Insert additional data into the IDoc 

- Change existing data in the IDoc, for example, qualifiers 

Standard settings 

In the standard system, the BAdI is not activated. When you activate the BAdI without modifying it, 

only the standard code for the report RSMIPROACT will be executed, without any changes from the 

BAdI. 

The BAdI is not reusable. The BAdI is not filter-dependent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 
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See also: 

Methods 

Final changes before sending IDoc PROACT 

37.7.1.4 BAdI: Data Extraction Management for Contract Manufacturing 

Use 

This Business Add-In (BAdI) is used in the Cross-Application Components (CA) component. This BAdI 

enables you to extract material data using input parameters. You can use this BAdI to adapt the reports 

ROEMPROACT and RCMPROACT to your customer needs. The BAdI is called after the reports have 

processed the input parameters. 

Standard settings 

The BAdI is activated in the standard system.  No default code is executed when there is no customer 

implementation. The BAdI is not reusable and not filter-dependent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 
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When the application program is executed, the system carries out the code in the method you wrote. 

Example 

See also: 

Methods 

Data extraction management for OEM 

Data extraction management for CM 

Select for Key Figure 

37.7.1.5 BAdI: Master Data Transfer for Kanban 

Use 

This Business Add-In (BAdI) is used in the SCM Basis (SCM-BAS) component. You can use this BAdI 

to adjust the KANBAN_MD_TRANSMIT report with which you transfer master data for Kanban to SAP 

Inventory Collaboration Hub or SAP Supply Network Collaboration. 

Standard settings 

The BAdI is not active in the standard system. Before you activate the BAdI, you need to have created a 

customer implementation. 

The BAdI is not filter-dependent. The BAdI is multiple use. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 
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4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

See also: 

Methods 

Change ERP Data for Material 

Extend Data for Contact Person 

Extend Data Before Data Transfer 

Change Log Outputs 

37.7.1.6 BAdI: Change Calculated Component Consumptions 

Use 

This Business Add-In (BAdI) is used in the Inventory Management (MM-IM) component. You can use 

this BAdI to replace the standard calculation of component consumptions for outsourced manufacturing 

scenarios. In the standard system, component consumptions are automatically calculated from data that 

has been extracted from inbound 

ManufacturingWorkOrderProductionProgressNotification XML message. The BAdI is called after 

the receipt of the XML message and before the system posts the component consumptions as goods 

movements. 

For more information about the component consumption calculation, see the MM-IM documentation 

under Component Consumption Calculation. 

Requirements 

You can use this BAdI if you have integrated SAP ERP with another system, such as SAP Supply 

Network Collaboration (SAP SNC), in an application-to-application (A2A) communication. 

SAP SNC sends information to SAP ERP about component consumptions of a supplier using 

ManufacturingWorkOrderProductionProgressNotification XML messages. 
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You use subcontract orders in SAP ERP. 

Standard settings 

In the standard system, there is no activated BAdI implementation. 

The BAdI is designed for multiple use. All activated implementations are called and executed. 

The BAdI is not filter-dependent. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

See also: 

This BAdI uses the interface ICH_BIF_IF_WO_IN. For more information, display the interface in the 

Class Builder. 

37.7.1.7 BAdI: Modify Approved Manufacturer Parts List Transfer 

Use 

This Business Add-In (BAdI) is cross-application. 

You can use this BAdI to modify approved manufacturer parts list (AMPL) data that has been passed to 

the Core Interface (CIF). 

Requirements 

Data has been mapped from the AMPL to the CIF_AMPL structure. 

Standard settings 

In the standard system, there is no activated BAdI implementation. 

The BAdI is designed for multiple use. 

The BAdI is not filter-dependent. 

See Also: 

This BAdI uses the CIF_AMPL_USER_EXIT interface. For more information, display the interface in 

the class builder. 
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37.8 Data Transfer to Business Warehouse 

The Business Information Warehouse Implementation Guide contains information and activities 

required for extracting and transferring data from an SAP source system into a SAP BW. 

A distinction is made between the transfer of data from 

1. OLTP or ERP systems, 

2. source BW systems, and 

3. additional SAP source systems. 

Regardless of the kind of source system, the Implementation Guide contains the following: 

- General settings for the transfer of data from a source system into an SAP BW 

- Option of activating BI Business Content delivered by SAP 

- Option of maintaining generic DataSources 

- Option of subsequently processing DataSources on a source system-level 

For OLTP and additional SAP source systems, the implementation guide also contains: 

- Source-system specific settings for application-specific DataSources, if appropriate. 

Note 

You can find further information on the points mentioned here in the corresponding sections of the 

implementation guide. 

37.8.1 General Settings 

In this section you make general settings for data extraction from a source system into BW. 

37.8.1.1 Maintain Control Parameters for Data Transfer 

In this step, you specify various control parameters for data transfer by using the service API 

(SAPI). 

You will also find information for every parameter about whether and how the parameter can be replaced 

for data transfer using operational data provisioning (ODP). 
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Activities 

1. Source System 

Enter the logical system of your source client and assign the control parameters you selected to it. 

You can find further information on the source client in the source system by choosing the path 

Tools -> Administration -> Management -> Client Administration -> Client Maintenance. 

2. Maximum Size of the Data Package 

When you transfer data into BW, the individual data records are sent in packages of variable size. 

You can use this parameter to specify how big these data packages usually are. 

If nothing is specified, the data is transferred with a default setting of 10,000 kBytes per data 

package. The memory requirement not only depends on the settings of the data package, but also on 

the size of the transfer structure and the memory requirement of the relevant extractor. 

The following applies for data transfer using operational data provisioning: 

For data transfer processes: 

A data package with 50 MB is requested by the extractor. The transfer size of a data package can be 

increased in the definition of the data transfer process on the Extraction tab. However, the data 

package passed by the extractor is not split again for the data transfer, in order to achieve the exact 

DTP package size. The uncompressed size of the data package transferred by the DTP usually 

corresponds to the largest multiple of 50 MB that fits the DTP package size. 

For InfoPackages: 

The size of the data package is set to 50 MB. 

3. Maximum Number of Rows in a Data Package 

With large data packages, the memory requirement mainly depends on the number of data records 

that are transferred with this package. Using this parameter, you can control the maximum number 

of data records that the data package should contain. 

By default a maximum of 100,000 records are transferred per data package. 

The maximum main memory requirement per data package is approximately 2*'Max. 

Rows'*1000 Byte. 

The following applies for data transfer using operational data provisioning: This 

setting is not relevant. 

4. Frequency 

The frequency specifies the number of IDocs that an Info IDoc is to be sent to, or how many data 

IDocs an Info IDoc describes. 

Frequency 1 is set by default. This means that an Info IDoc follows every data IDoc. In general, you 

should select a frequency between 5 and 10 but no higher than 20. The larger the data IDoc package, 

the lower the frequency setting should be. This means that when you upload data, you can view 

information on the relevant data loading status at regular intervals. 

With the help of every Info IDoc, you can check the BW monitor to see if there are any 

errors in the loading process. If there are no errors for any one of the Data IDocs described in an 

Info IDoc, then the traffic light in the monitor will be green. The Info IDocs contain information 

such as whether the corresponding data IDocs were uploaded correctly. 

The following applies for data transfer using operational data provisioning: This 

setting is now obsolete. 

5. Maximum number of parallel processes for the data transfer An 

entry in this field is only relevant from release 3.1I onwards. 
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Enter a number greater than 0. The maximum number of parallel processes is set to 2 by default. 

The ideal parameter selection depends on the configuration of the application server, which you use 

for transferring data. 

The following applies for data transfer using operational data provisioning: 

For data transfer processes: 

In the BW system, you can specify the maximum number of work processes using Goto -> Batch 

Manager Settings. 

For InfoPackages: 

The data transfer is performed in one synchronous process. To update data into the PSA (BW 

system), you can specify the maximum number of work processes (in the InfoPackage on the 

Processing tab under Parallel Processing). 

6. Target system of background job  

Enter the name of the application server on which the extraction job is to be processed. 

To find out the name of the application server, choose Tools -> Administration -> Monitor -> 

System Monitoring -> Server. The name of the application server is displayed in the column 

Computer. 

The following applies for data transfer using operational data provisioning: This 

setting is not available. 

7. Maximum Number of Data Packages in a Delta Request 

You use this parameter to restrict the number of data packages in a delta request or in a repeated 

delta request. 

Only use this parameter if you are expecting delta requests with a very large volume of data and you 

expect more than 1000 data packages in a request despite the large data package size. 

With an initial value or when the value is 0, there is no restriction. Only a value larger than 0 leads 

to a restriction in the number of data packages. However, this number is not always kept to. The 

actual restriction can deviate from the specified limit by up to 100, depending on the extent to which 

data is compressed in the qRFC queue. 

The following applies for data transfer using operational data provisioning: 

This setting is not available. 

37.8.1.2 Check Delta Queue (Transfer Using SAPI) 

The delta queue of the Service API (SAPI) is a data store in the source system, in which data records are 

either written automatically using an update process (for example, with FI documents) or by extraction 

using a function module following a data request from BW (for example, LIS extraction for BWs earlier 

than BW 2.0). 

The data records are transferred from the BW scheduler into BW when a delta request takes place. 

The data is compressed in the delta queue. It can be requested by more than one BW system. The delta 

queue can also be repeated, which means that data from the most recent extraction process is stored in the 

delta queue. The repeat mode of the delta queue is target system-specific. 

If changes have been made to the extract structure of a DataSource between writing the data to the delta 

queue and reading the queue data (for example, as a result of an upgrade) you can see from the data 

stored in the queue which structure the changes have been written to in the delta queue. In the queue 

monitor, fields that were previously empty, are now filled, and previously filled fields are now empty. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 253 

In this step you examine the delta queue. 

Activities 

The status symbol indicates whether the update in a delta queue is activated for a DataSource. If the status 

symbol is green, the delta queue is activated, which means it is filled with data records when an update 

process or a data request from BW is running. A prerequisite for the delta update is the successful 

completion of the delta process initialization in the BW scheduler. 

Displaying data records 

1. To check whether and how many data a delta queue contains, select the delta queue and choose 

Display data records. 

2. A dialog box opens where you can specify how you want the data records to be displayed. 

a) You can choose the data packages containing the data records that you want to see. 

b) You can choose to display specific data records in a data package. 

c) You can use a simulation of the extraction parameters to choose how you want the data records 

displayed. 

3. Choose Execute to display the data records. 

Displaying current status of the delta-relevant field 

For DataSources that support generic delta, you can display the current value of the delta-relevant field in 

the delta queue. You can do this by choosing Detail in the Status column. The value displayed contains 

the largest value of the delta-relevant field for the last extraction. It acts as the lower limit for the next 

extraction. 

Refresh 

If you choose Refresh, 

1. recently activated delta queues are displayed, 

2. data records recently written to the delta queue are taken into account, and 

3. data records that were deleted when reading the data records are no longer displayed. 

Deleting queue data 

If you want to delete the data in a delta queue for a DataSource, select the delta queue, and 

choose Delete Data from the context menu (right mouse-click). 

If you delete the data in a delta queue, you do not have to reinitialize the delta process before you can 

write the data records of the DataSource to the delta queue. 

Note: 

Note that data, which has not yet been read from the delta queue, is also deleted. This invalidates an 

existing delta update. Only use this function if you are aware of the consequences this will have. 

Deleting the Queue 

You delete the entire queue by choosing Queue -> Delete Queue. To write data records from the 

corresponding DataSource into a delta queue, you need to reinitialize the delta process. 
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37.8.2 Business Content DataSources 

Business Content DataSources delivered by SAP as well as those delivered by partners (when applicable) 

are in the SAP delivery version (D version). If you want to use a Business Content DataSource or a 

DataSource using Content data from a partner to transfer data from a source system into a BW system, 

you have to transfer it from the D version into the active version (A version). 

In the source system, the DataSources are assigned to specific application components. If you want to 

display the DataSources in the source system view of the BW Administrator Workbench - Modeling 

according to this application component hierarchy, you need to transfer these from the D into the A 

version. 

In this section you learn how to transfer the application component hierarchy and the DataSources that are 

delivered with the Business Content from BW and Partner Content (when applicable) into the active 

version. 

Note on transferring data from an OLTP system or other SAP source systems 

Note that you have to make settings for certain Business Content DataSources before you can transfer 

data into a BW system.  These settings are listed in the  Settings for Application-Specific DataSources 

section. (You can only find this section in the SAP source systems for which it is relevant.) 

37.8.2.1 Transfer Business Content DataSources 

In this step, you transfer and activate the DataSources delivered by SAP as well as partner DataSources 

delivered in your own namespace where applicable. After this step, for all connected BW systems, you 

can extract and transfer data from DataSources that have been activated and replicated into the current 

BW. 

Activities 

1. In the Install DataSources from Business Content screen, the DataSources for the application 

components assigned to you are displayed in an overview tree. Under an application component, the 

RECONCILITATION node indicates that DataSources for data reconciliation with one or more 

Content DataSources are assigned to the application component. You use these reconciliation 

DataSources, that are delivered with Business COntent, to check that data loaded from other 

DataSources is correct. If DataSources that are flagged as DataSources for data reconciliation exist 

for the application component, this is displayed by the RECONCILIATION subnode. This node is 

not displayed if reconciliation DataSources do not exist for an application component. 

2. In the application component hierarchy, select the node for which you want to transfer the 

DataSources to the active version. Do this by placing the cursor over the node and choosing Select 

Subtree. 

The DataSource and subtrees positioned beneath it are selected. 

3. Choose Select Delta. 

DataSources are highlighted in yellow when the check shows differences between their active and 

delivered versions (for example, due to extractor changes). 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 255 

4. To analyze the differences between the active and delivered versions of a particular DataSource, 

select the DataSource, and choose Version Comparison. The application log that appears contains 

more detailed information about the two versions. 

5. To transfer DataSources from the delivered version into the active version, select the DataSources 

you want to transfer in the overview tree using the Select Subtree pushbutton, and choose 

Activate DataSources. 

The error log appears if an error occurs. 

You can also call up the log regardless of whether your transfer into the active version was 

successful or not, under Display Log. 

With a metadata upload, when replicating DataSources in BW, the active version of the DataSource 

is recognized by the BW. 

Note: 

When activating Business Content DataSources, transferring the SAP version overwrites the active 

customer version. 

Further notes 

In the implementation guide under Postprocessing of DataSources, you have the option to change the 

transferred DataSources. 

Searching in the Overview Tree 

You can only search for DataSources or other nodes when all nodes have been expanded. 

37.8.3 Settings for Application-Specific DataSources (PI Basis) 

37.8.3.1 Extraction Individual Objects On/Off 

Use 

If you use SAP Business Information Warehouse (BW), this IMG activity lets you activate and deactivate 

the transfer of individual objects to the BW system. 

37.8.3.2 Status Concept for BP/Product/CRM Objects 

37.8.3.2.1 Process User Status 

Use 
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The status concept allows status objects to be displayed in BW. The system can transfer to BW the 

delivered system statuses as well as the user statuses that you have defined. 

In this activity, you assign status objects (user status) created by you to a BW status object. 

Background Information 

All statuses that are currently active for an object are usually displayed in the Business Patner and 

Product master data as well as in other CRM master data and transaction data. Any number of statuses 

can be active at the same time. 

However, there are a number of status values that exclude each other. In such cases, only one of these 

statuses can be active (for example, "In process" and "Completed"). 

You can combine these statuses in a BW status object and assign a BW status to each of the individual 

user statuses. The status that is active in the source system at the point when data is extracted is then 

transferred to SAP BW using the BW status object. 

To arrange the BW status objects semantically, you can combine them in BW status object groups. 

Activities 

Perform the following steps for this activity: 

1. Create one or several BW status object groups, depending on whether you want to arrange your 

status objects semantically. They could be grouped by application component, for example. 

2. Create a BW status object. 

The data is later extracted into SAP BW using the three-character name of the BW status object 

group and the four-character name of the BW status object. 

3. Use the possible entries function to select a combination of user status and status profile. 

4. In the BW Status field, assign a status number (not equal to 0) to this combination. You can use the 

status numbers in this way to order the statuses in BW semantically within a BW status object. 

For the current value of each status object to be transferred to SAP BW, you need to perform the 

following steps: 

5. Extract into SAP BW the texts for the BW status and generate a Text DataSource for BW Status 

Objects. 

6. Extend the DataSource that you want to use to extract into SAP BW the object to which the status 

belongs. Proceed as follows: 

a) In Customizing for the settings for SAP BW, choose Settings for Extractors and Business 

Content -> Follow-Up Processing of DataSources -> Edit DataSources. 

b) Select the DataSource to be edited. 

c) Extend the extract structure by adding a field of the data type CRMBWST with the technical 

name BWSTYYYXXXX, where YYY stands for the BW status object group and XXXX for 

the BW status object. 

d) Ensure that the field for the extraction is selected. Use the pen icon to switch to the mode for 

changing the DataSource. The Selection and Hide Field indicators must not be set. The 

Field only known in exit indicator must be set. 
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During extraction, the extended field is automatically filled with the status number for the status 

active at the time of the extraction. 

7. In SAP BW, create an InfoObject in which the value of the BW status object is to be set. It makes 

sense to use a naming convention of the form ZSTAYYYXXXX (see above). You can use the 

InfoObject 0STAMKTSYS0 as a template for technical settings such as data type and length. 

8. Assign this InfoObject as an attribute to the InfoObject that the status belongs to. 

9. Use the transfer structure to check the assignment between the extract structure field and the BW 

InfoObject. 

37.8.3.2.2 Display system status 

Use 

The status concept allows status objects to be displayed in BW. The system can transfer to BW the 

delivered system statuses as well as the user statuses that you have defined. 

In this activity, you can display the settings for the delivered system statuses. 

The structure of this IMG activity corresponds to that of the activity Edit User Status Settings. 

Activities 

Display the BW status objects and object groups delivered by SAP as an assignment to the system status. 

37.8.3.2.3 Generate Text DataSource for BW Status Objects 

Use 

In this activity, you generate a DataSource that enables you to copy the texts of a BW status object into 

BW. 

Activities 

1. Enter the technical names of the BW status object group and of the BW status object. 

2. Enter a descriptive text for the DataSource and select an application component. 
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3. Choose Generate. 

The system generates a DataSource with the name 0STAYYYXXXX_TEXT, where YYY stands 

for the BW status object group and XXXX for the BW status object. You can use this DataSource to 

extract the status texts for the corresponding BW status object (see Edit User Status Settings) into 

BW. 

4. Connect this DataSource to the InfoObject that you created for the BW status object. 

37.8.4 Settings for Application-Specific DataSources (PI) 

In this section, you find the settings for application-specific DataSources. 

You also find, for the settings under Business Content DataSources, settings for Business Content 

DataSources and find out how you extract application-specific data from a source system using 

customer-defined DataSources, and transfer it to BW. 

For some applications, you can connect to the Business Information Warehouse using customer-defined 

DataSources. Using generic data extraction, you can also extract data, which cannot be made available 

with the BW Business Content DataSources, from an R/3 source system and transfer it to BW. A flexible 

API, and a generation program for this,  secure the connection of such applications to the Business 

Information Warehouse. 

37.8.4.1 Utilities Industry 

This IMG activity contains all the information about how to configure the SAP Utilities (IS-U) 

component for the SAP Business Warehouse. 

Note the important documentation and examples in the following activities. 

A distinctive feature of the link between IS-U and BW is that you can transfer huge quantities of data to 

BW. Current data is required for some analyses and not just for the results of a period-end closing. 

A  delta procedure was therefore used to transfer the data. This is first of all initialized, by reproducing 

the data in one or more info packages. Finally, it depends upon how current the data must be for the 

analysis. A further info package is regularly planned (daily, for example), in which the delta is transferred 

for the last update. 

37.8.4.1.1 Sales Statistics 

The sales statistics for the SAP Utilities (IS-U) component are analyzed in the SAP Business Information 

Warehouse (BW). 

Due to the huge quantities of data, the delta procedure is used exclusively for the sales statistics. This 

procedure consists of full, initial, and delta updates. The DataSources 

0UC_SALES_STATS 01 and 0UC_SALES STATS_02 are available. For more information see the 

online BW documentation, under www.help.com. The DataSources extract all invoiced documents to 

BW, corresponding to the selections from BW. Newly created documents are extracted to BW in the next 

delta update. 

Standard settings 
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The DataSource for the sales statistics is used as standard with a large number of 

characteristics. According to the project scope, you only require a portion of the characteristics for your 

analyses in BW. The structure in the standard system for BW therefore only uses a portion of the 

available characteristics. 

Recommendation 

Due to the large quantities of data that are extracted to BW for the initial update, we recommend that you 

work on the required characteristics in this DataSource as early as possible. Avoid multiple initial loads 

due to 'forgotten' fields. 

Activities 

Check the fields required for your project and hide the unrequired characteristics in the DataSource. 

Perform the subsequent Customizing activities. 

Further notes 

Only those print documents are processed within an extraction, for which the following applies: 

- The billing documents to be updated are invoiced, or their invoicing step was reversed. The print 

documents may not be outsorted. 

- You can use the user exit BWESTA02 to specify that only those documents can be extracted that 

have also been transferred to the general ledger. For more detailled information on this subject, see 

the documentation for the aforementioned user exit. 

Only those document lines are processed for which the following applies: 

- Their billing quantity or net amount are relevant for the statistics. 

Whether a quantity or amount is relevant for statistics is derived from the definition of the 

corresponding statistics group quantity/amount and the definition of the billing variants. For more 

information, see Customizing for SAP Utilities under Information System -> Statistics -> Sales 

Statistics -> Update -> Updating Control (in particular statistics groups). 

- An update group is determined in billing. An update group is determined in billing. Make sure that 

the update group is entered in the relevant documents. The update group determination is not 

maintained for newly defined divisions that were not provided by SAP. 

37.8.4.1.1.1 Define Specifications for Sales Statistics Extractor 

The sales statistics extractor makes the information from the invoicing source documents available for 

BW. 

the following information describes the basic approaches for determining the scope and level of detail of 

the extracted data in order to optimize the extraction with regard to the runtime and volume of data 

transferred. 

Activities 
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1. Settings for Extraction of Billing Documents 

The billing document line items are formatted in the extractor. The lines are read, corresponding master 

data is determined and any other information is read. 

Based on their weighting procedures, the billing document lines items are are divided into months. This is 

done in order to statistically evaluate expected monthly values, despite cross-month billing (such as 

annual billing). Due to this level of detail, a large number of statistically relevant records are transferred 

to BW. In the case of large utilities companies, this may result in impaired system performance during the 

load process. 

The runtime of the extractor can be improved in the following ways: 

- If certain tables do not have to be read because the information in BW is not relevant for the 

evaluation. 

- If you do not want to divide the billing lines into months. This only applies to old documents since 

the divided bill values are statistically important. 

For this reason, this IMG activity contains three settings that can be changed at any time. 

a) Division by consumption months as of posting date 

In some IS-U projects, all of the existing bill documents are migrated from the legacy system. 

This entails the extraction of a large number of entries during the initial download. It is often 

the case that these legacy documents do not have to be divided by consumption month. You 

can use this setting to define the posting date as of which you want to documents to be divided. 

This avoids dividing up unnecessary documents and reduces the number of records for 

transfer. 

Only make this setting if you do not want to divide up documents that were migrated 

from the legacy system.  

b) Posting periods 

The standard settings determine that only the posting date is contained in the document. The 

system has to read additional function modules in order to determine the posting period. The 

posting period is required in order to compare the billing information with the general ledger. 

Only deactivate it in exceptional circumstances. Note that the posting date in the document can 

differ from the posting date of the transfer to FI. For this reason, a comparison of the extracted 

posting period with the posting period can lead to differences. Therefore, we recommend that 

you also extract the reconciliation key to BW and use it in the InfoCubes. This ensures a better 

comparison. 

Only set the posting period indicator if you absolutely do not require a comparison to the 

general ledger.  

c) Tax information 

Tax information includes information on the tax base amount, the tax amount, and the tax 

code. This information is not contained in the billing document but in the print document. The 

tax information is divided into monthly values, according to the net amounts. For this reason, 

the extractor reads the tax amounts from the invoice document. If you do not require the tax 

amounts (only necessary in certain countries), set the tax information indicator. If you do this, 

the print document line items are not read. 

If you do not require the tax information, set the tax information indicator  

2. Settings for Extraction of Additional Source Documents 
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If you want to extract additional invoicing source documents that were created in the SAP SD or SAP 

Convergent Invoicing components, you can set the respective indicators to activate the extraction. 

3. Reduction of Number of Records to be Extracted 

During the implementation project it is difficult to define what information does not need to be evaluated 

in BW and what information is required in detailed form. Certain information is only extracted for 

update rules in to BW. If these fields are already derived, or are not transferred, then it is possible to 

compress the data in the extractor (and not in the InfoCube) without losing information. 

However, several implementation projects have shown that the trend is towards a higher degree of detail 

in BW. This means that the lines that are relevant for statistics should also be available 1:1 in BW. For 

this reason, efforts to reduce and compromise extracted records can no longer take priority. The 

aggregation to a calendar year, for extrapolated documents (such as for unbilled revenue reporting) 

should be considered. This considerably reduces the data volume for annual customers. 

You can also reduce the amount of data to transfer to BW by hiding the extraction structure fields that 

you do not require in BW in DataSource maintenance. 

37.8.4.1.1.2 Define Update 

Use the update definition to define the basis of your individual Information System in BW. 

It is often required that certain specifications of data objects influence the statistics update. This usually 

means that certain data objects (such as rate category, division and contract) have an influence on the 

update in BW. 

The update group is a central control element of the update. During billing it determines a contract from 

the combination of the statistics group from the rate category, and the statistics group from the contract. 

37.8.4.1.1.2.1 Define Update Groups 

In this IMG activity you can 

- Create, change and display 

- Copy 

- Delete 

the update groups for the statistics update. 

Note about SAP Business Information Warehouse (BW) 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 262 

You can use the update groups in the update rules within BW, to use characteristics and key figures 

differently. 

Example BW 

The document number is always extracted to BW, independently of the customer grouping. However, you 

must still save the document number in the InfoCube - just for nonresidential customers. You do not 

require this information for residential customers. 

Check at document number field level in the update rules in BW, to see which update group is valid for 

this record. Set the document number field as 'initial'. If you do not do this, the document number is saved 

in the InfoCube. This reduces the time required for updating residential customers in BW. 

In the later analyses, you can: 

- Analyze sales and consumption per nonresidential customer 

- Analyze residential customers gathered under the 'dummy' business partner 

Standard settings 

All update groups that begin with a number or S are in the SAP namespace. 

Recommendation 

Organize the update groups based on your customer groupings. Basic differences are nonresidential and 

residential customers, but also take into account employees and competitive customers. 

Activities 

Maintain the update groups that can use the application. 

Further notes 

You must use the update groups in the billing documents, otherwise the document lines are not processed 

in the statistics update. 

37.8.4.1.1.3 Updating Control 

In this IMG activity you define the updating control. 

37.8.4.1.1.3.1 Define Statistics Groups for Rate Categories 

In this IMG activity you define the statistics groups that can be used for the allocation of individual rate 

categories. 

Allocate the statistics groups to the rate categories in Customizing under Contract Billing -> 

Billing Master Data -> Rate Structure -> Rate Categories -> Define Rate Categories. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 263 

You can use the statistics group in update group determination, to differentiate between residential and 

nonresidential customers, because you generally differentiate between these two groups by rate category. 

Recommendation 

Define a rate category structure group for each customer grouping. 

Activities 

1. Define which groups of rate categories affect the statistics update. 

2. Define the statistics groups. 

3. Ensure that the statistics groups are entered in the rate categories. 

Further notes 

Statistics group '  ' (SPACE) is also supported. 

37.8.4.1.1.3.2 Define Statistics Groups for Contracts 

In this activity you define the statistics groups that can be used for allocating individual contracts. 

Allocate the statistics groups in the contract. 

Only use the statistics group in exceptional cases, if, for example, you want to consider a residential 

contract as a nonresidential contract, due to its importance. Just one contract statistics group is normally 

sufficient in this case. 

Recommendation 

Enter nonresidential contract in the contract statistics group. 

Activities 

1. Define which groups of invoices affect the statistics update. 

2. Define the statistics groups. 

3. Ensure that the statistics groups are entered in the contracts. 

Further notes 

The statistics group '  ' (SPACE) is also supported. This means that the agent usually does not have to 

enter a statistics group in the contract. 
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37.8.4.1.1.3.3 Define Statistics Groups for Quantities 

In this IMG activity you define the statistics groups for quantities. Enter the statistics groups in the billing 

schema. You use a statistics group to control how the billing quantity enters into the sales statistics in the 

SAP Business Information Warehouse (BW), from the billing document. 

The statistics group can be used in the update rules in BW, to update the billing quantity in other key 

figures, or for restrictions within queries. If you do not define further key figures, we recommend that 

you include the Quantity statistics group as a characteristic in the InfoCube. 

In contrast to the maintenance for the Utilities Information System (UIS), you must only define relevant 

statistics groups. The additional maintainable key figures are not copied to BW. 

Statistics groups 000000 to 000002 are supplied as standard by SAP. If you add a rate to a new billing 

schema, the system proposes these statistics groups. The selection depends upon the variant program of 

the rate step. For variants, for example, where the variant definition is allocated as the type of billed 

quantity with value 1 (energy), the system proposes statistics group 000001. The billed consumption of 

billing lines is copied to the Billing quantity for internal billing format (I_ABRMENGE) field for the 

information structure. 

Standard settings 

Do not change the supplied statistics groups 00000 to 000002. 

Use the following customer namespaces: A*, B*, ... , Z* 

Recommendation 

Develop the statistics groups in detail. 

Example: 

- Active energy 

- Reactive energy 

- Eco-quantity 

- Concession quantity 

- Quantity not relevant to statistics 

You do not have to distinguish according to division, because in this case the division is included in the 

InfoCube as a characteristic or define InfoCubes by division. 

To facilitate the installation in the rate steps, we recommend that you use the corresponding key. 

Activities 

1. Define which statistics groups you require for quantities. 

2. Define the statistics groups. 

3. Ensure that the statistics groups are entered in the schema. 
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Further notes 

Discounts that are calculated using the discount variants in the rates, normally generate two statistics-

relevant lines in the billing document. One of the lines has attribute DIFFKZ that is interpreted in the 

update rules in BW. Use the details from the update rules supplied by SAP. 

Caution 

If you do not use further key figures in BW for discounts, you must include the indicator for discounts as 

a characteristic in the InfoCube, because otherwise the discount quantity exists twice in the InfoCube. 

37.8.4.1.1.3.4 Define Statistics Groups for Amounts 

In this IMG activity you define the statistics groups for amounts. Enter the statistics groups in the billing 

schema. You use a statistics group to control how the net amount enters the sales statistics in the SAP 

Business Information Warehouse (BW) from the billing document. 

The statistics group can be used in the update rules in BW, to update the net amount in other key figures, 

or for restrictions within queries.  If you do not define further key figures, we recommend that you 

include the statistics group Quantity as a characteristic in the InfoCube. 

In contrast to the maintenance for the Utilities Information System (UIS), you must only define relevant 

statistics groups. The additional maintainable key figures are not copied to BW. 

The statistics groups 000000 to 000005 are supplied as standard by SAP. If you add a rate to a new billing 

schema, the system proposes these statistics groups. The selection depends upon the variant program of 

the rate step. The type of billed quantity from the variant definition is defined by the default value. The 

billed amount of billing lines is copied to the Net Amount Billing Lines (NETTOBTR) field of the 

extraction structure. 

You can also use other statistics groups when you create a billing schema. 

Standard settings 

Do not change the supplied statistics groups 000000 to 000005. 

Use the following customer namespaces: A*, B*, ... , Z* 

Recommendation 

Develop the statistics groups in detail. 

Example: 

- Base amount 

- Energy amount 

- Demand amount 

- Concession amount 
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- Amount not relevant to statistics 

To facilitate the installation in the rate steps, we recommend that you use the corresponding key. 

Activities 

1. Define which groups you require for amounts. 

2. Define the statistics groups. 

3. Ensure that the statistics groups are entered in the schema. 

Further notes 

Discounts that are calculated using the discount variants in the rates, normally generate two statistics-

relevant billing lines in the billing document. One of the lines has attribute DIFFKZ, that is interpreted in 

the update rules in BW. Use the details from the update rules supplied by SAP. 

Caution 

If you do not use further key figures in BW for discounts, you must include the indicator for discounts as 

a characteristic in the InfoCube, because otherwise the discount quantity exists twice in the InfoCube. 

37.8.4.1.1.3.5 Define Update Group Determination 

In this IMG activity you allocate the statistics groups rate category and contract to an update group. In 

doing so you create the basis of your individual Information System in the SAP Business Information 

Warehouse (BW). 

It is often necessary that certain features of the data objects affect the statistics update. This generally 

means that certain objects in BW, such as rate category, division and contract, can influence the update. 

The update group is a central control element of the update. It is determined during billing of a contract 

from the statistics group for the rate category, and the statistics group for the contract, and the update 

group determination in this activity. 

Note about BW 

You can use the update groups in the update rules within BW, to use characteristics and key figures 

differently. 

Example BW 

The document number is always extracted to BW, independently of the customer grouping. However, you 

must still save the document  number in the InfoCube, just for nonresidential customers. You do not 

require this information for residential customers. 

Check at document number level in the update rules in BW, to see which update group is valid for this 

record. Set the document number  field to 'initial' for the update group for residential customers. This 

reduces the amount of time required for updating residential customers in BW. 

In the later analyses you can implement a breakdown in the document display in IS-U for non-residential 

customers. 
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Requirements 

You must have defined and allocated the statistics groups. 

Recommendation 

Organize the update groups based on your customer groupings. Basic differences are nonresidential and 

residential customers, but also take into account employees and competitive customers. 

Activities 

Allocate the statistics groups to the update groups. 

Further notes 

You must use the update groups in the billing documents, otherwise the document lines are not processed 

in the statistics update. You must maintain at least one update group for each combination of division, 

rate category statistics group and contract statistics group. 

37.8.4.1.1.3.6 Define Statistics Currency per Company Code 

In this IMG activity you define the statistics currency, if it is different to the local currency. 

Note the following for the: 

- Information System for SAP Utilities (UIS) 

This definition is valid for all information structures of the sales statistics. 

- Business Information Warehouse (BW) 

BW can process amounts from different currencies. For this reason, it is not necessary to set the 

statistics currencies. 

The amounts are normally updated in the local currency of the respective company code, in the 

information structures and the extract structures. 

37.8.4.1.1.3.7 Allocate Billing Unit of Measurement to Statistics Unit of 

Measurement 
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In this IMG activity you allocate units of measurement for billing to the units of measurement for 

statistics. This activity is required, in order to be able to convert different units of measurement for the 

same division into a uniform statistical unit of measurement. 

This allocation is only required for units of measurement used in billing that differ from the statistical unit 

of measurement. 

You define the conversion factor by choosing: General Settings -> Check Units of Measurement. 

37.8.4.1.2 Process Statistics 

37.8.4.1.2.1 Activate Business Process Areas for Message Management 

Use 

In this activity, you define which business process areas are to be monitored by Enhanced Message 

Management and BW Process Management. 

You can select the business process areas that SAP provides monitoring for via the possible entries. By 

setting the indicator Activate, you can exclude individual business process areas from the evaluation. 

You enter customer business process areas that you want to monitor in the activity Define Customer 

Business Process Areas for Message Management in the section Specifications for Customer-

Defined Business Processes and Messages. 

37.8.4.1.2.2 Suppression of Messages for Log Preparation 

Use 

In this activity you can define messages that are not used in error analysis and should be excluded from 

the preparation of the application logs. This helps you to ease the burden on your database. 

Activities 

Define the messages that you want to suppress in the log. If you only want to suppress messages within 

one business process area, specify this area. 

Note 

If you want to issue a message that you define in the log at a later point in time: 
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1. Remove the entry from the table. 

2. Prepare the application log for the transaction concerned again. 

37.8.4.1.2.3 Define Success Messages for the Extraction (SAP) 

Use 

Here, you can define the success messages, information messages and warning messages from the SAP 

system, which are to flow into the process statistics. 

Requirements 

The messages only flow into the process statistics if they do not lead to a dispute case in the Enhanced 

Message Management (EMMA) component, and the settings in the business process area mean that 

messages leading to dispute cases are not extracted. You can change these settings if you activate 

business process areas for message management. 

37.8.4.1.2.4 Define Success Messages for the Extraction (Customer) 

Use 

Here, you can define your own success messages, information messages and warning messages, which 

are to flow into the process statistics. 

Requirements 

The messages only flow into the process statistics if they do not lead to dispute cases in the Enhanced 

Message Management (EMMA) component, and the settings in the business process area mean that 

messages leading to dispute cases are not to be extracted. You can change these settings if you activate 

business process areas for message management. 

37.8.4.1.2.5 Define Customer Business Process Areas for Message 

Management 

Use 

In this activity, you enter the installation-specific business process areas that you have created that you 

want to monitor with transaction EMMA. 
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The business process areas that SAP provides monitoring by transaction EMMA for are contained in the 

delivery here. 

37.8.4.1.2.6 Define Customer Business Processes for Message Management 

Use 

In this activity, you enter the installation-specific business processs that you have created that you want to 

monitor with transaction EMMA . 

The business processes that SAP provides monitoring by EMMA for are contained in the delivery here. 

To display the application logs for customer-defined transactions and mass activities in transaction 

EMMA, you can use the method CL_EMMA_MALOG for mass activities, and method 

CL_EMMA_GET_LOG for dialog transactions. If you cannot use these SAP standard methods to 

display the application logs, you have to create a new implementation of the method 

GET_LOGNUMBER. For displaying the intervals of mass activities, SAP provides the standard method 

CL_EMMA_MA_INTINFO. 

See also SAP Note 144461. 

37.8.4.1.2.7 Define Customer Business Processes for Processes from CIC 

Use 

In this activity, you assign a business process code to a process that is executed with the action box from 

the Customer Interaction Center (CIC). You can only measure front office processes and BOR methods. 

To measure a front office process or a BOR method that is executed via action box, select a process ID 

from the possible entries. You can specify the action box configuration or the action box transaction. 

Note that when you measure a process, you measure it regardless of which action box configuration it is 

in. You can use the where-used list to determine the action box configurations and transactions 

concerned. 
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37.8.4.2 Media Companies 

37.8.4.2.1 Maintain Calendar Used to Define Time Slices 

The public holiday and factory calendar is a central module in the SAP System. It is used in many areas 

(e.g. in Logistics and in Human Resources) in the standard version. 

You can use calendar maintenance to maintain and display the components of the calendar system. The 

public holiday and factory calendar data calculated from calendar maintenance is directly available to the 

system. 

You can only change the holiday and factory calendar in the clients setup for them. The client must have 

the "Customizing" role and the "Repository and cross-client Customizing changes allowed" attribute. You 

must have maintenance authorization for the calendar. 

A factory calendar is allocated to your plant via another Customizing function. 

The calendar system consists of the following components: 

- Public holidays 

Definitions for public holidays: Calculation rule for date, religious denomination etc. 

- Public holiday calendar Any composition of public holiday rules. 

- Factory calendar 

Definition of workdays including special regulations, under the assignment of a particular public 

holiday calendar. 

Standard settings 

The system delivers definitions of all common public holidays and public holiday rules, as well as a 

standard factory calendar. 

A main memory area of 400000 Bytes is reserved for calendar data in the standard version. This is the 

mimimum buffer size, which you should not go under. 

Activities 

Check whether all the definitions for public holidays and public holiday rules that you need are available 

in the sytem. If necessary, maintain the public holiday definitions and copy them to new or existing 

public holiday rules. 

Create factory calendars if necessary. 

Public holidays 

Check that existing public holidays are complete, and create new definitions if required: 

1. Double-click with the mouse on the Execute symbol, select the option Public holidays and choose 

the function Display. 

2. Check whether the list of public holidays displayed contains all the public holidays that you need. 

If you want to see detailed information on any public holiday, choose the function Display def. 
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3. If you need other public holidays, return to the initial screen of the maintenance transaction, and 

choose the function Change. 

4. Choose the function Insert, and now make the following entries: 

- Public holiday type 

- Date or calculation rule 

- Public holiday text (short and long) 

- If required: Sort criterion, religious denomination or public holiday class (for notes on this, 

press the F1 Help). Save the definition. 

Public holiday calendar 

Combine the public holidays you require in a public holiday rule in the public holiday calendar: 

1. Double-click with the mouse on "Execute function", select the option Public holiday calendar and 

choose the function Display. 

2. Check whether all the public holiday rules that your require are available. To get the definitions for a 

public holiday calendar, position the cursor on it and choose the function Display def.. 

3. If you need other public holiday calendars or would like to change existing ones, return to the initial 

screen of the maintenance transaction and choose the function Change. 

4. To create a public holiday calendar, choose the function Insert (to change a public holiday calendar, 

position the cursor on it and choose Change), and make the following entries: 

- Calendar ID and a descriptive short text 

- Period of validity (From year, To year) 

5. Using the function Assign public holidays, generate a complete list of defined public holidays. 

6. Select the public holidays you need, and choose Assign public holidays. 

7. Save your entries. 

Factory calendar 

Define a factory calendar including the relevant public holiday calendar: 

1. Double-click with the mouse on "Execute function", select the option Public holiday calendar and 

choose the function Display. 

2. In calendar maintenance, select the option "Factory calendar", and choose the function Change. 

3. Choose the function Insert and make the following entries: 

- Factory calendar ID and a descriptive short text 

- Period of validity (From year, To year) 

- Public holiday calendar ID 

- Start no. factory date 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 273 

Number from which the factory date is incremented for each workday. If you 

do not make an entry, the default value is "0". 

4. Decide which days of the week are meant to be workdays. 

5. Define special rules if necessary (e.g. plant holidays). 

Further notes 

- Calendar buffer 

If you want to increase the size of the calendar buffer, maintain the parameter zcsa/calendar_area 

with the maintenance transaction for system profiles. Restart the system for the value to take effect. 

- Transport 

Changes to calendar data are not automatically included in a correction request. For the calendar 

data to be utilizable in another system, use the function Transport in the initial screen of the 

maintenance transaction. 

Note that you cannot transport individual public holidays or calendars. You can only transport 

calendar data in its entirety. When you do this, all public holidays, public holiday and factory 

calendars existing in the target system are deleted. 

37.8.4.2.2 Define and Assign Time Slice Rules for Contract Update 

In this step you define the time slice rules for COA update in BW and specify a combination of 

organizational data and publication for which the time slice rule is to be used for each time slice rule. 

Example 

You can assign a time slice rule for Monday magazines in the respective sales area for publications that 

are published on Monday. This time slice rule then applies for BW update of a COA in this sales area 

that has a COA requirement in the leading item that refers to a booking unit in this publication. 

Further notes 

Access to the time slice rule has multiple levels: 

1. Using the sales area, sales office, sales group and publication 

2. Using the sales area and the publication 

3. Using the sales area, sales office and sales group 

4. Using the sales area 

If no time slice rule is found for a COA using these accesses or a time slice rule without a factory 

calendar is found, the system generates a data record without a time slice for this COA. 

37.8.4.2.3 Unload Contracts Temporarily from BW 
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See also Program documentation. 

37.8.4.2.4 Revenue Recognition Key Dates 

You define the circumstances in which you require an update in the key date tables for order and/or 

billing document revenue recognition here. 

These tables can be used to perform a reconstruction for the Business Warehouse without losing 

individual changes that have been made to the documents. To ensure that each record is retained and not 

cumulated, both tables contain a number range (ISM_REV1, ISM_REV2, ISM_REV3, ISM_REV4). 

Table        Description 

JHAREV1      Revenue values for the order 

JHFREV2      Revenue values for the billing document 

JHAREV3      Revenue quantities for the order 

JHFREV4      Revenue quantities for the billing document 

These tables can also be used by specific uers independently of BW. The following four service reports 

are available for reconstructing tables or deleting records: 

Report      Description 

RJAREV1    Revenue values for the order 

RJHREV2    Revenue values for the billing document 

RJAREV3    Revenue quantities for the order 

RJHREV4    Revenue quantities for the billing document 

Example 

The system makes entries in tables from the point at which these fields are selected. 

Standard settings 

The system deactivates update as standard. 

Further notes 

Refer to the release notes on this topic. 

37.8.4.3 Bank Profitability Analysis 

In this step you can find information on creating the link between the Bank Operating Concern 

(Banking SEM-PA)  and SAP BW for a replication model. This allows you to evaluate the result data 

determined by the SAP system through SAP BW. 

A special feature of the Banking SEM-PA connection to SAP BW is that Banking SEM-PA is a 

generating application, and so does not deliver structures and tables. The system defines these structures 

and tables specifically for each customer in Customizing through the definition of the organizational unit 

for Bank Profitability Analysis (operating concern). The structure of the InfoCube needs to correspond to 

the structure of the relevant operating concern to ensure that the profitability analysis data is evaluated 

correctly in SAP BW. The structures of the operating concern are unknown, however, so the system 

cannot deliver InfoCubes or DataSources that correspond to these structures. You must therefore generate 
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a DataSource, which results in a procedure for the connection of SAP BW to Banking SEM-PA, which 

differs from the procedure for the connection of SAP BW to other applications. 

A further special feature of Bank Profitability Analysis is that the dataset, which the system creates during 

profitability analysis and must transfer to SAP BW, can be very large. In addition, the evaluations, (for 

example early warning information), require current data, rather than just period-end closing results. The 

system therefore implements a delta procedure for the transfer. The system first initializes the delta 

procedure by replicating all of the data through an InfoPackage. Afterwards, depending on how current 

the evaluation data must be, the system regularly (for example daily) schedules a further InfoPackage, 

through which the system transfers the delta to the last update. 

Bank Profitability Analysis is structured in the same way as standard profitability analysis (CO-PA). 

Bank Profitability Analysis therefore uses the CO-PA programs to extract transaction data. The system 

indicates bank-specific features. In addition, Bank Profitability Analysis offers different master data 

extracts. 

37.8.4.3.1 Procedure for Setting Up Replication Model 

The following is a description of the procedure for creating the connection between your Bank 

Profitability Analysis and SAP BW for a replication model. The procedure is different to the procedure 

used in other applications because the system cannot deliver DataSources that exactly match customer 

requirements. The system executes the activities that are necessary to create the connection between SEM 

Banking and SAP BW, partially in SEM Banking (the creation of the DataSource only), and mainly in 

SAP BW (for example, the creation of the InfoCube). The steps listed below constitute a rough 

description of this process and contain notes regarding special features in Bank Profitability Analysis. 

You can find more detailed documentation in the IMG Activity or in the SAP BW documentation. 

Note 

The steps listed below refer to the connection to a BW System Release 2.0. 

Activities 

1. Create DataSource 

Create a DataSource for the bank operating concern and transfer the default settings. Refer to the 

note in section Create DataSource. 

2. Activate Business Content 

Activate at least one part of the Business Content in Bank Profitability Analysis, namely the 

InfoObject of the InfoCube 'Profitability analysis' (technical name 0SEMPA_C1): This provides 

you with those InfoObjects generally used frequently in Bank Profitability Analysis. 

3. Metadata Upload 

The system replicates the DataSources of a source system in the BW System through Metadata 

Upload. Switch to the source system tree and choose the desired source system. 

If the Bank Profitability Analysis node is available under this source system, choose Update 

Metadata for this node in the context menu (with the right mouse button). If the component Bank 

Profitability Analysis is not available, choose the function Update Metadata for the whole source 

system. In the dialog box that follows, it is advisable to set up the upload to be executed in the 

background. Make sure that the time set for the execution is at least a few minutes in the future. 
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4. Create InfoSource 

Switch to the InfoSource tree and create an InfoSource for transaction data for the application 

component Bank Profitability Analysis using the right mouse button. The InfoSource can collect 

data from different (SAP) systems. 

5. Map the DataSource fields and InfoSource fields 

Switch to the source system tree and choose map DataSource to a BW InfoSource, using the right 

mouse button on DataSource. Assign the InfoSource that you have created. The system then 

generates a corresponding InfoObject in the background for each banking-specific field with a five-

character name. The name of the generated InfoObject consists of the five-character name of the 

field with the prefix 0G_x, where x=C stands for characteristic, x=A for amount, x=Q for quantity 

and x=U for unit of measure. The system therefore generates the InfoObject 0G_CWWXYZ for the 

characteristic WWXYZ. In the screen that follows, both the generated InfoObjects and the 

InfoObjects of the activated Business Content are already assigned to the corresponding DataSource 

fields. Enter the missing field InfoObject assignments manually. If necessary, create InfoObjects for 

this purpose. You can transfer the field assignments into the carryforward rules and copy the 

transfer structure and the communication structure using the icon propose carryforward rules. 

Finally activate the mapping settings. 

6. Create InfoCube 

Switch to the InfoCube tree (through data lines) and create an InfoCube with the InfoSource as a 

template using the right mouse button. Create dimensions for the InfoCube and assign the 

characteristics to these dimensions. Usually, the following dimensions are appropriate for 

profitability analysis: 

- Bank product 

- Business partner 

- Organizational structure 

- Miscellaneous 

You need to assign the characteristics to the dimensions in accordance with the settings for characteristic 

derivation. This means, for example, that you need to assign all characteristics derived from customer to 

the customer dimension. 

7. Create update rule 

The system connects the InfoCube to the InfoSource through the update rules. Using the right 

mouse button, create the update rules with the InfoSource as the data source. Confirm the proposal 

and activate the rules. 

8. Initialize delta process 

Switch to the InfoSource tree and navigate to the source system. 

The DataSource supports the selection criteria. If a particular selection is made in the initialization 

process, you can only load deltas that meet these requirements. 

9. Create an InfoPackage for the initialization of the delta process, using the right mouse button, and 

schedule it once only. 

10. Extract transaction data regularly 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 277 

Create an additional InfoPackage and schedule it regularly for a delta update. It is not advisable to 

create several InfoPackages for delta updates. 

37.8.4.3.2 Special Features of Bank Profitability Analysis 

Bank Profitability Analysis uses the standard profitability analysis programs (CO-PA) to extract 

transaction data. You can find these programs under Create DataSource. Transaction data extraction in 

Bank Profitability Analysis has the following special features: 

- In contrast to Bank Profitability Analysis, standard profitability analysis (CO-PA) delivers 

predefined key figures, which can be transferred into the DataSource. When you create a transaction 

data DataSource, the system gives the option 'calculated key figure from the key figure scheme,' 

although there are no predefined key figures in Bank Profitability Analysis. Do not select these 

fields. 

- You can also connect Bank Profitability Analysis to a SAP BW system with Release 1.2B. Follow 

the relevant notes in the following sections. Note that it is not possible to create a DataSource for 

bank operating concerns prior to 1.2B without errors. Note 204410 solves this problem. 

Unfortunately, this note cannot be delivered in the Support Package for technical reasons. You must 

therefore maintain this note for each Support Package import. 

- You can maintain the transaction data DataSource using the CO-PA tools. To do this, choose the 

following menu path in the Implementation Guide. Business Information Warehouse -> Customer-

defined DataSources -> Profitability analysis -> Tools. 

37.8.4.3.3 Master Data - Data Sources 

Bank Profitability Analysis offers three master data DataSources. If you want to edit these DataSources, 

follow the note and enter '0BA_SEM_PA' as the application component in the Start screen. This 

application component is not offered in F4 Possible Entries. 

You can edit the master data DataSources in the usual way. Find the corresponding InfoObjects in the 

BW-Content in the following list: 

0BA_PARTNR: 

This data source retrieves the business partner master data relating to the Treasury Business Partner. 

In SAP BW, you can either load the available information into the InfoOject 0BA_PARTNR, or use the 

InfoObject 0CUSTOMER, which belongs to CGP. 

This is an attribute DataSource. The system offers selections for language, business partner number 

(internal and external) and name. 

0BA_RBPROD: 

This DataSource provides bank product master data (product group). You can load this data into the 

InfoObject OBA_RBPROD. This is an attribute DataSource. 

0BA_RBPROD_TEXT: 

This text DataSource provides the texts relating to bank products. 

0BA_RKALRG: 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 278 

This DataSource provides costing rule master data. This can be loaded into the InfoObject 

0BA_RKALRG. This DataSource is not language-dependent. 

0BA_RKALRG_TEXT 

This text DataSource provides the texts relating to costing rule master data. 

37.8.4.4 Contract Accounts Receivable 

In the following activity, you make the settings for the extraction of data from Contract Accounts 

Receivable and Payable (FI-CA). 

37.8.4.4.1 Define Fields for the Extraction of Items 

In this activity you make the specifications for the extraction of data for open and cleared items and, in 

particular, for the fields of the transfer structures DFKKOPBW and DFKKCIBW. 

Requirements 

If you need additional fields to those delivered by SAP, you have to enter these in the includes 

CI_FKKOPBW (open items) and CI_FKKCIBW (cleared items). 

Standard settings 

SAP delivers some fields preconfigured. However, you can change the configuration for these fields here. 

This means that you can define: 

- How the fields are to be filled 

- From which fields or tables the fields are to be filled 

- With which grid and which source field and grid source field the DELAY field is to be filled 

Activities 

Select the type of items to be extracted and define the required fields. 

You can define character fields with a length of 14 characters as grid fields in the field Grid. Using the 

grid ID entered, the system determines a grid value using the comparison between source table/source 

field and grid source table/grid source field. The source fields must be date fields. The system places the 

value in the field you have specified under Field Name. 

37.8.4.4.2 Define Grid for Grouping of Items 
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Use 

In this activity, you can define a grid for open and cleared items that can be used to group the items for 

the extraction for the Business Information Warehouse (BW). This enables you to display all items 

due in the next 10, 20, and 30 days together using an evaluation of the due dates of the items, for 

example. 

37.8.4.4.3 Process Statistics 

37.8.4.4.3.1 Activate Business Process Areas for Message Management 

Use 

In this activity, you define which business process areas are to be monitored by Enhanced Message 

Management and BW Process Management. 

You can select the business process areas that SAP provides monitoring for via the possible entries. By 

setting the indicator Activate, you can exclude individual business process areas from the evaluation. 

You enter customer business process areas that you want to monitor in the activity Define Customer 

Business Process Areas for Message Management in the section Specifications for Customer-

Defined Business Processes and Messages. 

37.8.4.4.3.2 Suppression of Messages for Log Preparation 

Use 

In this activity you can define messages that are not used in error analysis and should be excluded from 

the preparation of the application logs. This helps you to ease the burden on your database. 

Activities 

Define the messages that you want to suppress in the log. If you only want to suppress messages within 

one business process area, specify this area. 

Note 

If you want to issue a message that you define in the log at a later point in time: 
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1. Remove the entry from the table. 

2. Prepare the application log for the transaction concerned again. 

37.8.4.4.3.3 Define Customer Business Process Areas for Message 

Management 

Use 

In this activity, you enter the installation-specific business process areas that you have created that you 

want to monitor with transaction EMMA. 

The business process areas that SAP provides monitoring by transaction EMMA for are contained in the 

delivery here. 

37.8.4.4.3.4 Define Customer Business Processes for Message Management 

Use 

In this activity, you enter the installation-specific business processs that you have created that you want to 

monitor with transaction EMMA . 

The business processes that SAP provides monitoring by EMMA for are contained in the delivery here. 

To display the application logs for customer-defined transactions and mass activities in transaction 

EMMA, you can use the method CL_EMMA_MALOG for mass activities, and method 

CL_EMMA_GET_LOG for dialog transactions. If you cannot use these SAP standard methods to 

display the application logs, you have to create a new implementation of the method 

GET_LOGNUMBER. For displaying the intervals of mass activities, SAP provides the standard method 

CL_EMMA_MA_INTINFO. 

See also SAP Note 144461. 

37.8.4.4.3.5 Define Customer Business Processes for Processes from CIC 

Use 

In this activity, you assign a business process code to a process that is executed with the action box from 

the Customer Interaction Center (CIC). You can only measure front office processes and BOR methods. 

To measure a front office process or a BOR method that is executed via action box, select a process ID 

from the possible entries. You can specify the action box configuration or the action box transaction. 
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Note that when you measure a process, you measure it regardless of which action box configuration it is 

in. You can use the where-used list to determine the action box configurations and transactions 

concerned. 

37.8.4.5 Cross-Application Components 

In this section you make settings for cross-application components for which data can be transferred from 

a source system into a Business Information Warehouse. 

37.8.4.5.1 Classification System 

Classification System in SAP System 

Objects in the SAP System are classified using the Classification System. The properties of objects are 

mapped using characteristics and characteristic values. Selecting values for an object is known as 

characteristic value assignment. 

Attributes in Business Information Warehouse 

The characteristic values assigned to classified objects in the SAP System are made available to the 

Business Information Warehouse as attributes. These attributes are used to generate the structure of a 

37.8.4.5.1.1 Maintain Data Sources for Classification Data 

In addition to the data sources from the BW conten referred to here as basis data sources, further data 

sources can be created. 

In this IMG activity, you assign the characteristics that you want to use as attributes in the Business 

Information Warehouse to the new data source. 

Activities 

1. 1. Enter a basis data source that you want to extend. 

2. 2. Select the client, class type, and object table from which you want to copy 

classification data. 

3. 3. Select the data source to which you want to assign characteristics, then 

choose Characteristics. 

- 4. Choose New entries and enter the characteristics you want to assign. 
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- 5. If you want to define a sequence for the characteristics, enter position numbers. 

4. Statuses are assigned automatically: N = New: this status appears before a new 

data source has been created. 

- R = Ready: the status is converted to this status after generation. If you change a characteristic, reset 

the status to N before generation. 

Choose Data source to generate the data source. This also generates the characteristic data sources 

for characteristics of data type CHAR. 

An internal key starting with "1CL_..." is assigned as a data source name. 

Further notes 

- The possible entries button only displays data for the client you are logged on to. 

- InfoSources in BW-System from AdminWorkbench must be created for the DataSources generated 

and assinged to the DataSources. 

37.8.4.5.2 Status Concept 

The status concept allows you to represent SAP status objects in BW. The system can transfer system and 

user statuses from the ERP system to BW. 

In the following steps: 

- To make the SAP default settings available in the productive client, carry out an import from the 

Customizing client for Customizing table BWCUSYSTAT (system status) before the production 

start-up. 

- Assign the ERP status objects to a BW status object. 

Use either a standard BW status object, or create a user-specific BW status object. 

- Generate a DataSource for the BW status object. 

Background Information 

ERP master data usually shows all statuses currently active for an object. Any number of statuses can be 

active simultaneously. 

However, there are some status values that are mutually exclusive, so that only one of them can be active 

at any one time. 

For projects, for example, these statuses include the following: 

- Created 

- Released 

- Technically complete 

- Complete 

You can define a BW status object for these statuses in the source system, in Customizing for 

BW. 
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The statuses are combined under a four-character key. A sequence number is assigned to each status for 

the internal representation of the status value in BW. 

A BW status object can depict either a group of system statuses or a group of user statuses. Use 

transaction BWS1 in the case of system statuses or BWS2 in the case of user statuses. 

Additional Hints 

For detailed information on the status concept and implementation, see note 300300. 

37.8.4.5.2.1 Maintain BW Status Object for System Status 

In this work step, you assign a BW status object to an ERP system status object. You can assign any 

number of ERP system status objects to a BW status object. 

Requirements 

To make the SAP standard settings available in the productive client, carry out an import from the 

Customizing client for the Customizing table BWCUSYSTAT (system status) before the production start-

up. 

Activities 

1. Choose New Entries. 

2. If you want to add an assignment to a standard BW status object, enter the name of the 

standard BW status object. 

3. To create a new BW status object, enter any four-character name for the BW status object. 

4. Choose the ERP system statuses that you want to assign to the BW status object. 

5. Save your entries. 

37.8.4.5.2.2 Maintain BW Status Object for User Status 

In this work step you assign a BW status object to ERP  user status objects You can assign any number of 

ERP user status objects to a BW status object. 
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Activities 

1. Choose New entries. 

2. If you want to make an assignment to a standard BW status object, enter the name of the standard 

BW status object. 

3. If you want to create a new BW status object, enter any four character name for the BW status 

object. 

4. Choose the ERP user status that you want to assign to the BW status object. 

The system assigns the corresponding status profile to the user status automatically. 

5. Save the entry. 

37.8.4.5.2.3 Generate Data Source for a BW Status Object 

In this workstep you generate an info object for a BW status object. 

Activities 

1. Enter the four character abbreviation for the BW status object. 

2. Enter a description for the BW status object. 

This will be used in the BW as a column description. 

3. If you want to assign an info object to an application, enter the name of the application. 

If you do not want to assign an info object to any application, enter the abbreviation SAP-R/3-IO. 

Assignments help to search info objects in the BW. 

4. Choose Generate. 

The system produces 

- an info object with the name STATUS + four character status abbrev and - a data 

element with the name BWST + four character status abbrev. 

37.8.4.6 Financial Accounting - Special Purpose Ledger 

To be able to transfer transaction data from your user-defined ledgers from the source system into the 

Business Information Warehouse, you first need to perform the following Customizing activities in the 

source system: 

1. Generate a transfer structure for the totals table 

2. Define and assign a DataSource for a ledger 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 285 

Note 

Please note that ledgers are client-specific objects and DataSources are cross-client objects. A 

DataSource can be assigned to a maximum of one ledger within one client. If you assign a DataSource to 

more than one client, the ledgers assigned must all be created in the same totals table. 

37.8.4.6.1 Generate Transfer Structure for Totals Table 

In this activity, you generate a transfer structure for your totals table. This structure is used to transfer 

transaction data from your ledgers to the Business Information Warehouse. 

Note 

If you have already generated a transfer structure for the totals table, a new transfer structure is generated 

and assigned. The system records this transaction in a transport request. 

Activities 

1. Enter the name of the totals table. 

2. Choose Execute. 

The system generates a transfer structure and assigns it to the totals table. 

Name of transfer structure 

The system derives the name of the transfer structure from the name of the totals table according to the 

following rule: 

- If the name of the totals table ends with T, the T is replaced with a B. 

- If the name of the totals table does not end with T, a B is added to the name of the totals table. 

37.8.4.6.2 Create InfoSource for Ledger 

In this activity you define a DataSource for a ledger and assign this DataSource to the ledger. 

Note 

Please note that ledgers are client-dependent and DataSources client-independent objects. A 

DataSource can only be assigned to one ledger within a client. If you want to assign a DataSource across 

several clients the ledgers assigned must all be entered for the same totals table. 

Requirements 

To define a DataSource for a ledger and assign it you must have generated a transfer structure for the 

totals table of this ledger. Carry out this setting in Customizing for R/3 extractors under 

Business Information Warehouse -> Customer-Defined DataSources -> Financial Accounting - 

Special Ledger (FI-SL) -> Generate Transfer Structure for Totals Table. 

Activities 
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1. Check that your ledger has already been assigned a DataSource. 

In the list, all ledgers are displayed that have a transfer structure for their totals tables. The column 

Status displays whether the ledger has already been assigned a DataSource. If an assignment 

already exists (traffic light green) you can only change the description texts. 

2. Choose a ledger that you want to assign the DataSource to. 

3. Enter the name of the DataSource you want to assign to the ledger. 

The name must begin with the number 3 and may only contain letters, numbers and _. The system 

suggests a name that begins with the prefix 3FI_SL_ and contains the name of the ledger. 

Once you have saved the assignment you can no longer change the name. 

4. Enter a description for the assignment. You can use Copy ledger texts for this. 

5. Confirm your entries. 

6. Assign each of the fields in the transfer structure an InfoObject. 

You can not exclude transfer structure fields from the DataSource. 

7. Save your assignment. 

37.8.4.6.3 Generate DataSources for Set Hierarchies 

Requirements 

You have created set hierarchies in R/3 Systems before. 

To create a set hierarchy, go in the R/3 System and choose Accounting -> Financial Accounting -> 

Special Purpose Ledger -> Tools -> Set Maintenance -> Sets -> Create. 

Activities 

1. Enter the table that uses the set, and select the table field for the set. 

2. If the characteristic in BW, to which the hierarchy refers, is compounded and if you want to transfer 

its compound information of the source system with it to BW, select BW InfoObject 

(characteristic) is compounded. Specify the data element to which the hierarchy is compounded. 

When loading the hierarchy, the compound information in BW is now taken into account. If you 

want to extract FI-SL sets to a compounded characteristic, you must run the compounding in a 

customer exit program. In addition, create a project in transaction CMOD for SAP enhancement 

RSAP0001  and program EXIT_SAPLRSAP_004 (ZXRSAU04). 
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3. Execute the program to generate the DataSource for the set hierarchy. 

37.8.4.7 Overhead Cost Controlling 

37.8.4.7.1 Report Row Hierarchies  
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37.8.4.7.1.1 Define Report Row Hierarchies 

This menu item is optional. It enables you to define report row hierarchies for the evaluation of cost 

elements in BW. Here the values for the cost elements from a cost element group can be controlled 

depending on the sender/receiver indicator in different report rows. 

The following functions are available for defining the report row hierarchy: 

- BWOM01 Define Report Row Hierarchy 

- BWOM02 Display and Check Report Row Hierarchy 

Integration into BW Content 

The report row hierarchies are available for evaluations in BW queries as presentation hierarchies for the 

0CO_REPLINE InfoObject. The hierarchies can be extracted into the BW system using the extractors for 

this InfoObject. 

The 0CO_REPLINE InfoObject technically includes the concatenation of sender/receiver indicators 

(0DB_CR_IND) and the cost element (0COSTELEMNT). This value is calculated in the update rules for 

the respective InfoCube. 

The 0CO_REPLINE InfoObject is delivered and used with BW Content as of Release 3.10. However, the 

concept of report rows can also easily be integrated into BW Content for any earlier release. 

Example 

You have defined the following cost element groups in Controlling: 

- MATERIALCOSTS with cost elements 450000 and 450001 

- PERSCOSTS with cost elements 416000 and 416900 

- OVERRUNCOSTS with cost elements 474000 and 474001 

Now you want to define a "Personal and Material Costs" report row in which you remove the total from 

the debits under personal and material cost elements and the credits under overrun costs. 

To do this, define the report row hierarchy in Customizing as follows: 

Line 0100 / Sender-Receiver. - / Cost Element Group 04 Personal and Material Costs /Totals Row - / 

Description 

Line 0200 / Sender-Receiver S / Cost Element Group 01 Personal Costs / Total Row 0100 / Personal 

Costs Description 

Line 0300 / Sender-Receiver S / Cost Element Group 02 Material Costs / Total Row 0100 / Material 

Costs Description 

Line 0400 / Sender-Receiver H / Cost Element Group 03 Overrun Costs / Total Row 0100 / Overrun 

Costs Description Tip: 

Display the report row hierarchy after defining it with transaction BWOM02. The system then 

tests Customizing again for consistency. 

Requirements 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 289 

Cost element groups must exist in Controlling. 

Activities 

When attaching a report row hierarchy, define the basic report rows and totals rows. 

Assign the cost elements to a basic report row by using a cost element group. The cost elements need to 

be entered in this row. By using the setting for the sender/receiver indicator, you control whether credits 

or debits are entered in this report row. 

You assign basic report row using the totals row field for a higher-level totals row. 

You cannot specify cost element groups in the total rows. However, you can reference these rows for 

totals rows. Then enter the number for the respective totals row in the column of the same name. 

There has to be one report row hierarchy for each header line. This is the totals row that does not have an 

entry in the column of the same name. 

Procedure 

Call up transaction BWOM01. 

Choose New Entries. 

Enter a controlling area, the name of the report row hierarchy, and a description. 

Select the processed row. 

Choose Line Structure. 

Choose New Entries. 

Enter the totals row and basic report rows. 

If you select Hierarchy, the set hierarchy under the report row is extracted as the hierarchy structure into 

the BW system. By default, only the cost element assignments for the set are transferred, and not the 

hierarchical structure. 

37.8.4.7.1.2 Display and Check Report Row Hierarchies 

In this IMG activity you display the report row hierarchies. While the hierarchies are displayed, the 

system checks the their consistency. In case of inconsistencies, an error message is issued. 

If you receive such an error message, access the IMG activity Define Report Row Hierarchies and correct 

the faulty hierarchy. 

Requirements 

You have created such hierarchies in the IMG activity Define Report Row Hierarchies. 
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Activities 

After the transaction is started, all defined report row hierarchies are shown. To display a hierarchy, 

proceed as follows: 

1. Select the row with the hierarchy that you want to display. 

2. Choose Display Tree. 

3. The selected hierarchy is displayed in the window General Hierarchy Display. You can expand 

the list like normal. 

37.8.4.8 Profitability Analysis 

In this activity, you can find all the necessary information on how you can create the link between 

Profitability Analysis (CO-PA) and the Business Information Warehouse (SAP BW) for the replication 

model. By creating this link, you can then use the SAP BW to analyze the results data determined in CO-

PA. 

What is unusual about the integration of CO-PA to the SAP BW is the fact that CO-PA is an application 

that generates data but does not deliver any structures or tables. These structures and tables are only 

defined when the customer-specific organizational unit for Profitability Analysis (operating concern) is 

defined in Customizing. To ensure that CO-PA data is analyzed correctly in the SAP BW, the structure of 

the InfoCube should correspond to that of the appropriate operating concern. However, given that the 

operating concern structures are not known, it is impossible to deliver any InfoCubes - and hence no 

DataSources either - that match these structures. You therefore need to generate a DataSource, and this is 

where the procedure for connecting the SAP BW to CO-PA differs from other applications. 

There is another unusual aspect to Profitability Analysis: the dataset generated in CO-PA and copied to 

the SAP BW can be very large. Furthermore, it is necessary for some analyses, such as those for early 

warning information, to have up-to-date data as opposed to having just the results of period-end closing. 

For this requirement to be met, a delta procedure is implemented for the data transfer. This delta 

procedure is first initialized when all data is replicated via an InfoPackage. Then, depending on how 

current the analysis requires the data to be, an additional InfoPackage is planned on a regular basis (such 

as daily). This InfoPackage is then used to transfer the delta for the latest update. 

37.8.4.8.1 Procedure for Setting Up Replication Model 

This activity describes the process you should use to create the connection between your Profitability 

Analysis (CO-PA) and SAP BW, this connection being required for the replication model. Since it is 

impossible to deliver a DataSource that is tailored precisely to all the specific requirements that customers 

have for analyzing profitability data, the procedure applied here differs from that applied in other 

applications. 

Most of the activities necessary for creating the connection between CO-PA and SAP BW are not 

performed in the source system (only the creation of DataSources in performed there). The rest of the 

activities are performed in SAP BW (such as the creation of InfoCubes). The activities described below 
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are intended to provide a rough outline of the process and contain notes on particular aspects of 

Profitability Analysis that you need to be aware of. You can find more detailed information in the 

documentation for each IMG activity or in the SAP BW documentation. 

Note 

The steps described below relate to connecting a BW system from Release 2.0. If you also want to set up 

a connection to the BW system Release 1.2 with this extractor, see the section Procedure for Setting Up 

the Replication Model for BW Release 1.2. 

Activities 

1. Creating DataSource 

Create a DataSource for the operating concern and transfer the default settings for it. Be sure to see 

the notes in the section Create Transaction Data DataSource. 

2. Activating Business Content 

Activate at least one part of the Business Content for Profitability Analysis, in particular the 

InfoObjects for the InfoCubes CO-PA: Published Key Figures and CO-PA: Quickstart (S_GO). 

In this way, you can then use InfoObjects that are usually frequently used in Profitability Analysis. 

You should activate the other delivered InfoCubes if you want to use the corresponding operating 

concern templates that are available from R/3 Release 4.6. 

3. Metadata Upload 

The metadata upload function is used to replicate in the BW system the DataSources from a source 

system. 

Switch to the source system tree and choose the desired source system. If the Profitability Analysis 

node exists for the selected source system, select it with the cursor and use the right mouse button to 

choose Update metadata. If the Profitability Analysis component does not exist, use the right 

mouse button to choose the function for the source system. 

A dialog box then appears. You should always set the upload to occur in the background. Make sure 

that the time of execution is at least a few minutes ahead of the current time. 

4. Creating InfoSource 

Switch to the InfoSource tree and use the right mouse button to create for the application component 

Profitability Analysis an InfoSource for transaction data. The InfoSource can collect data from 

different systems. 

5. Mapping DataSource and InfoSource Fields 

Switch to the source system tree. Select the DataSource and use the right mouse button to choose 

Map DataSource to a BW InfoSource. Assign the created InfoSource. The system then 

generates a corresponding object in the background for each CO-PA-specific field with a five-

character name. The name of the generated InfoObject consists of the five-character field name 

and the prefix "0G_x" (where x=C for characteristic, x=A for amount, x=Q for quantity, and x=U 

for unit of measure). For 

example, for the characteristic WWXYZ, the system generates an InfoObject with the name 
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0G_CWWXYZ. 

In the next screen, the generated InfoObjects as well as the info objects for the activated Business 

Content are already assigned to the corresponding fields of the DataSource. Enter any missing 

assignments between field and InfoObject manually. This may require you to create InfoObjects. 

When you choose Suggest transfer rules, the system copies the field assignments to the transfer 

rules, the transfer structure, and the communication structure. Finally, activate the mapping 

settings. 

6. Creating InfoCube 

Switch to the InfoCube tree (by choosing Data targets) and use the right mouse button to create an 

InfoCube using the InfoSource as a template. Create dimensions for the InfoCube and assign the 

characteristics to these dimensions. 

As a rule, it is useful to use the following dimensions in Profitability Analysis: 

- Customer 

- Product 

- Organization structure 

- Other 

You should make the assignments of characteristics to the dimensions according to the settings for 

characteristic derivation. This means that you should assign to the dimension Customer, for 

example, all characteristics that were derived from the customer. 

7. Creating Update Rules 

The InfoCube is linked to the InfoSource via the update rules. 

Use the right mouse button to create the update rules for the InfoCube, using the InfoSource as the 

source of data. Copy the suggestion and activate the rules. 

8. Initializing the Delta Procedure 

Switch to the InfoSource tree and navigate to the source system. Use the right mouse button to 

create an InfoPackage for the initialization of the delta procedure and schedule it to occur once. 

9. Regular Extraction of Transaction Data 

Create one extra InfoPackage and schedule it to occur regularly for a delta update. It is not practical 

to create several InfoPackages for delta updates. 

37.8.4.8.2 Assign Key Figures 

In this activity, you assign elements of a key figure scheme to some of the key figures predefined in CO-

PA. By placing these elements into DataSources, you can transfer your contribution margin scheme 

(which you defined using the key figure scheme) to your SAP BW. This eliminates the need to define 

new key figures there. Another advantage is the fact that the key figure scheme in the SAP BW then has 

fixed concepts at its disposal that can be accessed in predefined Queries or from external systems without 

requiring knowledge of customer-specific information from CO-PA. However, it is necessary for the key 

figure and the element from the key figure scheme assigned to it to have the same meaning from a 

business point of view. 
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For more information about the business meaning of predefined key figures, see the documentation 

relating to the existing key figures listed below. You call up the documentation by clicking the 

appropriate key figure. 

- Sales Unit (COPASLQTU) 

- Sales Quantity (COPASLQTY) 

- Revenue (COPAREVEN) 

- Customer Discount (COPACDSCN) 

- Product Discount (COPAPDSCN) 

- Quantity Discount (COPAQDSCN) 

- Promotion (COPASPROM) 

- Cash Discount (COPACASHD) 

- Rebate (COPAREBAT) 

- Miscellaneous Sales Deductions (COPAODSCN) 

- Total Sales Deductions (COPADISCT) 

- Net Sales (COPANETSL) 

- Sales Commission (COPASCOMM) 

- Special Sales Direct Costs (COPASDIRS) 

- Anticipated Shipment Costs (COPAFRGTC) 

- Total Sales Direct Costs (COPADIRSL) 

- Net Revenue (COPANETRV) 

- Material Direct Costs (COPADMATC) 

- Variable Production Costs (COPAPRDCV) 

- Total Variable COGM (COPACOGSV) - Contribution Margin I (COPAMRGN1) 

- Material Overhead (COPAMATOH) 

- Fixed Production Costs (COPAPRDCF) 

- Total Fixed COGM (COPACOGSF) 

- Contribution Margin II (COPAMRGN2) 

- Total Variances (COPAVRNCS) 

- Contribution Margin III (COPAMRGN3) 

- Marketing Overhead (COPAOHMRK) 

- Sales Overhead (COPAOHSLS) 

- Administrative Overhead (COPAOHADM) 
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- R&D Overhead (COPAOHRND) 

- Logistics Overhead (COPAOHLOG) 

- Miscellaneous Overhead (COPAOHOTH) 

- Total Overhead (COPAOVHDC) 

- Operating Profit/Loss (COPAPROFT) 

If you do not wish to separate your costs of goods manufactured into fixed and variable, you can use the 

key figure Total COGM (COPACOGS). 

As is the case for the key figure scheme itself, the assignment of the elements of the scheme is specific to 

the operating concern. In other words, you assign the key figures individually for each operating concern. 

Instead of assigning an element from a key figure scheme, you can choose to assign a value field or one 

of the function modules at your disposal. 

Example 

Requirements 

Standard settings 

Recommendation 

Activities 

In the overview screen, choose New Entries and assign one of the following to a key figure: 

- An element from the key figure scheme 

- A value field, or 

- the function module of a user exit 

Ensure that the key figure and the object assigned to it have the same business meaning. 

Further notes 

To obtain an overview of all the assignments maintained, select the pushbutton Overview. 

37.8.4.8.3 Create Transaction Data DataSource 
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In this activity, you can create or delete a DataSource for analyzing data from Profitability Analysis (CO-

PA) as well as display its structure. 

Create: 

You define a DataSource on the basis of an existing operating concern. You can include in your 

DataSource all or just some of the characteristic and value fields of this operating concern. 

A DataSource is defined by the following elements: 

- Operating concern 

- Amount of characteristics 

- Amount of value fields 

- Amount of calculated key figures 

Up to and including Plug-In Release PI2003.1, a DataSource is only defined in the current client of the 

source system. This means that a DataSource can only be extracted from this client. The DataSource has a 

timestamp for the delta method, and this timestamp is only valid for the current client. This timestamp is 

managed by Profitability Analysis. 

With Plug-In Release PI2004.1, timestamp management was converted to a new method, called generic 

delta. This method works in combination with a BW system with Release 2.0 and higher. With this 

method, timestamp management is no longer performed by Profitability Analysis, but instead by the 

Service API (interface between Profitability Analysis and SAP BW). 

Compared to timestamp management in Profitability Analysis, the generic delta allows for 

several enhancements: 

- You can apply the delta method simultaneously using the same DataSource from more than one 

client of the source system because a separate timestamp is saved for each logical system. 

- You can apply the delta method for the same client of the source system simultaneously using the 

same DataSource from several BW systems. 

- You can perform several initializations of the delta method with different selections using the same 

DataSource from a given BW system for the same client of the source system. 

- The DataSource commands the "Delta Init Simulation" mode. With timestamp management in 

Profitability Analysis, this mode had to be implemented using the Simulate Delta Method 

Initialization transaction (see SAP Note 408366). 

For more information on the generic delta, see section Delta Transfer, whereby the steps of the 

"Specify Generic Delta for a DataSource" section are performed automatically for Profitability Analysis 

when a DataSource is created. For this, the field determining the delta is taken as the timestamp for 

Profitability Analysis (TIMESTMP), and the timestamp is stored for summarization levels and line item 

tables. However, in contrast to generic DataSources, the TIMESTMP field is not generated in the 

extraction structure because this is not necessary for DataSources in Profitability Analysis. As with 

timestamp management in Profitability Analysis, an upper limit of 30 minutes is set as the safety interval. 

You find the timestamp of a DataSource for the delta method in the current logical system either on the 

"Last Data Transfer" tab page or using the IMG activity Check Delta Queue. The timestamp is shown 
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here when you choose the selection button in the Status column for the combination of DataSource and 

BW system. 

DataSources created after implementing PI2004.1 automatically apply the new method. DataSources that 

were created in Plug-In releases prior to PI2004.1 still continue to use timestamp management in 

Profitability Analysis but can be converted to the generic delta in transaction Create CO-PA DataSource. 

For this, an additional selection option Convert to Generic Delta appears in the selection screen when a 

DataSource with timestamp management in Profitability Analysis is entered. Conversion from the generic 

delta to timestamp management in Profitability Analysis is not supported. 

Conversion is only possible for DataSources that are defined in the current client of the source system and 

for which the delta method has already been successfully initialized or for which a delta update has 

successfully been performed. This is the case once the DataSource has the replication status "Update 

successful". Furthermore, no realignments should have been performed since the last delta update. 

For the conversion, the timestamp for the current source system client is transferred from Profitability 

Analysis into the timestamp of the generic delta. In this way, the transition is seamless, enabling you to 

continue to perform delta updates after the conversion. If delta updates are to be performed from 

different clients of the source system for this DataSource, you first need to initialize the delta method for 

these clients. 

The conversion must be performed separately in each source system because the timestamp 

information is always dependent on the current R/3 System and is reset during the transport. If, however, 

a converted DataSource is inadvertently transported into a system in which it has not yet been converted, 

delta extraction will no longer work in the target system because the timestamp information is deleted 

during the import into the target system and is not converted 

to the timestamp information of the generic delta. If in this instance no new delta initialization is going to 

be performed in the target system for the DataSource, you can execute program 

ZZUPD_ROOSGENDLM_FROM_TKEBWTS from SAP Note 776151 for the DataSource. This 

program reconstructs the current time stamp information from the information for the data packages 

transported thus far and enters this time stamp information into the time stamp information for the generic 

delta. Once this program has been applied, delta extraction should work again. Normally, however, you 

should ensure during the transport that the DataSource uses the same logic in the source system and 

the target system. 

After the conversion, the DataSource must be replicated again from the BW system. 

A successful conversion is recorded in the notes on the DataSource. 

Since the generic delta does not offer any other log functions apart from the timestamp information 

(status: Plug-In Release PI2004.1), Profitability Analysis still logs the delta initialization requests or delta 

requests. However, the information logged, in particular the timestamps, only has a statistical character 

because the actual timestamp management occurs in the generic delta. Since the delta method can be 

performed simultaneously for the same source system client using the generic delta from several BW 

systems, the information logged is stored for each logical system (source system) and BW system. When 

a delta initialization is simulated, only the timestamp of the generic delta is set; Profitability Analysis is 

not called. Consequently, no information can be logged in this case. Messages concerning a DataSource 

are only saved for each logical system (on the source system side). You can use the IMG activity Display 

Detailed Information on DataSource to view the information logged. 

Another enhancement from Plug-In Release PI2004.1 means that you can no longer exclusively perform 

full updates (that is, update mode "F") for DataSources of the Extractor Checker of the Service API that 

have recently been created or converted to the generic delta. The following update modes are possible: 
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- "F" - Full update: Transfer of all requested data 

- "D" - Delta: Transfer of the delta since the last request 

- "R" - Repeat transfer of a data package 

- "C" - Initialization of the delta transfer 

- "S" - Simulation of the initialization of the delta transfer 

In the case of all update modes other than "F", you have to specify an BW system as the target system so 

that the corresponding timestamp and/or selection information for reading the data is found. The "Read 

only" parameter is set automatically and indicates that no timestamp information is changed and that 

Profitability Analysis does not log the request. 

Update mode "I" (transfer of an opening balance for non-cumulative values) is an exception: Although 

you can still select this mode, the system issues an error message because Profitability Analysis does not 

support this mode. 

Delete: 

You can delete a DataSource that you no longer require. 

Activities 

Create: 

1. Give the DataSource a unique technical name. As a default setting, this name starts with the prefix 

"1_CO_PA". This prefix is mandatory and cannot be changed. 

2. To create the DataSource, choose DataSource -> Create. 

3. Select the characteristics that are to be included in the DataSource. The DataSource must contain 

some of these characteristics. These are already selected for you and cannot be deactivated. 

It is also useful to include characteristics that are contained in the segment table and are hence used 

to create the profitability segments. These characteristics are already selected but you can 

deactivate them if necessary. 

When selecting the characteristics, ensure that they are formally independent of each other in 

Profitability Analysis. In this way, it is also possible to make postings at the aggregated level. In 

spite of this formal independence, a logical dependency can still exist between some characteristics. 

For example, the customer group is logically dependent on the customer. You need to keep this 

logical dependency in mind when transferring characteristics into SAP BW so that you obtain valid 

data there. We recommend that, for each characteristic you select, you also select all the 

characteristics that are logically dependent on the selected characteristic. As a general rule, it is not 

useful to model CO-PA characteristics as navigation attributes in SAP BW. The inclusion of 

dependent characteristics has no negative consequences for performance or for the dataset. 

4. For costing-based Profitability Analysis, select the value fields and calculated key figures that are to 

be included in the DataSource. It is useful to include all the value fields of the operating concern. 

These value fields are already selected but you can deactivate them if necessary. The system checks 

that the units of measure relating to the value fields are also transferred. 

Technical notes: 
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- Along with the selected characteristics and value fields, the fiscal year variant and the record 

currency are also included in the replication so that the data in SAP BW can be interpreted 

correctly. 

- The technical field PALEDGER (currency type) in Profitability Analysis is encrypted as 

CURTYPE (currency type) and VALUTYP (valuation) during the transfer to SAP 

BW. 

- The plan/actual indicator (PLIKZ) is copied to SAP BW as value type (WRTTP). 

5. You can use the Summarization level? icon to determine for costing-based CO-PA whether callup 

occurs by means of a summarization level when the delta procedure is initialized (the first time you 

replicate all CO-PA data into SAP BW). It is particularly useful to use a summarization level as a 

data source if the data in SAP BW is maintained at an aggregated level. In such cases, replication 

can be performed much more quickly due 

to the data having already been presummarized. If the system cannot find an appropriate 

summarization level for the characteristics and value fields that you selected, it reads the data from 

the segment level or from the line items. For more detailed information about data sources, see SAP 

Note 392635. For information about the data sources, see also SAP Note 392635. 

6. If no appropriate summarization level exists for the DataSource, you can use the function Create 

Summarization Level to create a proposal of a summarization level that is appropriate as a data 

source. 

7. Saving the DataSource generates a DataSource with the name 0G_Cyyyy_TXT (where yyyy = name 

of the characteristic) for the characteristics defined in CO-PA for the subsequent replication of the 

texts. 

8. Once the InfoObjects have been generated in the background, a screen appears in which you can 

specify whether selections can be made from a field in the InfoPackage. For account-based CO-PA; 

the fields "Period/Year" (PERIO) and "Controlling Area" (KOKRS) are mandatory fields for the 

selection. Furthermore, you can hide a field in the DataSource, but this is not relevant for CO-PA. In 

this screen, choose Save. In some cases, you access a screen in which you can perform an 

assignment of CO-PA fields to BW fields. This only applies when there is a connection to the 

SAP BW Release 1.2.. For more information, see the section Procedure for Setting Up the 

Replication Model for BW Release 1.2. 

For connections to SAP BW 2.0 or higher, only choose Save at this point. This takes you back to 

DataSource maintenance. 

Note: Up to and including Plug-In Release PI2003, a DataSource in CO-PA only carries one 

timestamp. This means that a maximum of just one BW system can be connected to a DataSource 

for a Delta replication. To connect additional BW systems, you need to create an additional 

DataSource or use the replication methods available in the BW system. 

Delete: 

1. By choosing DataSource -> Delete, you can delete any DataSources that you no longer require as 

well as the generated extract structure "ZOX*"  belonging to a deleted DataSource. 

Further notes 
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You cannot change a DataSource once created. You can, however, delete it and then create a DataSource 

with the same name but with different technical properties. You should not upload metadata between 

these two steps. 

37.8.4.8.4 Create Hierarchy DataSource 

In this activity, you create a DataSource for loading hierarchies from Profitability Analysis (CO-PA) into 

SAP BW. 

Enter the following data: 

- Name of the hierarchy DataSource 

- Short text 

- The InfoObject for which you are generating the DataSource 

- The related CO-PA characteristic for which you are creating the hierarchies. 

37.8.4.8.5 Tools 

Some functions are available as tools to provide assistance with setting up the connection between 

Profitability Analysis and SAP BW. 

37.8.4.8.5.1 Display Detailed Information on DataSource 

You can use this IMG activity to display the following information for a DataSource: 

- Header Information 

- Delta method: You see here whether the DataSource uses timestamp management in 

Profitability Analysis or the generic delta (see documentation on Create Transaction Data 

DataSource). 

- System information: For DataSources with timestamp management in Profitability Analysis, 

the source system and the client in which the DataSource is defined are displayed. For 

DataSources with generic delta, the current logical system is returned. 
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- Operating concern and type of profitability analysis 

- Extract structure 

- Replication status: This status is only relevant for DataSources with timestamp management in 

Profitability Analysis and is only displayed for such DataSources. 

- Timestamp information: For DataSources with timestamp management in Profitability 

Analysis, the delta method timestamp stored in Profitability Analysis is displayed and is used 

to read the data for the next delta update. With the generic delta, the timestamp information 

saved by the service API is returned. With timestamp management, this is the timestamp for 

the delta method (for reading the data of the next delta update), and with the generic delta, the 

timestamp for a repeat. 

- Information on how the extractor handles realignments: Initialization of the delta method needs 

to be repeated for realignments. 

- Information on Initialization and/or on Delta Updates of the Delta Method: 

The information offered for DataSources with timestamp management in Profitability Analysis 

differs from that offered for DataSources using the generic delta in the following ways: 

- DataSources with timestamp management in Profitability Analysis 

- Information on initializing the delta method 

- Information on the last delta update 

- Information on the individual delta init requests or delta requests 

If you have reset the DataSource using transaction Simulate the Initialization of the Delta 

Method, it is issued with the request name "ARTIFICIAL". 

- DataSources with generic delta 

Since the timestamp management is transferred in this case from the Service API, the 

timestamp information displayed only has statistical character. The timestamp relevant for 

reading the data is shown in the header information for the DataSource. Since it is possible to 

extract data simultaneously from several BW systems, the information issued depends on the 

BW system: 

Last Request: Information on the last request is returned. However, when data is extracted 

from several BW systems, the request that is chronologically the last is displayed. 

Per BW System: Information on the individual delta init requests or delta requests is listed, as 

well as the corresponding init selections. When data is extracted simultaneously from several 

BW systems, the number of records read and sent does not have to agree with the actual 

number due to the Service API logic. Delta init simulations cannot be entered because 

Profitability Analysis is not called up in this case. 

- Messages for the DataSource 

For DataSources with generic delta, messages are issued independently of the calling BW system. 

- Field list of the DataSource 

- Additional Information This is technical information. 

Example 
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Requirements 

Standard Settings 

Recommendation 

Activities 

Further Notes 

37.8.4.8.5.2 Simulate Initialization of Delta Process 

This function is only relevant for DataSources with timestamp management in Profitability 

Analysis. It is not relevant for DataSources that use the generic delta (see the documentation on 

Create Transaction Data DataSource). 

You can use this function to simulate the initialization of the delta procedure for a DataSource and to set 

the time stamp of the DataSource to a desired value. You can then plan an InfoPackage for delta updates. 

Important note: Only use this function in the cases described below. Inappropriate use can cause 

irreparable inconsistencies in your data in the SAP BW. 

The simulation occurs as follows: the system sets the DataSource status to "Update successful" and gives 

it the time stamp you entered. A data package is also logged with the interval 0 to that time stamp. This 

data package sends 0 records to the SAP BW. 

It makes sense to simulate the initialization of the delta procedure under the following circumstances: 

- You want to perform an initial test in the SAP BW using just a reduced amount of transaction data 

so that you can view reports with data from your CO-PA DataCube, for example, without having to 

replicate several million data records in the SAP BW. In this case, set the DataSource time stamp in 

the Date and Time field to a date a few weeks ago. 

Apart from executing this function, you also need to make the following settings in the SAP BW to 

simulate the initialization of the delta procedure. 

a) In transaction RSADMIN in the SAP BW, enter your name in the field User for whom the 

debugging mode is active. 

Consequently, the indicator Update data in the source system immediately in the tab page 

Update parameters in the InfoPackage Scheduler is then unlocked for entries. 
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b) Create an initialization InfoPackage and deactivate the indicator Update data in the source 

system immediately for this InfoPackage. In this way, you stop the system from immediately 

processing the request IDoc in the source system. 

c) Start the initialization InfoPackage. 

d) In the monitor, set the overall status for this InfoPackage to "OK" (green light). 

- You want to continue a delta replication from a different DataSource. This is sometimes necessary 

(for example, after an upgrade from R/3-Release 3.x) if you wish to use the new option for updating 

multiple valuations (transfer prices). You then need a DataSource containing the valuation category 

(VALUTYP) as well as the currency type (CURTYPE). In this case, simply copy the time stamp 

from the old DataSource by entering the name of that DataSource in the field from a different 

DataSource. Then continue the delta replication from the new DataSource. 

Note: The initialization of the delta procedure must also be simulated in the SAP BW for the new 

DataSource. To do this, follow the points a) thru. d) described above. 

- If a problem occurs during the replication, SAP Support may ask you to enter a particular time 

stamp directly for a DataSource. 

In this case, enter the value recommended by Support in the Direct entry field. 

Example 

Requirements 

Standard settings 

Recommendation 

Activities 

Further notes 

37.8.4.8.5.3 Activate Debugging Support 
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You should only use this function if SAP Support recommends that you do so. This function is required if 

debugging is necessary to analyze errors in your system. 

Data can only be extracted from one client for DataSources with timestamp management in Profitability 

Analysis. Consequently, debugging support per DataSource is activated independently of the client. 

With the generic delta (see documentation on Create Transaction Data DataSource), on the other hand, 

data can be extracted from several clients. Consequently, debugging is activated per DataSource and with 

the current logical system. 

Example 

Requirements 

Standard Settings 

Recommendation 

Activities 

Further Notes 

37.8.4.8.5.4 Activate Debugging Support Using InfoObject 

You should only use this function when you are asked to do so by SAP Support. It is required when 

debugging is necessary during error analyses in your system. 
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37.8.4.9 Investment Management 

In Investment Management, you sometimes need to rename investment programs from the OLTP system 

or systems before transferring them to the Business Information Warehouse (BW). 

37.8.4.9.1 Investment programs 

An investment program is a hierarchical structure of planned and budgeted costs for a company's or 

group's investments over a certain time frame. The program can be structured according to any number of 

criteria. 

Investment programs from the  OLTP system or systems that you want to report on in the Business 

Information Warehouse (BW) need to be renamed in the following instances: 

- If the name of the investment program in the OLTP system contains more than four characters, you 

need to give it a name with a maximum of four characters when transferring it to BW. 

- If you want to run summarization reports over more than one investment program from the OLTP 

system in BW, then you must give the OLTP programs a common name for BW. In addition, one of 

the investment programs needs to be marked as determining the structure of the program in BW. 

Note 

Investment programs whose names have no more than four characters and for which you do not want to 

run summarized reports in BW do not need to be maintained here. They are transferred to BW using their 

OLTP name and stored under that name in BW. 

37.8.4.9.1.1 Convert program name 

Example 

You wish to represent the investment programs "WORLD" and "USA", which exist in one or more OLTP 

systems, together in the Business Information Warehouse (BW). "WORLD" is to determine the 

hierarchy, while "USA" is only to supply data. 

The OLTP program name "WORLD" does not have four characters, and must therefore be replaced with 

a new BW program name (such as "PRO1"); you therefore rename the programs "WORLD" and "USA" 

for BW, and call them "PRO1". 

You set the indicator to denote that the OLTP program "WORLD" is the hierarchical program. 

In BW, reports can be run together for both investment programs, "WORLD" and "USA", under the name 

"PRO1". 

Requirements 

- The names of OLTP programs can have up to eight characters, but BW program names may only 

have four. It may be necessary to change longer program names to be no longer than four characters 

for the BW. 
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- One investment program from the OLTP has to specify the hierarchical structures of the overall 

program to be created, which means it must be hierarchical. All program items existing in the other 

OLTP investment programs have to be created in this program. The programs that only supply data 

may only be sub-hierarchies of the hierarchical program. You must have defined a complete 

investment program, therefore; any additional programs serve as sub-structures. 

- The program items of the hierarchical program must have the same names as the program items of 

programs supplying data. 

The user must ensure that the following conditions are met: 

- A hierarchical program is defined. 

- The system does not contain several programs that are defined as being hierarchical; the system 

checks whether more than one hierarchical program is contained in the system. 

- The hierarchical program contains the program items of the programs providing data. 

Standard settings 

Investment programs that have four-character names are automatically transferred to the BW under their 

OLTP names. They only need to be maintained in the table if they are to be represented together with 

other investment programs. 

Activities 

1. Assign new, four-character BW program names to all OLTP programs that have names containing 

more than four characters. 

2. Assign a common program name to all investment programs that are to be summarized in BW. You 

enter this name in the "Program (BW)" column. 

3. If several OLTP programs are combined in one BW program, indicate which is the hierarchical 

program by selecting the column "HierBearng" for the relevant program. 

Result: 

All investment programs to which you have assigned the same program name for BW and which have 

the same approval year can be represented together in the same summarization report. 

Further notes 

IMG -> Investment Programs 
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37.8.4.10 Enterprise Controlling 

In this section, you generate DataSources for the Enterprise Controlling component. 

37.8.4.10.1 Set Up Extractors for EC-EIS/EC-BP 

Before you can use the extractors for transfering data from the EC-EIS and EC-BP components, you have 

to create the corresponding DataSources from which the data is extracted and transfered to the Business 

Information Warehouse in the source system. 

Activities 

Perform this step to generate a DataSource for transaction data using the report you called up. 

Further notes 

When creating DataSorces, the OLTP system assigns names, which are formed according to the pattern 

'1_EC_EIS_BP_sysname_CFnnn_EX'. The following replacements have to be made: 

 sysname Name of the System 

 nnn Aspect Number 

To transfer master data and attributes, it is furthermore necessary to maintain generic 

DataSources. This is done using another activity: Maintain generic DataSources 

37.8.4.10.2 Create Customizing for Extractors in Consolidation 

Before you can use the extractors for the transfer of data from SAP consolidation components, 

you have to create the corresponding DataSources in the source system. The data will be extracted from 

this and transferred into the Business Information Warehouse. 

If you want to create a hierarchy DataSource for custom characteristics, then you have to define a 

hierarchy beforehand for which this DataSource is created. 

Activities 
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Execute this step in order to start the following processing via the the called up report: 

- Create a DataSource for transaction data includung custom characteristics 

- Create DataSources for text extraction for all custom characteristics, which have texts at their 

disposal 

- Create DataSources for hierarchy extraction for all custom characteristics, which have hierarchies at 

their disposal 

- Display an audit trail 

Enter a development class and a transport request, so that the generated structures can be transported from 

the test system into a production system. 

Further notes 

The OLTP system assigns names while creating the DataSources, they are formed according to the 

following schema: 

- for DataSources for transaction data: '3EC_CS_1' 

- for DataSources for text extraction for custom characteristics: '3' + CS-Field name+ 

'_TEXT' 

- for DataSources for hierarchy extraction for custom characteristics: '3' + CS-Field name 

+ '_EIS_HERE' 

37.8.4.11 Real Estate Management 

In this section you can make settings for extracting Real Estate data into the Business Information 

Warehouse. 

37.8.4.11.1 Extraction Vacancies 

Two parameters have to be set before you are able to extract imminent vacancies: 

1. The minimum length of a vacancy: If the vacancy in question is shorter than the value indicated in 

this field, it is not considered to be an imminent vacancy. This would be the case, say, for a regular 

tenant changeover when the rental unit remains vacant for a limited period, for redecoration or 

modernization work, for example. The entry is made in days. 

2. Period of warning: This is the period for which an immiment vacancy appears in the report in 

advance of the vacancy. When the report is executed, all the vacancies occurring after the key date 

and within the period indicated by this parameter are displayed. The entry represents the number of 

days. 

The parameter settings are client-dependent and can be made for each company code or usage type. 
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37.8.4.11.1.1 Parameters for Extracting Imminent Vacancies 

Example 

- In the vacancy extraction, you do not wish to consider vacancy periods between two rental periods 

for rental units with usage type "apartment" that are shorter than two months as these vacancies 

would be expected during regular tenant changeovers. On the other hand, you wish to consider 

vacancy periods of less than a month for rental units with another usage type, such as "office". 

- For imminent vacancies of rental units with usage type "apartment", you wish to be alerted three 

months before the vacancy start. On the other hand, a period of a month may suffice for offices. 

Enter the corresponding values for each usage type in the maintenance screen. You may enter different 

values for different company codes. If you intend the same settings to apply for each usage type for all 

company codes, you should leave the Company code field empty. Similarly, you should leave the Usage 

type field empty if the settings are to apply regardless of the usage type. 

Requirements 

External usage types for rental units have to be defined in Customizing for Real Estate. 

37.8.4.12 Logistics 

In Logistics, you need to carry out activities in several areas in order to connect your system to the SAP 

Business Information Warehouse. 

You can find the corresponding definition by clicking on each of the activities that need to be carried out. 

37.8.4.12.1 Managing Extract Structures 

This section describes Customizing of extract structures in movement data for Logistics. The old LIS 

technique described below for the transfer information structures has some disadvantages compared to the 

new technique and is no longer necessary. There are, however, some overlaps between the two 

techniques, particularly if you wish to use LIS and BW in parallel. 

37.8.4.12.1.1 Activate/Edit Extraction Structures 

The aim is to manage extract structures, used to transfer Logistics movement data from OLTP into the 

BW. 

The extract structures are completed using the communication structures in the Logistics Information 

System (LIS). 
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The Cockpit contains the following functions, entered in the following sequence: 

1. Maintenance of extract structures 

Each extract structure can be maintained by SAP or by you. The extract structures are provided from 

the assigned communication structures. You can only use selected fields from the communication 

structures. SAP already delivers extract structures. You can enhance these. After creating the extract 

structure, they are automatically generated. During this process, the missing fields (related units and 

features) are completed. The extract structure is created hierarchically in accordance with the 

communication structures. Each communication structure leads to the generation of a sub-structure 

of the actual extract structure. 

2. Maintaining InfoSources 

At this point, call up general maintenance of InfoSources. Here you can set the selection of 

selectable fields and the negativability of fields. 

3. Activating the update 

By setting as active, data is written into the extract structures, both online as well as during 

completion of setup tables. (see below). 

4. Job control 

5. Depending on the Update Mode you have set (see next section), a job may have to be scheduled, 

with which the updated data is transferred in the background into the central delta management. 

6. Update Mode 

Here, you can set how the incurred data is updated during delta posting: 

a) Serialized V3 Update 

This is the normal update method. Here, document data is collected in the order it was created 

and transferred into the BW as a batch job. 

The transfer sequence is not the same as the order in which the data was created in all 

scenarios. 

b) Direct Delta 

In this method, extraction data is transferred directly from document postings into the BW 

delta queue. 

The transfer sequence is the same as the order in which the data was created. 

c) Queued Delta 

In this method, extraction data from document postings is collected in an extraction queue, 

from which a periodic collective run is used to transfer the data into the BW delta queue. 

The transfer sequence is the same as the order in which the data was created. 

d) Unserialized V3 Update 

This method is almost exactly identical to the serialized update method. The only difference is 

that the order of document data in the BW delta queue does not have to be the same as the 

order in which it was posted. We only recommend this method when the order in which the 

data is transferred is not important, a consequence of the data target design in the BW. 
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Further notes 

For Release 4.0b and 4.5b set the cursor on the corresponding line for each step and press the relevant 

button. As from Release 4.6a, all steps go directly via the links. 

If the communcation structures are to be extended to new fields, using Customer exits and append 

technologies, these can also be recorded in in the extract structures. If you select such a new field, an 

append structure is created to the extract structure. 

37.8.4.12.1.2 BW Log 

You can control transfers to BW using a log. 

A user-related log is defined for each application, if the user parameter MCL is set. The last posting 

procedure for each application is always recorded; existing log entries are overwritten. 

Recommendation 

The log is only for test purposes. You should deactivate it during productive operation. 

37.8.4.12.1.3 Initialization 

Initialization must be prepared by OLTP. A setup completes setup tables, which are then read during 

initialization. 

To enable the setup to be reset after a termination, assign a name to each background run for a setup. 

Then, if a setup terminates or a setup from the archive documents is interrupted, the status of the setup at 

this point can be stored under this name. When you restart using this name, you can continue processing 

from here, without needing to go through the whole process again. Once the run has been completed 

successfully, the inbetween status that was stored in the memory is deleted. 

The setup must run in the background. 

37.8.4.12.1.3.1 Delete the Contents of the Setup Tables 

As the setup tables are no longer needed after initialization, you can delete them again. To be on the safe 

side, you can also do this before the setup to ensure that data that has not already been setup is available. 

Deleting tables is carried out for all clients, for performance reasons. 
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37.8.4.12.1.3.2 Filling in the Setup Table 

Completing setup tables is a critical action, that should be carried out with caution. For large data 

amounts, this can take longer than one night and may have to be done at the weekend. 

In the setup log (transaction NPRT) you can see more information on setups that have already been 

carried out. 

37.8.4.12.1.3.2.1 Cross-Application Selection Parameters 

The following text describes the selection parameters used by several applications for completing setup 

tables. 

Restrictions of document data: 

- Archive file 

Enter the name of the archive file, from which the archived documents should be read. If you do 

not enter an archive, the documents from the system are read. 

- Archiving run 

Archiving runs have sequential numbers that count in ascending order automatically. The numbers 

for the archiving runs apply to all objects. 

- Name of the run 

To continue with a setup that has been terminated or interrupted, you must assign a run name to 

each run in the report, so that the run can be saved at regular intervals and there is a constant record 

of the status. The system uses this name to search for the first document, that has not been processed 

and processing begins again here. 

Note: 

To avoid using a name that already exists, you can see all the run names in table "TMCW3" using 

transaction SE16. 

- New run 

If you set this indicator, document processing begins with the first document selected, if there is still 

an entry to be reset available under the run name. 

- Date and time of termination 

You can determine when processing finishes. If a report runs, for example, at the weekend, it is a 

good idea to finish processing on Monday morning when online processing begins again. This is 

particularly important, if you have chosen the option Block all documents. 
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37.8.4.12.1.3.2.2 Application-Specific Setup of Statistical Data 

This section describes the relevant, application-specific features for applications that can carry out 

statistical setups. 

37.8.4.12.1.3.2.2.1 Inventory Management - Perform Setup 

Requirements 

Before you execute this activity, there must be at least one extraction structure activated per application. 

For further information, refer to Logistics Extract Structures Customizing Cockpit. 

Further notes 

You can display the LIS setup log. For more information, refer Ito  LIS Setup Log. 

37.8.4.12.1.3.2.2.2 Perform setup - Purchasing 

Requirements 

Before you can implement this activity, at least one application structure per application must be 

activated. You can find more information under Logistics Extract Structures Customizing Cockpit. 

Further notes 

You can display the LIS restructure log. You can find more information under  LIS restructure log. 

37.8.4.12.1.3.2.2.3 Perform setup - Production 

The program RMCFNEUA reads the selected production orders and process orders and triggers the 

statistical update of these orders, according to the settings you made in the Customizing Cockpit. Only 

orders in the system are processed, not those that are already archived. 
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The program RMCFNEUD reads the document log for repetitive manufacturing and triggers the 

statistical update for these orders, according to the settings you made in the Customizing Cockpit. 

37.8.4.12.1.3.2.2.4 Perform setup - Quality Management 

The program RMCQNEBW reads the existing inspection results or quality notifications system and 

triggers the statistics update for these inspection results or notifications in accordance with the selection 

you made in the Customizing cockpit. Thereby only those inspection results or notifications resident in 

the system are processed, and not those already archived. 

Requirements 

Before you perform this activity, you must activate at least one extract structure per application. For more 

information, see Logistics Extract Structures Customizing Cockpit. 

Further notes 

You can display the BW log. For more information, see BW Log. 

37.8.4.12.1.3.2.2.5 Perform setup - Plant Maintenance 

The program RMCINEBW reads the maintenance messages in the system  and initiates, in accordance 

with your seection in the Customizing Cockpit, the statistical update of these messages. Only the 

messages resident in the system are processed, not those already archived. 

Requirements 

Before you execute this activity, at least one extract structure must be activated per application. For more 

information, refer to Logistics Extract Structures Customizing Cockpit. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 314 

Further notes 

You can display the BW log. For more information, refer to BW log. 

37.8.4.12.1.3.2.2.6 Service Management - Perform Setup 

The program RMCSNEBW reads the service messages in the system and initiates, in accordance with 

your settings in the Customizing Cockpit, the statistics update of these messages. Only the m essages 

resident in the system are processed, not those that are already archived. 

Requirements 

Before you execute this activity, at least one extract structure must be activated per application. For more 

information, refer to Logistics Extract Structures Customizing Cockpit. 

Further notes 

You can display the BW log. For further information, refer to BW Log. 

37.8.4.12.1.3.2.2.7 SD Sales Orders - Rebuild 

Standard settings 

In this activity, you call up selected sales orders and trigger the statistical update for the BW extraction 

structures for sales orders. The statistical update used here corresponds to the one you chose in the 

Customizing Cockpit. 

Activities 

1. If you want to use documents that have already been archived, enter the name of the archiving run. 

If you leave this field blank, the system calls up documents that are still resident in the system. 

2. You can also restrict the number of documents called up by entering a sales organization, company 

code, or specific range of documents. 

Further notes 
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Select Simulation if you want to check the update. In this case, the system only fills in the activated 

extraction structures but does not run an update. You can then analyze the structures in the Business 

Warehouse Log. 

Requirements 

Before you can carry out this activity, you must have activated at least one extraction structure per 

application. For more information, see Logistics Extract Structures Customizing Cockpit. 

37.8.4.12.1.3.2.2.8 LE Deliveries - Rebuild 

Standard settings 

In this activity, you call up selected deliveries and trigger the statistical update for the BW extraction 

structures for deliveries. The statistical update used here corresponds to the one you chose in the 

Customizing Cockpit. 

Activities 

1. If you want to use documents that have already been archived, enter the name of the archiving run. 

If you leave this field blank, the system calls up documents that are still resident in the system. 

2. You can also restrict the number of documents called up by entering a sales organization, company 

code, or specific range of documents. 

Further notes 

Select Simulation if you want to check the update. In this case, the system only fills in the activated 

extraction structures but does not run an update. You can then analyze the structures in the Business 

Warehouse Log. 

Requirements 

Before you can carry out this activity, you must have activated at least one extraction structure per 

application. For more information, see Logistics Extract Structures Customizing Cockpit. 

37.8.4.12.1.3.2.2.9 SD Billing Documents - Rebuild 

Standard settings 

In this activity, you call up selected billing documents and trigger thestatistical update for the BW 

extraction structures for billing documents. The statistical update used here corresponds to the one you 

chose in the Customizing Cockpit. 

Activities 
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1. If you want to use documents that have already been archived, enter the name of the archiving run. 

If you leave this field blank, the system calls up documents that are still resident in the system. 

2. You can also restrict the number of documents called up by entering a sales organization, company 

code, or specific range of documents. 

Further notes 

Select Simulation if you want to check the update. In this case, the system only fills in the activated 

extraction structures but does not run an update. You can then analyze the structures in the Business 

Warehouse Log. 

Requirements 

Before you can carry out this activity, you must have activated at least one extraction structure per 

application. For more information, see Logistics Extract Structures Customizing Cockpit. 

37.8.4.12.1.3.2.2.10 LES-Shipment Costs - Perform Setup 

The VTRBWVIFBW program reads the selected shipment cost documents and, depending on the settings 

you made in the Customizing Cockpit, triggers statistical updates of these documents. Only those 

shipment cost documents present in the system are processed. The ones that were previously archived are 

not. 

Requirements 

Before you can carry out this activity, you must have activated at least one extract structure per 

application. For more information, see Logistics Extract Structures Customizing Cockpit. 

37.8.4.12.1.3.2.2.11 LES-Transport - Perform Setup 

The program VTRBWVTBWNEW reads the selected shipment documents and initiates, in accordance 

with your settings in the Customizing Cockpit Extraction, the update of ths statistical data for these 

documents. 

Requirements 

Before you execute this activity, at least one extraction structure must be activated per application. For 

more information, refer to Logistics Extract Structures Customizing Cockpit. 
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37.8.4.12.1.3.2.2.12 Settlement Management - Setup 

In this step you set up documents in the agency business. 

Requirements 

Before you do this, you have to activate at least one extraction structure per application. For further 

information, see  Logistics Extraction Structures Customizing Cockpit. 

Further notes 

You can display the LIS setup log. For further information see  LIS Setup Log. 

37.8.4.12.1.3.2.2.13 Invoice Verification - Execute Reconstruction 

Use 

Before you perform an initial upload into BW, you first have to perform a reconstruction. The 

reconstruction writes the documents that are to be extracted in a setup table. 

37.8.4.12.1.3.2.2.14 Kanban - Perform Setup 

Use 

In this IMG activity, program RMCFNEV1 reads the selected kanban control cycles and triggers the 

initialization of data in the setup tables. The BI InfoPackage then sends this initialized data from the setup 

tables to the BI system. This is done using DataSource 2LIS_04_PKKANBAN. The update mode is 

specified in the logistics extraction structures of the Customizing Cockpit. 

Requirements 
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You have activated the Kanban extraction structure and selected the corresponding update mode in the 

LO Customizing Cockpit. For more information, see the Logistics Extraction Structures Customizing 

Cockpit. 

ACTIVITY 

To execute the IMG activity, select the required criteria for the data initialization. You can use the 

selection criteria plant, production supply area, and material for the control cycles that are relevant for the 

initialization. 

Initialization steps: 

1. In the initialization table or setup table (table MC04PK0KANSETUP), program 

RMCFNEV1 creates a data record for each control cycle. Using the control cycle table (table 

PKHD) and the kanban data (PKPS), the required key figures are then calculated for each control 

cycle. 

2. Key figures such as those specified in the time stamp for the initialization run are calculated. The 

kanban initialization process does not incorporate historical kanban data. 

3. All time-based key figures are set to null initially. 

4. Quantity or stock-based key figures are calculated based on the status of the control cycle and the 

kanban at the time of the initialization run. 

Further Notes 

You can display the setup log for the LO Cockpit. For more information, see BW Log 

(transaction LBWQ). 

You can delete data that has already been initialized. For more information, see Delete the Contents of the 

Setup Tables (transaction LBWG). 

37.8.4.12.1.3.3 LIS Setup Log 

You can use this activity to display the log from an LIS setup. Information about the length of a run, 

number of documents that were processed, or termination information for setup runs appears, according 

to the selection criteria you entered on the selection screen. 
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37.8.4.12.2 Managing Transfer Information Structures 

This section describes the Customizing for the transfer information structures. This technique is necessary 

if an application is not yet available in the extract structure management. If you already inserted transfer 

information structures, but extract structures already exist, you should switch to these, as it is technically 

far superior and delivers better data. 

37.8.4.12.2.1 Setup of Statistical Data 

During a setup (statistical setup), the information structures are filled with consistent and complete data. 

The statistical setup of one or more information structures is necessary in the following cases: 

- If an information structure was created using the Logistics Data Warehouse (statistical database) 

- If the update for the information structures was activated after documents were already in the system 

that were meant to be included in the statistics 

- If the statistical update in Customizing was changed 

- If the statistical data is inconsistent 

Preparation 

To restart a statistical update after an termination, allocate a name to each background run of 

the setup. 

If a statistical setup is then terminated or if a setup is interrupted from the archive documents, the status of 

the setup will then be saved under the name of this run. 

When restarting under the same name, processing will continue from the intermediate status that was 

saved. 

After the run is successfully completed, the intermediate status that was saved is deleted. 

Recommendation 

- The reports should run as a background job. 

- You should not change the sequence of steps that describe the statistical setup of information 

structures (procedure). 

Procedure 

The following steps are necessary to perform a complete statistical set up: 

1. Initialize version for statistical setup 

For reasons of security, the statistical data determined during a setup is not directly written into an 

information structure, but are saved instead under a separate version name. This version must be 

activated for intermediate storage before the statistical setup is carried out. 

For this purpose, the report RMCSISCP is available. 
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The actual data is saved under the version name "000". 

2. Save actual data 

The actual data in the system should be saved for safety reasons. Again, use 

report RMCSISCP for this purpose. 

3. Edit all archived documents 

To do this, you can use the various reports that are available in the individual applications. 

4. Edit all documents in the system 

This also takes place via the various reports that are available in the individual applications. 

5. Transfer the data which was obtained in the statistical setup from the statistical setup version 

to the actual version 

The data obtained is only imported to the actual version instead of the existing data after the 

successful completion of the statistical setup. 

The report RMCSISCP is again used for this purpose. 

Note 

You can see the versions of the standard information structures by using the standard analyses. Here 

are the following possibilities: 

a) You can allocate the version number of the version as a value to the user parameter "MCR" 

that you would like to see. 

On the selection screen of the standard analysis, the field Version  under Parameters is 

automatically completed  with the given version number. The version number can be changed 

simply by overwriting it. 

This setting is user-dependent and applies to all standard analyses. 

b) If you assign the value "X" to the user paramter "MCR", the version "000" will generally 

appear on the selection screen of the standard analyses. Even in this case, the version number 

can be overwritten. 

This setting is also user-dependent and applies to all standard analyses. 

If you want to use either one of these functions, select System -> User profile -> User 

parameters. You can select this function from any menu. 

Recommendation 

You should change the user parameters in an alternative session, as it is not possible to return 

to the starting point from the user parameters maintenance screen. 

c) Via "User settings", you can also make specifications for the versions, which are also user-

dependent, but also only refer to one particular standard analysis. To do this, in the selection 

screen of the standard analysis, select Goto -> User settings. 

You are now in the standard drill-down. Select Goto ->Parameters. If you set the 

indicator "Selectable version", the field "Version" with the version number "000" will also 

appear on the selection screen. This version number can be overwritten at any time and thus 

changed. 

6. Follow-up processing 

After successfully completing the statistical setup, you can then delete data that is no longer 

needed by deleting the version under which this data is saved. These include: 
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- Safety copy 

- Version for statistical setup 

The report RMCSISCP can be used for this purpose. 

Activities 

To carry out a statistical setup, procede as follows: 

1. Enter your selection requirements. 

2. Save your entries. 

3. Select Program -> Execute. 

Description of the report RMCSISCP 

The report RMCSISCP is used in all information systems in Logistics. For this reason, the report is 

described below. 

You can use report RMCSISCP you can copy or delete versions from information structures under which 

statistical data has been saved. 

The data, that has been saved in an information structure, is different due to the version under which they 

have been saved. 

The version "000" includes the actual data, i.e., the data that was written into the information structure as 

a result of the statistical update. 

The intermediate results are stored in the versions that begin with "&(" and that are created when an 

information structure is setup. 

Planning data is stored under all other versions (that means version A000 and all numerical versions 

except version 000). 

The statistical setup of an information structure is carried out just like the online update, with the 

difference being that the data is not usually written into version "000" first, but rather into a version that 

you choose, that begins with "&(". The data is only copied from this version into the "000" version after 

the successful completion of the initial transfer. 

Note 

While copying into the "000" version, you must not carry out any postings that update the 

respective information structure. 

To keep the old version "000" (the existing actual data) from being lost, save it under another version. 

This "safety copy" is also generated with report RMCSISCP. 

You can use the indicator "Initialize target version" to delete data data stored until now under this version. 

If the indicator "Do not copy initial records" is set, data records are only set if at least one key figure is 

not initial. 

Attention 

The report RMCSISCP should only be used for copying, deleting and for copying + deleting. Copy 

Management should be used to meet more complex requirements (Tools -> Copy Management). 
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Activities 

1. Enter the name of the information structure that is to be copied/deleted. 

2. Choose a processing type. 

The Copy Management screen is called up. The processing type that you have selected is already 

set. 

3. Here you make all the remaining entries required for selection. 

Additional functions 

You can also call up a log which contains detailed information about all of the completed setup runs. 

This function allows you to make restrictions by specifying the start date of a run, the run name, the user 

and the application. 

You can also either print the list of selected setup runs or the detail screen for a setup run. 

37.8.4.12.2.1.1 Version Copier for (Transfer) Information Structures 

With the version copier for (transfer) information structures, you can copy and delete the 

statistics data in the information structures Snnn and the delta tables of the LIS environment SnnnBIW1 

and SnnnBIW2. 

It replaces the report RMCSISCP that is used in the Setup of the statistical data to copy and delete 

versions. 

A copy program is generated, if required, for each table. The following functions and input options are at 

your disposal: 

 1. (Transfer) Information Structure 

Only information structures for which the LIS environment for linking up to the Business 

Information Warehousee (BW) has been generated can be processed. 

a) Table 

Selection of the tables to be processed: 

- (Transfer) Information Structure Snnn 

- Delta Table SnnnBIW1 

- Delta Table SnnnBIW2 

where Snnn is the name of the information structure. 

b) Processing Type 

- Copy version: 

@2U@ The selected data of the source version is copied to the target version. 

- Delete version: 
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@11@ The selected data of the source version is deleted. 

- Copy + delete: 

The selected data of the source version is copied to the target version and then deleted in the 

source version. 

Activities 

To copy and/or delete the statistics data, proceed as follows: 

1. Enter the name of the (transfer) information structure. 

2. Choose the table. 

3. Select the processing type. 

If required, the system generates a copy program and the selection screen is called up. 

4. Enter the source version and, for copying, the target version. 

During copying, the standard setting has the indicator 'Initialize target version' preset. With this 

indicator set, the data in the target version is deleted before copying. If the indicator is not set, 

indicators that can be accumulated (sliding comma figures, integers, packed numbers) and are 

marked in the definition of the information structure as figures that can be accumulated (summation 

indicators) are added up, and thus compressed to values that already exist. 

5. If only certain data is to be processed, this can be limited in the selection parameters for the 

characteristics and the period. 

6. Choose Programm -> Execute or Program -> Background processing. 

Note 

No postings (online updates) may follow if data is copied to the version  000 using actual data, that 

is, data that was written to the table by the statistics update. 

37.8.4.12.2.1.2 Cross-Application Selection Parameters 

The following section describes the selection parameters that are used by several applications for the 

setup of statistical data. 

Specifications for the target structures: 

- Information structure to be set up 

Here, you can specify which information structures you would like to supply with data. The 

information structures that you specify here will be set up. 

- Save under a version 

To optimize saving the statistical data, the actual data will not be overwritten by the data of the 

statistical setup. 
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During the statistical setup, the statistical data is stored under the version that you specify here, 

whereas statistical data is stored in the information structures under the version "000" (actual data) 

in the case of online entry and online updating of an order. 

The "000" version is the version that is used by the information systems to refer to their data. 

The reports for the statistical setup do not prevent the data that already exists from being 

unavailable. The old data is not replaced by the new data until later, in a subesequent step of the 

setup. 

After completing the setup of statistical data you can analyze the results and then copy them to the 

actual version (report RMCVISCP). This report also allows you to save the old actual values in a 

version. 

Note 

All versions, that begin with "&(" are reserved for the setup of statistical data. The other 

versions (i.e. version A00 and all numerical versions except version 000) are available as 

planning versions. 

You can use a standard analysis to look at the SAP standard information structures, by specifying 

the version number of the version that you would like to analyze (to see the various options 

available to you here, refer to the section Setup of Statistical Data under "Procedure"). The standard 

analyses then read the data of the version you have specified, and no longer read the actual data. 

Restriction of the document data : 

- Archive file 

Here, you specify the name of the archive file from which the archived documents are to be read. 

If you do not specify an archive, the documents will be read from the residence (the documents 

located in the system). 

- Archiving run 

Archiving runs are numbered consecutively, and called up automatically and sequentially. The 

numbers for the archiving runs are applicable to all objects. 

Control of the setup run: 

- Name of the run 

In order to continue an interrupted or a terminated setup, you must assign a name to each run of the 

report, under which the status of the run will be permanently stored. The system then searches for 

the first document that has not yet been processed and subsequently begins to process it under this 

name. 

Note 

To avoid similarities in the names, use the transaction se16 to check the list of names that already 

exist in the table TMCW3. 

- New run 

If you set this indicator, document processing then begins with the first selected document if an 

entry for restarting still exists under the run name used. 

- Termination date and termination time You can determine when processing should end. 

If a report runs over the weekend, for example, it would make sense to stop processing on Monday 

morning when online operations begin again. 
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This is particularly necessary if you have selected the option "Lock all documents". 

- Redetermining the update group 

If you set this indicator, the update group will be redetermined for the documents processed during 

the setup in accordance with the settings that you have made in Customizing for the respective 

application. 

- Update documents 

If you set this indicator, the redetermined update groups will be written to the documents. The 

advantage here is that if a change is made to a document, the current update group is taken into 

account when the change is updated. 

If you have changed the Customizing settings, you should definitely make use of this option. 

Specifications for the use of ALE (Application Link Enabling: 

- Statistical setup: partner system 

In the case of distributed systems, if you set this indicator, only the partner system will be set up, 

and not the local one. 

- Logical target system 

Here, you specify the name of the system that is to be set up. 

Further information about logical systems can be found in the Implementation Guide for 

"Distribution (ALE)", under Cross-Application Components -> Distribution (ALE) -> Basic 

Configuration -> Set up logical system. 

37.8.4.12.2.1.3 Application-Specific Setup of Statistical Data 

This section describes the application-specific features of the respective applications that can perform a 

setup of statistical data. 

37.8.4.12.2.1.3.1 Perform Setup - Sales and Distribution 

In this step you can either populate the information structures of the Sales Information System initially 

using document data from the SD application, or correct data inconsistencies. 

The report RMCVNEUA performs the statistical setup of the sales information structures from orders. 

It reads the orders and updates the data with statistical relevance in the same way as if they were being 

newly created. 

Both archived orders and orders that are in the system are used in the processing. 

The report reads the documents that you selected in the selection screen and triggers the statistics update. 

This helps you to ensure that the documents processed by the report are updated in such a way that the 

newly determined update group is placed in the order. The advantage here is the same rules apply when 

subsequentchanges are made to an order, and so the process is identical to the statistical set up. 

Archived documents are not updated, as they should no longer be changed, as a rule, and the update 

would be too time-consuming. 
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Note 

The report RMCVNEUL performs the statistical set up of the sales information structures from 

deliveries, the report RMCVNEUF performs the statistical set up from billing documents. 

The same rules apply to both of these reports as those for the report which processes the orders. The 

reports RMCVNEUL and RMCVNEUF will not therefore be described separately. 

Requirements 

To execute the statistical setup of one or more of the information structures, all of the orders, deliveries 

and billing documents must be read. As a rule, this involves a large overhead. To avoid any 

inconsistencies, all of the documents that are in the system must be processed in one step. 

At this time the sales documents should not be changed, and no new sales documents should be created. 

Documents that have already been archived can be worked on in succession. 

Recommendation 

In order to keep the number of documents to be set up in the system down to a minimum, you should 

archive unnecessary sales documents before the statistical setup . 

Application-specific selection parameters 

- Sales organization 

Here you specify the sales organizations to which the statistical setup applies. 

- Company code 

If a link to cash management and forecast exists, then this will be supplied with the data from the 

Sales Information System update. The update of this data is company code-dependent. 

Selecting the company codes means that only the data from the sales organizations that are allocated 

to the selected company codes is updated. 

If you use this selection criterion, the documents are not updated, even when you have selected the 

option "Update documents" at the same time. 

- Sales document 

Here, you can restrict the number of documents that should be included in the statistical setup. 

You should only use this selection criterion for tests and when making subsequent updates of faulty 

documents, since all of the documents should, as a rule, be worked on. 

- Block all orders/deliveries/billing documents 

You should select this option to prevent the sales documents that are in the system from being 

changed during a statistical setup. 

It is, however, not advisible to use the block in the case of tests that run parallel to the operative 

system. 

During the processing of archives, blocking is automatically suspended. 

- Number of tolerated faulty documents 

If the report comes across a faulty document during the statistical setup (for example, if an order 

includes a customer that is no longer available in the system), the document and the cause of the 

error are then shown in the log of the background job. In this case, no updating takes place. 
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You can also determine the number of faulty documents that are to be tolerated before the report 

terminates. 

You should first start the report with a small number of tolerated faulty documents. This will allow 

general errors (for example, a sales organization no longer exists) to be found beforehand. 

Procedure 

A complete statistical setup of the sales information structures consists of the following steps: 

1. Update the version for the statistical setup 

For security reasons, the statistical data that is obtained during a statistical setup is not directly 

written into an information structure, but is stored under a separate version name. 

This version must be initialized before the statistical set up for intermediate storage purposes. 

To do this, use report RMCSISCP. 

The actual data is saved under the version name "000". 

2. Save actual data 

The actual data that is in the system should be saved for reasons of safety. To do this, 

also use RMCSISCP. 

3. Process all archived orders You can do this via 

the report RMCVNEUA. 

Note 

Processing of the archived orders can easily be carried out in a few steps without any problems. 

4. Process all archived deliveries To do this, use 

report RMCVNEUL. 

Note 

Processing of the archived deliveries can easily be carried out in a fewsteps without any problems. 

5. Process all archived billing documents To do 

this, use report RMCVNEUF. 

Note 

Processing of the archived billing documents can be easily carried out in a few steps without any 

problems. 

6. Process all sales and distribution documents in 

the system 

The sales and distribution documents (orders, deliveries and billing documents) that have been 

archived can be changed online at any time. 

To prevent inconsistent statistical data, no sales and distribution documents may be created or 

changed during the processing of these documents. 

For this reason, this step is divided up into three parts, each of which should be carried out as a 

background job: 

a) Process all orders that reside in the system 

b) Process all deliveries that reside in the system 

c) Process all billing documents that reside in the system 
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Note 

Perform these steps sequentially. 

Do not start the next step until the previous one has been successfully completed. 

Caution 

If the update group has been correctly set in all of the documents, you do not need to redetermine 

the update group during the statistical setup. Furthermore, you do not need to perform a document 

update. 

In this case, it is possible to carry out the reports RMCVNEUA, RMCVNEUL and 

RMCVNEUF in parallel. 

If you wish to use this option, you can neither set the indicator "Redetermine update group" nor the 

indicator "Update documents". 

Detailed information can be found in the note 0019056 in OSS. 

7. Analyze and process incorrect documents where necessary 

a) Check the faulty documents that have been listed in the log of the background runs. 

b) Correct the errors. 

c) Start the corresponding statistical setup reports with the corrected documents. 

8. Transfer the data that was obtained by the statistical setup from the version for the statistical 

setup into the actual version  

The data obtained from the statistical setup is not imported to the actual version to replace the 

existing data until the setup has been successfully completed. You should use report RMCSISCP 

to do this. 

9. Subsequent processing 

After the statistical setup has been successfully  completed, you can delete the data that is no 

longer needed. This consists of: 

- versions that are no longer needed Use the 

report RMCSISCP to delete them. 

- the statistical data that was created during the 

setup in intermediate storage Use the report 

RMCVNEDE to delete this data. 

Description of the report RMCVNEDE 

The report "RMCVNEDE" is only used in the Sales Information System. 

It is designed to delete the temporary storage which was created during the statistical setup. 

During the statistical set up, data is stored temporarily during the processing of orders and deliveries. This 

data is required in subsequent steps of the statistical setup. 

Intermediate storage takes place in the tables "MCVSRFK" (header data) and "MCVSRFP" (item data). 

You can delete this intermediate storage area after the statistical setup has been successfully completed. 

Note 
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When the update group is redetermined in the Sales Information System, the statistic currency for the 

sales organization is redetermined according to the current Customizing settings (if you selected the 

option Update documents) and is copied to the appropriate application tables in Sales & Distribution. 

Caution 

The report "RMCVNEDE" is only intended to be used as a background job. 

To do this, select System -> Services -> Reporting. Specify the name of the report and select the 

function Program -> Background. You also have to specify a variant. 

Additional Hints 

Before you set up information structures in the Sales Information System (SIS), please read note 0174134 

in OSS. 

In this note, you will find a list of all of the notes that are concerned with known program errors or 

performance problems in the setup of statistical data for SIS. These notes contain both the necessary 

corrections for your release level and tips and tricks. 

37.8.4.12.2.1.3.2 Perform Setup - Sales Support 

In this IMG activity, you have the option of resetting the information structures in the Sales Information 

System for Sales Suppoer. 

Program RMCVNEUC is designed to statistically set up the sales information structures from the 

following areas: - Sales activities 

- Sales promotions 

- Address lists 

It reads the documents and updates the statistically relevant data in such a way that it is as if it has been 

newly created. 

Here both archived documents and documents residing in the system are processed. 

The program selects the documents in accordance with the selection criteria you define in the selection 

screen and triggers updating. 

You can also specify that this program puts the current defined update group in the respective document. 

This ensures that the subsequent change made to a document is carried out in accordance with the same 

rules that apply to the setup of statistical data. 

37.8.4.12.2.1.3.3 Perform Setup - Transportation 

In this step, you initialize the information structures of the transportation information system. 

The report RMCVNEUT is used for the statistical setup of the transportation information structure from 

transport documents. 
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It reads the documents and updates the data relevant to statistics as if it were newly created. Only orders 

resident in the system are processed. 

The report reads the documents you chose in the selection screen and triggers the statistics update. You 

can define that this report updates the documents it processes. It does this by including in the order the 

update group determined in the order. The advantage is that the additional change to the order is carried 

out according to the same rules as for statistical setup. 

Application-Specific Selection Parameters 

- Name of run 

Name in which the date determined is to be saved. 

Use 

In case you include a terminated run (in other words, do not carry out a new run), it starts with the 

data already determined, which means that the next run is executed with data that was selected up to 

the termination time specified. 

- New run 

Indicator defining that a new run should be started. 

Use 

If you set this indicator, the processing of the documents begins with the first of the selected 

documents if there is still an entry to be restarted in the run name used. 

- Termination date 

Date until which the run should be executed. 

- Termination time 

Time until which the run should be executed. 

- Redetermine update groups 

If you set this indicator, the update group for the documents processed in the statistical setup is 

redetermined according to the definitions made in Customizing of the relevant application. 

- Update documents 

If you set this indicator, the redetermined update groups will be put in the documents. The 

advantage therefore being that the current update group is used to update any change to a document. 

If you have changed the Customizing settings, you should make use of this option. 

- Block all transports 

You should select this option to prevent resident transport documents from being changed during a 

statistical setup. However, it can be advantageous not to choose this option if tests are to be carried 

out while the system is in operative use. 

- Number of faulty documents tolerated 

If the report comes across a faulty document during the statistical setup (for example, an order 

contains a customer who is no longer available in the system), the document and the cause of error 

are included in the log for the background run. In this case, the update is not continued. At this 

point, you can define the number of faulty documents tolerated before the report is terminated with 

an error message. 

At first, you should start the report with a low number of tolerated faulty documents. This means 

that general errors can be found in advance. 
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Procedure 

A complete statistical setup of the transportation information structures consists of the following steps: 

1. Initialize version for statistical setup 

For security reasons, the statistical data determined in the statistical setup is not written 

straight to an information structure. Instead, it is saved under its own version name. 

This version for temporary storage must be initialized before the statistical setup. 

The report RMCSISCP is available for this purpose. 

The actual data is saved under the name "000" 

2. Save actual data 

The actual data in the system should be saved for security. You 

should also use report RMCSISCP for this purpose. 

3. Process all transport documents 

Transport documents that are not archived can be changed online at any point. To prevent 

statistical data becoming inconsistent, no transport documents can be created or changed while 

these documents are being processed. 

Attention 

If the update group is already correctly set in all documents, it does not need to be redetermined 

during the statistical setup. This also means that no document update needs to take place. 

4. Analyze, and if necessary, reprocess faulty documents 

a) Check the list of faulty documents in the log for the background run. 

b) Correct the error. 

c) Start the relevant statistical setup report with the repaired documents. 

5. Copy recovered data from version for statistical setup to actual version Once the statistical 

setup has been successfully completed, the recovered data is copied to the actual version (instead of 

the previous data). This also takes place via the report RMCSISCP. 

6. Post-process 

You can delete data no longer required once the statistical setup has been successfully completed. 

This data consists of versions no longer required. 

Use the report RMCSISCP to delete versions no longer needed. 

37.8.4.12.2.1.3.4 Perform Setup - Purchasing 

In this step you can initialize the information structures from the Purchasing Information System. 

The report RMCVNEUA performs the statistical setup of the sales information structures from 

purchasing documents. 
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It reads the purchasing documents and triggers the statistical update of these documents in accordance 

with the selection you made in the selection screen. 

Both archived documents and documents that are in the system are processed. 

Start statistics reconstruction for archived purchase vouchers. Mark  in addition the flag < ZK>Archive 

file< / >. it were added: Use a  version, which with ' & (' begins. This name space is reserved for statistics 

reconstruction. Start afterwards statistics reconstruction  for resident purchase vouchers. Mark in addition 

the flag < ZK>Archive file< / > < ZH>not< / >. using you the same version, which you already used for 

the statistics reconstruction  of the archived purchase vouchers. Check your version of the  information 

structure over the ' flexible analyses ' or ' standard analyses '. In order to analyze with the standard 

analyses the data of the again structured version, you enter the parameter ' MCR ' into your user master 

and assign it as value the version  of reconstruction. Delete the actual version 000 over the report  < 

ZH>RMCSISCP< / >. copying you afterwards with the help of the report < ZH>RMCSISCP< / > your 

version of the  information structure into the actual version 000. < ZH>Note< / > 

Note 

No online postings can be made while a statistical setup of Purchasing Information System information 

structures is running in the background. 

Application-specific selection parameters 

- Purchsing organization 

Here you can specify the purchasing organizations for which the statistical setup is to be carried out. 

- Purchasing document 

Here, you can restrict the number of documents which are to be included in the statistical setup. 

This selection criterion should only be used for tests and during the subsequent update of faulty 

documents, since all documents should be processed as a rule. 

- Block all documents 

You should select this option to prevent the purchasing documents that are in the system from being 

changed during a statistical setup. 

It is, however, not advisible to use the block in the case of tests that run parallel to the operative 

system. 

During the processing of archives, blocking is automatically suspended. 

37.8.4.12.2.1.3.5 Perform Setup - Inventory Controlling 

In this step you can initialize the information structures in Inventory Controlling. 

You can use the following reports for this purpose: 

- RMCBNEUA 

This report supports the statistical setup of information structures from material movements. It reads 

the material documents and triggers the statistical update of these documents in accordance with the 

selection that you made in the selection screen. 

The system then processes both the archived documents and those documents in the system. 
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Application-specific selection parameters 

- Posting date 

Here you specify the posting date of the documents, which is to be affected by the statistical 

setup. 

- Material document 

Here you can restrict the number of documents to be included in the statistical setup. You 

should only use this selection criterion for tests and for the subsequent updating of incorrect 

documents, since all documents should be processed as a rule. 

Note 

Using the radio button, you can decide whether you want to select by document number or posting 

date. 

- RMCBNEUB 

This report supports the statistical setup of information structures from INVCO. It reads the 

material stocks and other material master information and triggers the statistics update of these 

documents in accordance with the selection that you made in the selection screen. 

This also allows you to display the stocks for which no goods movements exist. 

Application-specific selection parameters 

- Plant 

Here, you enter the keys of the plants to be affected by the statistical setup. 

- Material 

Here you specify the number of the materials which are to be affected by the statistical setup. 

- Storage location 

Here you specify the number of the storage locations which are to be affected by the statistical 

setup. 

Note 

You can use the radio button to select from only valued stocks, or from all stocks, including those 

where no value is assigned. 

- RMCBNERP 

This report supports the statistical setup of information structures from invoice verification. It reads 

the accounting documents and triggers the statistical update of these documents in accordance with 

the selection you made in the selection screen. 

The system then processes both the archived documents and the documents in the system. 

Application-specific selection parameters 

- Company code 

Here you specify the company code that is to be used in the setup of statistical data. 

- Accounting document 
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Here you specify the numbers of the accounting documents, which are to be used in the 

statistical setup. 

Note 

Here it is also possible to select according to posting date or document number. 

37.8.4.12.2.1.3.6 Perform Setup - Warehouse Management 

In this step you can initialize the information structures of Warehouse Management. 

You can use the following reports to do this: 

- RMCWMNMB 

This report supports the setup of information structures from material documents. It reads the 

material documents and triggers the statistical update of these documents, based on the selection 

you made in the selection screen. 

In this process, both the archived documents and the documents in the system are processed. 

Application-specific selection parameters 

- Warehouse number 

Here you specify the key of the warehouse to which the statistical setup is to apply. 

- Material document year 

Specify the material document years which are to be included in the statistical setup. 

- Posting date 

Specify the posting date of the documents to which the statistical setup applies. 

- Material document 

Here you can restrict the number of documents that are to be included in the setup. This 

selection criterion should only be used for tests and during the subsequent update of faulty 

documents, since generally all documents should be processed. 

- Block all material documents 

You should select this option to prevent the material documents that are in the system from 

being changed during a statistical setup. 

It is, however, not advisable to use the block in the case of tests that run parallel to the 

operative system. 

During the processing of archives, blocking is automatically suspended. 

- RMCWMNTA 

This report is used for the setup of information structures from transfer orders. It reads the 

transfer orders and triggers the statistics update of these documents in accordance with 

the selection you made in the selection screen. 

Caution 

During the setup of information structures S090 (Stock placement and removal) or S091 
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(Flow of quantities) from the archive, it is possible that information will not be available from the 

dependent documents for the transfer orders. 

The transfer order of the central document is in Warehouse Management, and therefore in this case 

the key figures cannot be updated in the same way as is the case for online updating. 

Application-specific selection parameters 

- Date of Creation 

Here you specify the creation date of the tranfer orders to which the statistical setup should 

apply. 

- Transfer order 

Here you specify the numbers of the transfer orders which are to be included in the statistical 

setup. 

- Block all transfer orders 

You should select this option to prevent the transfer orders that are in the system from being 

changed during a statistical setup. 

It is, however, not advisible to use the block in the case of tests that run parallel to the 

operative system. 

During the processing of archives, blocking is automatically suspended. 

37.8.4.12.2.1.3.7 Perform Setup - Production 

In this step you can initialize the information structures from the Shop Floor Information System. 

The following report helps you to do this: 

- RMCFNEUA. 

It reads the production orders and triggers the statistics update of these orders in accordance with the 

selection you made in the selection screen. 

In this process, only the production orders in the system are processed and not those that have 

already been archived. 

Application-specific selection parameters 

- Plant 

Here you specify the key of the plants to which the setup of statistical data applies. 

- MRP controller 

Here you specify the numbers of the MRP controllers or the MRP controller groups which are 

to be included in the statistical setup. 

- Production order 

Here, you specify the order numbers which are to be included in the statistical setup. 

- Production scheduler 

Here, you specify the production scheduler groups which are to be included in the 
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statistical setup. 

- Entry date 

Here, you specify the creation date of the production orders to which the statistical setup 

applies. 

- Check for S021 

If you set this indicator, the system carries out a check via the information structure S021 

(production order) to see whether a production order was already updated for the specified 

version. 

Updating is only carried out if this is not the case. 

Note 

In the standard R/3 system, this indicator is not set. 

- Enhanced setup of statistical data 

Some communication structures must be stored in the Shop Floor Information System for 

technical reasons. This applies to release versions and costs. 

If you use the indicator "Enhanced setup", the respective communication structures will be set 

up. 

The note also applies to this (see below), which states that the quality of the setup data is 

generally worse than the quality of the data from online updating. You can use report 

RMCFCSCP to copy the communication structures that were created by the enhanced 

statistical setup. 

Caution 

You can perform a statistical setup for two basic reasons: 

In the first case, you wish to perform a statistical setup of all the selected data because the 

statistics update was switched off, for example, or because there were errors in the statistical 

data. In this case, it is recommended to execute an enhanced statistical setup. 

In the second case, you want to fill a new information structure with statistical data. In this 

case, you should not execute an enhanced statistical setup. 

 - RMCFCSCP 

This report has essentially the same functionality as the report RMCSISCP. 

Both of these reports enable you to copy or delete versions as part of the statistical setup. In contrast 

to report RMCVISCP, the selection criterion "Date" is not not included in the report RMCFCSCP. 

Instead, the report RMCFCSCP uses the selection criterion Order. Here, you need to specify the 

order numbers of the production orders which determine the restrictions to be made. 

Note 

Due to technical reasons involving data, the calculated costs cannot be reconstructed according to 

specific work centers because this allocation is only temporary. This is not relevant to the production 

cost analysis (S027) since the work center is not a characteristic in this standard analysis. 

37.8.4.12.2.1.3.8 Perform Setup - Quality Management 

In this step, you can initialize the information structures of the Quality Management Information System 

(QMIS). 

To do this, use report RMCQNEUA. This report supports the statistical setup of information 

structures from the following documents: - Inspection lots 
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- Inspection lots with usage decision 

- Quality notifications 

The system reads these documents and triggers the statistical update of these documents, in accordance 

with the selection made by you in the selection screen. 

Only documents in the system will thus be processed, and not those documents that have been already 

archived. 

Application-specific selection parameters 

- Block all documents 

You should select this option to prevent the documents that are in the system from being changed 

during a statistical setup. 

It is, however, not advisible to use the block in the case of tests that run parallel to the operative 

system. 

During the processing of archives, blocking is automatically suspended. 

37.8.4.12.2.1.3.9 Perform Setup - Plant Maintenance 

In this step you can initialize the information structures of the Plant Maintenance Information System. 

The following reports are available for this purpose: 

- RIPMCO00 

This report is designed for the statistical setup of file PMCO (order costs). 

- RIPMS001 

This report is designed for the statistical setup of the information structures in Plant Maintenance. 

The following events are taken into account: 

- Plant maintenance notification 

- Equipment 

- Functional location 

- PM order (historical and current orders) 

The statistical setup of information structures is necessary in the following situtaions: 

- if you have created new information structures 

- if you have changed the value categories 

- if you have changed the statistics currency 

You must then always start report "RIPMC000" if you have changed the value categories in Customizing. 

Afterwards you must set up the information structures respectively again. 

Caution 
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The file PMCO is the basis file for the information structures of Plant Maintenance, therefore you 

absolutely must perform the statistical setup of this file before you set up the information structures. 

Documentation for report RIPMS001 

The report RIPMS001 always sets up all information structures of application 07 (plant maintenance). 

From a technical viewpoint, the setup of statistical data occurs in three steps: 

1. Check / Deletion of the target version 

2. Setup of the info structures of application 07 into the temporary version 

The system automatically creates temporary versions beginning with the start indicator you 

specified in the selection screen. 

3. Aggregation of the temporary versions to the target version 

Possible input parameters 

- Target version 

The newly setup info structure data is saved under this version. 

- Temporary version 

The information structures are filled during the parallel setup of statistical data under this version 

number. 

- Server group 

Server groups are used internally for load distribution of background jobs. 

- Number of parallel processes 

You can define the maximum number of parallel used processes here. If the number you choose 

here is larger than the maximum number (for system technical reasons) of parallel processes, only 

the system technical process number is used. 

- Run name 

Is used to identify the setup of statistical data. The system fills the field run name with the first two 

letters of the user name and current date. 

- Date / Time of termination 

Time by which the setup of statistical data should be completed. 

- New run 

If you select this indicator, the data determined up until the specified date and time of termination is 

included in the next program run and is not recalculated. 

- Lock all documents 

Indicator with which you can determine that resident documents are locked during a statistical setup 

of data and can thereby not be changed. 

For tests that run parallel to the operative process, it can be desirable not to set the lock. 

- Parallel merge 
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In the last phase of the statistical setup of data, in which the target version is set up from the 

temporary versions, you can decide whether this merge takes place sequentially in the active 

background process or whether a separate background process is started per info structure. 

Additional functions 

In the Plant Maintenance Information System, the system automatically makes a log after every 

completed Online run. 

This log can be printed, but not saved. 

37.8.4.12.2.1.3.10 Perform Setup - Warehousing & Shipping 

In this step you can initialize information structures for the rough load estimate. 

Note 

A statistical setup of rough load information from historical information is not normally necessary, as 

only the current daily load or coming loads for days in the future are of any relevance to controlling. 

It can however also be used to set up comparison values from historical horizons, for example so that the 

approximate warehouse load can be forecasted for special weeks in the year (christmas and easter sales, 

for example). 

However, if you do wish to carry out a statistical setup for the rough load estimate so that you can 

forecast based on values for a year, you must initialize the appropriate information structures for the 

rough load estimate. Do so as follows: 

1. Execute the statistical setup for Purchasing and 

2. the statistical data from sales orders and deliveries 

in the Sales & Distribution area. 

Note 

Please note that this statistical setup is very performance intensive. It should only be executed after 

careful consideration. 

Further notes 

Before carrying out a statistical setup of information structures for the rough load estimate, you must read 

OSS note 0017557. 

This note lists all notes that deal with known program errors and performance problems within the rough 

load estimate statistical setup. These notes describe the corrections required for your release, and also 

contain useful tips and tricks. 

37.8.4.12.2.2 Activate/Deactivate Update 
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In this process step, you determine when the information structures are to be updated and whether or not 

the delta update is to be activated. 

You have the following options when deciding when the information structures are to be updated: 

- Synchronous Update (V1-Update) 

Statistics are updated synchronously with the document update. However, if errors arise during the 

update causing the statistics update to terminate, the associated documents also become unavailable. 

You then need to enter these documents once again. 

- Asynchronous Update (V2-Update) 

In this case, document- and statistics update are decoupled, meaning that termination of the statistics 

update has no affect on the update of documents existing in the operative application. 

You are also able to execute document update and statistics update in two separate systems. 

- No Update, Meaning Update is Deactivated 

If the data is to be sent to the BW as delta information, select Delta Update Active. The Delta update is 

client-dependent, analagous to the normal LIS update. This is in contrast to this environment and the 

DataSource, which are client-independent. 

37.8.4.12.3 Settings: Sales and Distribution 

37.8.4.12.3.1 Maintain Statistics Group Material 

To enable the updating of statistics data in the information structures S001 and S005, all statistically 

relevant materials must be assigned to the statistics group '1'. 

The assignment of statistics groups to materials is carried out in the maintainenance of the material master 

record (screen "Sales 2").  
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37.8.4.12.3.2 Change statistics currency for each sales organization 

In this step, you define in which currency the value fields of information structures S001 and S005 are 

updated per sales organization. 

37.8.4.12.3.3 Assign Update Group 

To ensure that the statistics data is updated correctly in the information structures S001 and S005, 

maintain the following entries: 

- Assign update group on the header level: 

1. Entry   2. Entry 

Sales organization           ' '        ' ' 

Distribution channel         ' '        ' ' 

Division                     ' '        ' ' 

StatGrpCustomer              '+'        '+' 

StatGrpSalesDoc              '1'        '2' UpdateGrp                    '1'        

'2' 

- Assign update group on item level: 

1. Entry   2. Entry   3. Entry   4. Entry 

Sales organization          ' '        ' '        ' '        ' ' 

Distribution channel        ' '        ' '        ' '        ' ' 

Division                    ' '        ' '        ' '        ' ' 

StatGrpCustomer             '+'        '+'        '+'        '+' 

StatGrpMat                  '1'        '1'        '1'        '1' 

StatGrpSalesDoc             '1'        '1'        '2'        '2' 

StatGrpSalesItem            '1'        '2'        '1'        '2' 

UpdateGrp                   '1'        '2'        '1'        '2' 

37.8.4.12.4 Settings: Purchasing 

In this section you configure the settings for the SAP BW in the source system if you wish to extract 

purchasing data. 

37.8.4.12.4.1 Determine Industry Sector 

In this operation, you can define if data should be transferred to SAP BW. If this is the case, you can 

choose one area that you wish to transfer to SAP BW. 
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By focussing on only one area, allows a derivation for the logistical business transactions. 

Further notes 

You derivation is planned for more areas from the same system or clients . 

37.8.4.12.4.2 Transaction Key Maintenance for SAP BW 

In this operation, you can transform key figures in the transaction key for a suitable transfer control of the 

logistics movement data in SAP BW. 

This transformation is made for each area and LIS application. 

Example 

Control for Purchasing in CP. 

At this level you can assign transaction keys for the individual business transactions. 

Settings: 

- Application components: MM, 

- Application: 02 (Purchasing) 

- Transaction key: 1 (PO for external vendors) 

Further notes 

- Transaction key identification (name range for the SAP transaction key: 001-499) only takes place 

as long as an industry sector was defined. 

- Customer-specific transaction key can be created (customer name range: 500-999). These 

transaction keys must exist in the relevant customer exits for the relevant LIS applications. 

37.8.4.12.5 Settings: Inventory Controlling 

37.8.4.12.5.1 Determine Industry Sector 
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In this operation, you can define if data should be transferred to SAP BW. If this is the case, you can 

choose one area that you wish to transfer to SAP BW. 

By focussing on only one area, allows a derivation for the logistical business transactions. 

Further notes 

You derivation is planned for more areas from the same system or clients .  
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37.8.4.12.5.2 Transaction Key Maintenance for SAP BW 

In this operation, you can transform key figures in the transaction key for a suitable transfer control of the 

logistics movement data in SAP BW. 

This transformation is made for each area and LIS application. 

Example 

Control for Purchasing in CP. 

At this level you can assign transaction keys for the individual business transactions. 

Settings: 

- Application components: MM, 

- Application: 02 (Purchasing) 

- Transaction key: 1 (PO for external vendors) 

Further notes 

- Transaction key identification (name range for the SAP transaction key: 001-499) only takes place 

as long as an industry sector was defined. 

- Customer-specific transaction key can be created (customer name range: 500-999). These 

transaction keys must exist in the relevant customer exits for the relevant LIS applications. 

37.8.4.12.5.3 Stock initialization 

Information structure S278 was created for stock initialization in SAP BW. This ensures the correct 

transfer of initial stock to SAP BW. 

In this stock initialization, stocks are copied directly from the operational stock tables into the information 

structure. 

37.8.4.12.5.4 MM View 

Use the documentation of the respective IMG activity for the plant view or the warehouse view. 

37.8.4.12.5.4.1 Plant view 

RMCBNEUA 

This report is for the setup of information structures from material movements. It reads the material 

documents and triggers the the statistics update of these documents according to the selection you made 

in the selection screen. Both the archived documents and those that are resident in the system are 

processed. 
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Application-specific selection parameters 

- Plant 

Here you specify the key for plants for which the setup of statistics is to be effective. 

- Material document year 

Here you specify the material document year for which the setup of statistics is to be effective. 

- Posting date 

Here you specify the posting date of the documents for which tje setup of statistics is to be effective. 

- Material document 

You have the option of limiting the number of Documents that are to be used for the setup. This 

selection criterion should only be used for tests and for subsequent processing of erroneous 

documents, because generally, all documents are supposed to be processed. 

RMCBNERP 

This report is used for the setup of information structures from invoice verification. 

It reads the accounting documents and triggers the statistics update of these documents according to the 

selections you made in the selection screen. Both the archived documents and those that are resident in 

the system are processed. 

Application-specific selection parameters 

- Company code 

Here you specify the Company codes that are to be used for the setup of the statistics. 

- Fiscal year 

Here you specify the Fiscal years for which the setup is to be effective. 

- Accounting document 

Here you specify the number of the Accounting documents that are to be used for the setup. 

The determination of the periodic stock for later use in the SAP Business Information 

Warehouse can only be done after setup of the information structures is complete. 

Now execute the following report: 

RMCBS198 

This program determines the periodic stock quantities and values from the current stock and the 

associated material movements for the material plant level. 

The data generated from setup and from periodic stock determination are then available for transfer and 

evaluation in the SAP Business Information Warehouse. 

37.8.4.12.5.4.2 Warehouse View 

RMCBNEUA 

This report is used for setup of information structures from material movements. 
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It reads the material documents and triggers the statistic update of these documents according to the 

selections you made on the selection screen. Both the archived documents and those that are resident in 

the system are processed. 

Application-specific selection parameters 

- Plant 

Here you specify the key for Factories for which the statistic setup is to be effective. 

- Material document year 

Here you specify the material document year for which the setup of statistics is to be effective. 

- Posting date 

Here you specify the posting date of the documents for which the setup of statistics is to be 

effective. 

- Material document 

Here you have the option of limiting the number of documents that are to be used in the setup of the 

statistics. This selection criterion should only be used for tests and during subsequent processing of 

erroneous documents because generally, all documents should be processed. 

RMCBNEUB This report is for the setup of information structures from stock. 

It reads the material stock and other material master data information and triggers the statistic update of 

these documents according to the selections you made in the selection screen. 

This gives you the option of showing stock for which there was no material movement. 

Application-specific selection parameters 

- Material 

Here you specify the numbers of materialis for which the statistic setup is to be effective. 

- Storage location Here you specify the numbers of storage locations for which the statistic setup is 

to be effective. 

The determination of periodic stocks for later use in the SAP Business Information Warehouse can only 

be done once the setup of the information structures has been completed. Then execute the following 

report: 

RMCBS197 

This program determines the periodic stock quantities for the level material/plant/storage location from 

the current stock and the associated material movements. 

37.8.4.12.6 Settings: Production 

In this section, you make the application-specific update settings for Production. 

37.8.4.12.6.1 Activate Update and Release Version for each Order Type 
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In this IMG activity you can activate updating of the information structures in the Shop Floor Information 

System. 

In addition, you can also define the release version for the production orders on the header, item or 

operation level. 

The release version is the version at the time of the release. 

The specifications that you can make in this activity are dependent on the respective plant and order 

type. 

If production orders are often changed during their processing, the target and actual values become more 

and more similar, so that the target/actual deviation can no longer be calculated reliably. 

By using a release version you can combat this problem. 

If you have defined a release version, the following key figures are updated (from 

communication structures): - at header level: 

- order finish date 

- order start date 

- scheduled release date 

- scheduled finish 

- scheduled start 

- release date plan 

- total scrap quantity, order 

- total order quantity - at item level: 

- start date of the planned order 

- delivery date of the planned order 

- fixed production scrap quantity 

- total planned order quantity 

- item quantity, order 

- item scrap quantity - at operation level: 

- operation quantity 

- scrap quantity, operation 

- earliest scheduled start 

- latest scheduled start 

- earliest scheduled finish 

- latest scheduled finish 

All subsequent updates will then refer to these key figures. This will modify these key figures and those 

dependent on them in the communication structures. 
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Activities 

1. Select the plant and the order type for which you want to make your specifications. 

2. Select Goto -> Details. 

3. Set the update indicator. 

4. Select the level on which you want to define the release version. 

5. Save your settings. 

Additional information 

You can a find a description of order type-dependent parameters in the Implementation Guide for Shop 

Floor Control. 

37.8.4.12.6.2 Define Performance Settings 

In this step you can optimize performance, as the determination of characteristics and key figures can be 

very performance intensive. 

You can switch off communication structures in Performance Customizing. 

At operation level, you can activate or deactivate some key figures and key figure groups. This affects the 

work center analysis, in which, for example, the process of determining capacity key figures at the time 

of evaluation is complicated. 

You can set the units for some key figures. These key figures are then converted to the units selected as 

soon as is possible. This makes it easier to make a comparison, as unit conversion is not possible in the 

standard analyses. 

It is also possible to display co-products as items and to read the work centers for the relevant costs. The 

latter is particularly performance intensive. 

With effect from Release 4.5A, there are new run schedule header information structures for goods issues 

(S226) and costs (S227). They enable you to have the previous information structures S026 and S027 

updated only by process and production orders. They can, as previously, also be updated by run schedule 

headers. 

See the appropriate Release Note for more information. 

Standard Settings 

All settings are activated in the SAP standard shipment. Only key figures that have appeared since 

Release 4.0 are not active. 

Activities 

 1. Select the required settings and save. 

Additional Information 
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Further information can be found in the F1 Help  in the dialog field. 

37.8.4.12.7 Settings for IBU Retail / CP 

Here you make the settings for SAP BW in the source system if you are currently using IBU Retail, CP 

products and want to transfer data from your source system to SAP BW. 

37.8.4.12.7.1 Determine Industry Sector 

In this operation, you can define if data should be transferred to SAP BW. If this is the case, you can 

choose one area that you wish to transfer to SAP BW. 

By focussing on only one area, allows a derivation for the logistical business transactions. 

Further notes 

You derivation is planned for more areas from the same system or clients . 

37.8.4.12.7.2 Transaction Key Maintenance for SAP BW 

In this operation, you can transform key figures in the transaction key for a suitable transfer control of the 

logistics movement data in SAP BW. 

This transformation is made for each area and LIS application. 

Example 

Control for Purchasing in CP. 

At this level you can assign transaction keys for the individual business transactions. 

Settings: 

- Application components: MM, 

- Application: 02 (Purchasing) 

- Transaction key: 1 (PO for external vendors) 

Further notes 

- Transaction key identification (name range for the SAP transaction key: 001-499) only takes place 

as long as an industry sector was defined. 

- Customer-specific transaction key can be created (customer name range: 500-999). These 

transaction keys must exist in the relevant customer exits for the relevant LIS applications. 
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37.8.4.12.7.3 Stock initialization 

Information structure S278 was created for stock initialization in SAP BW. This ensures the correct 

transfer of initial stock to SAP BW. 

In this stock initialization, stocks are copied directly from the operational stock tables into the information 

structure. 

37.8.4.12.7.4 Assignment of Retail Objects to Cost Centers 

In this step you can assign retail objects to cost centers. 

This assignment takes place indirectly using organizational management organizational units. 

The assignments maintained here are retrieved from the BW system using the DataSources 

0RT_ORGUNIT_ATTR  (delivers the site organizational unit assignment) and 0ORGUNIT_ATTR 

(delivers the cost center organizational unit assignment). 

The user interface is divided into four screen areas: 

- In the left screen area, the Search Area, you look for individual organizational objects using the 

search function. In the Selection Area, the search results are displayed. 

- These organizational objects can be transferred from here into the central screen area, the Overview 

Area. There they are displayed in the organizational chart. 

- In the lower screen area, the Detail Area, information about individual objects is displayed which 

you can edit here. 

Activities 

- If the organizational structure of your enterprise is already mapped, using one of the search 

functions available, you can select the required organizational object and transfer it with a double-

click into the Overview Area and Detail Area. 

- If the organizational structure of your enterprise is not mapped, use the activity Create Retail Object 

Assignment , to create a new root organizational unit for your enterprise. 

- In the Detail Area, you can now assign a cost center or a retail object to an organizational unit. To 

assign a cost center, use the tab page Account Assignment, and to assign a retail object, use the tab 

page Attribute. 

Further notes 

You can find detailed Documentation by choosing the menu: 
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- Help -> Application Help (contextual documentation) 

- Help -> R/3 Library -> Personnel Management -> Organizational Management (complete 

documentation) 

37.8.4.12.8 Logistics Information System 

The link-up of the Logistics Information Systems to the SAP Business Information Warehouse takes 

place through the report RMCSBIWC. Using this report, you can set up the LIS as a source for the data 

transfer to the SAP Business Information Warehouse. 

The data transfer usually takes place in two ways 

- Complete Update: 

All the data from the information structure us transferred according to the selection criteria defined 

in the scheduler in the SAP BW. 

- Delta Update: 

Only the data that has been changed or is new since the last update is transferred. To use this option, 

you must activate the delta update. 

37.8.4.12.8.1 Version Copier for (Transfer) Information Structures 

With the version copier for (transfer) information structures, you can copy and delete the statistics data in 

the information structures Snnn and the delta tables of the LIS environment SnnnBIW1 and SnnnBIW2. 

It replaces the report RMCSISCP that is used in the Setup of the statistical data to copy and delete 

versions. 

A copy program is generated, if required, for each table. The following functions and input options are at 

your disposal: 

 1. (Transfer) Information Structure 

Only information structures for which the LIS environment for linking up to the Business 

Information Warehousee (BW) has been generated can be processed. 

a) Table 

Selection of the tables to be processed: 

- (Transfer) Information Structure Snnn 

- Delta Table SnnnBIW1 

- Delta Table SnnnBIW2 

where Snnn is the name of the information structure. 

b) Processing Type 

- Copy version: 

@2U@ The selected data of the source version is copied to the target version. 
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- Delete version: 

@11@ The selected data of the source version is deleted. 

- Copy + delete: 

The selected data of the source version is copied to the target version and then deleted in the 

source version. 

Activities 

To copy and/or delete the statistics data, proceed as follows: 

1. Enter the name of the (transfer) information structure. 

2. Choose the table. 

3. Select the processing type. 

If required, the system generates a copy program and the selection screen is called up. 

4. Enter the source version and, for copying, the target version. 

During copying, the standard setting has the indicator 'Initialize target version' preset. With this 

indicator set, the data in the target version is deleted before copying. If the indicator is not set, 

indicators that can be accumulated (sliding comma figures, integers, packed numbers) and are 

marked in the definition of the information structure as figures that can be accumulated (summation 

indicators) are added up, and thus compressed to values that already exist. 

5. If only certain data is to be processed, this can be limited in the selection parameters for the 

characteristics and the period. 

6. Choose Programm -> Execute or Program -> Background processing. 

Note 

No postings (online updates) may follow if data is copied to the version  000 using actual data, that 

is, data that was written to the table by the statistics update. 

37.8.4.12.8.2 Connect Information Structures 

This marker enables you to link up an LIS information structure to the Business Information Warehouse 

(BW). A link in this case means data transfer of an informaton structure through a respective data source 

into the BW. 

You can select the different functions through radio buttons. You can execute them separately. 

These functions are explained as follows: 

Information Structures 

The LIS distinguishes between standard information structures (delivered with the name range S001 - 

S500) and customer-individual information structures (generated in the name range S501 - S999). 

If the delta update in LIS is supported, you can switch this on or off via activate/deactivate. 

Note 
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This step does not have any effect on the activation of the standard LIS update. It only affects the 

additional update of the delta information. 

For the transfer information structures, you can activate both the update type as well as the delta update 

through the function Activate/Deactivate Update in Management of Transfer Information Structures. 

- Standard Information Structures 

Only certain standard information structures are designed for data transfer to the BW. These 

structures are also offered in the input options (F4 help) of the field Information structures. 

Standard information structures are delivered either with or without support of the delta update in 

the BW. These settings can be called up using Display settings. 

- User-Defined Information Structures 

As a rule, you can transfer user-defined information structures to the BW. The delta update is 

supported for this. Two copies of the table belonging to the information structure and a transfer 

structure are creaated for this in the DataDictionary and in the database. For example, the tables 

S501BIW1, S501BIW2 und the structure S501BIWS are created for the information structure S501. 

Settings 

The system issues a log with details of the link status. If the delta update is active in LIS, you receive 

detailed specifications on the current table by calling up the description text of the messages issued. 

Generate Environment 

Before a data source can be generated from an information structure, the so-called environment must be 

generated. This consists of two tables (SnnnBIW1, SnnnBIW2) and of the extract structure SnnnBIWS. 

The latter is tailored to the needs of the BW and uses partially different, more uniform data elements. The 

tables SnnnBIW1 and SnnnBIW2 are exact copies of the information structure. 

Generate Data Source 

If the environment was generated without errors, you can generate a data source in this step. The name of 

the data source is derived from the information structure and the application: 

Example: 

S501, Application 01: Name of data source: 2LIS_01_S501 The 

description is taken from the information structure. 

Depending on the SAP BW you are using, one of the following appears: 

- A maintenance view (from SAP BW 2.0 onwards) for choosing the selection fields for the data 

extraction. 

- A maintenance view (only SAP BW 1.2) for assigning extract structure fields for info objects. Here 

the system proposes the correct unit fields automatically. You will find a description of the 

maintenance view under Expand Info Source (Movement Data) and Expand Info Source (Master 

Data). 

You can select indicators that are type C (text), type D (date), type T (time) and indicators whose 

summation indicator is not set in the information structure definition. Please note that only those 

fields that are marked as "selectable" in the maintenance view of the DataSource (Selection of the 

Selection Fields) will be taken into account during extraction. 
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The generation of a data source is independent of the name range of the information structure. 

Delete Environment / Data Source 

If the environment and the data source of an information structure are created, you can use this option to 

delete all the objects generated for it. The objects that will be deleted include:  

: 

- Tables SnnnBIW1 and SnnnBIW2 

- Extract structure SnnnBIWS 

- Any data element copies that may have been created 

- The generated programs belonging to the tables in the data selection 

- The DataSource 

After the LIS environment has been deleted successfully, the update programs for the information 

structure are automatically regenerated. The LIS updating must be deactivated in all clients for this step to 

work properly. 

Delta Update in the  LIS 

The following two items are only of importance if the data is to be transferred to the BW in the form of 

delta information. Updating delta information is only possible if the update program is re-generated. 

In contrast to the environment and the data source, which are client-independent, the delta update is 

client-dependent, in the same way as the standard LIS update. 

Generate Update 

In this step, the update programs can be regenerated. In this way, an additional update of the tables 

SnnnBIW1 and SnnnBIW2 is possible. The LIS update must be deactivated during this. 

Activate/Deactivate 

If tables such as SnnnBIW1 and SnnnBIW2 exist and the update program supports the delta update, you 

can switch on or off the updates to these tables (client-dependent) in this step. Information as to which 

table is currently active for delta updates is stored in the table TMCBIW. This information is accessed in 

the update programs (that is, during the update posting). 

Activities 

To maintain the link from the meta data of a standard information structure to the BW, proceed as 

follows: 

1. Enter the information structure. 

2. Choose the radio button Generate data source. 

3. Depending on the SAP BW you are using, process the respective maintenance views as described 

above. 

To link up your own user-defined information structure, proceed as follows: 

1. Set Up LIS Environment 

The Customizing environment is set to the requirements for data transfer to the BW. To support the 

delta update in LIS, you create two database copies of the information structure and a transfer 
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structure. In this way, for example, tables S501BIW1 and S501BIW2 as well as the structure 

S501BIWS are created for the information structure S501. 

2. Generate DataSource 

Depending on the SAP BW, process the respective maintenance views as described above. 

3. Delta Update in LIS 

To support the delta update mode for the data transfer to BW, a delta update must be enabled in the 

LIS. For this purpose, the update programs for the respective information structure must be 

regenerated. 

4. Update Activation 

First activate the delta update and then the LIS update. 

37.8.4.12.8.3 Activate Update 

In this IMG activity, you make settings for updating the information structures. 

Data analysis in the information systems is based on statistical data which is updated from the operative 

application to the information structures. Updating is triggered by an event in a logistics application (e.g. 

purchase order, sales order). An event is a point in time when information is created that needs to be 

recorded. 

You can influence updating by making the following settings: 

- Period unit of the update 

You define the time level on which statistical data is to be cumulated. Here you can choose 

from the following periods: - updating on a daily basis 

- updating on a weekly basis 

- updating on a monthly basis 

- updating on the basis of posting period 

In this case, you can allocate a posting period to the information structure. The period is then 

always determined on the basis of this posting period and not in accordance with the posting 

period for the company code. 

You should allocate a posting period if the company code cannot be accurately derived from 

the characteristics in the information structure. 

If you do not specify the fiscal year variant, the period split "Posting period" will correspond to 

the posting period that is automatically determined in the documents for the connection to 

Financial Accounting. 

If you want to define your own period split (e.g. quarter, two weeks) for an 

information structure, you need to specify a fiscal year variant. 

If you change the periodicity, data in the information structure for the old periodicity is 

deleted. 

- Type of updating 

You determine when the information structures are updated. Here, you have the following options: 
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- Synchronous update (V1 update) 

The statistics update is carried out at the same time as the document update. If, however, 

errors occur during updating and the statistics update is therefore terminated, the 

corresponding documents are no longer available and will need to be re-entered. 

- Asynchronous update (V2 update) 

Here the document update and the statistics update take place separately so that if the statistics 

update is terminated, this does not affect the update of the documents that are available in the 

operative application. 

In addition, you can perform the document update one one system and the statistics update on 

another. 

- Collective update (U3 update) 

Again in this case, the document update is separate from the statistics update. This means that 

if the statistic update is terminated, it does not affect the document update in the operating 

application. 

However, contrary to the U2 update, the U3 collective update must be scheduled as a job. 

- No update, which means that the update is switched off. 

The update can be activated for each application. 

Note 

You can only change the update periods when the information structures contain planning data only. 

For this reason, the information structure whose update period you wish to change cannot be updated yet, 

i.e. filled with actual data. 

Activities 

1. Select the application in which you wish to change the update parameters of the information 

structures. 

2. Place the cursor on the information structure whose update parameters you wish to change. 

3. Choose the function "Parameters". 

The update parameters are displayed. 

4. Select the setting you require. 

5. Copy the setting you have selected. 

6. Save the update parameters you have changed. 

37.8.4.12.9 Modify Product Hierarchies for Transfer into SAP BW 

Requirements 

You have already defined the product hierarchy in customizing. 

You can find the relevant activities for this in the SAP reference IMG under General Logistics -> Master 

Material ->  Material or Settings for Central Fields ->  Sales-Relevant Data 

-> Define Product Hierarchies  
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Activities 

In this step, the product hierarchy information is adjusted for the data transfer into the SAP Business 

Information Warehouse. The RPHALPRH report is executed for this. 

Further notes 

If the hierarchy structure was changed, execute this activity again to overwrite the data that has already 

been generated. 

37.8.4.12.10 Generate DataSources for General Hierarchies 

Requirements 

The general hierarchy has to exist in the system. 

To create a general hierarchy, go to the system and choose Logistics -> Logistics Controlling -> 

Logistics Information System -> Environment -> General Hierarchy -> Create . 

Activities 

In this step the metadata for general hierarchies is created for the SAP Business Information Warehouse 

in the source system. To do this, execute the RPHALGEN report. 

To make the metadata known in BW, execute a metadata upload in the BW Administrator Workbench. 

37.8.4.13 Project System 

In the following sections, you make settings to the info sources of the project systems that represent the 

data basis for schedule reporting in the Bussines Information Warehouse. 

37.8.4.13.1 Project System Dates, Durations, and Floats in the BW 

Schedules, duration, and buffer for different objects in the Project System are transported to BW using 

the following InfoSources: 

- PS_DAT_PRJ - Schedule of Projects 

- PS_DAT_WBS - Schedule of WBS Elements 

- PS_DAT_NTW - Schedule of the Network 
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- PS_DAT_NWA - Schedule of the Network Activity 

- PS_DAT_NAE - Schedule of the Network Activity Element 

- PS_DAT_MLS - Milestone Dates 

The following InfoObjects are used to describe the schedules, duration and buffer: 

- BW value type - VTYPE 

The BW value type serves to differentiate the Plan/Actual from the forecast dates. 

- Event - DATE_EVENT 

The event differentiates the start/end from the release dates. 

- Origin - DATE_SOURCE 

The origin describes how the date came into being. 

In addition to the SAP standard delivery dates, you can also extract other dates from ERP. 

Activities 

The required procedure has two steps: 

1. New combinations of the InfoObjects "Value Type", "Origin", and "Event" are implemented and 

named. 

2. You determine which characteristic vector in BW represents which date field in an ERP master 

table. You must enter the characteristic vector, the master data table, the attribute and the data 

element for each one. If you want to describe a date exactly by entering a time, you can do this 

here. 

Once the two process steps have been completed, the system transports the dates using the named sources 

automatically to BW. 

37.8.4.13.1.1 Date Event 

Details which event spawns a date; for example, Start or End. Standard SAP events include Start and End. 

You can also maintain user-defined events. 

In this work step, you maintain user-defined events. 

Activities 

1. Choose New entry. 

2. In column Event enter a name from the namespace 9000 - 9999. 

3. Enter a description for the event: short and longer. 
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4. Save your entry. 

The system enters the event. 

37.8.4.13.1.2 Date Origin 

Indicates how the date came about - for example, if it was entered manually, if there was a termination, or 

as a response. 

SAP delivers the following sources by default: 

- Manually 

- Terminated 

- Terminated (early) 

- Terminated (late) 

- Response 

You can also maintain sources of your own in the current step. 

Activities 

1. Choose New entries. 

2. In the Source column, enter a name from the range 9000 - 9999. 

3. Enter a name for the source, of a short and medium length. 

4. Save your entries. 

The system creates the source. 

37.8.4.13.1.3 Dates: Maintain Key Figure 

In this work step you can create and name combinations of the info objects 'value type', 'event' and 

'origin' used to describe a date, and which do not yet exist. 

Activities 
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1. Choose New Entry. 

2. Enter the corresponding info objects and a short and longer description of the combination. 

3. Save the entry. 

37.8.4.13.1.4 Dates: Maintain Assignment of Table to Value Type 

In this work step specify which characteristic vector in BW is used to represent which data field in an 

SAP master data table. 

Activities 

1. Choose New entries. 

2. Enter the combination of the info object, table names, date field, data element of the date field and 

the description. 

You can also specify the duration by entering the respective times and the corresponding data 

element. 

3. Save the entry. 

37.8.4.13.1.5 Duration: Maintain Key Figure 

In this workstep you can create and name combinations of the info objects 'value type', 'event' and 'origin' 

which do not already exist and which describe the duration. 

Activities 

1. Choose New entries. 

2. Enter the corresponding infor objects and a short and longer description for the combination. 

3. Save your entry. 
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37.8.4.13.1.6 Duration: Maintain Assignment of Table to Value Type 

In this work step specify which characteristic vector in BW is used to represent which duration field in an 

SAP master data table. 

Activities 

1. Choose New entry. 

2. Enter the combination of the info objects, table names, fields and units for the duration, the data 

elements of the corresponding field, and the description. 

3. Save the entry. 

37.8.4.13.1.7 Float: Maintain Key Figure 

In this workstep you can create and name new combinations of the info objects 'value type', 'event' and 

'origin' used to describe the buffer: 

Activities 

1. Choose New entries. 

2. Enter the corresponding info object and a short and longer description of the combination. 

3. Save the entry. 

37.8.4.13.1.8 Float: Maintain Assignment of Table to Value Type 

In this work step you specify which characteristic vector in BW is used to represent which buffer field in 

an SAP master data table: 

Activities 

1. Choose New entries. 

2. Enter the combination of the info objects, table names, buffer field, the data element for the buffer 

field, and the description. 
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3. Save your entries. 

37.8.4.14 Human Resources 

In this section, you make the settings for the info sources in Personnel Time Management that will 

provide the basic data for the time data reports in the Business Information Warehouse. 

37.8.4.14.1 Check Assignment of Time Units 

In this activity, you check whether the assignment between HR units and standard SAP units is correct. 

The Time/measurement unit shows the HR unit and the Unit of measurement shows the standard SAP 

unit. 

37.8.4.14.2 Personal Work Schedule Hours OHR_PT_01 

In this step, you make the settings for the info source Personnel Work Schedule Hours OHR_PT_01 

that will provide the basic data for the scheduled working times of employees. 

37.8.4.14.2.1 Set Up Customer Enhancement 

You can use an SAP enhancement to access a Customer Exit. A customer exit will complete the info 

source fields with data you specify for the Personal Work Schedule Hours 0HR_PT_01 during the data 

transfer. 

See the documentation available on the customer exit before carrying out this step. Choose the "Utilities" 

menu option to access the online manual. 

Requirements 

To use the customer exit successfully, you should have sufficient knowledge of the ABAP programming 

language. You can insert your own coding at specific points in the program that are reserved for this 

purpose, however, SAP does not offer service or support for the content of your coding. Any data that 

you make available to the application using the defined interface is stored consistently in the system. If 

data cannot be processed correctly in the system, the data is ignored. 

Standard settings 

The customer exit is not activated in the standard system. 

Activities 
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1. Create an enhancement project. 

2. Assign the enhancement HRPTDW01 to this project. 

3. Edit the customer exit EXIT_SAPLHRMS_BIW_PTDW_001. 

4. Document your project (provide long text). 

5. Activate the project. Your enhancement must be activated before it takes effect. 

Further notes 

When maintaining the customer exit, insert your coding in the Include ZXPTDWU01. Enhancements, in 

contrast to modifications, are basically independent of release. Enhancements are not made in the 

standard system but in a name range specifically reserved for customers. 

For more information on SAP enhancements, see the documentation on HRPTDW01 Time Data 

Extractor: Customer-Specific Fields. 

37.8.4.14.3 Actual Employee Times OHR_PT_02 

In this step, you make the settings for the info source Actual Employee Times 0HR_PT_02 that will 

provide the basic data for the actual working times of employees. 

37.8.4.14.3.1 Define Reporting Time Types 

In this activity, you define reporting time types. You can use reporting time types 

- To define display objects for the Time Manager's Workplace 

- For the SAP Query in the simulated infotype 2501 

- To transfer time and labor data to the SAP Business Information Warehouse (SAP BW) 

Reporting time types allow you a consolidated view of time and labor data of SAP Time Management. 

You can create and name your own reporting time types and use them to group time and labor data from 

the following datasets: 

- Absences infotype (2001) 

- Attendances infotype (2002) 

- Employee Remuneration Information infotype (2010) 

- Time types (table ZES, cluster B2) 

- Time wage types (table ZL, cluster B2) 

The system outputs the values of the individual time and labor data according to the unit chosen and the 

container filled as a cumulated value of the reporting time type. 

Units and containers for time and labor data 
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Two different views are available for defining reporting time types: one for the Time Manager's 

Workplace and one for SAP Query and SAP BW. The system interprets one view or the other, depending 

on the location from which the data is requested. 

- In the case of reporting time types for the Time Manager's Workplace, you must specify in the 

reporting time type itself the unit you want to be used for the value determined (hours or days). This 

guarantees that time administrators correctly interpret the value that is output. 

In the case of attendance/absence types, you can also specify whether you want the payroll 

hours/days (that is, the account-relevant field is selected) or the absence hours/days to be output. 

- However, in the case of reporting time types for SAP Query and SAP BW, the values can be 

accumulated in various containers, according to the unit chosen and the specified value (payroll 

hours, days, absence hours and days). You therefore specify for each attendance or absence the data 

you want to be read.  For time wage types and time types, you specify what you want the value read 

to be interpreted as, that is, which container it is to be placed in. You must restrict the selection to 

one unit. To ensure that the data you receive is of use to you, you should fill the containers 

consistently for each reporting time type. Taking account of personnel subarea groupings and/or 

country groupings You can take account of employees' organizational assignments as required: 

- You can group time and labor data of different personnel subarea groupings in one reporting time 

type. Example: The absence type 0100 has the same business significance for several personnel 

subareas. This means that you can group the absence type 0100 of all relevant personnel subarea 

groupings in one reporting time type. 

- You can manage time and labor data of different personnel subarea groupings in different reporting 

time types. This may be necessary if, for example, absence types with the same subtypes have a 

different business significance. 

The same applies to time types with personnel subarea groupings or for wage types with country 

groupings. Note that you have to maintain the assignments for all personnel subarea groupings if you do 

not want to exclude employee data from particular personnel subareas. Taking account of other 

organizational assignments of employees and purpose of data 

You can also form reporting time types according to other organizational assignments of employees, such 

as the cost center or the Time Management status. To do so, you maintain the GRDWT feature. It 

determines the rule group(s) for the definition of reporting time types. In the standard system, all 

employees have the rule group 01. 

If you use the reporting time types both in the Time Manager's Workplace and in SAP Query and SAP 

BW, you can use the rule groups to have different time and labor data included for different purposes. To 

do so, you use the decision field REPAR in the decision tree of the feature. 

Important note: Many customers who use the SAP Cross-Application Time Sheet do not use the SAP HR 

component. These customers are therefore not able to use the GRDWT feature. So that they can still use 

the InfoSources of the Cross-Application Time Sheet, only the reporting time types of rule group 01 are 

processed for the Time Sheet. 

If you use the HR component and also the Time Sheet InfoSource, you must also reserve rule group 01 

for the Time Sheet. 

Example 
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You want to define a reporting time type, Overtime, for your salaried employees (with Time Management 

status  0) and your hourly-paid employees (with Time Management status 1). You have to take account of 

overtime from time balances (cluster table ZES) and employee remuneration information (infotype 2010). 

You proceed as follows: 

1. You maintain the GRDWT feature. You group employees in a rule group according to the Time 

Management status: Employees with the Time Management status 1 in rule group 01, those with 

the Time Management status 0 in rule group 02. 

2. In the Maintain Reporting Time Types activity, you create a reporting time type, Overtime. 

3. In this reporting time type, you group the time type overtime worked (rule group 01 for employees 

with the Time Management status 1) and the wage types overtime 25% (MM10), overtime 50% 

(MM20), and overtime basic remuneration (MM00) (rule group 02 for employees with the Time 

Management status 0). 

Standard settings 

SAP provides some reporting time types in the standard system. 

Activities 

1. If required, choose the Maintain Feature GRDWT activity and maintain the feature. 

2. Choose the Maintain Reporting Time Types activity. 

3. Create a reporting time type and enter easily identifiable description for the time type text. 

4. You can use any alphabetical or numerical characters in the name of a reporting time type. Note, 

however, that the SAP namespace is reserved for reporting time types beginning with a number. 

5. If you are creating reporting time types for the Time Manager's Workplace, specify whether you 

want them to be managed in days or hours. 

6. Select the reporting time type. 

7. In the dialog structure, double-click on the type of assignment you want: Attendances/Absences 

Assignment, Time Types Assignment, or Wage Types Assignment. 

8. In the  Rule Group: Reporting Time Types field, enter the rule group to which you want the 

reporting time type to belong. The rule group is queried by the GRDWT feature. 

9. Enter a valid combination of personnel subarea grouping and attendance/absence type or time type, 

or of a country grouping and wage type. 

You can assign several attendance/absence types, time types, and wage types to one reporting time 

type. You have to make a new entry for each assignment. You can assign both wage types that were 

determined by time evaluation and stored in the ZL table in cluster B2 and wage types that you 

entered in the Employee Remuneration Information infotype (2010). 

10. Specify how you want the time to be interpreted: 
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a) For the Time Manager's Workplace: If you assign an attendance/absence type, you must 

specify whether you want the system to read the actual times entered or the times that 

would be deducted from a quota (payroll hours/days) In the latter case, you have to 

choose the account-relevant option. 

b) For SAP Query and SAP BW: Enter the individual values you want to read. 

Further Notes 

37.8.4.14.3.2 Set Up Customer Enhancement 

If the options for defining reporting time types in the standard system are not sufficient, you can use an 

SAP enhancement to access a Customer Exit. A customer exit will complete the info source fields with 

data you specify for the Actual Employee Times 0HR_PT_02 during the data transfer. 

If you want to record time data in your enterprise that includes alternative payment information, you can 

explicitly provide data for the Valuation basis field in the function exit at the specific point when that 

information is entered (indirectly) by a wage type or premium entry. 

See the documentation available on this customer exit before carrying out this step. Choose the "Utilities" 

menu option to access the online manual. 

Requirements 

To use the customer exit successfully, you should have sufficient knowledge of the ABAP programming 

language. You can insert your own coding at specific points reserved for this purpose, however, SAP 

does not offer service or support for the content of your coding. Any data that you make available to the 

application using the defined interface is stored consistently in the system. If data cannot be processed 

correctly in the system, the data is ignored. 

Standard settings 

The customer exit is not activated in the standard system. 

Recommendation 

Use the customer exit option only after you have implemented all of the modification options available in 

Customizing. 

Activities 

1. Create an enhancement project. 

2. Assign the SAP enhancement HRPTDW02 to this project. 

3. Edit the customer exit EXIT_SAPLHRMS_BIW_PTDW_002. 
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4. Document your project (provide long text). 

5. Activate the project. Your enhancement must be activated before it takes effect. 

Further notes 

When maintaining the customer exit, insert your coding in the Include ZXPTDWU01. Enhancements, in 

contrast to modifications, are basically independent of release. Enhancements are not made in the 

standard system but in a name range specifically reserved for customers. 

For more information on SAP enhancements, see the documentation on HRPTDW01 Time Data 

Extractor: Customer-Specific Fields. 

37.8.4.14.4 Quota Transation Data OHR_PT_03 

In this step, you make the settings for the info source Quota Transaction Data 0HR_PT_03 that will 

provide the basic data for the time compensation of employees. 

37.8.4.14.4.1 Define Reporting Quota Types 

In this activity, you define quota types for reporting.You can use these reporting quota types 

- To define display objects for the Time Manager's Workplace 

- For the SAP Query in the Quota Statuses simulated infotype (2502) 

- To transfer quota statuses to the SAP Business Information Warehouse (SAP BW) 

Reporting quota types allow you a consolidated view of the following attendance/absence entitlements of 

SAP Time Management: 

- The Attendance Quotas infotype (2007) 

- Absence Quotas infotype (2006) 

- Monthly totals (SALDO table, cluster B2), only for use in the Time Manager's Workplace  

- Leave Entitlement infotype (0005), only for use in SAP Query and SAP BW 

You can group several attendance/absence entitlements in one reporting quota type. The system outputs 

the values of the individual entitlements as a cumulated value in the reporting quota type. 

Taking account of personnel subarea groupings and employee subgroups  

You can take account of employees' organizational assignments as required: 

- You can group time and labor data of different personnel subarea groupings or employee subgroups 

in one reporting quota type. Example: The absence quota type 0100 has the same business 

significance for several personnel subareas. This means that you can group the absence quota type 

0100 of all relevant personnel subarea groupings in one reporting quota type. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 368 

- You can group attendance and absence entitlements of different personnel subarea groupings or 

employee subgroups in different reporting quota types. This may be necessary if, for example, 

absence quota types with the same subtypes have a different business significance. 

The same applies to time types with personnel subarea groupings. Note that you have to maintain the 

assignments for all personnel subarea groupings or employee subgroups if you do not want to exclude 

employee data from particular personnel subareas or employee subgroups. Taking account of other 

organizational assignments of employees and purpose of data 

You can also form reporting quota types according to other organizational assignments of employees, 

such as the cost center or the Time Management status. To do so, you maintain the GRDWK feature. It 

determines the rule group(s) for the definition of reporting quota types. In the standard system, all 

employees have the rule group 01. 

If you use the reporting quota types both in the Time Manager's Workplace and in SAP Query and SAP 

BW, you can use the rule groups to have different attendance/absence entitlements included for different 

purposes. To do so, you use the decision field REPAR in the decision tree of the feature. 

Displaying balances from the SALDO table in cluster B2 

The Time Manager's Workplace displays different values depending on whether you carry over the period 

balance from the previous month or year in the Define Time Types IMG activity: 

- If you carry over the period balance, the system  displays the balance as of the current day. 

- If you do not carry over the period balance, SAP R/3 displays the balance as of the time evaluation 

period in which the selected day lies. This means that in March you can analyze the balance as at the 

end of January if you have selected a day in January, for example. 

Example 

In the Maintain Reporting Quota Types activity, you create a reporting quota type, Leave. 

You use this reporting quota type to group the absence quota types Standard annual leave, Educational 

leave and Special leave. 

Standard settings 

SAP provides some reporting quota types in the standard system. 

Activities 

1. If required, choose the Maintain Feature GRDWK activity and maintain the feature. In the 

standard system, all employees have the rule group 01. 

2. Choose the Maintain Reporting Quota Types activity. 

3. Create a reporting quota type and enter easily identifiable description for the quota type text. 

You can use any alphabetical or numerical characters in the name of a reporting quota type. Note, 

however, that the SAP namespace is reserved for quota time types beginning with a number. 

4. Select the reporting quota type. 
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5. In the dialog structure, double-click on the type of assignment you want: Assign Absence Quotas, 

Assign Attendance Quotas, or Assign Leave Quotas. 

6. In the  Rule Group: Reporting Quota Types field, enter the rule group to which you want the 

reporting quota type to belong. The rule group is queried by the GRDWK feature. 

Enter an attendance or absence quota type, a leave type, or a monthly total. You can assign several 

attendance or absence types, leave types, or monthly totals to one reporting quota type. You have 

to make a new entry for each assignment. 

Further Notes 

37.8.4.14.4.2 Maintain Customer Enhancement 

If the existing options for defining reporting quota types in the standard system are not sufficient, you can 

use an SAP enhancement to access a Customer Exit. A customer exit will complete the info source fields 

for Quota Transaction Data 0HR_PT_03 with data you specify during the data transfer. 

See the documentation available on this customer exit before carrying out this step. Choose the "Utilities" 

menu option to access the online manual. 

Requirements 

To use the customer exit successfully, you should have sufficient knowledge of the ABAP programming 

language. You can insert your own coding at specific points reserved for this purpose, however, SAP 

does not offer service or support for the content of your coding. Any data that you make available to the 

application using the defined interface is stored consistently in the system. If data cannot be processed 

correctly in the system, the data is ignored. 

Standard settings 

The customer exit is not activated in the standard system. 

Recommendation 

Use the customer exit option only after you have implemented all of modification options available in 

Customizing. 

Activities 

1. Create an enhancement project. 

2. Assign the SAP Enhancement HRPTDW03 to this project. 

3. Edit the customer exit EXIT_SAPLHRMS_BIW_PTDW_003. 

4. Document your project (provide long text). 
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5. Activate the project. Your enhancement must be activated before it takes effect. 

Further notes 

When maintaining the customer exit, insert your coding in the Include ZXPTDWU03. Enhancements, in 

contrast to modifications, are basically independent of release. Enhancements are not made in the 

standard system but in a name range specifically reserved for customers. 

For more information on SAP enhancements, see the documentation on HRPTDW01 Time Data 

Extractor: Customer-Specific Fields. 

37.8.4.14.5 Define Time Frame for Transfer 

In this step, you define the time frame used to select time data for reports in the Business Warehouse. 

Only time data entered for a date or period within this time frame is transferred to 

BW. 

The time frame you specify is activated when you 

- Request data for initializing the delta transfer 

- Request the delta since the last request or repeat the delta request 

- Transfer all requested data and do not restrict the required period in BW. 

Example 

1. You regularly use BW to gain an overview of the current calendar year. You enter January 1, 

2001 as the earliest transfer date and December 31, 2001 as the latest transfer date. At the start 

of the next year, you set the dates forward one year. 

2. You want to have regular access to the current data. You also want to take account of 

time data that has changed in the last six months. You are also interested in absences that have been 

recorded for future periods. 

You therefore set the earliest transfer data to six months ago and the latest transfer date to six 

months in the future. Each month, you set the dates forward one month. 

Recommendation 

Make the time frame as small as possible to avoid unnecessarily long runtimes, and as large as necessary 

to transfer all relevant data. 

Activities 

1. Choose the Check Feature TIMMO activity. 
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2. Check the modifiers specified. If you want to use special modifiers for BW, adjust the feature 

accordingly. 

3. Choose the Earliest Transfer Date activity and enter the date up to which 

a) Data is to be selected (when you request all data) 

b) All changes made after the last request are to be selected (for a delta request) 

4. Choose the Latest Transfer Date activity and enter the date up to which data entered for the future 

is to be selected. 

5. Note these activities (outside the SAP system) for your periodical activities so that you can update 

the time frame monthly or annually, for example. 

37.8.4.14.6 Pension Fund Selection PC Activities and Value Types 

Use 

In this activity, you define which PC activities are permitted and which associated value types are 

returned by the PC interpreter from the  SAP Business Information Warehouse. 

Requirements 

There has to be a PC action in the VS plan that calculates this type of value. 

Activities 

1. Call the activity and enter the country grouping for the pension fund for which you wish to process 

values. 

2. Define the required PC activity in the dialog structure Permitted PC activity for BW using 

New entries. 

3. For every inserted entry, define the associated value types that should be returned by the system in 

the subdialog Value types per PC actvity for BW. 

To do this, select the corresponding entry from the subdialog and double click to define the value 

types. 

37.8.4.14.7 BAdI: Take Account of Employees Who Have Joined Company 

Use 
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In this activity, you can ensure that the data of employees who have joined the company since the last 

delta initialization is taken into account in the extraction. 

For more information, see the documentation of the CREATE_MISSING_0439 method. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

37.8.4.14.8 Payroll Plug-In 

37.8.4.14.8.1 Assignment of Payroll Data to BW Month 

Use 
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In this IMG activity, you determine the criterion for the assignment of payroll data to a BW month to run 

reports in the Business Information Warehouse. You specify the criterion for each Country Grouping. 

You can determine the BW month using the following time data: 

1. End Date of For-Period 

2. End Date of In-Period 

3. Payment Date of For-Period 

4. Payment Date of In-Period 

The DataSource 0HR_PY_1 possesses not only the selection criterion Personnel Number, but also the 

selection criterion BW Month. The selection criterion BW Month is only supported in Full Upload  

mode. In this mode,  the selection of the criterion for the assignment of the payroll data to a BW month 

also has an effect upon which basis the period selection takes place. 

Standard settings 

If there is no criterion specified for a country grouping, then SAP R/3 uses the criterion End Date of the 

For-Period. 

Activities 

Enter the country grouping and the criterion for the time assignment of the payroll data to a BW month. 

Example 

In your company, you run the payroll for the country groupings of Germany (01) and the USA (10). For 

the employees in Germany, you want to assign the payroll data according to the criterion End Date of 

the For-Period. For the employees in the USA, you want to assign the payroll data using the payment 

date. To do this, enter the following: 

 Country Grouping  Time-Based Assignment 

 01  End Date of the For-Period 

 10  Payment Date of the In-Period 

37.8.5 Generic DataSources 

In this section, you can find out how to extract data from a source system into a BW system using generic 

DataSources. 

Regardless of the application, you can use generic data extraction from all kinds of transparent tables, 

database views, or SAP query functional areas. To do this, no program knowledge in ABAP is necessary. 

Furthermore, you can use function modules for generic data extraction. 

In this way, you can use your own DataSources for transaction data, master data attributes, or texts. Data 

for such DataSources are read generically and transferred to the BW system. 
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In this way, generic DataSources enable the extraction of data that can neither be supplied with the 

Business Content DataSources delivered by SAP nor supplied with the customer-defined DataSources in 

the application. 

37.8.5.1 Maintain Generic DataSources 

This step gives you the option of creating and maintaining generic DataSources for transaction data, 

master data attributes or texts from any kind of transparent tables, database views or SAP query 

functional areas or via a function module, regardless of application. This enables you to use the generic 

extraction of data. 

Activities 

Create a Generic DataSource 

1. Select the DataSource type and assign a technical name to it. 

2. Choose Create 

The screen for creating a generic DataSource appears. 

3. Choose an application component to which the DataSource is to be assigned. 

4. Enter the descriptive texts. You can choose these freely. 

5. Choose from which data sets the generic DataSource is to be filled. 

a) If you want to extract data from a transparent table or database view, choose Extraction from 

View and enter the name of the table or database view. 

The result of generation is a DataSource whose extract structure corresponds to the database 

view or transparent table. 

For more information on creating and maintaining database tables and views, see the ABAP 

Dictionary documentation. 

b) If you want to use an SAP query functional area as a data source, choose Extraction from 

Query. Select the required functional area from the functional area catalog. 

Enhancements for Extracting Using SAP Queries 

The result of generation is a DataSource whose extract structure corresponds to the functional 

area. 
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You can find additional information about the maintenance of functional areas in the SAP 

query documentation. 

c) If you want to extract data using a function module, choose Extraction Using FM and specify 

the function module and the extract structure. 

The data must be transferred from the function module to an interface table 

E_T_DATA . 

Interface Description and Extraction Process 

You can find information about the function builder in the ABAP Workbench documentation. 

d) For texts, data can also be extracted from domain fixed values. 

6. If necessary, maintain settings for the Delta Transfer. 

7. Choose Save. 

Extraction Using Functional Areas: Assignment to a User Group 

Note for Extracting from a Transparent Table or a View: 

If the extraction structure contains a key figure field that references a unit of measure field or a 

currency unit field, then this unit field has to be included in the same extraction structure like 

the key figure field. 

A screen appears in which you can edit the extract structure fields. 

8. Edit the DataSource: 

- Selection 

When scheduling a data request in the BW scheduler, you can enter the selection criteria for 

data transfer. You can, for example, set the data request to only cover data from the previous 

month. 

If you set the Selection indicator for a field of the extract structure, the data for this field is 

transferred according to the selection criteria for the Scheduler. 

- Hide Field 

Set this indicator to exclude an extract structure field from the data transfer. This field is now 

no longer available in the BW when setting transfer rules, and thus it is no longer available 

when generating the transfer structure. 

- Cancelation Field 

Reverse postings are possible for customer-defined key figures. Cancelations are therefore 

only active with certain transaction DataSources. These are DataSources that have a field 

designated as a cancelation field, for example, the Update Mode field in the DataSource 

0FI_AP_3. If this field has a value, the data records are interpreted as reversal records in the 

BW. 

If you want to carry out a cancelation posting for a customer-defined field (key figure), set the 

Cancel indicator. The value of the key figure is transferred inverted (multiplied by -1) into the 

BW. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 376 

- Field Known Only in Exit. 

You can improve the quality of data by adding fields in append structures to the extract 

structure of a DataSource. 

For fields in an append structure, the indicator  Field Known Only in Exit is set, meaning that, 

by default, these fields are not passed to the field list and the selection table in the extractor. 

Remove the Field known only in Exit indicator if you want the Service API to pass the field 

in the append structure to the extractor, along with the fields from the delivered extract 

structures in the field list and in the selection table. 

9. Choose DataSource -> Generate. 

The DataSource is now saved in the source system. 

Maintain Generic DataSource 

Change DataSource 

To change a generic DataSource, go to the initial screen of  DataSource maintenance, enter the name of 

the DataSource and choose Change. 

You can change the assignment of a DataSource to an application component as well as the DataSource 

texts. By double-clicking on the name of the table, view, functional area or extract structure, the 

corresponding maintenance screen appears. You can make the changes here required to add new fields. 

You can also completely substitute transparent tables and database views, though not functional areas. If 

you return to the DataSource maintenance and choose Create, the screen used to process the DataSource 

appears. To save the DataSource in the source system, choose DataSource -> Generate. 

If you want to test the extraction in the source system independently of BW system, choose DataSource -

> Test Extraction. 

Delete DataSource 

In the Change Generic DataSource screen, you can delete a DataSource that is no longer relevant. If you 

extract data from a functional area, also delete the corresponding query. If you want to delete a 

DataSource, make sure it is not connected to any BW system. 

Further notes 

Information about Extraction using the ABAP Query / ABAP/4 Query / SAP Query 

37.8.6 Postprocessing of DataSources 

In this section, you find out how to subsequently process DataSources or application component 

hierarchies. 

37.8.6.1 Edit DataSources and Application Component Hierarchy 
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To adjust existing DataSources to your requirements, you edit them in this step and transport them from a 

test system into a productive system. 

You can also use this procedure to post-process the application component hierarchy. 

Activities 

DataSource 

- Transporting DataSources 

Select the DataSources that you want to transport from the test system into the productive system, 

and choose Transport. Specify a development class and a transport request, so that the 

DataSources can be transported. 

- Maintaining DataSources 

To edit a DataSource, select it, and choose Maintain DataSource. The following editing options 

are available: 

- Selection 

When scheduling a data request in the BW Scheduler, you can enter selection conditions for 

the data transfer. You can, for example, determine that data requests are applied only to data 

from the last month. 

If you set the Selection indicator for a field in the extract structure, the data for this field is 

transferred according to the selection conditions determined in the scheduler. 

- Hide Field 

To exclude a field in the extract structure from the data transfer, you must set this indicator. 

The field is used in the BW to determine the transfer rules, and can no longer be used to 

generate the transfer structure. 

- Cancelation Field 

Reverse postings are possible for customer-defined key figures. Cancelations are therefore 

only active with certain transaction DataSources. These are DataSources that have a field 

designated as a cancelation field, for example, the Update Mode field in the DataSource 

0FI_AP_3. If this field has a value, the data records are interpreted as reversal records in the 

BW. 

If you want to carry out a cancelation posting for a customer-defined field (key figure), set the 

Cancel indicator. The value of the key figure is transferred inverted (multiplied by -1)into the 

BW system. 
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- Field Known Only in Exit 

You can improve the quality of data by adding fields in append structures to the extract 

structure of a DataSource. 

For fields in an append structure, the indicator Field Known Only in Exit is set, meaning that, 

by default, these fields are not passed to the field list and the selection table in the extractor. 

Remove the Field Known Only in Exit indicator if you want the Service API to pass the field 

in the append structure to the extractor, along with the fields from the delivered extract 

structures in the field list and in the selection table. 

- Enhancing Extract Structures 

If you want to transfer additional information for an existing DataSource from a source system into 

the BW, you have to enhance the extract structure of the DataSource with additional fields. 

To do this, you create an append structure for the extract struture. 

a) Use the Enhance Extract Structure pushbutton to reach the field maintenance for the append 

structure. The name of the append structure is generated from the extract structure name in the 

customer namespace. 

b) Enter the fields you want to append and the data elements based on them into the field list. All 

functions available for field maintenance for tables and structures are available here. 

c) Save and activate the append. 

For more information on the append structure, see the ABAP Dictionary documentation for 

maintaining tables. 

- Function Enhancements 

To fill the fields of the append structure with data, create a customer-specific function module. 

Information on enhancing the SAP standard with customer-specific function modules can be found 

in the R/3 library under Basis -> ABAP Workbench -> Enhancements to the SAP Standard -> 

R/3 Enhancement Concept or under Enhancing DataSources. 

- Testing Extractions 

If you want to test the extraction in the source system independent of a BW system, choose 

DataSource -> Test Extraction. 

Application Component Hierarchy 

- To create a node on the same level or under it, place the cursor on this node and choose Object -> 

Create Node. You can also create subordinate nodes by choosing >LS>Object -> Create Children. 

- To rename a node, to expand or compress it, place the cursor on the node and click the 

corresponding pushbutton. 
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- To reassign a node or a subtree, select the node to be reassigned ( by positioning the cursor over it 

and clicking the Select Subtree pushbutton), position the cursor over the node to which the 

selected node is to be assigned, and click on the Reassign pushbutton. 

- If you select a node with the cursor and choose Set Section, the system displays this node with its 

subnodes. You can use the respective links in the line above the subtree to jump to subordinate 

nodes for this subtree. 

- When you select a node with the cursor and choose Position, the node in the first line in the view is 

displayed. 

- All DataSources for which no valid (assigned) application component could be found appear under 

the node NODESNOTCOLLECTED. The node and its sub-nodes are only constructed during the 

transaction runtime, and updated when saving in the display. NODESNOTCONNECTED is not 

stored persistently in the database. For this reason, it is not transferred into other systems when the 

application component hierarchy is transferred. Note that hierarchy nodes created under the 

NODESNOTCONNECTED node are lost when you save. After saving, only those nodes under 

NODESNOT- CONNECTED are displayed that were moved with DataSources under these nodes. 

Example 

A DataSource lies under an application component X. You transfer a new application component 

hierarchy from Business Content, which does not contain the application component X. The system 

then automatically assigns this DataSource under the component NODESNOTCONNECTED in 

this application component. 

- Special DataSources can be delivered with Business Content that are not used to extract data but to 

reconcile data with one of more Content DataSources. With these reconciliation DataSources you 

can check that the data loaded from other DataSources is correct. 

The RECONCILIATION node of the application component indicates that reconciliation 

DataSources of this type are assigned to the application component. If DataSources exist for an 

application component that can be flagged as DataSources for reconciliation, this is displayed in 

the corresponding RECONCILIATION lower-level node. If no DataSources exist for an 

application component that can be used for reconciliation, this node is not displayed. 

Note that changes made to the application component hierarchy are only valid until the next transfer from 

Business Content takes place. 

37.9 Business Packages/Functional Packages 

37.9.1 LDAP-Enabled Directory Service 

37.9.1.1 Provision of HR Data in LDAP-Enabled Directory Services 

37.9.1.1.1 BAdI: Changing Attribute Values 
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Use 

With this Business Add-In (BAdI) you can change the defaults that the SAP standard system generates 

for the key of an employee record in the LDAP directory, and specify customer-specific keys. 

If you are using several HR systems, the description of an employee in the LDAP directory using his or 

her personnel number is not usually unique. Since a personnel number always describes an employee 

uniquely within one logical system, we provide a default in the standard that is a concatenation of the 

name of the logical system that provided the data, and the personnel number of the employee. You can 

change this default. 

If you are using enterprise portals based on a mySAP Workplace system, the Workplace user name of an 

employee is of central importance. In the standard, we provide the attribute SAP WP User Name 

(SAP_WP_USER). If an HR user name exists, the system fills the attribute with the HR user of an 

employee. If there is no HR user name, or if you are using more than one HR system, so that an 

employee's HR user name is not unique, you must assign a unique Workplace user name for each 

employee in the Workplace system group. 

Standard settings 

This BAdI is not implemented in the standard system. Unless you create an implementation, the system 

generates the keys for the LDAP directory according to the defaults defined in the standard system. 

Activities 

When you call the Implementation Guide (IMG) activity, a dialog box appears in which you enter a name 

for the implementation. 

If you have already created implementations for this BAdI, a dialog box appears that lists the existing 

implementations. In this box, choose Create, and continue as follows: 

1. In the dialog box, in the Implementation field, enter a name for the BAdI implementation, and 

choose Create. 

The initial screen for creating BAdI implementations appears. 

2. On the initial screen, in the Short Text for Implementation field, enter a short text for the 

implementation. 

3. Choose the Interface tab page. 

On the tab page, the system automatically fills the Name of Implemented Class field, since it 

assigns a class based on the name of your implementation. 

4. Save your entries and make the assignment to a development class. 

5. Position the cursor on each method in turn and double click to call method editing. 

6. Between the commands method <Interface Name>~<Name of Method>.  and end 

method. enter the code you require for the implementation. 

7. Save and activate your code. 

8. Navigate back to the Change Implementation screen. 
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9. Choose Save on the Change Implementation screen. 

Note: You can also create an implementation for a BAdI and activate it later. In that case, stop 

editing now. 

10. Choose Activate. 

Now, when you execue the application program, the system runs the code you stored in the method. 

Further Notes: 

Interface 

Method: Return RDN for a Person 

Method: Return Workplace User Names 

37.9.2 Manager Self-Service (mySAP ERP) 

37.9.2.1 Personalization 

37.9.2.1.1 Personalization: Overview 

Use 

In personalization, you specify the values that belong to the area of responsibility of a business package 

user, such as the cost centers for which a manager or Business Unit Analyst is responsible. 

You can enter the personalization information in different ways: 

- In the following IMG activities you can, for certain personalization characteristics, fill the 

data for the users from their authorizations stored in the system: 

- Fill Personalization Data from Authorizations (Cost Centers) 

- Fill Personalization Data from Authorizations (Profit Centers) 

- In the IMG activity Personalization Data: Collective Processing, you can enter data manually 

for one or more users. 

- Users can enter their own data in the Web application under Personalize Data. You can 

simulate this entry of users for support purposes in the IMG activity   Personalization Data: 

Individual Processing (includes update). 

For more information, see the SAP Library under Cross-Application Components -> Personalization. 
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37.9.2.1.2 Automatic Generation of Default Authorizations 

Use 

As preparation for the IMG activity Fill Personalization from Authorizations, you can first fill the 

authorizations either from the cost center master record or from Organizational Management. This is 

initially possible only for the authorization object K_CCA. 

To fill the authorizations, first specify entries for default authorizations in this Customizing activity. Then 

execute one of the two following programs: 

- FPB_GENERATE_PROFILE_CCMD to transfer the assignment of cost center and user ID 

from the cost center master record 

- FPB_GENERATE_PROFILE_HRORG to transfer the assignment of cost center and user ID 

from the organizational hierarchy 

With these programs, you can assign default authorizations that you have entered in this 

Customizing activity to a set of users that you specify in the selection screen. These authorizations refer 

exclusively to the authorization object K_CCA. You can assign authorizations at the level of cost centers 

or hierarchy nodes. 

Requirements 

- For the program FPB_GENERATE_PROFILE_CCMD there are cost centers for which the 

user ID is entered in the Person Responsible field. 

- For the program FPB_GENERATE_PROFILE_HRORG you have specified the users' cost 

center in the Organizational Management (BC-BMT-OM) component. 

In both cases you can modify the selected area of responsibility with BAdI 

FPB_AUTHORISATIONS and method CHANGE_RESPAREA. 

Example 

Example entry in this Customizing activity that defines the authorization to display for cost center 

managers: 

- Authorizations 

- ID: TEST1 (You enter this ID as the profile ID in the reports.) 

- Activity: 03 

- Authorization object: K_CCA 

- Authorization name: CC_DISPLAY 

- Text: Cost Center Accounting 

- Authorization values 
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- Object field: CO_ACTION 

- Length: 0 

- Value from: 3027 

- Value to: 3029 

37.9.2.1.3 Fill Personalization Data from Authorizations (Cost Centers) 

Use 

In this IMG activity, you can read user-specific data for the controlling area and cost centers centrally for 

all users from their authorizations, and transfer this data into the personalization framework. You can 

decide whether the cost center hierarchy should be exploded and whether data for internal orders and 

WBS elements should be read. 

If you execute this IMG activity as a test run, the user data is only displayed and not written to the 

personalization framework data store. 

If you activate expert mode, you can specify first the personalization subcontext and second the 

personalization application and characteristic in the personalization hierarchy, under which the data is to 

be updated. 

Requirements 

- The authorizations are maintained. You can use the IMG activity  Automatic Generation of Default 

Authorizations and the programs mentioned in the documentation for the IMG activity for this 

purpose. 

- To enable the internal orders/WBS elements for the area of responsibility to be filled, this 

information must exist in the master data of the internal orders/WBS elements (field for responsible 

cost center). 

- To execute the activity in expert mode, you must have set the parameter Personalization: 

Activate Expert Mode (FPB_PERS_EXPERT) in the user profile to X. 

37.9.2.1.4 Fill Personalization Data from Authorizations (Profit Center) 

Use 

In this IMG activity you can read user-specific data for the controlling area and profit center centrally for 

all users from their authorizations, and transfer it into the personalization framework. You can decide 
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whether the profit center hierarchy should be exploded and whether data for internal orders and WBS 

elements should be read. 

If you execute this IMG activity as a test run, the user data is only displayed and not written to the 

personalization framework data store. 

If you activate expert mode, you can specify first the personalization subcontext and second the 

personalization application and characteristic in the personalization hierarchy, under which the data is to 

be updated. 

Requirements 

- The authorizations are maintained. 

- To enable the internal orders/WBS elements for the area of responsibility to be filled, this 

information must exist in the master data of the internal orders/WBS elements (field for profit 

center). 

- To execute the activity in expert mode, you must have set the parameter Personalization: Activate 

Expert Mode (FPB_PERS_EXPERT) in the user profile to X. 

Standard settings 

Activities 

37.9.2.1.5 Personalization Data: Collective Processing 

Use 

In this IMG activity you can enter the personalization data of users in a personalization dialog either 

supplied by SAP or in one you created yourself. You enter the values that apply to the selected users for 

each personalization characteristic. The personalization dialog defines the entry screen for the data. 

This form of collective processing is particularly useful for characteristics that are the same for many 

users (the current year would be an example). For characteristic values that are different for particular 

users, you can also use this IMG activity by entering individual users instead of user groups in the 

selection screen. 

If you start collective processing for an individual user for whom personalization data had been entered 

in the past, then these characteristic values are also displayed in the personalization dialog. If you start 

collective processing for several users then the personalization dialog is displayed without the 

personalization data, because the individual characteristic values usually differ depending on the user. 

Notes 
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- In collective processing, no authorization check or existence check is made of the personalization 

data entered, so as not to impede performance. These checks are first made in the applications that 

use the personalization data for the selection. 

- If users enter their personalization data in the application themselves, this data counts as the entries 

that apply rather than the data entered here in collective processing. In this situation and unlike 

collective processing both an authorization check and an existence check is made. 

- If you want to enter personalization data under a particular application subcontext, the 

corresponding field is only displayed in the selection screen for collective processing if you have 

activated expert mode in the user parameters for your own user (under System -> User Profile -> 

Own Data -> Parameters: Parameter ID: FPB_PERS_EXPERT, Parameter Value: X). 

Requirements 

- The users have been created. 

- Custom or standard SAP personalization dialogs exist. 

- You have activated expert mode in your own user parameters as necessary. 

Activities 

1. Choose the personalization dialog you want to use to enter data. 

2. Enter the user or users for whom you want to enter the personalization data. 

3. Enter the application subcontext for which you want to enter the personalization data. 

4. Enter a time period. If you do not make an entry, the system assumes the largest possible time period 

(01/01/0001 to 12/31/9999). 

5. Specify whether you want the system to update only the data you entered or also the fields you left 

empty. 

- If you select Update Input Data Only, only the values that you explicitly enter are updated. 

Nothing is updated for the fields that you leave empty. Any data for these characteristics 

existing on the database is not changed. 

- If you select Update Initial Data Also, the values for the empty fields that are on the database 

are overwritten with the initial values. 

6. Choose Program -> Execute. 

The entry screen for the selected personalization dialog appears. 

7. Enter the personalization data and save it. 

37.9.2.1.6 Additional Functions in Personalization 
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37.9.2.1.6.1 Personalization Data: Single Processing 

Use 

As the administrator, you can simulate the entry of personalization data by users in the Web application in 

this IMG activity. This enables you analyze problems without having to use the Web front end, and 

determine whether the problem lies in the front end or in the update of the data in the back end. 

Unlike collective processing, in single processing of personalization data both an authorization check and 

existence check is made. 

If you start single processing for an individual user for whom personalization data had been entered in 

the past, then these characteristic values are also displayed in the personalization dialog, meaning that 

individually entered personalization data overrides administratively entered data. Note 

If you want to enter personalization data under a particular application subcontext, the corresponding field 

is only displayed in the selection screen for single processing if you have activated expert mode in the 

user parameters for your own user (under System -> User Profile -> Own Data -> Parameters: 

Parameter ID: FPB_PERS_EXPERT, Parameter Value: X). 

Activities 

1. Choose the personalization dialog you want to use to enter data. 

2. Enter the application subcontext for which you want to enter the personalization data. 

3. Enter the user whose data entry you want to simulate. 

4. Choose Program -> Execute. 

The entry screen for the selected personalization dialog appears. 

5. Enter the personalization data and save it. 

37.9.2.1.6.2 Edit Personalization Hierarchy 

Use 

In this IMG activity you can make the following settings for the personalization hierarchies: 

- You can include additional personalization applications (meaning nodes in the hierarchy) in the SAP 

personalization hierarchy delivered. 

- You can include new characteristics in the personalization applications delivered. You should note 

that in this case you have to adapt the personalization dialogs to make it possible to enter 

personalization data for the characteristics. 
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- You can create your own personalization hierarchies parallel to the personalization hierarchy 

delivered. 

For general information on personalization hierarchies, see the SAP Library under Cross-Application 

Components -> Personalization -> Components of the Personalization Framework. 

Standard settings 

The standard delivery for SAP ECC already contains standard personalization hierarchies. Hence, for 

example, the root nodes of the standard personalization hierarchy for applications in the Controlling 

environment are CO. 

For all of the applications delivered in the standard system that require personalization data from the 

personalization framework as start parameters, corresponding personalization applications with the 

appropriate personalization characteristics are also delivered in the standard system. For these 

applications, only the personalization data still needs to be entered for the users (see personalization 

data: collective processing). You are not required to create your own personalization hierarchies, 

applications and characteristics. 

Activities 

1. To create your own personalization application, choose New Entries  in the view Personalization 

Hierarchy. 

2. You sort the personalization application in the existing personalization hierarchy by specifying the 

higher-level node of the hierarchy in the field Higher-Level Personalization Application. If you 

leave this field blank, you create the uppermost node (root node) of a new personalization hierarchy. 

Make sure that you do not implement a circular hierarchy. Each hierarchy must have a root node, 

and the evaluation path of a hierarchy path must be unique from the lowest node to the root node. 

3. To include characteristics in a personalization application, select the personalization application in 

the view Personalization hierarchy and then choose Personalization characteristics. 

4. Enter the necessary data for the characteristic in the view Personalization characteristics. This is 

where you specify how personalization data for the characteristic is later displayed and entered in 

the personalization dialog. Amongst other things, you also specify here the personalization 

characteristiscs reference to the ABAP Dictionary. 

37.9.2.1.6.3 Edit Personalization Dialog 

Use 

In this IMG activity you can define separate personalization dialogs for the entry of personalization data. 

You may find this is necessary, for example, if you have enhanced the personalization hierarchy 

delivered. 

One personalization dialog can consist of several tab pages with various field groups. 

Standard settings 
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The standard delivery for SAP ECC already contains standard personalization dialogs. For example, the 

standard dialog for entering personalization data in the Controlling environment for cost center reporting 

is DIA_CO_CCA_IS. 

For all of the applications delivered in the standard system that require personalization data from the 

personalization framework as start parameters, corresponding personalization dialogs with the 

appropriate personalization characteristics are also delivered in the standard system. Only the 

personalization data still needs to be entered for your users (see personalization data: collective 

processing). You are not obliged to create your own personalization dialogs. 

Activities 

1. To create your own personalization dialog, choose New Entries in the view Dialog ID. To group 

the fields of a personalization dialog, carry out the following steps: 

2. Create a tab page, by selecting the personalization dialog and then choosing Dialog Tab Page 

Title. Assign an ID and name for the tab page title. 

3. To create a field group on the tab page, select the dialog tab page title and then choose Dialog 

Groupings. Assign an ID and name for the grouping of dialog fields. 

4. To specify the individual fields of the grouping, select the dialog grouping and then choose Dialog 

Fields. 

5. Create a field using New Entries. You can define the link to the personalization hierarchy by 

entering the personalization application and characteristic (field). You also need to specify whether 

the field on the personalization dialog is to be ready for input, or whether personalization data 

should be displayed only. Using position, you determine the order of the dialog fields within the 

grouping. 

37.9.2.1.6.4 Display Personalization Data 

Use 

In this IMG activity you can display all of the existing personalization data for one or more users. The 

system then displays the data entered by both the administrator in collective processing centrally, and the 

data entered by users themselves. 

The personalization data view corresponds to the display of the data records in the database table 

(technical view). Consequently, you can quickly ascertain which personalization data has actually been 

saved for each user. 

37.9.2.1.6.5 Delete Personalization Data 

Use 

In this IMG activity you can delete the data entered for a personalization application for one or more 

users. This is particularly useful if you experience data inconsistencies. 
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If you only want to delete the personalization data for a particular personalization characteristic, then 

enter that characteristic in the selection screen. In the input help, you are offered only those 

personalization characteristics that, in accordance with the personalization hierarchy, also relate to the 

personalization application you have already selected. If you want to delete all of the data for the 

personalization application, then leave the field Characteristic blank. 

The system then deletes the data entered by both the administrator in collective processing centrally, and 

the data entered by users themselves. 

In the test run, you can check which data records are deleted in the upate run. 

The personalization data view corresponds to the display of the data records in the database table 

(technical view). Consequently, you can quickly ascertain which personalization data has actually been 

saved for each user. 

37.9.2.1.6.6 Reorganize Personalization Data 

Use 

In this IMG activity you can assign the existing data for a personalization application for a particular 

characteristic to a different personalization application. As you do this, you can decide whether to retain 

the data for the original personalization application or to delete it. 

Requirements 

It is only possible to reorganize the personalization data if there is a corresponding target characteristic in 

the target personalization application. The input help only displays relevant personalization 

characteristics. The target characteristic does not have to have the same name, but must have the same 

domain as the source characteristic. 

Include the relevant personalization characteristics for the personalization applications in the 

personalization hierarchy as necessary, before you reorganize (see also the IMG activity Edit 

Personalization Hierarchy). You are not required to create your own personalization hierarchies, 

applications and characteristics, but can enter existing or standard system delivery personalization 

characteristics for personalization applications as the target for the reorganization. 

37.9.2.1.7 Business Add-Ins 
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37.9.2.1.7.1 BAdI: Personalization: Authorization Checks 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

This BAdI enables you to make authorization checks for objects in connection with personalization. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-In is filter-dependent, but cannot be used more than once. 

Create one implementation for each personalization application for which you wish to make an 

authorization check in the environment. If an active implementation exists, this is also executed. 

The following implementation is delivered in the software component EA-APPL: 

FPB_PERS_AUTH_CO (Personalization: Existence checks in the CO environment; filter 

characteristics/applications: CO*, BUA*) 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 
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37.9.2.1.7.2 BAdI. Personalization: Existence Checks 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

This BAdI enables you to make existence checks for objects in connection with personalization. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-in is filter-dependent, but cannot be used more than once. Create one implementation 

for each personalization application for which you wish to make an existence check in the environment. 

If an active implementation exists, this is also executed. 

The following implementations are delivered in the software component EA-APPL: 

- FPB_PERS_EXIST_CO (Personalization: Existence checks in the CO environment; filter 

characteristics/applications: CO*, BUA*) 

- MT_PERS_CHECK_EXIST (Personalization: Existence checks in the maintenance technology 

environment; filter characteristics/applications: OPS-EAM*) 

- OPS_PERS_CHECK_EXIST (Personalization: Existence checks in the quality check environment; 

filter characteristic/application: OPS) 

- QI_PERS_CHECK_EXIST (Personalization: Existence checks in the quality check environment; 

filter characteristics/applications: OPS-QM*) 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 
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6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.2.1.7.3 BAdI: Personalization: Resolution of Intervals and Groups 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

With this BadI, you can resolve groups and intervals into their respective single values within the 

personalization of objects. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-in is filter-dependent, but cannot be used more than once. 

Create an implementation for each personalization application required in whose environment you want 

to resolve groups and objects into their respective single values. If an active implementation exists, this is 

also executed. 

The following implementation is delivered in the software component EA-APPL: 

FPB_PERS_RESOLVE_CO (Personalization: Resolve in CO environment; filter 

characteristics/applications: CO*, BUA*) 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 
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3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.2.1.7.4 BAdI: Personalization: Conversion of Data Formats 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

This BAdI enables you to undertake the conversion of data formats for objects in connection with 

personalization. This means you can convert the relevant personalization data for a particular 

personalization characteristic from external to internal format, and the other way round. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-in is filter-dependent, but cannot be used more than once. Create one implementation 

for each personalization application in whose environment you wish to make a conversion. 

If an active implementation exists, this is also executed. 

If the system is unable to determine any implementations, then in the standard system the default code for 

conversion of external to internal format (or the other way round) is executed automatically. To display 

the default code, choose Goto -> Default Code -> Display . 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.2.1.7.5 BADI for Generating Default Authorizations 

Use 

With this Business Add-In (BAdI) you make additional checks or changes for the areas of responsibility 

of the users determined by program FPB_GENERATE_PROFILE_CCMD or 

FPB_GENERATE_PROFILE_HRORG. 

For more Informationen on using the programs, see the documentation for the IMG activity Automatic 

Generation of Default Authorizations. 

Standard settings 

No standard implementation is delivered for this BAdI. The areas of responsibility are determined as they 

are by one of the above programs and processed further. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.2.2 Object and Data Provider 

37.9.2.2.1 Object and Data Provider: Overview 

Use 

In this section of the Implementation Guide (IMG), you make Customizing settings for the Object and 

Data Provider (OADP). The Object and Data Provider enables you to display structures from 

Organizational Management in a list or tree structure in a Web Dynpro application and thereby display 

such structures in SAP Enterprise Portal. Furthermore, you can use columns to provide users with 

additional information about objects. 

You can use the Object and Data Provider to enable users to perform the following activities: 

- Obtain an overview of objects 

Example: A manager can display a tree structure in which all the organizational units for which he 

or she is responsible are displayed. 

- Search for objects 

Example: A manager who is responsible for a large number of employees can search for a particular 

employee. 

- Select objects and display detailed object information 
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Example: A manager displays a list of all employees who report directly to him or her. When the 

manager selects a particular employee, the employee profile for this employee is displayed. 

- Execute processes 

Example: Based on a list of employees who report directly to the manager, he or she can perform 

salary planning for these employees. 

Requirements 

- You have depicted the organizational plan of your company in Organizational Management. This 

includes the organizational structure and staff assignments. 

- The user who is logged on, or the person to which the user is assigned in the Communication 

infotype (0105), holds a chief position. 

- If you want to display cost centers, you must have assigned cost centers to the organizational unit or 

chief positions. 

Note 

We recommend you use structural authorizations for the Object and Data Provider. 

Activities 

1. In the Object Provider section, you define which objects are to be displayed to users. You can also 

enables users to restrict which objects are displayed to comprise navigation objects only. 

2. In the Data Provider section, you define which further information is to be displayed to users in 

addition to the objects defined in the first step. 

3. In the Organizational Structure Views section, you define the format in which the information 

defined in the first two steps is to be displayed for users. 

4. In the Organizational Structure Views section, you specify the format in which the information 

you defined in the first two steps is to be displayed for the user. 

Example 

In this section of the IMG, you create the following objects or make Customizing settings for these 

objects: 

1 Group of Organizational Structure Views - Example: A manager's employees 

1.1 Organizational Structure View - Example: Employees who report directly to the manager 

1.1.1 Object Selection 

1.1.1.1 Object Selection Rule for Root Objects - Example: Organizational units for which the manager 

holds the chief position 

1.1.1.2 Object Selection Rule for Navigation Objects (optional) - Example: Organizational units for 

which the manager is directly responsible 

1.1.1.3 Object Selection Rule for Target Objects - Example: All employees who are assigned to 

organizational units led directly by the manager. 
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1.1.2 Group of Data Views - Example: Additional employee data. 

1.1.2.1 Data View - Organizational data from infotype 0001. 

1.1.2.1.1 Column Group 

1.1.2.1.1.1 Column - Example: Name 

1.1.2.1.1.2 Column - Example: ID 

1.1.2.1.1.3 Column - Example: Abbreviation 

1.1.2.1.1.4 Column - Example: Link Text 

1.1.2.1.1.5 Column - Example: Valid from 

1.1.2.1.1.6 Column - Example: Valid to 

1.1.2.1.1.7 Column - Example: Assigned as of 

1.1.2.1.1.8 Column - Example: Assigned until 

1.1.2.1.1.9 Column - Example: Percentage 

1.1.2.1.2 Header Type (optional) - Example: Column ID is overwritten by Position ID. 

1.1.2.2 Data View - Example: Personal data from infotype 0002. 

1.1.2.2.1 Column Group 

1.1.2.2.1.1 Column - Example: Date of Birth 

1.1.2.2.1.2 Column - Example: Place of Birth 

1.1.2.2.1.3 Column - Example: Nationality 

1.1.2.2.2 Header Type (optional) 

1.2 Organizational Structure View - Example: All employees who report directly or indirectly to the 

manager. 

1.2.1 Object Selection 

1.2.1.1 etc. 

This is presented as follows on the user interface: 

The manager sees a combo box that contains the entries Directly Reporting Employees and All 

Employees. If the manager selects Directly Reporting Employees, he or she can view, in a tree 

structure, all the organizational units for which he or she holds the chief position. When the manager 

selects one of these organizational units, he or she obtains a table that contains all employees who belong 

to this organizational unit. Above this table, the system displays an additional combo box that contains 

the entries Organizational Data and Personal Data. When the manager selects Personal Data, the 

date of birth, place of birth, and nationality of each employee is displayed in a separate column. 

37.9.2.2.2 Transfer Existing Customizing Settings 
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Use 

In this IMG activity, you transfer the Customizing settings you made prior to mySAP ERP 

2005 for the Object and Data Provider to the Customizing tables that are used as of mySAP 

ERP 2005. For more information, see the documentation for the report  

RP_OADP_MIGRATE_CUSTOMIZING. 

37.9.2.2.3 Object Provider 

37.9.2.2.3.1 Define Rules for Object Selection 

Use 

In this IMG activity, you create object selection rules. The system distinguishes between different types 

of selection rules. You can restrict the result of a selection rule to objects of a particular type (such as 

person or cost center). 

You group selection rules together as object selections. in the IMG activity Define Object Selections. 

Standard settings 

The view for creating object selection rules contains a customer namespace. You can create customer-

specific entries in the namespaces Y* and Z*. You must not change the entries in the standard system. 

Activities 

If you want to restrict the selection result to several object types, you must create several entries for this 

selection rule in the Restrict Object Types view. 

37.9.2.2.3.2 Business Add-Ins (BAdIs) 

37.9.2.2.3.2.1 BAdI: OADP: Exclude Managers 

Use 

This Business Add-In (BAdI) is used in the Object and Data Provider. This BAdI enables you to remove 

objects from the results for an object selection rule. 

Requirements 

In the IMG activity Define Rules for Object Selection, you have set the indicator Exclude Managers for 

the relevant object selection rule. 

Standard settings 
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If you do not create an implementation of your own, the system runs the default implementation that uses 

the function module HRWPC_OADP_EXCLUDE_MANAGER. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

A line manager is permitted to perform activities such as salary planning for his or her employees. 

However, the line manager does not have authorization to peform such activities for him or herself or for 

other line managers responsible for the same level or a higher level in the hierarchy. If you use an object 

selection rule for the Manager role in the SAP Enterprise Portal, you should, therefore, delete all users 

who are logged on (that is, line managers) and all managers on the same or higher level in the hierarchy 

from the results of the selection rule. This example is included in the default implementation. 

See also 

Methods 

 EXCLUDE_MANAGER (Excludes Managers) 

37.9.2.2.3.2.2 BAdI: OADP: Modification of Navigation Objects 

Use 
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This Business Add-In (BAdI) is used in the Object and Data Provider. This BAdI enables you to edit the 

navigation object texts displayed for the user. 

Requirements 

In the IMG activity, Define Rules for Object Selection, you have created a rule for selecting navigation 

objects. 

Standard settings 

The BAdI is not active in the standard system. In the standard system, the long text (OBJEC-STEXT) of 

navigation objects is displayed. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

An example implementation of this BAdI returns a combination of the object type (OBJEC-OTYPE) and 

object ID of the navigation object as the text that is to be displayed. 

See also 

Methods 
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GET_TEXTS  (Delivers Display Texts for Navigation Objects). 

37.9.2.2.3.3 Group Parameters for Object Search 

Use 

In this IMG activity, you create parameter groups. For each parameter group, you define parameters for 

the object search and enter values for these parameters. 

Note 

You need only perform this IMG activity, if you set the Object Search indicator in the IMG 

activity Define Object Selections. 

In the IMG activity, Define Object Selections, group the parameter groups together with the 

corresponding search class and assign them to an object selection. 

Standard settings 

The view for creating parameters contains a customer namespace. You can create customer-specific 

entries in the namespaces Y* and Z*. You must not change the entries in the standard system. 

37.9.2.2.3.4 Define Object Selections 

Use 

In this IMG activity, you define the objects of the organizational structure that are to be displayed for the 

user. 

You also define whether the user can use navigation objects to restrict the view to include target objects 

only. 

If there is a large number of target objects, this enables you to provide the user with a clearer overview. 

Alternatively, you can allow the user to use predefined search parameters to find specific objects. In this 

case, the user can enter values for the search parameters in the search template displayed. 

Requirements 

- In the IMG activity Define Rules for Object Selection, you have checked whether suitable object 

selection rules exist or, if necessary, you have created object selection rules of your own. 

- If you want to provide managers with a search template, the following prerequisites also apply: 

- You have used the Class Builder to create a class for the object search. 
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Note 

If you want to allow managers to search according to a selection ID, you can use the search 

class CL_HRWPC_SEARCH_VIA_SELID, which is included in the standard system. Since 

this search class was created generically, you do not need to create a new implementation. To 

add additional search parameters, you simply need to create a selection ID that contains the 

relevant fields. You create the selection ID in the IMG activity Define Selection IDs in 

Customizing for Personnel Management under Human Resources Information System -

> Selection IDs. 

- If the class requires particular parameters, a parameter group must exist that contains these 

parameters. The search class must be able to evaluate the pairs of parameters and parameter values 

that are assigned to the parameter group. For more information, see Group Parameters for Object 

Search. 

Standard settings 

This view contains a customer namespace. You can create customer-specific entries in the namespaces 

Y* and Z*. You must not change the entries in the standard system. 

Activities 

- If a predefined set of objects is to be displayed for the user, set the Rules for Object Selection 

indicator. You must define an object selection rule for root objects and at least one rule for 

navigation objects or a rule for target objects. If you enter two rules only, the system determines the 

result set for the second rule based on the set of root objects. 

- If you want to allow the user to search directly for specific objects, enter a class for the object search 

and, if required, assign a suitable search class. 

37.9.2.2.4 Data Provider 

37.9.2.2.4.1 Define Columns 

Use 

In this IMG activity, you create columns. In these columns, the user can display additional information 

about the objects you specified for the defined object selections. 

Requirements 

If it is to be possible to sort the column content, it must be displayed in an appropriate format. For more 

information, see Sorting Column Content. 

Standard settings 

This view contains a customer namespace. You can create customer-specific entries in the namespaces 

Y* and Z*. You must not change the entries in the standard system. 

Activities 
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- If you leave the FM for Column Content field blank, the Web Dynpro application must get the 

column content. 

The Web Dynpro application affected must register the objectDataApplicationColumnProcess 

event sent by the Object and Data Provider, and use the method 

setObjectDataApplicationColumnData to transfer the column content. 

- If the column content is to be determined in the backend system, enter a function module that is to 

get the column content. 

To create a function module of your own, use the function module 

HRWPC_CB_CONTENT in the standard system as a template. You must use this as a template 

since your function module must have the same interface as the function module in the standard 

system. 

- If you want to reuse a function module that you have created for the Column Framework of the 

Personnel Management component, enter FM from Column Framework in this field. 

You can find the relevant function modules in Customizing for Personnel Management under 

Global Settings in Personnel Management -> Column Framework -> Define Your Own 

Columns/Change Column Group Text -> Define Your Own Column -> Column Group 

Definition (view T77COL). 

- If you want to display an icon in a column for which the content was provided by a function module, 

make a suitable entry in this function module in the ICONNAME field of the 

COLUMN_CONTENT table. 

- If you want to display a SAP GUI icon, enter the name of the relevant file (*.gif). 

- If you want to display an icon that is defined by a Web Dynpro application, make an entry in the 

following format 

<imageDC>*<imageComponent>*<imageFilename>. The elements of this entry have 

the following meaning: 

* = Separator between parameters 

<imageDC> = Name of development component (such as sap.com/pcui_gp~xssutils) 

<imageComponent> = Name of Web Dynpro component (such as 

com.sap.xss.ser.xssmenu.vc.areagroup.VcXssMenuAreaGroup) 

<imageFilename> = Name of icon (such as car.gif) 

- If the column content provided by the function module is not to be converted in the standard 

manner, enter a suitable conversion routine. If you do not specify a conversion routine, the system 

converts the column content in the standard manner. 

For more information, see SAP Library under SAP NetWeaver -> Application Platform -> 

ABAP Technology -> ABAP Workbench -> ABAP Dictionary -> Domains -> Input and 

Output Conversions. 

- If you want to store a hyperlink for the text or icon in a column, specify the service the system can 

use to obtain information about the link. You create services in Customizing for the Column 

Framework under Services -> Define Services. 
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37.9.2.2.4.2 Define Coherence Relationships 

Use 

In this IMG activity, you create coherence relationships. 

Note 

You need only perform this IMG activity if you want to define a coherence relationship for certain 

columns in the IMG activity Define Column Groups. 

The name of the coherence relationship is displayed in the dialog box for column configuration, 

which the user can call for each organizational structure view. 

You assign coherence relationships to the appropriate columns in the IMG activity Define Column 

Groups. 

Standard settings 

This view contains a customer namespace. You can create customer-specific entries in the namespaces 

Y* and Z*. You must not change the entries in the standard system. 

Example 

You do not want the user to be able to show or hide the Start Date and End Date columns separately 

that belong to the Organizational Data column group. In this IMG activity, therefore, you create the 

coherence relationship Org.Data Period. In the IMG activity, Define Column Groups, you assign this 

coherence relationship to the Start Date and End Date columns that belong to the Organizational Data 

column group. 

37.9.2.2.4.3 Define Column Groups 

Use 

In this IMG activity, you group columns together in column groups. To do this, you create new column 

groups or change column groups that exist in the standard system. 

Note 

The names of the column groups are not displayed on the user interface. 

You can make the following settings for each column group: 

- Define position of columns in column group 

- Set visibility attributes 

Depending on these attributes, the user can show or hide columns individually. 

- Define coherence relationships between individual columns 

You assign the column group you have created to a data view in the IMG activity Define Data Views. 

Requirements 
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- You have performed the IMG activity Define Columns. 

- If you want to define a coherence relationship between two columns, you must also have performed 

the IMG activity Define Coherence Relationships. 

Standard settings 

- The view for creating customer-specific column groups contains a customer namespace. You can 

create customer-specific entries in the namespaces Y* and Z*. You are not permitted to change the 

entries of the standard system in this view. 

- If you want to change a column group of the standard system, you must use the technical name of 

the relevant standard column group for your customer-specific entry in the IMG activity Create or 

Change Assignment of Columns to Column Groups. This enables you to overwrite the standard 

system entry. 

37.9.2.2.4.4 Define Hierarchical Column Groups 

Use 

In this IMG activity, you define hierarchies for columns and column groups. This is beneficial if a column 

group is used in more than one organizational structure view and you want to add a column to the column 

group in one of these views. 

When you arrange columns and column groups in a hierarchy, the system displays the subordinate 

columns and column groups for a column group on the user interface. 

Requirements 

You have performed the IMG activity Define Column Groups. 

Standard settings 

If you want to change a column group of the standard system, you must use the technical name of the 

relevant hierarchical column group in the standard system for your customer-specific entry in the activity 

Create or Change Hierarchical Column Groups. This enables you to overwrite the standard entry. 

Example 

Example 1 

In a particular context, you want to add column S to an existing column group, A. Therefore, you create a 

column S in the IMG activity, Define Columns. In the IMG activity Define Column Groups, you create 

a new column group, B to which you assign the column S. You then arrange the column groups in this 

IMG activity in a hierarchy. You assign column group A, in which the system is also to display column S 

to the column group B, which you have just created. 

Example 2 

You assign column groups A and B to column group C. Column group A is a hierarchical column group 

to which the column groups A1 and A2 are assigned. 
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When the user selects the columns that belong to column group C, the system automatically displays the 

columns that belong to column groups A and B as well. The columns are displayed in the following 

sequence: 

1. Columns that belong to column group C 

2. Columns that belong to column group A 

3. Columns that belong to column group B 

4. Columns that belong to column group A1 

5. Columns that belong to column group A2 

37.9.2.2.4.5 Redefine Column Headers 

Use 

In this IMG activity, you can store column headers that are dependent on the context or object type that is 

displayed. To do this, you use header types to which you assign suitable headers. 

You assign the header types to the relevant data views in the IMG activity, Define Data Views. 

Standard settings 

- The view for creating customer-specific column headers contains a customer namespace. You can 

create customer-specific entries in the namespaces Y* and Z*. In this view, you are not permitted to 

change the entries in the standard system. 

- If you want to edit a header type in the standard system, you must use the technical name of the 

standard header type for your customer-specific entry in the activity Create or Change Column 

Headers. 

Example 

A technical label is displayed in a column, which means that the user cannot recognize the object type. If 

the objects that are displayed represent cost centers, label the column Cost Center. If the objects that are 

displayed are persons or employees, label the column Personnel Number. 

37.9.2.2.4.6 Define Data Views 

Use 

In this IMG activity, you define the information that is to be available to users in addition to the target 

objects. To do this, you display additional columns together with the column for target objects. 

Requirements 
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- You have performed the IMG activity Define Column Groups. 

- If you want to change column headers, you must also have performed the IMG activity Redefine 

Column Headers 

Standard settings 

This view includes a customer namespace. You can create customer-specific entries in the namespaces 

Y* and Z*. You must not change the entries in the standard system. 

37.9.2.2.4.7 Group Data Views 

Use 

In this IMG activity, you group individual data views together in groups. The user can use the data views 

in such a group to display different column groups with additional information about the same object set. 

You assign the group of data views to an organizational structure view 

Requirements 

You have performed the IMG activity Define Data Views. 

Standard settings 

The view for creating groups of data views contains a customer namespace. You can create customer-

specific entries in the namespaces Y* and Z*. You are not permitted to change the entries in the standard 

system. 

Example 

You provide the managers at your company with a group of data views that offer additional information 

about the managers' individual employees. The group comprises the following data views: 

- Organizational Data 

When the manager selects this data view, data for the relevant employee is displayed from the 

Organizational Assignment infotype (0001). 

- Personal Data 

When the manager selects this data view, data for the relevant employee is displayed from the 

Personal Data infotype (0002). 

37.9.2.2.5 Organizational Structure Views 

37.9.2.2.5.1 Define Organizational Structure Views 

Use 
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In this IMG activity, you define the views for the organizational structure of your company. Each 

organizational structure view includes an object selection (see Define Object Selections) and a group of 

data views (see Group Data Views). If the object selection includes an object selection rule for 

navigation objects, a navigation area is also displayed for the user in which he or she can further refine 

the view for particular objects. 

You group organizational structure views together in the IMG activity Group Organizational Structure 

Views. 

Requirements 

You have performed the following IMG activities: 

- Define Object Selections 

- Group Data Views 

Standard settings 

This view contains a customer namespace. You can create customer-specific entries in the namespaces 

Y* and Z*. You must not change the entries for the standard system. 

Example 

- An organizational structure view shows managers a list of their directly subordinate employees. 

- At your company, managers perform budget planning. Therefore, you create an organizational 

structure view that shows each manager a list of all the cost centers that belong to his or her area of 

responsibility. 

- Managers are to be able to display, without any restrictions, their employees according to the 

organizational unit to which they belong. Therefore, you create an organizational structure view that 

displays the manager's organizational units in a tree structure in the navigation area. When a 

manager selects an organizational unit, he or she obtains a list of all employees who belong to the 

selected organizational unit. 

- Managers who are responsible for a large number of employees are to be able to search for 

individual employees. Therefore, you create an organizational structure view with an object 

selection that includes a search template that enables the manager to search for an employee. 

37.9.2.2.5.2 Group Organizational Structure Views 

Use 

In this IMG activity, you group the individual organizational structure views and define the position of 

the views within the group. 

The system displays these groups on the user interface. The individual organizational structure views that 

belong to a particular group are displayed as list boxes in a combo box. By specifying the position 

number, you can define the sequence in which the list boxes are displayed. From the group of 

organizational structure views displayed (for example, Employee Selection), the user selects the 

organizational structure view (for example, Directly Subordinate Employees) he or she requires. 
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Requirements 

You have performed the IMG activity, Define Organizational Structure Views. 

Standard settings 

The view for creating organizational structure views includes a customer namespace. You can create 

customer-specific entries in the namespaces Y* and Z*. You must not change the entries in the standard 

system. 

Activities 

If you create your own view groups, you must assign them as a property to the required Web Dynpro 

application. 

37.9.2.2.6 BAdI: Determine RFC Connection for Object 

Use 

This Business Add-In (BAdI) is used in the Object and Data Provider. In complex distribution scenarios, 

it enables you to determine the original system of Personnel Development objects. 

You use this BAdI if you use Application Link Enabling (ALE) to replicate data from the organizational 

structure in a central system and the detailed data for the distributed objects (such as personal data) is 

stored in a different system to the one from which ALE distribution was started. This is the case if 

specific information (such as infotype records) does not exist in the original ALE system. 

The BAdI is called after the original system has been determined using ALE. 

Requirements 

- You use ALE to distribute business data. 

- You have set the switches ALE REPLI and ALE REPPA so that the original system of the 

distributed objects is also written. 

You can find these switches in Customizing for Cross-Application Components under 

Predefined ALE Business Processes -> Human Resources -> Master Data Distribution in 

the IMG activities Set Up Distributed Organizational Management and Distributed HR 

Master Data. 

Standard settings 

- If you do not create a customer-specific implementation, the default BAdI source code is run. 

According to this source code, the BAdI returns the transferred RFC connection without making any 

changes. 

- The BAdI is not filter-dependent. 
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See also 

Interface IF_EX_XSS_DATAORIGIN 

37.9.2.3 Working Time 

37.9.2.3.1 Set Up Approval of Leave Requests 

Use 

In this IMG activity, you set up the Approve Leave JAVA Web Dynpro application. 

This Web application mostly uses the same user interfaces and functions that are used for the 

Leave Request Web application. You therefore do not need separate settings in Manager Self-Service. 

The one exception is the connection of the service to the Enterprise Portal, for which you use the 

Manager Self-Service technology. 

For more information about the leave request, see SAP Library for SAP ERP: SAP ERP 

Central Component -> Human Resources -> Shared Services -> Business Package for 

Employee Self-Service 1.41 -> Applications of the Employee Self-Service (ESS) Component -> 

Working Time -> Leave Request. 

Requirements 

- You use the Leave Request Web Dynpro JAVA application. 

- You have configured the Leave Request Web Dynpro JAVA application. For more information, see 

the Implementation Guide for Personnel Management and choose Employee Self-Service -> 

Service-Specific Settings -> Working Time -> Leave Request. 

37.9.2.3.2 Team Calendar 

37.9.2.3.2.1 Create Rule Groups 

Use 

In this IMG activity, you specify the groups of employees for which you want special rules for Web 

applications to apply. You define rule groups for the following applications: 

- Leave Request in Employee Self-Service (ESS) 
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- Team Calendar in Leave Request and Manager Self-Service (MSS) 

- Attendance Overview (MSS) 

- Time Accounts (ESS) 

- Clock-In/Out Corrections (ESS) 

- Approval of Working Times (CATS)(MSS): You need to carry out this activity only if you want to 

use the Manager Self-Service view group or the Time Manager's Workplace group ID to determine 

the working times to be approved. 

To determine the number of rule groups required, find out how many different groups of employees in 

your enterprise require different Customizing settings for the above-named applications. It may also be 

the case that you require only one rule group. 

If required, you can form the rule groups on the basis of the Web applications that the employees use. 

This enables you to form different rule groups for the Leave Request and Team Calendar in Manager 

Self-Service than for the Clock-In/Out Corrections applications. 

Activities 

1. Choose the Create Rule Group activity. 

2. Define the various rule groups that you require and give them easily identifiable names. This will 

make it easier for you subsequently to find the required rule group in Customizing. If you do not 

want to group your employees, you need to create at least one rule group, 00000001. 

3. Choose Adjust WEBMO Feature. If required, assign your employees to the defined rule 

groups based on their organizational assignments. Create at least the rule group 00000001 based on 

the country indicator, for example. 

Example 

Your employees can use the Leave Request Web application to submit requests for illness without a 

doctor's certificate. For employees with a particular organizational assignment, you want the HR 

department to be informed about the absence directly, whereas for all other employees, the manager's 

approval is sufficient. In this case, you require two rule groups to store two different workflow templates 

for the absence type (one with and one without notification to the HR department). 

Further notes 

In the V_T554S_WEB view Specify Processing Processes for Types of Leave you can also use the 

Personnel Subarea Grouping for Attendance/Absence Types field (MOABW). You do not 

therefore have to create any rule group to be able to make separate settings for your personnel subareas. 

37.9.2.3.2.2 Specify Absences to Be Displayed 

Use 
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You use this Customizing activity in the following circumstances: 

 - Information for processing absences in the Leave Request web application (Employee 

Self-Service (ESS)) 

You can determine whether you want to use an approval process when processing absences. If you 

want to use an approval process, you can also specify in this activity whether you want to use a 

workflow to do so. 

Note 

If you use or copy workflow pattern 12300111 delivered by SAP, it is not possible to make any 

changes to leave requests that have already been approved. You can only make changes again once 

the absences (infotype 2001) have been created. However, it is possible to delete an approved leave 

request. 

If you use the approval process without a workflow, you can make changes or deletions at any time. 

- Display of absence times in the Web application Clock-In/Out Corrections (ESS) 

- Display of absences in Team Calendar (Manager Self-Service (MSS)) and in Team Calendar and 

Absence Overview in the Web application Leave Request (MSS and ESS) 

Absences for the team calendar, overview of leave, clock-in/out corrections 

With this Customizing activity, you specify which absence types and attendance types are displayed in 

the team calendar, absence overview, and clock-in/out corrections. 

Procedure 

1. Select the action Define Processing Processes/Absences 

2. Enter all the absence types and attendence types that you want to display with the Web application. 

If you want only to display absence types in the team calendar, leave overview, or clock-in/out 

corrections, but do not want your employees to be able to request that type of absence, you have to 

select the following fields: 

- EEs Not Permitted to Submit Requests 

- No Changes to Leave Permitted 

- No Deletion of Leave Permitted 

Processing processes for the leave request 

With this Customizing activity, you specify which types of leave are displayed in the Leave Request 

Web application and which can be processed. You specify how the absences are to be processed, and can 

define user interface elements depending on the absence type. 

Procedure 

1. Select the action Define Processing Processes/Absences 

2. Enter all types of leave that you want to process in the Web application. 

3. If required, enter the periods for each type of leave. 
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Note 

- Note that any periods you specify here are counted from the start date of the relevant leave. 

- You can use the Check Request Date According to Subtype in the Business Add-In 

PT_ABS_REQ to override the periods according to your requirements 

4. Specify whether you want to use the workflow function. If so, enter the required workflow template. 

You can use either standard workflow templates or your own customized copy of the workflow 

template 12300111. You should use the workflow template 12300111 as a basis for your own 

customer-specific workflow templates. 

Note that you can no longer use workflow templates for previous versions of the leave request 

(using the Internet Transaction Server (ITS)) because the technology is not the same. 

5. Enter information about the user interface elements that are to be displayed for the leave. 

Note 

You assign the field selection in a subsequent Customizing activity, Define Field Selection. 

6. Specify how you want the leave to be processed and which actions the employees are permitted to 

carry out (create, change, delete). 

7. If required, choose Create Explanatory Texts for Absences. 

8. Choose the document class Dialog Text. 

9. Create an appropriate text. 

10. Enter the technical name of the text in the Explanation of Absence Type field in the Processing 

Processes for Absence Types view. 

11. If required, have the text translated. 

Further notes 

If the employee replaces a type of leave that is subject to approval with one that is not, the leave request 

still has to be approved again, because the system cancels the request with the leave type that is subject to 

approval. 

37.9.2.3.2.3 Specify Color Display of Absences 

Use 

In this activity, you specify, for each rule group, whether the manager can view the status of the leave 

requests in the team calendar. 

Requirements 
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Your settings apply to each rule group in the team calendar. If you also use the Leave Request Web 

application, the setting also applies to it. This means that employees can view the status of their leave 

when editing it, and managers when approving leave requests. 

Activities 

If you want the status to be visible in the team calendar, select the Color Display of Status of Leave 

Requests field. The other fields in the view are not relevant for the team calendar. 

Note 

Managers can set the maximum display of absences in the Web application. 

37.9.2.3.2.4 Select Employees 

Use 

In this IMG activity, you specify which team members you want to be displayed in your team calendar. 

You can define the selection of employees to be displayed for the various application areas of the team 

calendar in Manager Self-Service and the Leave Request Web application. 

Requirements 

You have defined rule groups. 

Activities 

1. Choose New Entries. 

2. Enter the required rule group. 

3. Enter a validity period. 

4. Select the required team calendar mode. 

5. Select the employees whose absences you want to display in the team calendar. First enter the type 

of grouping in the View/Grp. field. The following types are available: 

- If you use the Manager Self-Service (MSS) or Employee Self-Service (ESS) 

components at your enterprise, you will probably use the view groups. They are based on 

employees organizational assignments. 

- If you use the Time Managers Workplace (TMW), you probably use grouping IDs. You 

now have to select the employees whom you want to display in the team calendar. To do so, 

enter the required view group or grouping ID in the relevant field. 
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6. Save your data. 

37.9.2.3.2.5 Define Layout of Team Calendar 

Use 

In this IMG activity, you make settings for the team calendar that is displayed in the Web application. 

The team calendar displays all team members' absences, which simplifies the scheduling of absences. 

Requirements 

You have specified in the Create Processing Processes for Types of Leave activity which 

absences you want to be displayed in the team calendar. 

Standard settings 

Activities 

1. Choose New Entries. 

2. Select the rule group for which you want to define the layout. 

3. Enter the number of rows that you want to be displayed in the team calendar. 

4. Save your data. 

Example 

37.9.2.3.2.6 BAdI: Control Processing of Leave Requests 
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Use 

This Business Add-In (BAdI) is used in the Attendances and Absences  component (PT-RC-AA). You 

can use it for the following Web applications: 

- Leave Request: To control processing of leave requests 

For more information, see the Implementation Guide (IMG) for Personnel Management -> 

Employee Self-Service. 

- Team Calendar: To set the layout of the team calendar in Manager Self-Service (MSS) and 

Employee Self-Service (ESS) 

- Time Accounts (ESS): To determine time accounts 

- Attendance Overview (MSS): To adjust the legend 

Standard settings 

The Business Add-In is active in the standard system. The default code is executed automatically. 

Methods: 

Simulating and updating quotas 

- Simulate Attendances/Absences with BLoP 

- Post Attendance/Absence Types with BLoP 

Checking periods 

- Check Request Date According to Subtype 

Controlling the processing process 

- Gets Customizing for Workflow 

Attachment Processing 

- Set Mandatory Checking of Attachments 

- Convert File Formats of Attachments 

- Get Attachment Configuration 

Multiple Approvals for a Leave Request 

- Get Multiple Approvers 

- Check Duplicate Approvers 

- Update Multiple Approvers 

To determine time accounts 

- Gets Time Accounts from Infotype 0005 - Determine Time Types as Time Accounts 

- Determines MOD and QTYPE for Func.Module HR_GET_QUOTA_DATA 

Layout of the application 
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- Gets Customizing for Field Selection 

- Adjust Colors of Calendar and Team Calendar 

- Adjust Color for Overlapping Absences 

- Adjust Legend for Calendar and Team Calendar 

- Adjust Legend for Availability Overview 

- Enrich Team Calendar 

- Process Messages 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.9.2.3.3 Attendance Overview 

37.9.2.3.3.1 Create Rule Groups 

Use 

In this IMG activity, you specify the groups of employees for which you want special rules for Web 

applications to apply. You define rule groups for the following applications: 

- Leave Request in Employee Self-Service (ESS) 

- Team Calendar in Leave Request and Manager Self-Service (MSS) 

- Attendance Overview (MSS) 

- Time Accounts (ESS) 

- Clock-In/Out Corrections (ESS) 

- Approval of Working Times (CATS)(MSS): You need to carry out this activity only if you want to 

use the Manager Self-Service view group or the Time Manager's Workplace group ID to determine 

the working times to be approved. 

To determine the number of rule groups required, find out how many different groups of employees in 

your enterprise require different Customizing settings for the above-named applications. It may also be 

the case that you require only one rule group. 
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If required, you can form the rule groups on the basis of the Web applications that the employees use. 

This enables you to form different rule groups for the Leave Request and Team Calendar in Manager 

Self-Service than for the Clock-In/Out Corrections applications. 

Activities 

1. Choose the Create Rule Group activity. 

2. Define the various rule groups that you require and give them easily identifiable names. This will 

make it easier for you subsequently to find the required rule group in Customizing. If you do not 

want to group your employees, you need to create at least one rule group, 00000001. 

3. Choose Adjust WEBMO Feature. If required, assign your employees to the defined rule groups 

based on their organizational assignments. Create at least the rule group 00000001 based on the 

country indicator, for example. 

Example 

Your employees can use the Leave Request Web application to submit requests for illness without a 

doctor's certificate. For employees with a particular organizational assignment, you want the HR 

department to be informed about the absence directly, whereas for all other employees, the manager's 

approval is sufficient. In this case, you require two rule groups to store two different workflow templates 

for the absence type (one with and one without notification to the HR department). 

Further notes 

In the V_T554S_WEB view Specify Processing Processes for Types of Leave you can also use the 

Personnel Subarea Grouping for Attendance/Absence Types field (MOABW). You do not 

therefore have to create any rule group to be able to make separate settings for your personnel subareas. 

37.9.2.3.3.2 Select Employees 

Use 

In this IMG activity, you define which team members are to be displayed in the attendance overview. 

Requirements 

You have defined rule groups. 

Activities 

1. Choose New Entries. 

2. Enter the rule group you require. 

3. Define a validity period. 
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4. Choose the Overview of Leave mode. 

5. Select the employees whose attendances or availabilty information is to be displayed. To do this, 

you must first enter the grouping characteristic in the View/Grp field. Two different grouping 

characteristics exist: 

- If you implement the Manager Self-Service (MSS) or Employee Self-Service (ESS) 

components, you probably use View Groups in your company. These are based on the 

organizational assignment of your employees. 

- If you implement Time Manager's Workplace (TMW), you probably use Grouping IDs. 

You must select the employees who are to be displayed in the attendance overview. To do this, enter 

the view group or grouping ID in the View Group or Group field. 

6. Choose Save. 

37.9.2.3.3.3 BAdI: Control Processing of Leave Requests 

Use 

This Business Add-In (BAdI) is used in the Attendances and Absences  component (PT-RC-AA). You 

can use it for the following Web applications: 

- Leave Request: To control processing of leave requests 

For more information, see the Implementation Guide (IMG) for Personnel Management -> 

Employee Self-Service. 

- Team Calendar: To set the layout of the team calendar in Manager Self-Service (MSS) and 

Employee Self-Service (ESS) 

- Time Accounts (ESS): To determine time accounts 

- Attendance Overview (MSS): To adjust the legend 

Standard settings 

The Business Add-In is active in the standard system. The default code is executed automatically. 

Methods: 

Simulating and updating quotas 

- Simulate Attendances/Absences with BLoP 

- Post Attendance/Absence Types with BLoP 

Checking periods 

- Check Request Date According to Subtype 

Controlling the processing process 

- Gets Customizing for Workflow 
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Attachment Processing 

- Set Mandatory Checking of Attachments 

- Convert File Formats of Attachments 

- Get Attachment Configuration 

Multiple Approvals for a Leave Request 

- Get Multiple Approvers 

- Check Duplicate Approvers 

- Update Multiple Approvers 

To determine time accounts 

- Gets Time Accounts from Infotype 0005 

- Determine Time Types as Time Accounts 

- Determines MOD and QTYPE for Func.Module HR_GET_QUOTA_DATA 

Layout of the application 

- Gets Customizing for Field Selection 

- Adjust Colors of Calendar and Team Calendar 

- Adjust Color for Overlapping Absences 

- Adjust Legend for Calendar and Team Calendar 

- Adjust Legend for Availability Overview 

- Enrich Team Calendar 

- Process Messages 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.9.2.3.4 Approve Working Time 

37.9.2.3.4.1 Define Approval Views 

Use 
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In this activity, you define the type of information that is to be provided to approvers in the Approve 

Working Times Web application. You specify the fields that best support the approvers in their tasks and 

define the criteria that are most suited to a collective approval of working times. You can have two 

columns with additional information displayed to enable a comparison of the recorded working times 

with data already recorded or planned data. 

You can assign multiple approver views to one approver, which means that he or she can view the data 

from various points of view as required. 

Requirements 

- You use the Approve Working Times Web application. 

- You have read the conceptual information and detailed information in the SAP Library. For 

more information, see the CATS documentation in the SAP Library: Approve Working Times. 

Standard settings 

- You can copy one of the following standard approval views and adjust it to suit your 

requirements: 

- SAP_LINE: Model approval view for line managers. It groups recorded data according to the 

employees assigned to the line manager. 

- SAP_PROJ: Model approval view for project leads. It groups the recorded data according to a 

work breakdown schedule (WBS) element. 

- The following fields are displayed by default in the collective approval view: 

- The start and end date of the period 

- A column for displaying messages. If a message has been issued, a symbol appears. The quick 

info contains the text of the message. 

- The total recorded times 

- A field for displaying the approval decision (such as approve or reject) 

- The rejection reason 

Activities 

1. Specify which approval views you want your approvers to have access to. 

2. In the General Settings section, specify the periods according to which you want the data to be 

sorted in the list. 

Note: You will enter data for field selections in a subsequent activity. 

3. Specify the criteria you require for the collective approval. 

- You can enter up to three criteria. The number of the criteria corresponds to the sequence of 

the columns from left to right. The collective approval criterion 1 is therefore the main 

criterion for the collective approval. The collective approval criterion 2 has to be a logical 

refinement of the data of criterion 1; likewise, criterion 3 has to be a logical refinement of 

criterion 2. 
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Example: 

Order > Operation > Suboperation 

Project > Personnel number 

Personnel number > Attendance/absence type, or Attendance/absence type > Personnel 

number; both combinations are logical. 

- In selecting criteria, you can choose from all sender and receiver objects in the CATS database 

(CATSDB and CI_CATSDB). The input help provides an overview of the fields. 

- You can specify the heading displayed in the Web application and the quick info for the 

columns. If you do not enter this information and you display fields from the CATSDB, the 

system uses the texts from the ABAP dictionary. You can overwrite these texts if necessary. 

4. Enter the data that you want to use for any comparison with recorded data. You can fill the columns 

using the HRCATS_APPR_CUST Business Add-In (CATS Approval: 

Customizing Settings). For more information, see the documentation for the 

FILL_COMPARATIVE_COLUMNS method (Determine Values for Comparison Columns). 

37.9.2.3.4.2 Define Field Selection for Individual Approval View 

Use 

In this activity, you can specify which fields, and therefore which information, are displayed for the 

recorded time data in the individual approval view and the detail view. 

The field selection in this activity is less complex than the field selection for the data entry profiles. 

- Individual approval screen 

The individual approval screen lists all individual records that come under a combination of the 

collective approval criteria 1  3, that is, one line in the collective approval. The system automatically 

enters the collective agreement criteria in the header of the list. You do not need to select them at 

this point. Likewise, the following fields are already available in the standard individual approval 

screen: 

- Date 

- Fields of field selection 

- Quantity/number 

- Field for approving recorded time data 

- Rejection reason 

- Messages (with the text of the message) 

We advise you to add at least one of the following fields: 

- Personnel number (PERNR) 
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- Formatted employee name (EMNAM) 

- System user name (CATS_ERNAM) 

The fields selected in the field selection for the individual approval view and the relevant standard 

fields are also used in the overviews of the following screens: 

- Display of working times already recorded 

- Review and save 

- Completed 

- Detail screen 

The detail screen displays data for an individual record. You can specify the additional fields that 

you want to display as detailed information about a data record. This is information that cannot be 

displayed on the individual approval screen on account of readability or lack of space. 

You should also incorporate the key information from the field selection for the individual approval 

view, so that the approver has a complete picture of the data record. 

In the next activity, you assign the field selection to the approval views, which means that you can display 

different fields for each approval view in the Web application. 

Standard settings 

In the standard system, the field selection is hard-coded. For more information, see the field help for the 

fields contained in the DE.HRMSS_CAT_APPR_FIELDSEL>field selection. 

Recommendation 

Activities 

1. Choose New Entries. 

2. Create a field selection and choose ENTER. 

You should try to make the name of the field selection and your label easily identifiable. 

3. Select the field selection, and double-click Field Customizing in the dialog structure. 

4. Choose Select Fields. 

5. Select the fields you want to display. Field help is available for the fields in the list. You can toggle 

in the list between the technical field name and the field label. 

6. Choose <Object>Continue. 

7. For each field, specify the column width for the Web application. 
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8. If required, enter your own label for the column heading. If you leave this field blank, the system 

uses the most appropriate heading from the Data Dictionary, according to the display length you 

enter. 

Further notes 

37.9.2.3.4.3 Define Field Selection for Detail View 

Use 

In this activity, you can specify which fields, and therefore which information, are displayed for 

the recorded time data in the individual approval view and the detail view. 

The field selection in this activity is less complex than the field selection for the data entry profiles. 

- Individual approval screen 

The individual approval screen lists all individual records that come under a combination of the 

collective approval criteria 1  3, that is, one line in the collective approval. The system automatically 

enters the collective agreement criteria in the header of the list. You do not need to select them at 

this point. Likewise, the following fields are already available in the standard individual approval 

screen: 

- Date 

- Fields of field selection 

- Quantity/number 

- Field for approving recorded time data 

- Rejection reason 

- Messages (with the text of the message) 

We advise you to add at least one of the following fields: 

- Personnel number (PERNR) 

- Formatted employee name (EMNAM) 

- System user name (CATS_ERNAM) 

The fields selected in the field selection for the individual approval view and the relevant standard 

fields are also used in the overviews of the following screens: 

- Display of working times already recorded 

- Review and save 

- Completed 
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- Detail screen 

The detail screen displays data for an individual record. You can specify the additional fields that 

you want to display as detailed information about a data record. This is information that cannot be 

displayed on the individual approval screen on account of readability or lack of space. 

You should also incorporate the key information from the field selection for the individual approval 

view, so that the approver has a complete picture of the data record. 

In the next activity, you assign the field selection to the approval views, which means that you can display 

different fields for each approval view in the Web application. 

Standard settings 

In the standard system, the field selection is hard-coded. For more information, see the field help for the 

fields contained in the DE.HRMSS_CAT_APPR_FIELDSEL>field selection. 

Recommendation 

Activities 

1. Choose New Entries. 

2. Create a field selection and choose ENTER. 

You should try to make the name of the field selection and your label easily identifiable. 

3. Select the field selection, and double-click Field Customizing in the dialog structure. 

4. Choose Select Fields. 

5. Select the fields you want to display. Field help is available for the fields in the list. You can toggle 

in the list between the technical field name and the field label. 

6. Choose <Object>Continue. 

7. For each field, specify the column width for the Web application. 

8. If required, enter your own label for the column heading. If you leave this field blank, the system 

uses the most appropriate heading from the Data Dictionary, according to the display length you 

enter. 

Further notes 

37.9.2.3.4.4 Define Profiles and Assign to Views 
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In this activity, you create approval profiles that you can assign to the individual line managers or project 

leads. You can assign the approval profiles to multiple approval views. The approvers can then choose 

the view that they require in the Web application. 

The approval profiles have the same function as the data entry profiles in the Time Sheet. The approval 

profile determines the information displayed about the data to be approved and how it is subsequently 

processed. 

Example 

You want approvers to be able to toggle between two approval views: 

- One view containing all recorded time data for one employee 

- One view containing all times confirmed for one project 

You therefore configure a profile to which you assign the two relevant approval views. 

Activities 

1. Choose New Entries. 

2. Create an approval profile. 

You should try to make the technical name of the approval profile and your label easily identifiable. 

3. If you use SAP Human Resources, specify whether the approved data is to be transferred directly to 

the HR application. 

4. Specify whether employees are to be notified by e-mail if their working times are rejected. 

5. Choose Enter. 

6. Select the approval profile and double-click on Link Between Approval View and Profile in the 

dialog structure. 

7. Specify the approval views that you want to offer with this profile. Save your data. 

8. Return to the profile definition screen. 

9. In the Initial View field, enter the view that you want your approvers to see when they access the 

application. Save your data. 

10. Go to the role maintenance or user maintenance function. 

11. Assign the profiles to your roles or your approvers. 

- You can do this by using the CATS_APPR_PROF user parameter. Enter the ID of your approval 

profile as the parameter value. 

- Alternatively, you can use a method of the HRCATS_APPR_CUST Business Add-In (CATS 

Approval: Customizing Settings) to assign the approval profile to the approvers: 

IO.IF_EX_HRCATS_APPR_CUST        GET_PROFILE_ID>GET_PROFILE_ID 

(Determine Approval Profile ). 

- You can use the CATS_APPR_PERSPCTIVE user parameter to override the default initial view for 

each approver. 
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37.9.2.3.4.5 Select Employees 

37.9.2.3.4.5.1 Create Rule Groups 

Use 

In this IMG activity, you specify the groups of employees for which you want special rules for Web 

applications to apply. You define rule groups for the following applications: 

- Leave Request in Employee Self-Service (ESS) 

- Team Calendar in Leave Request and Manager Self-Service (MSS) 

- Attendance Overview (MSS) 

- Time Accounts (ESS) 

- Clock-In/Out Corrections (ESS) 

- Approval of Working Times (CATS)(MSS): You need to carry out this activity only if you want to 

use the Manager Self-Service view group or the Time Manager's Workplace group ID to determine 

the working times to be approved. 

To determine the number of rule groups required, find out how many different groups of employees in 

your enterprise require different Customizing settings for the above-named applications. It may also be 

the case that you require only one rule group. 

If required, you can form the rule groups on the basis of the Web applications that the employees use. 

This enables you to form different rule groups for the Leave Request and Team Calendar in Manager 

Self-Service than for the Clock-In/Out Corrections applications. 

Activities 

1. Choose the Create Rule Group activity. 

2. Define the various rule groups that you require and give them easily identifiable names. This will 

make it easier for you subsequently to find the required rule group in Customizing. If you do not 

want to group your employees, you need to create at least one rule group, 00000001. 

3. Choose Adjust WEBMO Feature. If required, assign your employees to the defined rule groups 

based on their organizational assignments. Create at least the rule group 00000001 based on the 

country indicator, for example. 

Example 

Your employees can use the Leave Request Web application to submit requests for illness without a 

doctor's certificate. For employees with a particular organizational assignment, you want the HR 

department to be informed about the absence directly, whereas for all other employees, the manager's 

approval is sufficient. In this case, you require two rule groups to store two different workflow templates 

for the absence type (one with and one without notification to the HR department). 

Further notes 
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In the V_T554S_WEB view Specify Processing Processes for Types of Leave you can also use the 

Personnel Subarea Grouping for Attendance/Absence Types field (MOABW). You do not 

therefore have to create any rule group to be able to make separate settings for your personnel subareas. 

37.9.2.3.4.5.2 Select Employees for Approval 

In this activity, you specify the employees for whom an approver is responsible and whose working times 

her or she is to approver. 

Note 

- You also use this function in Manager Self-Service for the display of the team calendar and 

attendance overview, and for the display of the team calendar in the Leave Request, for 

example. For more information, see Select Employees. 

- You need to carry out this activity only if you want to use the Manager Self-Service view 

group or the Time Manager's Workplace group ID to determine the working times to be 

approved. 

Activities 

1. Choose New Entries. 

2. Enter the required rule group. 

3. Enter a validity period. 

4. Choose the CATS Approval mode. 

5. Select the employees whose data is to be approved. 

First enter the type of grouping in the View/Grp. field. The 

following types are available: 

- If you use the Manager Self-Service (MSS) or Employee Self-Service (ESS) components, 

you can use the view groups. They are based on employees' organizational assignments. 

- If you use the Time Manager's Workplace (TMW), you can use grouping IDs. 

Select the employees whose data is to be approved. To do so, enter the required view group or 

grouping ID in the relevant field. 

Further notes 

37.9.2.3.4.6 BAdI: Refine Settings for Approval 

Use 
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This Business Add-In (BAdI) is used for the approval of working times using the Web Dynpro 

application Approve Working Times of the Cross-Application Time Sheet (CATS). You can use it to 

further refine processing of the approval. 

The interface contains the following methods: 

- Determine Values for Comparison Columns 

- Enter Text for Message Column (Collective Approval View) - Enter Text for Message 

Column (Individual Approval View) 

- Change Number of Records to be Approved 

- Authorization Check for Selected Records 

- Determine Approver Profile 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

37.9.2.4 Employee Data 

37.9.2.4.1 Define Wage Types for Annual Salary 

Use 

In this IMG activity, you can define wage types for salaries and bonuses, for instance. The system uses 

these to determine the annual salary and displays the annual values determined for the wage types in the 

Employee Review workset, in the Salary Development (com.sap.pct.hcm.salaryhistory.ivu)iView. 

The iView can determine annual values for payroll results or for the infotypes Basic Pay (0008), 

Recurring Payments and Deductions (0014), and Additional Payments (0015). In either case, you 

must perform this IMG activity. 

Recommendation 

When creating wage types, we recommend you use subapplication MSSH because the technical key of 

the subapplication must be stored as the value of the PCD parameter Wage Type 

Application from VC_596A_C for the Salary Development 

(com.sap.pct.hcm.salaryhistory.ivu) iView in portal administration (content administration). The value 

MSSH is stored in the standard delivery of the Business Package for Manager Self-Service. This means 

that when you use this technical key, you do not need to process the PCD parameter. 

Activities 

1. Create a subapplication (for example, MSSH). 
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2. Define for this subapplication the cumulation wage types that the system should display in the 

Salary Development iView (for example, the technical key 1SAL and the cumulation wage-type 

text Salary, and the technical key 2BON and the cumulation wage-type text Bonus). 

Note 

Note that the system displays the cumulated wage types sorted according to your technical keys. 

3. For each cumulation wage type, define the relevant wage types. 

Note 

If you want the system to determine the annual salary based on the infotypes Basic Pay (0008), 

Recurring Payments and Deductions (0014), and Additional Payments (0015) as opposed to 

payroll results, you must use a wage type in this process step that refers to a module in view 

V_T511 (Wage Type Characteristics). You must have defined this module in view V_T539J 

(Basic Wage Type Valuation). 

Further notes 

If you use a technical name for the subapplication that differs from our recommendation, you must adjust 

the PCD parameter accordingly. 

37.9.2.4.2 Adjust Periods for Annual Salary 

Use 

In this IMG activity, you can use the enhancement HRWPCEP1 (SAP Enhancement for Employee 

Profile) to make customer-specific changes to the periods used to determine the annual salary. 

Further notes 

For more information, see the documentation for the enhancement. 

37.9.2.4.3 Filter Absence Records 

Use 

In this IMG activity you can use the enhancement HRWPCABS (Filtering Absence Records) to 

specify whether the system should only display certain absence records of a particular absence type in 

the iView Employee Review. 
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For further information, see the documentation on the Enhancement. 

37.9.2.5 Personnel Change Requests 37.9.2.5.1 Recommendation: Implement 

Processes to Change Employee Data 

Use 

Until now, in the portal, a manager used Personnel Change Requests  to initiate processes for 

changing employee data. 

Now the new service and form application HR Administrative Services is available for such processes. 

This application is more flexible and allows you to convert much more complex processes more quickly. 

In mySAP ERP 2005, HR Administrative Services and Personnel Change Requests are 

available in parallel and are supported. In future releases, the standard delivery will concentrate on HR 

Administrative Services.  Personnel Change Requests are available in mySAP ERP 2005 for the 

last time in the standard delivery. 

As the HR Administrative Services are already available with mySAP ERP 2005, we highly 

recommend that in mySAP ERP 2005 you implement processses for changing employee data using HR 

Administrative Services. 

The HR Administrative Services have the following advantages: 

- The new portal role HR Administrator is available and you can include it in your processes within 

HR Administrative Services. 

- Within a form-based process, every portal role (Employee Self-Service, Manager Self-Service, 

HR Administrator and others) can start the process or edit one of the process steps. 

- You can also implement very complex processes. The processes can include an unlimited number of 

steps and use an unlimited number of forms. 

- The process modeling is more flexible as it uses more SAP Business Workflow functions. The 

standard delivery contains preconfigured workflow templates and standard tasks that you can easily 

modify. 

- You can track the processes. 

- You can version the forms. 

- The new functions Save Draft and Cancel are available for the processes. 
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- Extensive Customizing settings are available for the form logic and back-end functions. This also 

includes input help, standard values and checks for consistency. In most cases, you do not need to 

define any coding for these functions. 

- A service for changing HR master data is available in the portal. You can configure the service so 

that it automatically saves data in the back-end system on the database, on the basis of the business 

logic of HR Administration. 

- You can define attachments and links for the forms. 

- The processes are integrated with the Digital Personnel File (DPF). This means that you can 

automatically store the documents created during a process in the DPF. 

For more information, see the HR Administrative Services Implementation Guide and SAP Library 

and choose SAP ERP Central Component -> Human Resources Management -> Personnel 

Management -> HR Administrative Services. 

37.9.2.5.2 Define Employee Groupings 

Use 

In this IMG activity you specify employee groupings for change requests. 

In the iView Change Request for Employee Data you can use employee groupings to create 

employee-specific assignments of request types to request scenarios. 

You usually group the employees independently of the scenarios. This means that the grouping is valid 

for all scenarios. 

37.9.2.5.3 Define Change Request Types 

Use 

In this IMG activity you define the data that is necessary for the change requests, in other words you 

define the request types. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 433 

37.9.2.5.4 Group Change Request Scenarios 

Use 

In this IMG activity you assign your request scenarios to request types and employee groupings. 

Request types bundle the scenarios according to time and employee groupings. 

You can use employee groupings to control the employee-specific assignment of request scenarios to 

request types. 

37.9.2.5.5 Define Scenario Attributes 

Use 

In this IMG activity you assign specific HR attributes to the request scenarios. You can assign a 

personnel administrator type to your scenarios. In other words you can specify, for example, that a 

scenario should be further processed by a personnel administrator for Payroll. In addition, you can 

specify the affected personnel action, so that a personnel administrator can postprocess changes in the 

system. 

Note: 

SAP recommends that you create a personnel action for each request scenario. 

Note that you must in any case create the personnel action for the request scenarios Position Change 

and Internal Reassignment. 

37.9.2.5.6 Define Reasons for Special Payment 

Use 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 434 

In this IMG activity you define the reasons for special payments that you want to use in the iView 

Change Request for Employee Data in the Special Payment request scenario. 

When you have done this, the system shows the manager the possible reasons for a special payment, and 

the manager can select one. 

37.9.2.5.7 Assign Wage Types to Special Payment Reasons 

Use 

In this IMG activity you assign wage types for the request scenario Special Payments to the special 

payment reasons. In addition, you specify whether you want to allow the manager to enter the special 

payment reason him- or herself. 

37.9.2.5.8 Set Up Workflows for Personnel Change Requests 

Use 

In this activity, you can set up workflows for the approval processes that are needed for personnel change 

requests. This includes the following workflow templates: 

- Submit Change Request (0) (50000042) -

 Submit Change Request (1) 

(50000041) 

- Submit Change Request (2) (50000031) 

Note 

The numbers specified in parentheses in the name of the workflow template specify the number of 

approval steps the change request must run through after it has been sent. 

To implement these workflows, you must assign agents to the relevant tasks contained in each of the 

workflow templates and activate event linkage, that is the events that trigger the workflow. 

Standard settings 

In the standard system, agents are not yet assigned for the workflow template and event linkage is 

deactivated. 

Activities 
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Perform Customizing activity (transaction PCRWF). The screen Task Customizing Overview appears, 

which displays in a tree structure the activities you need to perform. 

- Assign Agents to Tasks -

 Activate Event Linkage 

Agent Assignment 

First perform activity Assign Agents to Tasks. The screen Task Group: Maintain Agent Assignment is 

displayed. Here, the workflow templates to be implemented are also displayed in a tree structure for 

selection. 

Assign agents one after another for each of the workflow templates. 

1. Expand the tree structure for one of the workflow templates. This displays all tasks that belong to 

this workflow and, if necessary, any additional workflow templates that can be called within this 

workflow. 

2. To assign the agent, place the cursor on a task and choose Create Agent Assignment from the 

function bar or menu. 

Note 

Behind each task is displayed whether or not it is a background task. If it is a background task, you 

do not need to or cannot assign an agent. 

If the task is not a background task, the dialog screen Choose Agent Type is displayed after you have 

chosen a function. 

3. Choose an Agent Type (for example, object type Position). 

4. Then choose the relevant agent (that is, the concrete position) 

5. Perform all agent assignments for the displayed tasks in this way. To leave agent assigning, choose 

Back. 

Activating Event Linkage 

Perform activity Activate Event Linkage. The screen Event Linkage: Triggering Events is displayed. Here, 

the workflow templates are displayed once more in a tree structure for selection. For each of the 

workflow templates, activate the events that trigger the individual workflows. 

1. Expand the tree structure for one of the workflow templates. All triggering events are displayed for 

the appropriate workflow template. Behind each event is displayed whether or not it is activated or 

deactivated. 

2. Activate the events of the workflows you want to use. To do this, position the cursor on the event 

and choose Activate/Deactivate Event Linkage from the function bar or menu, or double-click on the 

event. 

If you want to deactivate an event, do exactly the same. 

Note 

The icon displayed behind the event enables you to display the attributes of event linkage. The 

function Display Object in the function bar, or Goto in the menu, enables you to display the 

business object for which the triggering event is used. 

See also 
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For more information on workflow templates, see: 

- Agent Assignment: 

To display the workflow template, choose the Attributes function from the function bar or Edit 

from the menu when you have positioned the cursor on the relevant workflow template or double-

click on the workflow template. The workflow template is displayed. 

- Activate Event Linkage 

When you have positioned the cursor on the relevant workflow template, choose the function Goto -

> Display Object from the menu. 

37.9.2.5.9 Business Add-Ins 

37.9.2.5.9.1 BAdI: Adjust Employee Groupings 

With this Business Add-In (BAdI) you can make customer-specific assignments of employees to 

employee groupings in the context of change requests. 

For further information on using employee groupings in change requests for employees, see the 

documentation on the field Employee Groupings for Change Requests(HRWPC_PCR_PCR_EEGRP). 

Requirements 

You must have defined the employee groupings in the settings for the business package Manager Self-

Service (transaction SIMG_SPORT). 

Standard settings 

This BAdI is not implemented in the SAP standard. If you do not create an implementation, the system 

runs the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 
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The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust Employee - Employee Grouping Assignment. 

37.9.2.5.9.2 BAdI: Adjust Header Data in Request Forms 

With this Business Add-In (BAdI) you can format the header data in change request forms for employee 

data to suit your requirements. 

You have, for example, the following option: 

 - You can format the employee name in a customer-specific way. 

This is useful if the display based on I0001-ENAME is not satisfactory. You can put together the 

elements of the employee name (title, first name, last name, and so on) as you wish. 

Example 

For example code, see the documentation on the MANIPULATE_INIT_DATA method. 

Standard settings 

This BAdI is not implemented in the SAP standard. If you do not create an implementation, the system 

runs the standard coding. 
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Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust Header Data in Change Request Forms. 

37.9.2.5.9.3 BAdI: Adjust Entry Help in Request Forms 

With this Business Add-In (BAdI) you can make customer-specific adjustments to the entry help in 

change request forms for employee data. 

For fields that consist of a technical name and a descriptive name, the standard is that the entry help 

offers, in a list box, a combination of both names, connected by - (hyphen). 

Example 
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You can specify that for particular fields - for example Employee Subgroup (PERSK) - the system should 

not use the technical name, and should only display the descriptive name. 

For a coding example, see the documentation on the method MANIPULATE_ADD_VALUES (Adjust 

Entry Help for Change Request Forms). 

Standard settings 

The BAdI is not implemented in the SAP standard. If you do not create an implementation, the system 

runs the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust Entry Help for Change Request Forms. 
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37.9.2.5.9.4 BAdI: Adjust Effective Date for Request Forms 

This Business Add-In (BAdI) enables you to set the effective date in the form header of personnel change 

requests customer-specifically. 

You have the following option: 

 - You can preset the effective date. 

As standard, the system always uses the system date (SY-DATUM) as the initial value for the 

effective date. In that case managers must usually overwrite the date. If change requests are subject 

to general enterprise rules (for example change requests always become valid at the end of the next 

month or quarter), you can use this BAdI to preset the date. 

Example 

For example code, see the documentation for the method MANIPULATE_EFF_DATE. 

Standard settings 

This BAdI is not implemented in the SAP standard. Unless you create an implementation, the system runs 

the standard code. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 
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8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

InterfaceMethod: Adjust Effective Date in Change Request Forms. 

37.9.2.5.9.5 BAdI: Adjust Check for Effective Date 

Use 

This Business Add-In (BAdI) enables you to implement a customer-specific check for the effective date. 

The effective date refers to the date as of which any changes to employee data are valid. 
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Standard settings 

This BAdI is not implemented in the standard SAP System. If you do not create an implementation, the 

system runs through the standard code. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

See also 

Interface IF_EX_HRWPC_PCR_CHECK_DATE 

Method CHECK_EFFECTIVE_DATE (Customer-Specific Check for Effective Date) 

37.9.2.5.9.6 BAdI: Adjust Rule Resolution for Receiving Manager 

Use 

This Business Add-In (BAdI) enables you to tailor the rule resolution of rule ApproverForm (50000132) 

to suit customer requirements. The entire rule container is available for this purpose. 
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Example 

The rule ApproverForm is used within the approval workflow ProcessPCR_2 (50000031) for personnel 

change requests to determine the approver. 

If this rule resolution fails, the entire workflow is terminated. You can use this Business Add-In to 

implement customer-specific error handling in the event of the standard rule resolution failing. 

Workflow ProcessPCR_2 (50000031) is used in the transfer scenario, for example, and is triggered after 

the Request for Transfer form has been submitted. 

Standard settings 

This BAdI is not implemented in the standard SAP System. If you do not create an implementation, the 

system runs through the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

See also 
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Interface IF_EX_HRWPC_PCR_APPR_FORM 

Method  MANIPULATE_ACTOR_TAB (Change the Processing Table for Rule Resolution) 

37.9.2.5.9.7 BAdI: Adjust Rule Resolution for Higher-Level Manager  
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37.9.2.6 Recruitment  
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37.9.2.6.1 Define Manager Groupings 

Use 

In this activity you define manager groupings for staff requisitions. 

In MSS Recruitment scenarios, you use manager groupings to define employee-specific assignments of a 

form type to request scenarios. 

Standard settings 

SDEF is delivered as a standard manager grouping.  
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37.9.2.6.2 Define Form Types for Staff Requisitions 

Use 

In this activity you define the form types for requisition requests. You can also give the selected form 

types a meaningful description. 

Activities 

1. Enter the required form types. 

2. Enter a meaningful description. This description will be displayed on the interface in the application. 

37.9.2.6.3 Group Form Types 

Use 

A request scenario is determined by the time-dependent assignment of a form type and a manager 

grouping. 

Using a manager grouping allows you to assign a form type to a request scenario for particular 

employees. 

37.9.2.6.4 Define Attributes for Request Scenarios 

Use 

In this activity you can assign attributes to the request scenarios. 

You can assign a specific logic to your scenarios, for instance which HR administrator is to be sent which 

request scenarios via workflow. 

37.9.2.6.5 Assign Start Mode 
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Use 

In this activity you can assign specific start modes to each manager grouping. Depending on the particular 

start mode, the appropriate data is displayed on the interface. For example, if the Position start mode is 

assigned to the manager grouping, only positions are displayed for the end user. 

37.9.2.6.6 Assign E-Recruiting System Name 

Use 

In this activity you assign an E-Recruiting system name to enable you to access data in the E-Recruiting 

system. 

Requirements 

The name must already exist and have been maintained as an RFC destination (transaction 

SM59). You have run the previous IMG activity Create RFC Connection for E-Recruiting 

System 

Activities 

1. Enter ERMSS in the 'Group' column. 

2. Enter LOGSY in the 'RQ Semantic Abbreviation' column. 

3. Enter the name you previously specified using the Create RFC Connection for E-Recruiting 

System IMG activity in the 'Semantic Abbreviation Value' column. 

4. Save your entries. 

Example 

Group RQ Sem. Abb. Sem. Abb. Value Text 

 ERMSS LOGSY KER_100 E- 

Recruiting System 
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37.9.2.6.7 Business Add-Ins 

37.9.2.6.7.1 BAdI: Define List Field Values 

Use 

This Business Add-In (BAdI) is available if you want to adjust the entries in the dropdown lists for 

Requisition request forms yourself. 

The input help field comprises a name (description) and a technical name. In the standard delivery, the 

technical names are displayed in parentheses. 

Standard settings 

The BAdI is not implemented in the standard delivery. If you do not create an implementation, the system 

uses the standard code. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 
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The code you stored in the method will be run when the application program is executed. 

Example 

For specific fields (such as Recruitment Officer (EREQ_RECRUITER)), you can specify that the system 

should use the description instead of the technical name. 

Result: The description Personnel Number is displayed as opposed to the technical name (PERNR). 

If this role resolution fails, the entire workflow is terminated. If this is the case, use this Business Add-In 

to implement customer-specific error handling. 

Workflow ProcessRQ (50000050) is used for the Requisition Request - Long Form, for example, and is 

sent after the first approval request has been triggered. 

See also: 

Interface IF_EX_HRWPC_EREC_ADD_VALS 

Method MANIPULATE_ADD_VALUES 

37.9.2.6.7.2 BAdI: Initialize Date on Requisition Forms 

Use 

This Business Add-In (BAdI) is available if you want to initialize the closing date for applications in the 

requisition request forms. 

In the standard delivery, the system uses the month after the system date (SY-DATE) as the initial value 

for the closing date for applications. If your requisition requests are only valid as of the end of the coming 

month/quarter, for example, you can use this BAdI to preset this date. 

Standard settings 

The BAdI is not implemented in the standard delivery. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 
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2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

See: 

Method MANIPULATE DATE(Adjust Date on Requisition Forms) 

37.9.2.6.7.3 BAdI: Assign Managers to Groupings 

Use 

This Business Add-In (BAdI) is available if you want to assign managers to manager groupings (in the 

context of requisition requests). 

See also: Managerial Groupings for Requisition Requests. 

Requirements 

You have defined the Manager Groupings in the IMG for Manager Self-Service. 

Standard settings 

This BAdI is not implemented in the standard delivery. 

Activities 
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After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

See also: 

Interface IF_EX_HRWPC_EREC_MGR_GRP 

Method EVALUATE_MGR_GROUPING (Assign Managers to Groupings) 

37.9.2.6.7.4 BAdI: Enhancement of Recruiter Role in E-Recruiting 

Use 

This Business Add-In (BAdI) is available if you want to adjust the resolution logic of the recruiter 

(12300042). 
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Example: 

In the standard delivery, the Recruiter role is used in the Requisition Request workflow to determine 

who was the last person to change data in the E-Recruiting system. 

If this role resolution fails, the entire workflow is terminated. If this is the case, you can use this BAdI to 

implement customer-specific error handling. 

The role and the workflows are used in the enhanced requisition request and are triggered after the final 

approval has been requested. 

Standard settings 

This BAdI is not implemented in the standard delivery. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 
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See also: 

Interface IF_EX_HRWPC_EREC_RECRUITER 

37.9.2.6.7.5 BAdI: Modification of Rule Resolution for Next Approver 

This Business Add-In (BAdI) enables you to tailor the rule resolution logic of role ApproverNext (50000144) to 

suit customer requirements. The entire role container is available for this purpose. 

Example 

The role ApproverNext is used within the approval workflow of ProcessRQ (50000050), ProcessRQ_1 

(21300032) and ProcessRQ_3 (21300043) for requisition requests to determine the first approver.  

Additionally, this role is also used in the new E-Recruiting Requisition related workflows: 

ProcessEREC1 (12300159) and ProcessEREC2 (12300158). 

If this role resolution fails, the entire workflow is terminated. You can use this Business Add-In to 

implement customer-specific error handling in the event of the standard role resolution failure. 

Workflow ProcessRQ (50000050) is used for example in Requisition Request - Long Form and is 

triggered after the form has been submitted by the Manager.  On the E-Recruiting side, this role is 

used in both Simple and Extended Requisition Requests in the same way. 

Standard settings 

This BAdI is not implemented in the standard SAP System. If you do not create an implementation, the 

system runs through the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 
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4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface  

IF_EX_HRWPC_PCR_APPR_NEXT 

Method 

MANIPULATE_ACTOR_TAB (Change the Actor Table for Role Resolution) 

37.9.2.7 Workforce Requirements 

37.9.2.7.1 Set Up ALE Scenario AC - HR 

Use 

In this IMG activity you set up the ALE Scenario Transfer Quota Planning Results to Accounting 

(AC). You must set up this scenario if you use Organizational Management and Accounting in two 

separate systems. 

Functions in the HR System: Sending System (Server) 

When you transfer the results of quota planning to CO, the system adjusts the time-specific planning 

results to the corresponding periods in CO. The results are then updated in CO. In distributed systems, the 

read, write and validation checks are all carried out in the CO System. For this reason, before every cross-

system operation, the HR System determines the receiving system by means of your entries in the 

distribution model. 

- When the planning data has been formatted into periods, the system reads the relevant data in the 

CO System with the help of a BAPI. 

- Once posting of the planning data has been triggered, the following takes place: 

- The system checks the posting data against CO data with the help of a synchronous BAPI. 

- The system transmits the data via ALE asynchronously to the receiving system. 
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Functions in the CO System: Receiving System (Client) 

The system posts data to the CO System. 

Setting Up the Distribution Model 

To ensure the communication flow between the two systems, you must specify a message type and/or an 

object with the corresponding method when you set up the distribution model. Enter the following for 

sending and receiving systems: 

- Sender/Client: HR System 

- Recipient/Server: CO System 

Object Name            Method         Meaning 

BUS6031 PlanDataTransferCO.GetSourceInfos Information on settings of planning data source 

BUS6031 PlanDataTransferCo.CheckKeyFigures Plandatentransfer: Check statistical key figures 

BUS6031 PlanDataTransferCo.PostKeyFigures Plandatentransfer: Post statistical key figures 

Partner Profiles 

You can generate the partner profiles from the distribution model. For more information on 

this, refer to the implementation guide (IMG) for Basis under Application Link Enabling (ALE) -> 

Business Process Modeling and Implementation -> Setting Up Partner Profiles and Processing 
Time -> Generate Partner Profiles . 

Settings in the HR System 

You must set the following switches in your HR system in table T77S0 (system table): 

- SKFCO / COPLS (plan source for CO data transfer) 

- SKFCO / KFACNT (stat. key figures: number of positions (change)) 

- SKFCO / KFBCNT (stat. key figures: number of positions (budget)) 

For more information, refer to the documentation for the business package Manager Self-Service 

under Technical Description ->  iView Pool -> Quota Planning. 

Settings in the CO System 

In the CO System, you must first create the statistical key figures you want to use in table T77S0 (system 

table). 

Activities 

1. Check whether the methods listed have been created for object BUS6031 in your customer 

distribution model. 

2. Ensure that the required CO data has been distributed to the HR System. 
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37.9.2.7.2 BAdI: Transfer Planing Results to Accounting 

This Business Add-In allows you to realize customer-specific requirements when transferring required 

positions planning to CO. 

For further information, see the following documentation: 

- Interface Documentation 

- Method Documentation 

Example 

For an example implementation, see the class CL_IM_HRWPC00_HEADCNT2CO 

- Implementation Documentation 

37.9.2.8 Cost Center Monitor 

37.9.2.8.1 Edit Administration Rules for Cost Center Variances 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 
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3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.2.8.2 Edit Administration Rules for Cost Center Line Items 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 
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4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.2.8.3 Execute Evaluation for Critical Cost Center Variances 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.2.8.4 Execute Evaluation for Cost Center Line Items 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 
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The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.2.8.5 Delete Cost Center Line Items from Display Set 

Use 

When a user confirms a posting in the monitor, the posting disappears from the monitor and is written to a 

separate database table so that it does not reappear in the monitor after the data is updated. In this IMG 

activity you can delete the entries from the table with the confirmed postings. All postings that were made 

before the current evaluation date of the rule are deleted. 

If after deletion of this table the evaluation date of the rule is reset to an earlier date, the postings will 

reappear in the monitor. 

37.9.2.8.6 Display Rules for Cost Center Variances per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 
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could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.2.8.7 Display Rules for Cost Center Line Items per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.2.9 Internal Order Monitor 
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37.9.2.9.1 Edit Administration Rules for Order Variances 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.2.9.2 Edit Administration Rules for Order Line Items 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 
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- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.2.9.3 Execute Evaluation for Critical Order Variances 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 
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You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.2.9.4 Execute Evaluation for Order Line Items 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 
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37.9.2.9.5 Delete Order Line Items from Display Set 

Use 

When a user confirms a posting in the monitor, the posting disappears from the monitor and is written to a 

separate database table so that it does not reappear in the monitor after the data is updated. In this IMG 

activity you can delete the entries from the table with the confirmed postings. All postings that were made 

before the current evaluation date of the rule are deleted. 

If after deletion of this table the evaluation date of the rule is reset to an earlier date, the postings will 

reappear in the monitor. 

37.9.2.9.6 Display Rules for Order Variances per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 
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37.9.2.9.7 Display Rules for Order Line Items per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.2.10 Profit Center Monitor 

37.9.2.10.1 Edit Administration Rules for Profit Center Variances 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 
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If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.2.10.2 Edit Administration Rules for Profit Center Line Items 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 
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Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.2.10.3 Execute Evaluation for Critical Profit Center Variances 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.2.10.4 Execute Evaluation for Profit Center Line Items 

Use 
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In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.2.10.5 Delete Profit Center Line Items from Display Set 

Use 

When a user confirms a posting in the monitor, the posting disappears from the monitor and is written to a 

separate database table so that it does not reappear in the monitor after the data is updated. In this IMG 

activity you can delete the entries from the table with the confirmed postings. All postings that were made 

before the current evaluation date of the rule are deleted. 

If after deletion of this table the evaluation date of the rule is reset to an earlier date, the postings will 

reappear in the monitor. 
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37.9.2.10.6 Display Rules for Profit Center Variances per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.2.10.7 Display Rules for Profit Center Line Items per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 
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2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.2.11 Equipment Monitor 

37.9.2.11.1 Edit Views 

Use 

In this IMG activity you can configure the views of the Equipment Monitor (MSS) or the Equipment 

Overview (ESS). The views are used as follows: 

- The Assignment view (ASSIGNMENT) is used in Manager Self-Service (MSS) and shows the 

employees to which the equipment on the manager's cost center is assigned. 

- The Costs view (COST) is used in MSS and shows the costs incurred for the equipment on the 

manager's cost center. 

- The Employee view (EMPLOYEE) is used in Employee Self-Service (ESS) and shows the 

equipment assigned to an employee. 

You can specify the following for each view: 

- You can give the views a different name. 

- You can specify the object type from which the fields (such as the personnel number, cost center, 

room number, or location) are filled that exist in all three object types (asset, equipment, and loan 

object). You can specify a priority for each object type. When the monitor is displayed, the system 

attempts to fill a common field first from the object type with the highest priority, then from the 

object type with medium priority, and finally from the object type with the lowest priority. 

- You can specify which equipment types and asset classes are displayed. This enables you to exclude 

equipment and assets that are from a different business context and that cannot be assigned to any 

employee. 

The Business Add-In FCOM_EQM_CHANGE enables you to further modify how data is displayed (such 

as contents and column display). 

Activities 

1. Select a view and switch to the detail screen. There you can specify the name of the view and the 

priority for filling common fields from the object types. 

2. Back in the initial screen, select a view and specify under Equipment Categories and Asset 

Classes the values that you want to display in the view. 

37.9.2.11.2 Specify RFC Connection to HCM System 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 472 

Use 

The leading system in data selection is the Financials system. To read additional data (personnel data and 

data on loan objects), enter the RFC connection to the HCM system in which the data is located. 

Requirements 

The RFC destination has been created. 

37.9.2.11.3 Prepare Cost Determination 

Use 

In this IMG activity, you (as an administrator) prepare the cost determination process for the Equipment 

Monitor. When you do this, the system creates rules that are needed in cost determination for technical 

reasons. 

Preparation of cost determination only needs to be done once for each user. 

Requirements 

The personalization settings have been made for the user (see Personalisierungs-Framework: Übersicht). 

Activities 

1. Prepare cost determination for all users of the Equipment Monitor. 

2. If new users are added later, you only need to do the preparation for the new users. 

Note: If you create rules for many users, you should run the job in background. 

37.9.2.11.4 Execute Cost Determination 

Use 

In this IMG activity you execute cost determination and write the results to the database table. The 

Equipment Monitor displays the costs from this table, enabling faster access to the data than if the costs 

had to be recalculated each time they were displayed. 

You should run the cost determination on a regular basis (preferably daily in an overnight background 

run) so that all users have current data at the start of each day. 

Requirements 
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Cost determination has been prepared (see Prepare Cost Determination). 

Activities 

1. Enter data as required: 

You can run cost determination for one user or for all users (enter *). You can execute cost 

determination as a test run first. However, this is only possible for a single user. The following 

time-based selections are available: 

- Last access after: Cost determination is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before the 

specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute cost determination or schedule a regular background job. 

37.9.2.11.5 Business Add-Ins 

37.9.2.11.5.1 BAdI: Change Equipment Monitor 

Use 

This Business Add-In (BAdI) is used in the following components: 

- Manager Self-Service (EP-PCT-MGR) 

- Employee Self-Service (CA-ESS) 

This BAdI enables you to influence how data is displayed in the Equipment Monitor or the 

Equipment Overview. You can modify the data content as well as column headers and the 

visibility of columns. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 
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1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

See also: 

Methods 

Change Contents 

Change Layout 

37.9.2.11.5.2 BAdI: Assignment of Equipment to Users 

Use 

This Business Add-In (BAdI) is used in the following components: 

- Manager Self-Service (EP-PCT-MGR) 

- Employee Self-Service (CA-ESS) 

You use this BAdI to establish how the system determines the items of equipment assigned to a user and 

the users for a list of equipment. 

Requirements 
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You have maintained the assignment of equipment to users (user name, personnel number). 

Standard settings 

In the example implementation, the items of equipment for a user are determined as follows: 

- The system evaluates the partner roles VW and VU for the equipment. 

- The partner role VW is evaluated first, then the partner role VU (since personnel numbers are 

evaluated first). 

Activities 

See whether the example implementation can be used for your system. 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 
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See also: 

Methods 

Determine Equipment for User 

Determine User for Equipment 

37.9.2.11.5.3 BAdI: Equipment Monitor, Select Cost Determination 

Use 

This Business Add-In (BAdI) is used in the Manager Self-Service (EP-PCT-MGR) component. 

The Equipment Monitor shows the costs for  equipment and assets that were collected on the assigned 

maintenance orders or internal orders. This BAdI assigns additional costs to the assets and equipment. 

These costs are displayed in the Equipment Monitor in the costs column. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 
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9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

See also: 

Methods 

Determination of Costs 

37.9.2.12 Reporting 

37.9.2.12.1 Set Up LaunchPad 

Use 

In this IMG activity, you define the applications (links to reports, transactions, URLs) for the Launchpad 

iView . 

For additional information, see the SAP Library under SAP ERP Central Component -> Business 

Packages/Functional Packages -> Business Package for Common Parts -> Launchpad. 

Standard settings 

If you are using the Hierarchy then the object types of the hierarchy are displayed as object nodes. The 

object nodes in this case form the first level of the subdivision of the launchpad. For the Business Unit 

Analyst you can determine the selection of object types under Business Unit Analyst 2.0 (mySAP 

ERP) -> Hierarchy -> Set Hierarchy. You cannot change the selection for the Manager Self-Service. 

Activities 

When you execute the IMG activity for the first time or have not yet saved any settings, you need to 

decide whether you want to use the Hierarchy. If you do want to use the hierarchy, proceed as follows: 

1. Select an object node. When you do this, other pushbuttons are displayed. 

2. You can assign all applications directly to the object node. In addition, you can group the launchpad 

by creating new folders. The folders are used in the portal as headers for the links to the 

applications. 

Choose New Folder. Enter a text for the new folder, and choose Enter. The folder is added below 

the selected node. 
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3. To create applications, select the object node or the folder to which you want to assign the 

applications, and choose New Application. 

4. Enter the required data. 

5. Select the application category. Depending on your selection additional input fields are displayed, 

which you can use to specify or select the parameters of the application. 

6. If you want to enter a description that is displayed in the portal under the link but is to be longer than 

255 characters, choose Editor for Description to the right of the field Descript.. 

7. Enter the System Alias (except for URL). 

If you do not want to use the hierarchy, first select the uppermost node if this has not already been 

selected. The uppermost node then takes over the functions of the object node. You can therefore assign 

folders and applications direct to this node without a hierarchy. 

The inactive applications folder is used for collecting the applications that are available in the portal, but 

that you do not want to display. These applications are displayed in the portal in a table that the user can 

view when he or she changes the launchpad settings. 

37.9.2.12.2 Key Figure Monitor 

37.9.2.12.2.1 Systems 

37.9.2.12.2.1.1 Define Logical System for Key Figure Values 

Use 

In this IMG activity you define the logical systems from which the key figure values can come. You can 

also specify a description per system. 

The definition is valid for all types of source system. 

Activities 

Define a logical system and specify a description. 

37.9.2.12.2.1.2 Create RFC Connections 

In this section, you define the technical parameters for the RFC destinations. 

The Remote Function Call (RFC) is controlled by the RFC destination parameters. 
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To create an RFC port, the RFC destinations must be assigned. 

The name of the RFC destination should be the same as the logical system name. 

The following types of RFC destinations can be assigned: 

- R/2 connections 

- SAP connections 

- Internal connections 

- Logical destinations 

- CMC connections 

- SNA/CPI-C connections 

- TCP/IP connections 

- ABAP driver connections 

Example 

 1. For an SAP connection, enter the following parameters: 

- Name of RFC destination: S11BSP001 

- Connection type: 3 (for SAP connection) 

- Target system: bspserver01 

- System number: ,11 

- User in target system: CPIC 

- Password, language and target client. 

Standard settings 

No RFC destinations are assigned in the standard system. 

Activities 

1. Select one of the types (for example, SAP connections) and choose Edit -> create; 

2. Enter the parameters required for that type. 

3. For an SAP connection, these are, for example, the name of the RFC destination, the name of the 

partner system, logon parameters (see example). 

Processing RFCs With Errors 

Since RFC destinations are usually registered in the QOUT Scheduler when you use ALE, it is usually no 

longer necessary to schedule the program RSARFCEX in a background job for the collective processing 

of RFCs with errors. We also recommend that you do not do this. The QOUT Scheduler now repeats the 

execution of RFCs with errors automatically (See transaction SMQ1. For detailed documentation about 

the QOUT Scheduler, see the SAP Library under qRFC (Queued Remote Function Call)). 
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In some cases, for example, if there are many RFCs with errors, and they cannot be executed again with 

the QOUT Scheduler, you can start the report RSARFCEX manually. 

Practise handling errors in remote function calls before the function is used productively. 

Further notes 

The 'SAP*' user cannot be used for remote function calls on the target system. 

For connecting to R/2 Systems: 

- Use an R/2 destination to read the users with passwords. The actual communication uses CPI-C. 

- Select 'Unencrypted password' 

Notes on the transport 

The maintenance of the RFC destination is not a part of the automatic Change and Transport System. 

Therefore the setting has to be made manually on all systems. 

37.9.2.12.2.2 Define Key Figure Categories 

Use 

In this IMG activity, you define the key figure categories for the generic key figure monitor. 

The key figure category consists of the ID and the description. You can use the category to group together 

similar key figures for the authorization check. You assign the key figure category in the IMG activity 

Define Key Figures. 

Note the documentation on the authorization objects: 

- Key Figures in Generic Key Figure Monitor (Administrator) 

- Key Figures in Generic Key Figure Monitor (User) 

37.9.2.12.2.3 Define Intervals for Updating Key Figures 

Use 
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In this process step, you define the intervals for key figures. You assign the intervals to the key figures in 

the process step Define Key Figures. 

To determine key figure values, use the report KFM_VALUE_DET_SCHEDULE. This report determines 

all key figure values for an interval. 

Example 

You have created the interval DAILY with description Daily 8:00. You have assigned this 

interval to the key figures Key Figure 1, Key Figure 2, and Key Figure 3. 

To determine the key figure values for Key Figure 1, Key Figure 2, and Key Figure 3 each morning at 

8:00, you must schedule the report KFM_VALUE_DET_SCHEDULE with interval DAILY to be run at 

8:00 every morning. 

37.9.2.12.2.4 Define Key Figures 

Use 

In this IMG activity, you define the key figures for the generic key figure monitor. The key figures and 

their values are displayed for the roles in the portal that use the generic key figure monitor. 

Enter the following data for the key figure: 

- Header Area: 

- Technical Name 

- Name 

- Description 

- Source Data: 

Specify the source system for the key figure and the program that was used to determine the key 

figure values. 

- Format: 

Specify the unit, currency, and format for the key figure. 

- Periods: 

Specify the evaluation period for the key figure, and in which temporal intervals the key figure 

values are to be determined. 

The settings for the evaluation period also influence how the changes in value are displayed in the 

portal. 

- Other Settings: 
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Specify if the key figure can be personalized or not, if comments can be created, and the key figure 

category. 

37.9.2.12.2.5 Define Key Figures that can be Personalized 

37.9.2.12.2.5.1 Define Personalizable SAP BW Key Figures 

Use 

In this process step, you define the connection between key figures in the generic key figure monitor and 

personalization. 

If you want to use key figures that can be personalized, you must make the relevant settings in this 

process step. 

To make the Customizing settings for personalization, see Cross-Application Components -> 

General Application Functions -> Generic Functions of mySAP Suite -> Personalization. 

Example 

You want to display an evaluation for each cost center for each cost center owner. 

You have made the following settings: 

- The key figure has the setting Can be Personalized (Value Determination for each Key 

Figure and User). 

- In report KFM_KF_REPORT_BW_QUERY, you have created a variant that contains the logical 

system name of the SAP BW system, the name of the required BW query, and the name of the BW 

key figures. 

- If value determination is triggered via the report KFM_VALUE_DET_SCHEDULE, then the 

system evaluates the personalization for each user that is using this key figure, and determines the 

value for each user. 

37.9.2.12.2.5.2 Define SAP ERP Key Figures that can be Personalized 

Use 

In this process step, you define the connection between key figures in the generic key figure monitor and 

personalization. 

If you want to use key figures that can be personalized, you must make the relevant settings in this 

process step. 
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To make the Customizing settings for personalization, see Cross-Application Components -> 

General Application Functions -> Generic Functions of mySAP Suite -> Personalization. 

Example 

You want to display an evaluation for each cost center for each cost center owner. 

You have made the following settings: 

- The key figure has the setting Can be Personalized (Value Determination for each Key Figure 

and User). 

- In report Z_COST_CENTER, the selection parameter P_KOSTL specifies for which cost center 

the evaluation is to be carried out. 

- If value determination is triggered via the report KFM_VALUE_DET_SCHEDULE, then the 

system evaluates the personalization for each user that is using this key figure, and determines the 

value for each user. 

37.9.2.12.2.6 Examples for Determination of Key Figure Values 37.9.2.12.2.6.1 

Determination of Key Figure Values from SAP ERP or SAP 

R/3 

Use 

You can determine key figure values for the key figure monitor using SAP R/3 or SAP ERP reports and 

display them in the Portal. For this, SAP provides two example reports that show you how the 

determination of such key figures can look: 

- Evaluation of capacity load utilization (EPM_CAPLOAD_KPI) 

- Evaluations of manufacturing and/or process orders (EPM_ORDER_KPI) - Example of a key 

figure generating report (KFM_KF_REPORT_EXAMPLE) For more information, see the 

documentation for the individual reports. 

SAP provides the following INCLUDE function modules for key figure determination in customer-

specific programs: 

- INCLUDE kfm_kf_report_top 

- INCLUDE kfm_kf_report_parameters 

- INCLUDE kfm_kf_report_initialization. 
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- INCLUDE kfm_kf_report_selscreen_output 

- INCLUDE kfm_kf_report_at_sel_screen 

- INCLUDE  kfm_kf_report_get_kf_info 

- INCLUDE kfm_kf_report_insert_kf_data 

You can use these INCLUDE function modules to easily create key figure reports. For example, you can 

include them in existing programs at the appropriate places. 

The above INCLUDE function modules are also used in the example reports EPM_CAPLOAD_KPI and 

EPM_ORDER_KPI mentioned above. 

Requirements 

- If you use key figures that can be personalized, you have created data for personalization in 

Customizing. You find Customizing for personalization under Cross-Application Components -> 

General Application Functions -> Generic mySAP Suite Functions -> Personalization. 

- In the work step Define Key Figures you have created a key figure whose value you want to 

determine. You have specified Business Information Warehouse as the Source System Type. 

37.9.2.12.2.6.2 Determination of Key Figure Values from SAP BW 

Use 

For the key figure monitor, you can automatically and regularly determine key figures from the SAP 

Business Information Warehouse (BW) and display them in the Portal. SAP provides the standard report 

KFM_KF_REPORT_BW_QUERY for this purpose. It determines individual key figures from BW data 

sources. 

Requirements 

- If you use key figures that can be personalized, you have created data for personalization in 

Customizing. You find Customizing for personalization under Cross-Application Components -> 

General Application Functions -> Generic mySAP Suite Functions -> Personalization. 

- In the work step Define Key Figures you have created a key figure whose value you want to 

determine. You have specified Business Information Warehouse as the Source System Type. 

- If you want to see the data with the possibility of drill down in addition to determining the key 

figure value, you have created an information consumer pattern for the corresponding SAP BW 

query. If you create an information consumer pattern, see SAP Note 721983. 
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Activities 

1. Create a variant for report KFM_KF_REPORT_BW_QUERY. 

For a key figure that can be personalized, do not specify a value for PARAMETER and SELECT-

OPTIONS, as these values are filled from personalization. 

You define the link between the key figure and the personalization data in the work step Define SAP 

BW Key Figures that can be Personalized. 

2. In the work step  Define Key Figure, enter the Report and the Variant for the key figure in step 1 

in the group box Source Data. In the group box Periodicity, define the interval for value 

determination of the key figures. 

3. For the report KFM_VALUE_DET_SCHEDULE, create a report variant that contains the interval 

for value determination. 

4. Schedule the report KFM_VALUE_DET_SCHEDULE with the newly created variant as a regular 

job. Define the job so that it runs in time spans that correspond to those of the interval. 

37.9.2.12.2.6.3 Determination of Key Figure Values from External System 

Use 

It is also possible to determine key figures values from external systems and display them in the Portal. 

The following RFC functions modules are provided for this: 

- You can use the function module KFM_KF_DEFINITION_GET_RFC to get information about the 

definition of a key figure (such as threshold values, description, and target values) from the SAP 

ERP system. 

- You can use the function module KFM_KF_DB_VALUE_INSERT to transfer key figure values to 

the SAP ERP system. 

You must initiate key figure determination in the external system and start there. If you want the 

determination to occur regularly, you must also configure this in the external system. The SAP ERP 

system only receives the key figure values. 

Requirements 

In the work step Define Key Figure  you have created the key figure for which you want to determine the 

values. You have specified External System as the Source System Type. If necessary enter a URL in 

the URL of External System field for displaying the detailed screen. 

Activities 

1. To determine information about the key figure, call the function module 
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KFM_KF_DEFINITION_GET_RFC with the parameter I_KF_ADM_VAR (technical name of 

key figure). 

2. Perform value determination in the external system. 

3. Call the function module KFM_KF_DB_VALUE_INSERT with the parameters I_KF_ADM_VAR 

and I_KF_VALUE to transfer the key figure values to the SAP ERP system. 

37.9.2.12.3 Personal Object Worklist 

37.9.2.12.3.1 Cockpit for POWL Administration (as of SAP NetWeaver 7.02) 

Use 

The POWL Administrator Cockpit is a single point of entry to perform different administrator activities 

relevant for Personal Object Worklist (POWL) development, Customizing, and testing. 

There are three types of POWLs: 

- Standard POWL 

Standard POWL is the type of personal object worklist that is generated by implementing the 

interface IF_POWL_FEEDER (Interface for POWL Feeders) and creating POWL Customizing 

using the following transactions: 

- Define Personalization Hierarchy (FPB_MAINTAIN_HIER) 

- Define Categories (POWL_CAT) 

- Define Query Visibility at User Level (POWL_QUERYU) 

- Query visibility at Role Level (POWL_QUERYR) 

- Define Default Queries (POWL_QUERY) 

- Configure Worklist Type Repository (POWL_TYPE) 

- Define Worklist Type Visibility at User Level (POWL_TYPEU) 

- Define Worklist Type Visibility at Role Level (POWL_TYPER) 

To find these IMG activies in SAP Customizing, choose Cross-Application Components -> 

General Application Functions -> Generic SAP Business Suite Functions -> Personal 

Object Worklist. 

- Reporting POWL 

Reporting POWL is the type of personal object worklist that is generated based on an InfoSet 

Query. Data that is to be available for analysis purposes is grouped in InfoSets. 

- Easy POWL 

Easy POWL is the type of personal object worklist that is generated using the transaction Easy 

POWL Builder (EASY_POWL). 
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Activities 

You can specify the type of POWL for which you need to perform administrator activities: 

- Standard POWL 

Standard POWL selection enables you to perform the following operations: 

- Create/Maintain/Delete Application ID 

- Create/Maintain/Delete POWL Type 

- Assign POWL Type to Application ID (Role-Based/User-Based) 

- Create/Maintain/Delete POWL Query 

- Assign POWL Query to Application ID (Role-Based/User-Based) 

- Create/Maintain/Delete POWL Category 

- Check Consistency of POWL Customizing Entries 

- Test-Launch POWL Application 

- Reporting POWL 

If you select a Reporting POWL, you can further specify the kind of action that you wish to 

perform, such as registering infoset queries or maintaining actions for a reporting 

POWL. 

Reporting POWL selection enables you to perform the following operations: 

- Call InfoSet Query 

- Maintain Actions for a Reporting POWL 

- Easy POWL  

Easy POWL selection enables you to start the Easy POWL Builder. For more information, see 

report documentation  Easy POWL Builder. 

37.9.2.12.3.2 BAdI:  Visible POWL Types 

Use 

This Business Add-In (BAdI) is used in the Personal Object Worklist component. 

This BAdI definition provides an option to modify the POWL types at runtime. 

POWL runtime makes a call to the implementation of this BAdI definition providing the visible POWL 

types, application ID, user name and system language corresponding to the POWL application that is 

executed. The implementations can modify the POWL types and pass it back to the framework. 
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Example 

Consider that the following is the POWL customization that is available statically. 

- Application ID: PURDOC 

- The following POWL types are mapped to this application ID: 

- PURDOC_MY 

- PURDOC_ALL. 

If it is required that the POWL type PURDOC_ALL should not be available for certain users, then, this 

definition needs to be implemented and the POWL type PURDOC_ALL should be removed from the 

visible types and returned back. 

Thus, the static POWL type assignments can be modified at runtime. 

37.9.2.13 Internal Service Request 

37.9.2.13.1 Internal Service Request: Overview 

Use 

Internal Service Requests (ISRs) are integrated into various Web applications. Users can send a request in 

a Web application by clicking a pushbutton. For example, a Business Unit Analyst can request a change 

to master data. 

For more information on the ISR scenarios available in the applications of Manager Self-Services or the 

Business Unit Analyst, refer to the SAP Library under Cross-Application Components -> Manager 

Self-Service or Business Unit Analyst. 

The customizing settings for Internal Service Requests are located under Cross-Application 

Components -> Internet/Intranet Services -> Internal Service Request. 

37.9.2.14 Express Planning 

37.9.2.14.1 Define Planning Scenario 

Use 

In this IMG activity you define a planning scenario that you use for planning with Express 

Planning in the SAP NetWeaver Portal . You can find additional information on using Express Planning 

in the SAP library under Cross-Application Components -> Express Planning. 

For each planning scenario you create at least one Express Planning instance. If you create several 

instances, you can use the planning scenario for more than one planning round. You can additionally 

define a context area in which information for the planner can be displayed in the portal. 

Requirements 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 489 

The plan versions defined in the instance are available in the IMG activity Maintain Versions. 

Standard settings 

The planning scenario  Express Planning: Cost Center Planning (0_CC_EXP) is contained in the 

standard delivery, which you can use an example. For additional information on this example, see the 

SAP library under Cross-Application Components -> Express Planning -> Example Scenario for 

Cost Center Planning. 

Activities 

You create a planning scenario under Scenario -> Create. 

Under the Specification Work Area node you can then define the steps and substeps of the planning 

scenario. To do this, place the cursor on the higher-level node and from the context menu choose Insert 

Step/Substep. 

You can also use all steps and substeps across a range of scenarios. When you do this, you have the 

option of either creating the subordinate elements of a scenario again by copying, or including them as a 

reference of the original. 

You make the basic settings for a substep. You use this to include a planning service and define its 

parameters. If you want to change the standard selection of the object types for the planning service, 

enter a personalization dialog at the level of the planning scenario that contains the required object types. 

You can enter an RFC Destination for some substeps. You can specify a different system in the RFC 

destination than the one that is linked in the portal. The planning service then determines the data in the 

system specified in the RFC destination when you execute planning. 

To define an instance for the planning scenario, place the cursor on the Specification Instance node, 

and from the context menu choose Insert Instance. 

Under the Specification Context Area node you can assign steps and substeps of a planning scenario an 

explanatory text, a document or a URL. To create a new entry, place the cursor on the higher-level 

element and from the context menu choose Insert Section/Item. You can change the sequence of the 

context area sections using the arrow keys. 

For additional information regarding the settings options, see either the documentation for the fields, or 

the SAP library under  Cross-Application Components -> Express Planning -> Configuring a 

Planning Scenario.  You can also access this documentation by choosing Help -> Application Help. 

37.9.2.14.2 Define Key Figure Prices 

Use 

In this IMG activity you can define prices that can be used within Express Planning for the valuation of 

statistical key figures entered. 

To enter prices, the following entries are mandatory: 
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- Controlling area that is used to determine the currency and to restrict the validity of key figures and 

cost elements. 

- Key figure for which the valuation is to be made. 

- Cost element to which the valuation is posted (if you use the same cost element for several key 

figures, the individual values are added together). 

With these required entries you can enter general prices in the system that are not specified in greater 

detail with regard to company code, version and also fiscal year and period. 

In addition to these general prices, you can also enter prices in greater detail by specifying one or more 

additional parameters such as the company code. 

If you enter several prices in differing levels of detail for a key figure and cost element then the price used 

for the key figure valuation is the one with the finest granularity (technically the price with the maximum 

number of matching arguments). If, for example, the valuation is to be carried out for a particular period, 

and a price has been defined for this period, then this price is used for the valuation. However, if no price 

has been defined for the period, then the price that has been defined (for example) for the corresponding 

fiscal year is used. For the price determination, this means that the parameters that can be defined for a 

price are gradually made more general. Only if no price can be found at the key figure or cost element 

level in the course of this gradual generalization is the system unable to carry out a key figure valuation. 

You enter the price for a price unit. The price unit frequently has the value 1, but you can also specify 

prices that relate to a particular quantity (for example, price per 100 units) 

37.9.2.14.3 BAdI: Change Room Parameters 

Use 

This Business Add-In (BAdI) is used in the role Business Unit Analyst (BUA) 2.0. In this role you can 

create planning rounds for Express Planning.  In the portal, a room is created for every planning round 

in which you send Express Planning planning tasks to the manager, and can follow the status of these 

planning tasks. 

You can use this BAdI to change the parameters of the planning round or room. The BAdI is called when 

you create a planning round in the portal. 

Standard settings 

This BAdI is active in the standard SAP system. It cannot be multiply used and is not filter-dependent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

For more information, see: 

Methods 

Change person responsible 

Change role names 

Change the room parameters 

Change application parameters 

37.9.3 Manager Self-Service 

37.9.3.1 Personalization 

37.9.3.1.1 Personalization Framework: Overview 

SAP provides you with a framework in the delivery, which completely supports the personalization of 

iViews. This framwork comprises a data storage system and a generic personalization dialog. This 

enables the user to create their own personalization dialogs. 

In addition, SAP delivers personalization dialogs. 

The following IMG activities support the administrative tasks for the activation of these dialogs: 

Maintain Personalization Data User 

Maintain Personalization Data Cost Center Accounting 
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Maintain Personalization Data Profit Center Accounting. 

In addition, the system administrator can also use the IMG activity Maintain Personalization Data User 

for personalization dialogs that he or she created. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.1.2 Maintain User Personalization Data 

This transaction can be used by the administrator to maintain (also retrospectively) the data of single 

users for personalization dialogs (created by user or provided by SAP). 

Requirements 

You have created the user. Your own/or SAP's personalization dialogs exist. 

Activities 

You select a personalization dialog and then a user. 

Further notes 

Personalization dialogs can only be assigned to users and not to roles. 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.1.3 Personalization Data - Collective Maintenance 

The system administrator uses this transaction to edit the data of a group of users for personalization 

dialogs (both custom dialogs and the standard dialogs supplied by SAP). 

Requirements 

You have created users. Your own custom personalization dialogs and/or the standard personalization 

dialogs for the back-end system exist. 

Activities 

1. Enter a group of users (from - to). 2.

 Select one of the following options: 

a) Overwrite Existing Data: Assigns the personalization data to all selected users. 

b) Create New Data Only: Assigns the personalization data only to the selected users to whom 

no data has been assigned up to now. 

3. Choose the personalization dialog that you want to assign. 
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4. Choose Program -> Execute. 

Further notes 

You can assign personalization dialogs only to users, not to roles. 

For more information, see the documentation for the business package Manager Self-Service. 

37.9.3.1.4 Maintain Cost Center Accounting Personalization Data 

To implement the Business Package Manager Self-Service, the system administrator is provided with 

ABAP reports, which enable the user-specific data (e.g. controlling area) to be maintained centrally by all 

users. 

This report can also be started as a test run, whereby the user data is only listed rather than written to the 

data storage system in the personalization framework. These two programs are only intended for use in 

the Business Package Manager Self-Service. They write the data to the corresponding nodes in the 

application hierarchy for Overhead Cost Controlling. 

Requirements 

To use these reports, you either need to maintain the the HR-ORG structures or maintain the 

authorizations in the component system. 

So that the internal orders/WBS elements for the area of responsibility can be filled, you need to maintain 

this information in the master data of the appropriate cost centers. 

Further notes 

If you use the HR-ORG to derive the cost center, or the profit center, then a restriction applies, whereby 

the cost center group or profit center group is broken down and written to the personlization data. 

Example: If a department manager (cost center group) has four cost centers assigned to him/her, the cost 

center group is not written to his/her personalization data, but the four cost centers that are in the area of 

responsibility of his/her cost center group. 

However, if you use the authorizations for maintaining the area of responsibility, then only the cost center 

group is written to the personalization storage system in the above example. 

It is only possible to break down the cost center hierarchy if the data from the authorization maintenance 

is filled. 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.1.5 Maintain Profit Center Accounting Personalization Data 

To implement the Business Package Manager Self-Service, the system administrator is provided with 

ABAP reports, which enable the user-specific data (e.g. controlling area) to be maintained centrally by all 

users. 
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This report can also be started as a test run, whereby the user data is only listed rather than written to the 

data storage system in the personalization framework. These two programs are only intended for use in 

the Business Package Manager Self-Service. They write the data to the corresponding nodes in the 

application hierarchy for Overhead Cost Controlling. 

Requirements 

To use these reports, you either need to maintain the the HR-ORG structures or maintain the 

authorizations in the component system. 

So that the internal orders/WBS elements for the area of responsibility can be filled, you need to maintain 

this information in the master data of the appropriate cost centers. 

Further notes 

If you use the HR-ORG to derive the cost center, or the profit center, then a restriction applies, whereby 

the cost center group or profit center group is broken down and written to the personlization data. 

Example: If a department manager (cost center group) has four cost centers assigned to him/her, the cost 

center group is not written to his/her personalization data, but the four cost centers that are in the area of 

responsibility of his/her cost center group. 

However, if you use the authorizations for maintaining the area of responsibility, then only the cost center 

group is written to the personalization storage system in the above example. 

It is only possible to break down the cost center hierarchy if the data from the authorization maintenance 

is filled. 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.2 Internal Service Request 37.9.3.2.1 Maintain Additional Data for 

Scenarios for Internal Service 

Request 

In this IMG activity, you add to your details on scenarios for internal service requests that you want to use 

for the Business Package Manager Self Service. You can influence the display of the request data in the 

notification, define workflow templates for scenarios and provide additional characteristics in the status 

overview. You need to enter the name of the portal component so that your scenario is fully supported in 

the Manager Self-Service. 

Requirements 

In the standard IMG, you have completed all the required activities for defining scenarios. For 

information on the procedure, see the standard IMG under Cross-Application Components -> 

Internet/Intranet Service -> Internal Service Request. 

Standard settings 

All the scenarios provided by SAP are in the namespace S. 
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Activities 

Once you have called up the IMG activity, the system displays a box with all the created scenarios. 

Double-click on the scenario for which you want to create additional data. This takes you to the editing 

screen. 

In the group box Display of Request Data in the Notification, choose the following: 

- The short text to appear in the notification. 

- How the request data is to be displayed in the notification. 

- Whether request fields that have no entry in the form are to be displayed in the table of request data 

in the notifcation/task (extended view). 

- Which style sheet you want for the request data in the notification (selection possible if you have 

created your own CSS style sheets, otherwise the standard is used). 

- Which HTML template you want to use for the request data in the notification (selection possible if 

you have created your own HTML templates, otherwise the standard is used). - The 

component to be started for this scenario in the portal. 

In the group box Scenario Workflow Template, you can specify the workflow template that is to be 

started for the events Create Notification and Notification in Process Again. 

In the group box Additional Characteristics in the Status Overview  choose up to five characteristics 

that are to be also displayed for the identification of the request in the status overview. 

In the group box Additional Characteristics on the Form you can select the date field. This field is 

only used for date characteristics of the type 'date' (type="date"). If you select this field and also define 

showHelp="true" in the JSP, a calendar is displayed for date fields of this type where F4 can be used to 

enter the date. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.3 Object and Data Provider 

37.9.3.3.1 Define Views of the Organizational Structure 

Use 

In this IMG activity, you define the views of the organizational structure used in the Business Package 

for Manager Self-Service. You define views as selection options for particular objects in an 

organizational structure. 

When a manager logs on, the system displays one of the defined views of the organizational structure. In 

some iViews, the manager can navigate from one view to other iViews. He or she can also change the 

view in order to edit other objects. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 496 

The individual iViews have a display function, or the manager can use them to perform tasks in his or her 

area. Therefore, you should define the views according to the manager's particular tasks. 

For example, you can define a view with which the manager can call up a list of the employees directly 

subordinate to him or her, or display all employees along the organizational structure. 

The different views allow the manager to select those objects that are relevant for his or her tasks (for 

example, choosing cost centers, if he or she performs tasks related to budget planning). 

The lists are not restricted to the Person object type. You can also define views for other object types, for 

example views of cost centers. 

Note: 

We provide you with a customer view in which you can define customer-specific views of the 

organizational structure. The standard entries are to be found in the view V_TWPC Definition of Views. 

If you want to override standard entries, you must use the same key as in the standard for each of your 

entries in the customer view, and change the remaining entries. 

Requirements 

The following general prerequisites must be fulfilled: 

- You must map your enterprise's organizational plan in Organizational Management. This 

mapping must include the organizational structure and the staff assignments, that is, the assignments 

between employees (object type Person) or users to positions. 

- The employees or users with a composite role (for example Manager Generic) must be holders of 

a chief position. 

- To display cost centers, you must assign cost centers to the organizational unit or to the chief 

positions. 

- You must define structural authorizations. 

Activities 

If you want to create new entries in the view, you first see a selection screen on which you define the 

details of the view you want to edit. Then the system displays detailed maintenance for the view. 

- Determine Root Objects 

To display views of the organizational structure, the system must first determine the root objects. 

In the Evaluation Path field, you save an evaluation path for this purpose. The root objects 

should be the organizational units where the manager holds the chief position. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 497 

Starting from each individual root object, the system follows the evaluation path entered in the 

Evaluation Path Objects field and determines all the organizational objects that lie below the root 

object. 

Alternatively, in the Function Module for Root Objects field, you can save a function module that 

returns root objects. As a template, we deliver the function module HRWPC_PATHROOTS 

(Function Module for Determining Root Objects). 

- Define Column Groups 

In the Column Group field, enter the column group under which you want the system to display a 

view. 

Note that you create the columns in the view V_WPC_COL (Column Definition). To do that you 

must perform the IMG activity Define Columns. 

For more information, see the IMG activity documentation, under Define Columns. 

- Overwrite Column Headers 

If you want to overwrite the headers of individual columns, enter the header type that your header is 

assigned to in the Header Type field. 

Note that you must first execute the IMG activity Redefine Column Headers. In that IMG activity 

you assign header types to your headers. 

For more information, see the IMG activity documentation, under Redefine Column Headers. 

- Define Output 

If you select the Delete Duplicates field, the system deletes duplicates of objects from the list. 

- Exclude Manager 

If you set this indicator, the system deletes the user who is logged on and the person assigned to this 

user (Communication infotype (0105)) from the output list. In addition, all users or persons who 

fulfill the following criteria are deleted from the output list or structure: 

- Users or persons who are holders of a chief position 

- Chief positions displayed in the output list or structure 

In the standard system, the following algorithm is used to determine the chief position: 

1. Starting from the user who is logged on, the evaluation path MANASS is used to determine all chief 

positions L and the related organizational units O. 

2. For each organizational unit O, the evaluation path B012 is used to determine all assigned chief 

positions and they are added to the set of L. 
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3. For each occurrence of a position from the set of L in the output list or structure, the users or persons 

assigned to this position are deleted. 

To ensure that this algorithm functions correctly, you must have set up Organizational Management in 

keeping with the standard SAP system. Two customer exits exist to ensure that the algorithm functions 

correctly for customer-specific relationships and reports: 

- EXIT_SAPLHRWPC_TO_REMOTE_001: This exit enables customers to exclude managers from 

the output list or structure manually. 

- EXIT_SAPLHRWPC_TO_REMOTE_002: This exit enables customers to replace the standard 

evaluation path MANASS. 

Note: If you implement exit 001, exit 002 is not called. 

37.9.3.3.2 Define Display of Object Types 

Use 

In this IMG activity you specify the object types that you want the system to display in the Manager 

Self-Service business package. 

For example: if, in the IMG activity Define Views of the Organizational Structure, you have created 

customer-specific views that also display customer-specific object types, you can use the current IMG 

activity to restrict individual views to objects of a particular type. You can also restrict SAP views to 

particular object types. 

Note: 

Note that SAP provides a customer view in which you can define customer-specific assignments of views 

to object types. The entries in the standard delivery are found in the view V_TWPC_OTYPES (Object 

Types to be Displayed in the List). 

If you want to overwrite entries in the standard, you must use the same key as in the standard for each of 

your entries in the customer view, and change the remaining entries. 

Requirements 

You have performed the IMG activity Define Views of the Organizational Structure. 

For further information, see the IMG activity documentation, under Define Views of the Organizational 

Structure. 
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37.9.3.3.3 Group Views of Organizational Structure 

Use 

In this IMG activity you group the indiviual views of organizational structures together and specify the 

position of the views within a view group. 

The system displays these groups on the user interface. It displays the individual views in a group in a list 

box, in the order that you define using position numbers. 

The manager can select individual views by choosing a view of the organizational structure from a view 

group (for example the view Directly Subordinate Employees). 

Note: 

Note that SAP provides a customer view in which you can define customer-specific assignments of views 

to object types. The entries in the standard delivery are found in the view V_TWPC_VG Grouping the 

Views. 

If you want to overwrite the standard entries, you must use the same key as in the standard for each of 

your entries in the customer view, and change the remaining entries. 

Note that the order of the views can sometimes change randomly. This is the case if you add a view to a 

view group, and assign a position number that is already assigned in the standard delivery (see the view 

V_TWPC_VG (Grouping the Views)). 

Example 

In the view V_TWPC_VG (Grouping the Views), in view group VG1, you have specified the positions 

1, 2, and 3 for the views V1, V2, and V3 respectively. If, in the current IMG activity - in other words in 

the view V_TWPC_VG_C (Grouping the Views - Customer) you add view V5 to the view group VG1 

and assign it position number 2, the system may display the order of the views as follows: 

- The system displays the views in the order V1, V5, V2, and V3. 

- The system displays the views in the order V1, V2, V5, and V3. 

Recommendation 

If you do not want the system to display individual views of the organizational structure that are in the 

standard delivery, you can hide them. 

To do this, you make an entry for the view of the organizational structure that you want to hide, and 

assign the position number 0 to it. 

37.9.3.3.4 Define Columns 
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Verwendung 

In this IMG activity you define columns and thereby specify the form, content, and function of each 

column. 

Note: 

Note that this view contains a customer namespace. Customer-specific entries must start with Y or Z. 

The following dependencies exist for entries in the PCD Service and FM for External Link fields: 

- You must either fill the PCD Service and the FM for PCD Parameters fields, or only the FM for 

External Link field. 

- If you fill all three fields, the system ignores the entry in the FM for External Link field. 

37.9.3.3.5 Redefine Column Headers 

Use 

In this IMG activity you can overwrite column headers. You can thereby save column headers that 

depend on the context or that depend on the object type displayed. For example, you can label a column 

Cost Center when the system displays cost centers, and Personnel Number when the system displays 

people or employees. 

Note: 

Note that the view V_TWPC_COLHTYP (Definition of Column Header Types contains a customer 

namespace. Customer-specific entries must start with Y or Z. 

Note that SAP provides customer views in the views V_TWPC_COLHEAD_C (New Definition of 

Column Headers - Customer) and V_TWPC_V_C (View Definition - Customer). 

In the standard delivery, the entries are in the views V_TWPC_COLHEAD (New Definition of Column 

Headers and V_TWPC_V (View Definition). 

If you want to overwrite entries from the standard delivery, you must keep the same key as in the standard 

for each of your entries in the customer view, and change the remaining entries. 

Note that you do not have to perform the Define Header Type step if you only want to change an 

existing header type. 

Activities 

- To overwrite a column header, you must first define a header type. You define a header type in the 

view V_TWPC_COLHTYP (Definition of Column Header Types), in other words in the Define 

Header Type step. The view V_TWPC_COLHEAD_C (New 

Definition of Column Headers - Customer) uses this header type to define the new header. To 

do this, use the Define Header and Assign to Header Type step. 
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- To enter new headers for a view of an organizational structure, enter the header type in the view 

V_TWPC_V_C (View Definition -Customer), in other words perform the IMG activity Define 

Views of the Organizational Structure. For further information, see the documentation on the 

IMG activity Define Views of the Organizational Structure. 

- To define a customer-specific header type, create one in the Define Header Type step, using a key 

with Y* or Z*. Then, in the Define Header and Assign to a Header Type step, assign your 

headers to the header type. 

- To overwrite a header that SAP delivers, perform the Define Header and Assign to a Header 

Type step and enter the header type of the T_TWPC_COLHEAD (New 

Definition of Column Headers) view in the customer view V_TWPC_COLHEAD_C (New 

Definition of Column Headers - Customer). Then allocate customer-specific headers to the 

columns that you want to change. 

37.9.3.3.6 Define Column Groups 

Use 

In this IMG activity you group columns into column groups. To do this, you define new column groups or 

change existing column groups. 

In addition, you can make the following settings: 

- Allocate positions to individual columns in a column group 

- Set visibility attributes 

- Define coherence relationships between individual columns 

If you want the system to only hide or display columns as a group, you can define a coherence 

relationship. Columns that you might want to hide or display together are, for example, columns that 

display the start date and end date. You can define a name for the coherence relationship. 

Activities 

1. Create a Column Group 

Note that the name that you create for a column group does not appear on the user interface. It is 

simply for documentation purposes. 
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2. Assign the Columns to a Column Group 

3. You can then enter the column groups you created in the V_TWPC_V_C (View 

Definition - Customer) view, in other words you perform the IMG activity Define Views of the 

Organizational Structure. For further information, see the documentation for the IMG activity: 

Define Views of the Organizational Structure. 

Note: 

Note that the view V_TWPC_ARRAYTP (Definition of Column Groups) contains a customer 

namespace. Customer-specific entries must start with Y or Z. 

Note that the view V_TWPC_ACOL_C (Put Columns Together in a Column Group Customer) is a 

customer view. 

The standard entries are in the view V_TWPC_ACOL (Put Columns Together in a Column Group). 

If you want to overwrite entries in the standard delivery, you must use the same key as in the standard for 

each of your entries, and change the remaining entries. 

37.9.3.3.7 Define Hierarchical Column Groups 

Use 

In this IMG activity, you define hierarchical groupings of columns and column groups. 

If you group columns and column groups hierarchically, when you choose a column group, the system 

displays the columns and column groups that are below it in the hierarchy as well. 

You can use this function, for example, to display a column in a particular context in addition to the 

columns of an already defined column group. 

Note: 

Note that SAP provides a customer view here. The entries in the standard delivery are in the view 

V_TWPC_HIERATP (Hierarchical Column Groups). 

If you want to overwrite entries from the standard delivery, you must use the same key as in the standard 

for each of your customer entries, and change the remaining entries. 

Example 1: 

You assign the column groups XYLARAYTP2 and XYLARRAYTP4 to the column group 

XYLARRAYTP3. 

If a manager chooses the columns in the column group XYLARRAYTP3, the system automatically 

displays the columns in the column groups XYLARAYTP2 and XYLARRAYTP4 as well. 

Example 2: 

In a particular context you want to add a column to an existing column group. To do that, you define a 

column and a new column group, to which you assign the column. This is done in the IMG activities 

Define Columns and Define Column Groups. Then, in the current IMG activity, you add the column 
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group to the hierarchy. Do that by assigning the newly created column group to the column group in 

which you want the system to display the additional column. 

For further information, see the IMG activity documentation under Define Columns and Define Column 

Groups. 

37.9.3.3.8 Define Coherence Relationships 

Use 

In this IMG activity you define coherence relationships. These have the effect that the system only 

displays or hides particular columns together on the user interface. 

When you create coherence relationships, you can use the definitions in the IMG activity Define 

Column Groups. 

For further information, see the IMG activity documentation under Define Column Groups. 

Note: 

Note that this view contains a customer namespace. Customer-specific entries must start with Y or Z. 

37.9.3.3.9 Define Navigation Objects 

Use 

In this IMG activity you can define navigation types that allow you to restrict views to particular object 

types. 

If the system displays too many objects in a view, this function offers the following advantages: 

- It improves display performance. 

- It offers the manager a better overview of the objects. 

To restrict views, you define particular objects as navigation objects. The system displays the navigation 

objects separately (for example in a table, combo box...) above the view. 

If a manager selects a navigation object, the system restricts the view to certain objects. 

Note: 

Note that the view V_TWPC_NAV (Define Navigation Attributes) contains a customer namespace. 

Customer-specific entries must start with Y or Z. 

Requirements 
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You must have performed the IMG activity Define Views of the Organizational Structure and you 

must have defined a view for which you define navigation types in the current IMG activity. 

Activities 

1. In the Navigation ID field, enter a name for your navigation type. 

2. In the View field, assign an already defined view of the organizational structure. You can use views 

that you created in the IMG activity Define Views of the Organizational Structure, or views that 

SAP delivers in the view V_TWPC_V_C (View Definition Customer). 

3. Enter an evaluation path in the Evaluation Path field. The system applies the path to the root 

objects and determines the navigation objects. 

For further information on determining root objects, see the documentation on the IMG activity: 

Define Views of the Organizational Structure. 

4. If applicable, specify in the Depth field the level of the organizational structure to which you want 

the system to evaluate objects according to the evaluation path. 

37.9.3.3.10 Restrict Number of Navigation Objects 

Use 

In this IMG activity you can restrict the set of navigation objects that you created in the IMG activity 

Define Navigation Objects to particular object types. 

Note: 

Note that SAP provides a customer view here, in which you can define customer-specific assignments 

between navigation objects and object types. The entries of the standard delivery are in the view 

V_TWPC_NAVOTYPE (Object Types Eligible for Navigation). 

If you want to overwrite the entries in the standard delivery, you must use the same key as in the standard 

for each of your entries, and change the remaining entries. 

Requirements 

You have performed the IMG activity Define Navigation Objects. 

For further information see the documentation on the IMG activity, under Define Navigation Objects. 
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37.9.3.3.11 Take Table Settings from Column Framework 

Use 

In this IMG activity you transfer table entries from the column framework to tables of the object and 

data provider. 

If you have been using the column framework of Organizational Management, for instance in the 

Manager's Desktop application, and want to continue using it in the Manager 

Self-Service business package, you can use the conversion report 

PWPC_TO_CONVERT_TABLES to integrate table entries from the column framework into tables of 

the object and data provider. This means that you can use previously defined columns and column 

groups: 

For more information, refer to the report documentation. 

37.9.3.4 Attendance Overview 

37.9.3.4.1 Convert Availability Status to Attendance Status 

Use 

In this IMG activity you can use the enhancement HRWPCAS (Converting Availability Status to 

Attendance Status) to convert the availability status into the attendance status. 

For further information, see the Enhancement documentation. 

37.9.3.5 Employee Review 

37.9.3.5.1 Define Wage Types for Annual Salary 

Use 

In this IMG activity, you can define wage types for salaries and bonuses, for instance. The system uses 

these to determine the annual salary and displays the annual values determined for the wage types in the 

Employee Review workset, in the Salary Development (com.sap.pct.hcm.salaryhistory.ivu)iView. 
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The iView can determine annual values for payroll results or for the infotypes Basic Pay (0008), 

Recurring Payments and Deductions (0014), and Additional Payments (0015). In either case, you 

must perform this IMG activity. 

Recommendation 

When creating wage types, we recommend you use subapplication MSSH because the technical key of 

the subapplication must be stored as the value of the PCD parameter Wage Type 

Application from VC_596A_C for the Salary Development 

(com.sap.pct.hcm.salaryhistory.ivu) iView in portal administration (content administration). The value 

MSSH is stored in the standard delivery of the Business Package for Manager Self-Service. This means 

that when you use this technical key, you do not need to process the PCD parameter. 

Activities 

1. Create a subapplication (for example, MSSH). 

2. Define for this subapplication the cumulation wage types that the system should display in the 

Salary Development iView (for example, the technical key 1SAL and the cumulation wage-type 

text Salary, and the technical key 2BON and the cumulation wage-type text Bonus). 

Note 

Note that the system displays the cumulated wage types sorted according to your technical keys. 

3. For each cumulation wage type, define the relevant wage types. 

Note 

If you want the system to determine the annual salary based on the infotypes Basic Pay (0008), 

Recurring Payments and Deductions (0014), and Additional Payments (0015) as opposed to 

payroll results, you must use a wage type in this process step that refers to a module in view 

V_T511 (Wage Type Characteristics). You must have defined this module in view V_T539J 

(Basic Wage Type Valuation). 

Further notes 

If you use a technical name for the subapplication that differs from our recommendation, you must adjust 

the PCD parameter accordingly. 

37.9.3.5.2 Adjust Periods for Annual Salary 

Use 

In this IMG activity, you can use the enhancement HRWPCEP1 (SAP Enhancement for Employee 

Profile) to make customer-specific changes to the periods used to determine the annual salary. 
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Further notes 

For more information, see the documentation for the enhancement. 

37.9.3.5.3 Filter Absence Records 

Use 

In this IMG activity you can use the enhancement HRWPCABS (Filtering Absence Records) to 

specify whether the system should only display certain absence records of a particular absence type in 

the iView Employee Review. 

For further information, see the documentation on the Enhancement. 

37.9.3.6 Personnel Change Requests 

37.9.3.6.1 Define Employee Groupings 

Use 

In this IMG activity you specify employee groupings for change requests. 

In the iView Change Request for Employee Data you can use employee groupings to create 

employee-specific assignments of request types to request scenarios. 

You usually group the employees independently of the scenarios. This means that the grouping is valid 

for all scenarios. 

37.9.3.6.2 Define Change Request Types 

Use 

In this IMG activity you define the data that is necessary for the change requests, in other words you 

define the request types. 

37.9.3.6.3 Group Change Request Scenarios 
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Use 

In this IMG activity you assign your request scenarios to request types and employee groupings. 

Request types bundle the scenarios according to time and employee groupings. 

You can use employee groupings to control the employee-specific assignment of request scenarios to 

request types. 

37.9.3.6.4 Define Scenario Attributes 

Use 

In this IMG activity you assign specific HR attributes to the request scenarios. You can assign a personnel 

administrator type to your scenarios. In other words you can specify, for example, that a scenario should 

be further processed by a personnel administrator for Payroll. In addition, you can specify the affected 

personnel action, so that a personnel administrator can postprocess changes in the system. 

Note: 

SAP recommends that you create a personnel action for each request scenario. 

Note that you must in any case create the personnel action for the request scenarios Position Change 

and Internal Reassignment. 

37.9.3.6.5 Define Reasons for Special Payment 

Use 

In this IMG activity you define the reasons for special payments that you want to use in the iView 

Change Request for Employee Data in the Special Payment request scenario. 

When you have done this, the system shows the manager the possible reasons for a special payment, and 

the manager can select one. 
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37.9.3.6.6 Assign Wage Types to Special Payment Reasons 

Use 

In this IMG activity you assign wage types for the request scenario Special Payments to the special 

payment reasons. In addition, you specify whether you want to allow the manager to enter the special 

payment reason him- or herself. 

37.9.3.6.7 Set Up Workflows for Personnel Change Requests 

Use 

In this activity, you can set up workflows for the approval processes that are needed for personnel change 

requests. This includes the following workflow templates: 

- Submit Change Request (0) (50000042) -

 Submit Change Request (1) (50000041) -

 Submit Change Request (2) (50000031) Note 

The numbers specified in parentheses in the name of the workflow template specify the number of 

approval steps the change request must run through after it has been sent. 

To implement these workflows, you must assign agents to the relevant tasks contained in each of the 

workflow templates and activate event linkage, that is the events that trigger the workflow. 

Standard settings 

In the standard system, agents are not yet assigned for the workflow template and event linkage is 

deactivated. 

Activities 

Perform Customizing activity (transaction PCRWF). The screen Task Customizing Overview appears, 

which displays in a tree structure the activities you need to perform. 

- Assign Agents to Tasks -

 Activate Event Linkage 
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Agent Assignment 

First perform activity Assign Agents to Tasks. The screen Task Group: Maintain Agent Assignment is 

displayed. Here, the workflow templates to be implemented are also displayed in a tree structure for 

selection. 

Assign agents one after another for each of the workflow templates. 

1. Expand the tree structure for one of the workflow templates. This displays all tasks that belong to 

this workflow and, if necessary, any additional workflow templates that can be called within this 

workflow. 

2. To assign the agent, place the cursor on a task and choose Create Agent Assignment from the 

function bar or menu. 

Note 

Behind each task is displayed whether or not it is a background task. If it is a background task, you 

do not need to or cannot assign an agent. 

If the task is not a background task, the dialog screen Choose Agent Type is displayed after you have 

chosen a function. 

3. Choose an Agent Type (for example, object type Position). 

4. Then choose the relevant agent (that is, the concrete position) 

5. Perform all agent assignments for the displayed tasks in this way. To leave agent assigning, choose 

Back. 

Activating Event Linkage 

Perform activity Activate Event Linkage. The screen Event Linkage: Triggering Events is displayed. Here, 

the workflow templates are displayed once more in a tree structure for selection. For each of the 

workflow templates, activate the events that trigger the individual workflows. 

1. Expand the tree structure for one of the workflow templates. All triggering events are displayed for 

the appropriate workflow template. Behind each event is displayed whether or not it is activated or 

deactivated. 

2. Activate the events of the workflows you want to use. To do this, position the cursor on the event 

and choose Activate/Deactivate Event Linkage from the function bar or menu, or double-click on the 

event. 

If you want to deactivate an event, do exactly the same. 

Note 

The icon displayed behind the event enables you to display the attributes of event linkage. The 

function Display Object in the function bar, or Goto in the menu, enables you to display the 

business object for which the triggering event is used. 

See also 

For more information on workflow templates, see: 

- Agent Assignment: 
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To display the workflow template, choose the Attributes function from the function bar or Edit 

from the menu when you have positioned the cursor on the relevant workflow template or double-

click on the workflow template. The workflow template is displayed. 

- Activate Event Linkage 

When you have positioned the cursor on the relevant workflow template, choose the function Goto -

> Display Object from the menu. 

37.9.3.6.8 Enhancements 

37.9.3.6.8.1 BAdI: Adjust Employee Groupings 

With this Business Add-In (BAdI) you can make customer-specific assignments of employees to 

employee groupings in the context of change requests. 

For further information on using employee groupings in change requests for employees, see the 

documentation on the field Employee Groupings for Change Requests(HRWPC_PCR_PCR_EEGRP). 

Requirements 

You must have defined the employee groupings in the settings for the business package Manager Self-

Service (transaction SIMG_SPORT). 

Standard settings 

This BAdI is not implemented in the SAP standard. If you do not create an implementation, the system 

runs the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 
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4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such 

a case, end the processing stage at this point. 

 9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust Employee - Employee Grouping Assignment.  
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37.9.3.6.8.2 BAdI: Adjust Header Data in Request Forms 

With this Business Add-In (BAdI) you can format the header data in change request forms for employee 

data to suit your requirements. 

You have, for example, the following option: 

 - You can format the employee name in a customer-specific way. 

This is useful if the display based on I0001-ENAME is not satisfactory. You can put together the 

elements of the employee name (title, first name, last name, and so on) as you wish. 

Example 

For example code, see the documentation on the MANIPULATE_INIT_DATA method. 

Standard settings 

This BAdI is not implemented in the SAP standard. If you do not create an implementation, the system 

runs the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 
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Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust Header Data in Change Request Forms. 

37.9.3.6.8.3 BAdI: Adjust Entry Help in Request Forms 

With this Business Add-In (BAdI) you can make customer-specific adjustments to the entry help in 

change request forms for employee data. 

For fields that consist of a technical name and a descriptive name, the standard is that the entry help 

offers, in a list box, a combination of both names, connected by - (hyphen). 

Example 

You can specify that for particular fields - for example Employee Subgroup (PERSK) - the system should 

not use the technical name, and should only display the descriptive name. 

For a coding example, see the documentation on the method MANIPULATE_ADD_VALUES (Adjust 

Entry Help for Change Request Forms). 

Standard settings 

The BAdI is not implemented in the SAP standard. If you do not create an implementation, the system 

runs the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, 

and choose Create. 

The screen for creating BAdI implementations is now displayed. 
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2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust Entry Help for Change Request Forms. 

37.9.3.6.8.4 BAdI: Adjust Effective Date for Request Forms 

This Business Add-In (BAdI) enables you to set the effective date in the form header of personnel change 

requests customer-specifically. 

You have the following option: 

 - You can preset the effective date. 

As standard, the system always uses the system date (SY-DATUM) as the initial value for the 

effective date. In that case managers must usually overwrite the date. If change requests are subject 

to general enterprise rules (for example change requests always become valid at the end of the next 

month or quarter), you can use this BAdI to preset the date. 

Example 

For example code, see the documentation for the method MANIPULATE_EFF_DATE. 

Standard settings 

This BAdI is not implemented in the SAP standard. Unless you create an implementation, the system runs 

the standard code. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 516 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

InterfaceMethod: Adjust Effective Date in Change Request Forms. 

37.9.3.6.8.5 BAdI: Adjust Check for Effective Date 

Use 

This Business Add-In (BAdI) enables you to implement a customer-specific check for the effective date. 

The effective date refers to the date as of which any changes to employee data are valid. 

Standard settings 
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This BAdI is not implemented in the standard SAP System. If you do not create an implementation, the 

system runs through the standard code. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, 

and choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

See also 

Interface IF_EX_HRWPC_PCR_CHECK_DATE 

Method CHECK_EFFECTIVE_DATE (Customer-Specific Check for Effective Date) 

37.9.3.6.8.6 BAdI: Adjust Rule Resolution for Receiving Manager 

Use 
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This Business Add-In (BAdI) enables you to tailor the rule resolution of rule ApproverForm (50000132) 

to suit customer requirements. The entire rule container is available for this purpose. 

Example 

The rule ApproverForm is used within the approval workflow ProcessPCR_2 (50000031) for personnel 

change requests to determine the approver. 

If this rule resolution fails, the entire workflow is terminated. You can use this Business Add-In to 

implement customer-specific error handling in the event of the standard rule resolution failing. 

Workflow ProcessPCR_2 (50000031) is used in the transfer scenario, for example, and is triggered after 

the Request for Transfer form has been submitted. 

Standard settings 

This BAdI is not implemented in the standard SAP System. If you do not create an implementation, the 

system runs through the standard coding. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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See also 

Interface IF_EX_HRWPC_PCR_APPR_FORM 

Method  MANIPULATE_ACTOR_TAB (Change the Processing Table for Rule Resolution) 

37.9.3.6.8.7 BAdI: Adjust Rule Resolution for Higher-Level Manager 

37.9.3.7 Recruitment  
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37.9.3.7.1 Create Values for Applicant Ranking 

Use 

In this IMG activity you can store the possible values that allow a manager to assign a rank to applicants 

in the Vacancies and Applicants workset. The manager can then create a personal ranking list when 

filling a vacancy.  
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37.9.3.7.2 Define Assignment Status Display 

Use 

In this IMG activity you can specify which vacancy assignment status (abbreviation: assignment status) 

the system displays in the Vacancies and Applicants workset. 

The system evaluates this view in the evaluation path HRWPCREC. 

37.9.3.7.3 Set Up Workflows for Recruitment Scenario 

Use 

In this activity, you can set up workflows for the approval processes that are needed for recruitment 

forms. This includes the following workflow templates: 

- Submit Vacancy Request for Position (21300037) 

- Invite Applicant (50000038) 

- Reject Applicant (50000039) 

- Offer Applicant Contract (50000040) 

To implement these workflows, you must assign agents to the relevant tasks contained in each of the 

workflow templates and activate event linkage, that is the events that trigger the workflow. 

Standard settings 

In the standard system, agents are not assigned for the workflow template and event linkage is 

deactivated. 

Activities 

Perform Customizing activity (transaction RECRWF). The screen Task Customizing Overview appears, 

which displays in a tree structure the activities you need to perform. 

- Assign Agents to Tasks 

- Activate Event Linkage 

Agent Assignment 
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First perform activity Assign Agents to Tasks. The screen Task Group: Maintain Agent Assignment is 

displayed. Here, the workflow templates to be implemented are also displayed in a tree structure for 

selection. 

Assign agents one after another for each of the workflow templates. 

1. Expand the tree structure for one of the workflow templates. This displays all tasks that belong to 

this workflow and, if necessary, any additional workflow templates that can be called within this 

workflow. 

2. To assign the agent, place the cursor on a task and choose Create Agent Assignment from the 

function bar or menu. 

Note 

Behind each task is displayed whether or not it is a background task. If it is a background task, you 

do not need to / cannot assign an agent. 

If the task is not a background task, the dialog screen Choose Agent Type is displayed after you have 

chosen a function. 

3. Choose an Agent Type (for example, object type Position). 

4. Then choose the relevant agent (that is, the concrete position) 

5. Perform all agent assignments for the displayed tasks in this way. To leave agent assigning, choose 

Back. 

Activating Event Linkage 

Perform activity Activate Event Linkage. The screen Event Linkage: Triggering Events is displayed. Here, 

the workflow templates are displayed once more in a tree structure for selection. For each of the 

workflow templates, activate the events that trigger the individual workflows. 

1. Expand the tree structure for one of the workflow templates. All triggering events are displayed for 

the appropriate workflow template. Behind each event is displayed whether or not it is activated or 

deactivated. 

2. Activate the events of the workflows you want to use. To do this, position the cursor on the event 

and choose Activate/Deactivate Event Linkage from the function bar or menu, or double-click on the 

event. 

If you want to deactivate an event, do exactly the same. 

Note 

The icon displayed behind the event enables you to display the attributes of event linkage. The 

function Display Object in the function bar, or Goto in the menu, enables you to display the 

business object for which the triggering event is used. 

See also 

For more information on workflow templates, see: 

- Agent Assignment: 

To display the workflow template, choose the Attributes function from the function bar or Edit 

from the menu when you have positioned the cursor on the relevant workflow template or double-

click on the workflow template. 
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- Activate Event Linkage 

When you have positioned the cursor on the relevant workflow template, choose the function Goto -

> Display Object from the menu. 

37.9.3.7.4 BAdI: Adjust HTML Format for Short Profile 

This Business Add-In (BAdI) lets you edit the display of applicant short profiles in HTML format. 

The BAdI, which defines the HTML format, affects all of the short profiles that you have created in 

Customizing for Recruitment under Applicant Management -> Short Profile -> Create Standard 

Text in SAPscript format. 

In SAPscript format, indentations are often indicated by means of spaces. However, browsers generally 

ignore repeated spaces in the display. For this reason, the default programming of the BAdI replaces 

repeated spaces with the HTML format &nbsp. The effect of this is that all of the spaces are dislayed. To 

highlight indentations, the BAdI sets the font to the non-proportional font Courier. 

The function module  HRWPC_RFC_RC_GET_SHORTP_HTML renders an applicant short profile in 

HTML format. If you select the indicator MANIPULATE_HTML in the function module, the system 

runs the BAdI. 

Per default the system calls the function module  HRWPC_RC_MANIPULATE_HTML_SP in the BAdI. 

You can create a customer-specific implementation for this BAdI if you want to adjust the HTML format 

to suit your own requirements. 

Standard settings 

The BAdI is not implemented in the standard system. If you create no implementation, the system runs 

the standard code. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 
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The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Interface 

Method: Adjust the HTML Format of Applicant Short Profiles 

37.9.3.8 Compensation 

37.9.3.8.1 Set Up Workflow for Compensation Adjustments 

Use 

In this process step, you can set up the workflow for approval processes that are needed for compensation 

adjustments. 

You can choose between two alternative workflow templates: 

- Approval Process for Compensation Adjustments (1000083) 

- Web-Approval Process for Compensation Adjustments (21300038) 

The main difference between these two workflow templates is that workflow template 21300038 is Web-

enabled and was developed specifically for Web-based approval processes, whilst workflow template 

1000083 is not Web-enabled. 

If you want to use the approval process via the Business Package for Manager Self-Service, you must 

implement workflow template 21300038. 

To implement one of these workflows, you must assign agents to the relevant tasks contained in the 

workflow template and activate event linkage, that is, the events that trigger the workflow. 
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Standard settings 

In the standard system, agents are not assigned for the workflow template and event linkage is 

deactivated. 

Activities 

Perform Customizing activity (transaction HRWPC_CMP_WORKFLOW). The screen Task Customizing 

Overview appears, which displays in a tree structure the activities you need to perform. 

- Assign Agents to Tasks -

 Activate Event Linkage 

Agent Assignment 

First perform activity Assign Agents to Tasks. The screen Task Group: Maintain Agent Assignment is 

displayed. Here the workflow templates are also displayed in a tree structure for selection. 

Assign an agent for the worklow template that you want to implement. 

1. Expand the tree structure for the workflow template. This displays all tasks that belong to this 

workflow and, if necessary, any additional workflow templates that can be called within this 

workflow. 

2. To assign the agent, place the cursor on a task and choose Create Agent Assignment from the 

function bar or menu. 

Note 

Behind each task is displayed whether or not it is a background task. If it is a background task, you 

do not need to / cannot assign an agent. 

If the task is not a background task, the dialog screen Choose Agent Type is displayed after you have 

chosen a function. 

3. Choose an agent type (for example, object type Position). 

4. Then choose the relevant agent (that is, the concrete position). 

5. Perform all agent assignments for the displayed tasks in this way. To leave agent assigning, choose 

Back. 

Activating Event Linkage 

Perform activity Activate Event Linkage. The screen Event Linkage: Triggering Events is displayed. Here, 

the workflow templates are displayed once more in a tree structure for selection. Activate the event that 

triggers the workflow for the selected workflow template. 

1. Expand the tree structire for the workflow template. The triggering event is displayed for the 

appropriate workflow template. Behind the event is displayed whether or not it is activated or 

deactivated. 

2. Activate the triggering event of the workflow that you want to use. To do this, position the cursor on 

the event and choose Activate/Deactivate Event Linkage from the function bar or menu, or double-

click on the event. 
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3. Proceed as before to deactivate the triggering event of the workflow template that you do not want 

to implement. 

Note 

Event linkage may only be activated for the workflow template that you want to implement. 

The icon displayed behind the event enables you to display the attributes of event linkage. Function 

Display Object in the function bar, or Goto in the menu, enables you to display the business object 

for which the triggering event is used. 

See also 

For more information on workflow templates, see: 

- Agent Assignment: 

To display the workflow template, choose the Attributes function from the function bar or Edit from 

the menu, position the cursor on the relevant workflow template or double-click on the workflow 

template. 

- Activate Event Linkage 

When you have positioned the cursor on the relevant workflow template, choose the function Goto -

> Display Object from the menu. 

37.9.3.9 Quota Planning 

37.9.3.9.1 Set Up ALE Scenario AC - HR 

Use 

In this IMG activity you set up the ALE Scenario Transfer Quota Planning Results to Accounting 

(AC). You must set up this scenario if you use Organizational Management and Accounting in two 

separate systems. 

Functions in the HR System: Sending System (Server) 

When you transfer the results of quota planning to CO, the system adjusts the time-specific planning 

results to the corresponding periods in CO. The results are then updated in CO. In distributed systems, the 

read, write and validation checks are all carried out in the CO System. For this reason, before every cross-

system operation, the HR System determines the receiving system by means of your entries in the 

distribution model. 

- When the planning data has been formatted into periods, the system reads the relevant data in the 

CO System with the help of a BAPI. 

- Once posting of the planning data has been triggered, the following takes place: 

- The system checks the posting data against CO data with the help of a synchronous BAPI. 

- The system transmits the data via ALE asynchronously to the receiving system. 
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Functions in the CO System: Receiving System (Client) 

The system posts data to the CO System. 

Setting Up the Distribution Model 

To ensure the communication flow between the two systems, you must specify a message type and/or an 

object with the corresponding method when you set up the distribution model. Enter the following for 

sending and receiving systems: 

- Sender/Client: HR System 

- Recipient/Server: CO System 

Object Name            Method         Meaning 

BUS6031 PlanDataTransferCO.GetSourceInfos Information on settings of planning data source 

BUS6031 PlanDataTransferCo.CheckKeyFigures Plandatentransfer: Check statistical key figures 

BUS6031 PlanDataTransferCo.PostKeyFigures Plandatentransfer: Post statistical key figures 

Partner Profiles 

You can generate the partner profiles from the distribution model. For more information on this, refer to 

the implementation guide (IMG) for Basis under Application Link Enabling (ALE) -> Business 

Process Modeling and Implementation -> Setting Up Partner Profiles and Processing Time -> 

Generate Partner Profiles . 

Settings in the HR System 

You must set the following switches in your HR system in table T77S0 (system table): 

- SKFCO / COPLS (plan source for CO data transfer) 

- SKFCO / KFACNT (stat. key figures: number of positions (change)) 

- SKFCO / KFBCNT (stat. key figures: number of positions (budget)) 

For more information, refer to the documentation for the business package Manager Self-Service 

under Technical Description ->  iView Pool -> Quota Planning. 

Settings in the CO System 

In the CO System, you must first create the statistical key figures you want to use in table T77S0 (system 

table). 

Activities 

1. Check whether the methods listed have been created for object BUS6031 in your customer 

distribution model. 

2. Ensure that the required CO data has been distributed to the HR System. 
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37.9.3.9.2 BAdI: Transfer Planing Results to Accounting 

This Business Add-In allows you to realize customer-specific requirements when transferring required 

positions planning to CO. 

For further information, see the following documentation: 

- Interface Documentation 

- Method Documentation 

Example 

For an example implementation, see the class CL_IM_HRWPC00_HEADCNT2CO -

 Implementation Documentation 

37.9.3.10 Easy Task Planning 

37.9.3.10.1 Specify Number Range Intervals for Easy Task Planning 

Enter an internal number range interval for task planning. The SAP System issues the numbers for 

internal number range intervals automatically. This number is between the From number and the To 

number. 

Activities 

1. Enter the object name ETP_TASKNR. 

2. Choose Goto -> Number Ranges. 

3. Choose Interval -> Change. 

4. Choose Edit -> Insert Interval. 

5. No.: Assign assignment number 01 to the number range interval. 

6. From number: Enter the first number that is to be assigned. 

7. To number: Enter the last number that is to be assigned. 

8. Ext.: Do not select this field. 
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9. Choose Insert (click on the icon or the enter button) 

10. Save your entries. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.10.2 Delete Tasks 

In this activity you can physically delete tasks, which can be useful for increasing performance. 

It is also possible to delete tasks on the Web frontend, but these only disappear from the display without 

actually being physically deleted. 

Activities 

You restrict the tasks to be deleted by using different criteria and then delete these tasks. 

If you have selected Test run, then no tasks are deleted. Instead you receive information on how many 

tasks would have been deleted. This enables you to decide whether deletion is worthwhile. 

Further notes 

Under status, you can also select 9 = deleted. This refers to tasks that have been deleted on the Web 

frontend (see above). 

For more information, see the documentation on the Business Package Manager Self-Service. 

37.9.3.11 Cost Center Monitor 

37.9.3.11.1 Create Rules for Critical Line Items 

The monitor displays alerts whenever certain values are not within predefined limits. Rules define the 

conditions under which alerts are displayed. Standard rules are provided by SAP, but you can use this 

transaction to change or delete these rules, or create new ones. 

You can create default rules here (apply to all users) and maintain user-specific rules. 

If you do not edit any rules, the system generates the standard rules. 

Default rules and user-specific rules need to be maintained after each other by different users: 

- The default rules need to be maintained centrally for all users. For this reason, this should be done 

by experts such as administrators or cost accountants who are familiar with the setup of the monitor. 

To prevent default rules from being created by other users, you need to issue authorization for this 

transaction. 

- Users can edit their own user-specific rules to meet their personal requirements. 

- These can also be maintained by an administrator, for example, rules that need to be created for a 

new user. 
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Requirements 

If rules are to be maintained for a user, you need to assign the appropriate personalization dialog to that 

user in the IMG activity Maintain User Personalization Data (transaction 

CMPERS_MAINTAIN_SGL). 

Activities 

The transaction has the same structure as rule maintenance in the Web. It is run in the SAP system 

because it is part of monitor administration. 

1. The default rules are created first (for each controlling area) so that they can be used by all users. 

The controlling area is set when the transaction is called up. You can, however, change this in the 

menu by choosing Extras -> Set Controlling Area. 

2. Then the default rules are copied to the special users so that they are available. These rules cannot be 

changed, but can only be copied or deleted. 

3. You can then add more user-specific rules for each user. If the default rules are not copied to the 

user, the user receives a warning when the first rule is created. 

4. Additional rules can be created for a certain user at any time. These user-specific rules can also be 

edited or deleted. 

5. When the default rules are copied to the user, the old default rules are deleted and the new ones are 

created. 

6. If the personalization for a single user is no longer needed, it can be deleted by the administrator 

using transaction MPO_PERS_DATA_DELETE. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under iView 

Pool -> iViews Manager Self-Service - My Budget. 

37.9.3.11.2 Create Rules for Critical Variances 

The monitor displays alerts whenever certain values are not within predefined limits. Rules define the 

conditions under which alerts are displayed. Standard rules are provided by SAP, but you can use this 

transaction to change or delete these rules, or create new ones. 

You can create default rules here (apply to all users) and maintain user-specific rules. 

If you do not edit any rules, the system generates the standard rules. 

Default rules and user-specific rules need to be maintained after each other by different users: 

- The default rules need to be maintained centrally for all users. For this reason, this should be done 

by experts such as administrators or cost accountants who are familiar with the setup of the monitor. 

To prevent default rules from being created by other users, you need to issue authorization for this 

transaction. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 531 

- Users can edit their own user-specific rules to meet their personal requirements. 

- These can also be maintained by an administrator, for example, rules that need to be created for a 

new user. 

Requirements 

If rules are to be maintained for a user, you need to assign the appropriate personalization dialog to that 

user in the IMG activity Maintain User Personalization Data (transaction 

CMPERS_MAINTAIN_SGL). 

Activities 

The transaction has the same structure as rule maintenance in the Web. It is run in the SAP system 

because it is part of monitor administration. 

1. The default rules are created first (for each controlling area) so that they can be used by all users. 

The controlling area is set when the transaction is called up. You can, however, change this in the 

menu by choosing Extras -> Set Controlling Area. 

2. Then the default rules are copied to the special users so that they are available. These rules cannot be 

changed, but can only be copied or deleted. 

3. You can then add more user-specific rules for each user. If the default rules are not copied to the 

user, the user receives a warning when the first rule is created. 

4. Additional rules can be created for a certain user at any time. These user-specific rules can also be 

edited or deleted. 

5. When the default rules are copied to the user, the old default rules are deleted and the 

new ones are created. 

6. If the personalization for a single user is no longer needed, it can be deleted by the administrator 

using transaction MPO_PERS_DATA_DELETE. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under iView 

Pool -> iViews Manager Self-Service - My Budget. 

37.9.3.11.3 Create Extracts for Critical Line Items 

In this IMG activity you create extracts for the monitor. This enables you to control data selection for the 

rules so that the rules always use current data. 

Recommendation 

This transaction should run overnight in a batch for all users so that users have current data at the start of 

the day. 
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Activities 

Save Extract: If the field is selected, extracts are created. If you want to do a test run, do not select this 

field. A test run shows you which data would be selected. Test runs are only possible for single users. 

User: Enter a single user, or an asterisk (*) for all users. 

Last accessed after: Selects all users who called up the iView after the data entered. This selection 

criterion only works if you run the transaction for all users (asterisk). 

Delete - last accessed before: Deletes the extracts from the database for all users who called up the 

iView before the date entered. This reduces the data volume and improves performance. 

Maximum no. of hits: The system only displays the number of rules that have been specified (only 

works if you run the transaction for a single user). 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under 

Technical Description -> iView Pool -> iViews Manager Self-Service - My Budget -> Generate 

Extracts for Critical Variances and Line Items. 

37.9.3.11.4 Create Extracts for Critical Postings 

In this IMG activity you create extracts for the monitor. This enables you to control data selection for the 

rules so that the rules always use current data. 

Recommendation 

This transaction should run overnight in a batch for all users so that users have current data at the start of 

the day. 

Activities 

Save Extract: If the field is selected, extracts are created. If you want to do a test run, do not select this 

field. A test run shows you which data would be selected. Test runs are only possible for single users. 

User: Enter a single user, or an asterisk (*) for all users. 

Last accessed after: Selects all users who called up the iView after the data entered. This selection 

criterion only works if you run the transaction for all users (asterisk). 

Delete - last accessed before: Deletes the extracts from the database for all users who called up the 

iView before the date entered. This reduces the data volume and improves performance. 

Maximum no. of hits: The system only displays the number of rules that have been specified (only 

works if you run the transaction for a single user). 

Further notes 
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For more information, see the documentation on the Business Package Manager Self-Service under 

Technical Description -> iView Pool -> iViews Manager Self-Service - My Budget -> Generate 

Extracts for Critical Variances and Line Items. 

37.9.3.12 Internal Order Monitor 

37.9.3.12.1 Create Rules for Critical Line Items 

The monitor displays alerts whenever certain values are not within predefined limits. Rules define the 

conditions under which alerts are displayed. Standard rules are provided by SAP, but you can use this 

transaction to change or delete these rules, or create new ones. 

You can create default rules here (apply to all users) and maintain user-specific rules. 

If you do not edit any rules, the system generates the standard rules. 

Default rules and user-specific rules need to be maintained after each other by different users: 

- The default rules need to be maintained centrally for all users. For this reason, this should be done 

by experts such as administrators or cost accountants who are familiar with the setup of the monitor. 

To prevent default rules from being created by other users, you need to issue authorization for this 

transaction. 

- Users can edit their own user-specific rules to meet their personal requirements. 

- These can also be maintained by an administrator, for example, rules that need to be created for a 

new user. 

Requirements 

If rules are to be maintained for a user, you need to assign the appropriate personalization dialog to that 

user in the IMG activity Maintain User Personalization Data (transaction 

CMPERS_MAINTAIN_SGL). 

Activities 

The transaction has the same structure as rule maintenance in the Web. It is run in the SAP system 

because it is part of monitor administration. 

1. The default rules are created first (for each controlling area) so that they can be used by all users. 

The controlling area is set when the transaction is called up. You can, however, change this in the 

menu by choosing Extras -> Set Controlling Area. 

2. Then the default rules are copied to the special users so that they are available. These rules cannot be 

changed, but can only be copied or deleted. 

3. You can then add more user-specific rules for each user. If the default rules are not copied to the 

user, the user receives a warning when the first rule is created. 

4. Additional rules can be created for a certain user at any time. These user-specific rules can also be 

edited or deleted. 
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5. When the default rules are copied to the user, the old default rules are deleted and the new ones are 

created. 

6. If the personalization for a single user is no longer needed, it can be deleted by the administrator 

using transaction MPO_PERS_DATA_DELETE. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under iView 

Pool -> iViews Manager Self-Service - My Budget. 

37.9.3.12.2 Create Rules for Critical Variances 

The monitor displays alerts whenever certain values are not within predefined limits. Rules define the 

conditions under which alerts are displayed. Standard rules are provided by SAP, but you can use this 

transaction to change or delete these rules, or create new ones. 

You can create default rules here (apply to all users) and maintain user-specific rules. 

If you do not edit any rules, the system generates the standard rules. 

Default rules and user-specific rules need to be maintained after each other by different users: 

- The default rules need to be maintained centrally for all users. For this reason, this should be done 

by experts such as administrators or cost accountants who are familiar with the setup of the monitor. 

To prevent default rules from being created by other users, you need to issue authorization for this 

transaction. 

- Users can edit their own user-specific rules to meet their personal requirements. 

- These can also be maintained by an administrator, for example, rules that need to be created for a 

new user. 

Requirements 

If rules are to be maintained for a user, you need to assign the appropriate personalization dialog to that 

user in the IMG activity Maintain User Personalization Data (transaction 

CMPERS_MAINTAIN_SGL). 

Activities 
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The transaction has the same structure as rule maintenance in the Web. It is run in the SAP system 

because it is part of monitor administration. 

1. The default rules are created first (for each controlling area) so that they can be used by all users. 

The controlling area is set when the transaction is called up. You can, however, change this in the 

menu by choosing Extras -> Set Controlling Area. 

2. Then the default rules are copied to the special users so that they are available. These rules cannot be 

changed, but can only be copied or deleted. 

3. You can then add more user-specific rules for each user. If the default rules are not copied to the 

user, the user receives a warning when the first rule is created. 

4. Additional rules can be created for a certain user at any time. These user-specific rules can also be 

edited or deleted. 

5. When the default rules are copied to the user, the old default rules are deleted and the new ones are 

created. 

6. If the personalization for a single user is no longer needed, it can be deleted by the administrator 

using transaction MPO_PERS_DATA_DELETE. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under iView 

Pool -> iViews Manager Self-Service - My Budget. 

37.9.3.12.3 Create Extracts for Critical Line Items 

In this IMG activity you create extracts for the monitor. This enables you to control data selection for the 

rules so that the rules always use current data. 

Recommendation 

This transaction should run overnight in a batch for all users so that users have current data at the start of 

the day. 

Activities 

Save Extract: If the field is selected, extracts are created. If you want to do a test run, do not select this 

field. A test run shows you which data would be selected. Test runs are only possible for single users. 

User: Enter a single user, or an asterisk (*) for all users. 

Last accessed after: Selects all users who called up the iView after the data entered. This selection 

criterion only works if you run the transaction for all users (asterisk). 

Delete - last accessed before: Deletes the extracts from the database for all users who called up the 

iView before the date entered. This reduces the data volume and improves performance. 

Maximum no. of hits: The system only displays the number of rules that have been specified (only 

works if you run the transaction for a single user). 

Further notes 
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For more information, see the documentation on the Business Package Manager Self-Service under 

Technical Description -> iView Pool -> iViews Manager Self-Service - My Budget -> Generate 
Extracts for Critical Variances and Line Items. 

37.9.3.12.4 Create Extracts for Critical Postings 

In this IMG activity you create extracts for the monitor. This enables you to control data selection for the 

rules so that the rules always use current data. 

Recommendation 

This transaction should run overnight in a batch for all users so that users have current data at the start of 

the day. 

Activities 

Save Extract: If the field is selected, extracts are created. If you want to do a test run, do not select this 

field. A test run shows you which data would be selected. Test runs are only possible for single users. 

User: Enter a single user, or an asterisk (*) for all users. 

Last accessed after: Selects all users who called up the iView after the data entered. This selection 

criterion only works if you run the transaction for all users (asterisk). 

Delete - last accessed before: Deletes the extracts from the database for all users who called up the 

iView before the date entered. This reduces the data volume and improves performance. 

Maximum no. of hits: The system only displays the number of rules that have been specified (only 

works if you run the transaction for a single user). 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under 

Technical Description -> iView Pool -> iViews Manager Self-Service - My Budget -> Generate 

Extracts for Critical Variances and Line Items. 

37.9.3.13 Monitor for Internal Activity Allocation 

37.9.3.13.1 Create Rules for Critical Variances 
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The monitor displays alerts whenever certain values are not within predefined limits. Rules define the 

conditions under which alerts are displayed. Standard rules are provided by SAP, but you can use this 

transaction to change or delete these rules, or create new ones. 

You can create default rules here (apply to all users) and maintain user-specific rules. 

If you do not edit any rules, the system generates the standard rules. 

Default rules and user-specific rules need to be maintained after each other by different users: 

- The default rules need to be maintained centrally for all users. For this reason, this should be done 

by experts such as administrators or cost accountants who are familiar with the setup of the monitor. 

To prevent default rules from being created by other users, you need to issue authorization for this 

transaction. 

- Users can edit their own user-specific rules to meet their personal requirements. 

- These can also be maintained by an administrator, for example, rules that need to be created for a 

new user. 

Requirements 

If rules are to be maintained for a user, you need to assign the appropriate personalization dialog to that 

user in the IMG activity Maintain User Personalization Data (transaction 

CMPERS_MAINTAIN_SGL). 

Activities 

The transaction has the same structure as rule maintenance in the Web. It is run in the SAP system 

because it is part of monitor administration. 

1. The default rules are created first (for each controlling area) so that they can be used by all users. 

The controlling area is set when the transaction is called up. You can, however, change this in the 

menu by choosing Extras -> Set Controlling Area. 

2. Then the default rules are copied to the special users so that they are available. These rules cannot be 

changed, but can only be copied or deleted. 

3. You can then add more user-specific rules for each user. If the default rules are not copied to the 

user, the user receives a warning when the first rule is created. 

4. Additional rules can be created for a certain user at any time. These user-specific rules can also be 

edited or deleted. 

5. When the default rules are copied to the user, the old default rules are deleted and the new ones are 

created. 

6. If the personalization for a single user is no longer needed, it can be deleted by the administrator 

using transaction MPO_PERS_DATA_DELETE. 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under iView 

Pool -> iViews Manager Self-Service - My Budget. 
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37.9.3.13.2 Create Extracts for Critical Postings 

In this IMG activity you create extracts for the monitor. This enables you to control data selection for the 

rules so that the rules always use current data. 

Recommendation 

This transaction should run overnight in a batch for all users so that users have current data at the start of 

the day. 

Activities 

Save Extract: If the field is selected, extracts are created. If you want to do a test run, do not select this 

field. A test run shows you which data would be selected. Test runs are only possible for single users. 

User: Enter a single user, or an asterisk (*) for all users. 

Last accessed after: Selects all users who called up the iView after the data entered. This selection 

criterion only works if you run the transaction for all users (asterisk). 

Delete - last accessed before: Deletes the extracts from the database for all users who called up the 

iView before the date entered. This reduces the data volume and improves performance. 

Maximum no. of hits: The system only displays the number of rules that have been specified (only 

works if you run the transaction for a single user). 

Further notes 

For more information, see the documentation on the Business Package Manager Self-Service under 

Technical Description -> iView Pool -> iViews Manager Self-Service - My Budget -> Generate 
Extracts for Critical Variances and Line Items. 

37.9.3.14 Appropriation Request 

37.9.3.14.1 Specify Assignment of iView Instance to Appropriation Request 

Type 

Use 

In this IMG activity you specify the assignment of iView instances to appropriation request types. This 

setting is necessary so that the "Status Overview" iView displays appropriation requests correctly. 
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37.9.4 Business Unit Analyst 2.0 (mySAP ERP) 

37.9.4.1 Personalization 

37.9.4.1.1 Personalization Framework: Overview 

Use 

In personalization, you specify the values that belong to the area of responsibility of a business package 

user, such as the cost centers for which a manager or Business Unit Analyst is responsible. 

You can enter the personalization information in different ways: 

- In the following IMG activities you can, for certain personalization characteristics, fill the 

data for the users from their authorizations stored in the system: 

- Fill Personalization Data from Authorizations (Cost Centers) 

- Fill Personalization Data from Authorizations (Profit Centers) 

- In the IMG activity Personalization Data: Collective Processing, you can enter data manually 

for one or more users. 

- Users can enter their own data in the Web application under Personalize Data. You can 

simulate this entry of users for support purposes in the IMG activity   Personalization Data: 

Individual Processing (includes update). 

For more information, see the SAP Library under Cross-Application Components -> Personalization. 

37.9.4.1.2 Automatic Generation of Default Authorizations 

Use 

As preparation for the IMG activity Fill Personalization from Authorizations, you can first fill the 

authorizations either from the cost center master record or from Organizational Management. This is 

initially possible only for the authorization object K_CCA. 

To fill the authorizations, first specify entries for default authorizations in this Customizing activity. Then 

execute one of the two following programs: 

- FPB_GENERATE_PROFILE_CCMD to transfer the assignment of cost center and user ID 

from the cost center master record 
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- FPB_GENERATE_PROFILE_HRORG to transfer the assignment of cost center and user ID 

from the organizational hierarchy 

With these programs, you can assign default authorizations that you have entered in this Customizing 

activity to a set of users that you specify in the selection screen. These authorizations refer exclusively to 

the authorization object K_CCA. You can assign authorizations at the level of cost centers or hierarchy 

nodes. 

Requirements 

- For the program FPB_GENERATE_PROFILE_CCMD there are cost centers for which the 

user ID is entered in the Person Responsible field. 

- For the program FPB_GENERATE_PROFILE_HRORG you have specified the users' cost 

center in the Organizational Management (BC-BMT-OM) component. 

In both cases you can modify the selected area of responsibility with BAdI 

FPB_AUTHORISATIONS and method CHANGE_RESPAREA. 

Example 

Example entry in this Customizing activity that defines the authorization to display for cost center 

managers: 

- Authorizations 

- ID: TEST1 (You enter this ID as the profile ID in the reports.) 

- Activity: 03 

- Authorization object: K_CCA 

- Authorization name: CC_DISPLAY 

- Text: Cost Center Accounting 

- Authorization values 

- Object field: CO_ACTION 

- Length: 0 

- Value from: 3027 

- Value to: 3029 

37.9.4.1.3 Fill Personalization Data from Authorizations (Cost Centers) 

Use 
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In this IMG activity, you can read user-specific data for the controlling area and cost centers centrally for 

all users from their authorizations, and transfer this data into the personalization framework. You can 

decide whether the cost center hierarchy should be exploded and whether data for internal orders and 

WBS elements should be read. 

If you execute this IMG activity as a test run, the user data is only displayed and not written to the 

personalization framework data store. 

If you activate expert mode, you can specify first the personalization subcontext and second the 

personalization application and characteristic in the personalization hierarchy, under which the data is to 

be updated. 

Requirements 

- The authorizations are maintained. You can use the IMG activity  Automatic Generation of Default 

Authorizations and the programs mentioned in the documentation for the IMG activity for this 

purpose. 

- To enable the internal orders/WBS elements for the area of responsibility to be filled, this 

information must exist in the master data of the internal orders/WBS elements (field for responsible 

cost center). 

- To execute the activity in expert mode, you must have set the parameter Personalization: Activate 

Expert Mode (FPB_PERS_EXPERT) in the user profile to X. 

37.9.4.1.4 Fill Personalization Data from Authorizations (Profit Center) 

Use 

In this IMG activity you can read user-specific data for the controlling area and profit center centrally for 

all users from their authorizations, and transfer it into the personalization framework. You can decide 

whether the profit center hierarchy should be exploded and whether data for internal orders and WBS 

elements should be read. 

If you execute this IMG activity as a test run, the user data is only displayed and not written to the 

personalization framework data store. 

If you activate expert mode, you can specify first the personalization subcontext and second the 

personalization application and characteristic in the personalization hierarchy, under which the data is to 

be updated. 

Requirements 

- The authorizations are maintained. 

- To enable the internal orders/WBS elements for the area of responsibility to be filled, this 

information must exist in the master data of the internal orders/WBS elements (field for profit 

center). 

- To execute the activity in expert mode, you must have set the parameter Personalization: Activate 

Expert Mode (FPB_PERS_EXPERT) in the user profile to X. 

Standard settings 
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Activities 

37.9.4.1.5 Personalization Data: Collective Processing 

Use 

In this IMG activity you can enter the personalization data of users in a personalization dialog either 

supplied by SAP or in one you created yourself. You enter the values that apply to the selected users for 

each personalization characteristic. The personalization dialog defines the entry screen for the data. 

This form of collective processing is particularly useful for characteristics that are the same for many 

users (the current year would be an example). For characteristic values that are different for particular 

users, you can also use this IMG activity by entering individual users instead of user groups in the 

selection screen. 

If you start collective processing for an individual user for whom personalization data had been entered 

in the past, then these characteristic values are also displayed in the personalization dialog. If you start 

collective processing for several users then the personalization dialog is displayed without the 

personalization data, because the individual characteristic values usually differ depending on the user. 

Notes 

- In collective processing, no authorization check or existence check is made of the personalization 

data entered, so as not to impede performance. These checks are first made in the applications that 

use the personalization data for the selection. 

- If users enter their personalization data in the application themselves, this data counts as the entries 

that apply rather than the data entered here in collective processing. In this situation and unlike 

collective processing both an authorization check and an existence check is made. 

- If you want to enter personalization data under a particular application subcontext, the 

corresponding field is only displayed in the selection screen for collective processing if you have 

activated expert mode in the user parameters for your own user (under System -> User Profile -> 

Own Data -> Parameters: Parameter ID: FPB_PERS_EXPERT, Parameter Value: X). 

Requirements 

- The users have been created. 

- Custom or standard SAP personalization dialogs exist. 

- You have activated expert mode in your own user parameters as necessary. 

Activities 
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1. Choose the personalization dialog you want to use to enter data. 

2. Enter the user or users for whom you want to enter the personalization data. 

3. Enter the application subcontext for which you want to enter the personalization data. 

4. Enter a time period. If you do not make an entry, the system assumes the largest possible time period 

(01/01/0001 to 12/31/9999). 

5. Specify whether you want the system to update only the data you entered or also the fields you left 

empty. 

- If you select Update Input Data Only, only the values that you explicitly enter are updated. 

Nothing is updated for the fields that you leave empty. Any data for these characteristics 

existing on the database is not changed. 

- If you select Update Initial Data Also, the values for the empty fields that are on the database 

are overwritten with the initial values. 

6. Choose Program -> Execute. 

The entry screen for the selected personalization dialog appears. 

7. Enter the personalization data and save it. 

37.9.4.1.6 Additional Functions in Personalization 

37.9.4.1.6.1 Personalization Data: Single Processing 

Use 

As the administrator, you can simulate the entry of personalization data by users in the Web application in 

this IMG activity. This enables you analyze problems without having to use the Web front end, and 

determine whether the problem lies in the front end or in the update of the data in the back end. 

Unlike collective processing, in single processing of personalization data both an authorization check and 

existence check is made. 

If you start single processing for an individual user for whom personalization data had been entered in 

the past, then these characteristic values are also displayed in the personalization dialog, meaning that 

individually entered personalization data overrides administratively entered data. Note 

If you want to enter personalization data under a particular application subcontext, the corresponding field 

is only displayed in the selection screen for single processing if you have activated expert mode in the 

user parameters for your own user (under System -> User Profile -> Own Data -> Parameters: 

Parameter ID: FPB_PERS_EXPERT, Parameter Value: X). 

Activities 
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1. Choose the personalization dialog you want to use to enter data. 

2. Enter the application subcontext for which you want to enter the personalization data. 

3. Enter the user whose data entry you want to simulate. 

4. Choose Program -> Execute. 

The entry screen for the selected personalization dialog appears. 

5. Enter the personalization data and save it. 

37.9.4.1.6.2 Edit Personalization Hierarchy 

Use 

In this IMG activity you can make the following settings for the personalization hierarchies: 

- You can include additional personalization applications (meaning nodes in the hierarchy) in the SAP 

personalization hierarchy delivered. 

- You can include new characteristics in the personalization applications delivered. You should note 

that in this case you have to adapt the personalization dialogs to make it possible to enter 

personalization data for the characteristics. 

- You can create your own personalization hierarchies parallel to the personalization hierarchy 

delivered. 

For general information on personalization hierarchies, see the SAP Library under Cross-Application 

Components -> Personalization -> Components of the Personalization Framework. 

Standard settings 

The standard delivery for SAP ECC already contains standard personalization hierarchies. Hence, for 

example, the root nodes of the standard personalization hierarchy for applications in the Controlling 

environment are CO. 

For all of the applications delivered in the standard system that require personalization data from the 

personalization framework as start parameters, corresponding personalization applications with the 

appropriate personalization characteristics are also delivered in the standard system. For these 

applications, only the personalization data still needs to be entered for the users (see personalization 

data: collective processing). You are not required to create your own personalization hierarchies, 

applications and characteristics. 

Activities 

1. To create your own personalization application, choose New Entries  in the view Personalization 

Hierarchy. 

2. You sort the personalization application in the existing personalization hierarchy by specifying the 

higher-level node of the hierarchy in the field Higher-Level Personalization Application. If you 

leave this field blank, you create the uppermost node (root node) of a new personalization hierarchy. 
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Make sure that you do not implement a circular hierarchy. Each hierarchy must have a root node, 

and the evaluation path of a hierarchy path must be unique from the lowest node to the root node. 

3. To include characteristics in a personalization application, select the personalization application in 

the view Personalization hierarchy and then choose Personalization characteristics. 

4. Enter the necessary data for the characteristic in the view Personalization characteristics. This is 

where you specify how personalization data for the characteristic is later displayed and entered in 

the personalization dialog. Amongst other things, you also specify here the personalization 

characteristiscs reference to the ABAP Dictionary. 

37.9.4.1.6.3 Edit Personalization Dialog 

Use 

In this IMG activity you can define separate personalization dialogs for the entry of personalization data. 

You may find this is necessary, for example, if you have enhanced the personalization hierarchy 

delivered. 

One personalization dialog can consist of several tab pages with various field groups. 

Standard settings 

The standard delivery for SAP ECC already contains standard personalization dialogs. For example, the 

standard dialog for entering personalization data in the Controlling environment for cost center reporting 

is DIA_CO_CCA_IS. 

For all of the applications delivered in the standard system that require personalization data from the 

personalization framework as start parameters, corresponding personalization dialogs with the 

appropriate personalization characteristics are also delivered in the standard system. Only the 

personalization data still needs to be entered for your users (see personalization data: collective 

processing). You are not obliged to create your own personalization dialogs. 

Activities 

1. To create your own personalization dialog, choose New Entries in the view Dialog ID. To group 

the fields of a personalization dialog, carry out the following steps: 

2. Create a tab page, by selecting the personalization dialog and then choosing Dialog Tab Page 

Title. Assign an ID and name for the tab page title. 

3. To create a field group on the tab page, select the dialog tab page title and then choose Dialog 

Groupings. Assign an ID and name for the grouping of dialog fields. 

4. To specify the individual fields of the grouping, select the dialog grouping and then choose Dialog 

Fields. 
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5. Create a field using New Entries. You can define the link to the personalization hierarchy by 

entering the personalization application and characteristic (field). You also need to specify whether 

the field on the personalization dialog is to be ready for input, or whether personalization data 

should be displayed only. Using position, you determine the order of 

the dialog fields within the grouping. 

37.9.4.1.6.4 Display Personalization Data 

Use 

In this IMG activity you can display all of the existing personalization data for one or more users. The 

system then displays the data entered by both the administrator in collective processing centrally, and the 

data entered by users themselves. 

The personalization data view corresponds to the display of the data records in the database table 

(technical view). Consequently, you can quickly ascertain which personalization data has actually been 

saved for each user. 

37.9.4.1.6.5 Delete Personalization Data 

Use 

In this IMG activity you can delete the data entered for a personalization application for one or more 

users. This is particularly useful if you experience data inconsistencies. 

If you only want to delete the personalization data for a particular personalization characteristic, then 

enter that characteristic in the selection screen. In the input help, you are offered only those 

personalization characteristics that, in accordance with the personalization hierarchy, also relate to the 

personalization application you have already selected. If you want to delete all of the data for the 

personalization application, then leave the field Characteristic blank. 

The system then deletes the data entered by both the administrator in collective processing centrally, and 

the data entered by users themselves. 

In the test run, you can check which data records are deleted in the upate run. 

The personalization data view corresponds to the display of the data records in the database table 

(technical view). Consequently, you can quickly ascertain which personalization data has actually been 

saved for each user. 
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37.9.4.1.6.6 Reorganize Personalization Data 

Use 

In this IMG activity you can assign the existing data for a personalization application for a particular 

characteristic to a different personalization application. As you do this, you can decide whether to retain 

the data for the original personalization application or to delete it. 

Requirements 

It is only possible to reorganize the personalization data if there is a corresponding target characteristic in 

the target personalization application. The input help only displays relevant personalization 

characteristics. The target characteristic does not have to have the same name, but must have the same 

domain as the source characteristic. 

Include the relevant personalization characteristics for the personalization applications in the 

personalization hierarchy as necessary, before you reorganize (see also the IMG activity Edit 

Personalization Hierarchy). You are not required to create your own personalization hierarchies, 

applications and characteristics, but can enter existing or standard system delivery personalization 

characteristics for personalization applications as the target for the reorganization. 

37.9.4.1.7 Business Add-Ins 

37.9.4.1.7.1 BAdI: Personalization: Authorization Checks 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

This BAdI enables you to make authorization checks for objects in connection with personalization. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-In is filter-dependent, but cannot be used more than once. 

Create one implementation for each personalization application for which you wish to make an 

authorization check in the environment. If an active implementation exists, this is also executed. 

The following implementation is delivered in the software component EA-APPL: 
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FPB_PERS_AUTH_CO (Personalization: Existence checks in the CO environment; filter 

characteristics/applications: CO*, BUA*) 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.4.1.7.2 BAdI. Personalization: Existence Checks 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

This BAdI enables you to make existence checks for objects in connection with personalization. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-in is filter-dependent, but cannot be used more than once. Create one implementation 

for each personalization application for which you wish to make an existence check in the environment. 
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If an active implementation exists, this is also executed. 

The following implementations are delivered in the software component EA-APPL: 

- FPB_PERS_EXIST_CO (Personalization: Existence checks in the CO environment; filter 

characteristics/applications: CO*, BUA*) 

- MT_PERS_CHECK_EXIST (Personalization: Existence checks in the maintenance technology 

environment; filter characteristics/applications: OPS-EAM*) 

- OPS_PERS_CHECK_EXIST (Personalization: Existence checks in the quality check environment; 

filter characteristic/application: OPS) 

- QI_PERS_CHECK_EXIST (Personalization: Existence checks in the quality check environment; 

filter characteristics/applications: OPS-QM*) 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method 

you wrote. 

37.9.4.1.7.3 BAdI: Personalization: Resolution of Intervals and Groups 
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Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

With this BadI, you can resolve groups and intervals into their respective single values within the 

personalization of objects. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-in is filter-dependent, but cannot be used more than once. 

Create an implementation for each personalization application required in whose environment you want 

to resolve groups and objects into their respective single values. If an active implementation exists, this is 

also executed. 

The following implementation is delivered in the software component EA-APPL: 

FPB_PERS_RESOLVE_CO (Personalization: Resolve in CO environment; filter 

characteristics/applications: CO*, BUA*) 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 
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37.9.4.1.7.4 BAdI: Personalization: Conversion of Data Formats 

Use 

This Business Add-In (BAdI) is used in the Personalization Framework (CA-GTF-SGF-FPB) 

component. 

This BAdI enables you to undertake the conversion of data formats for objects in connection with 

personalization. This means you can convert the relevant personalization data for a particular 

personalization characteristic from external to internal format, and the other way round. 

Standard settings 

The Business Add-In is active in the standard system. 

The Business Add-in is filter-dependent, but cannot be used more than once. Create one implementation 

for each personalization application in whose environment you wish to make a conversion. 

If an active implementation exists, this is also executed. 

If the system is unable to determine any implementations, then in the standard system the default code for 

conversion of external to internal format (or the other way round) is executed automatically. To display 

the default code, choose Goto -> Default Code -> Display . 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. 

The system displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 
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Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.4.1.7.5 BADI for Generating Default Authorizations 

Use 

With this Business Add-In (BAdI) you make additional checks or changes for the areas of responsibility 

of the users determined by program FPB_GENERATE_PROFILE_CCMD or 

FPB_GENERATE_PROFILE_HRORG. 

For more Informationen on using the programs, see the documentation for the IMG activity Automatic 

Generation of Default Authorizations. 

Standard settings 

No standard implementation is delivered for this BAdI. The areas of responsibility are determined as they 

are by one of the above programs and processed further. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. 

The system displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 
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7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

37.9.4.2 Hierarchy 

37.9.4.2.1 Set Hierarchy 

Use 

Change the settings only if you use the role Business Unit Analyst (BUA). 

In this IMG activity, you specify which hierarchies (my profit center, my cost centers, #) can be displayed 

in the  Hierarchy and which subnodes these hierarchies can have. The hierarchies are displayed under 

Planning and Reports and for the planning round. 

You can activate and deactivate individual hierarchies. 

The following are all the hierarchies possible: 

- My segments 

- My profit center 

- My cost centers 

- My cProjects projects 

- My PS projects 

- My internal orders 

- All Objects 

- Profit center by manager 

- Cost centers by manager 

Within a hierarchy you can also specify which objects are to be displayed as first subnodes (top objects), 

for example, my cost centers: cost center group and cost centers. You should not change this setting as a 

rule. 

The top objects are determined according to the following rules: 

- Segments, profit centers, cost centers, PS projects, internal orders: personalization 

- cProjects projects: favorites in cProjects 
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- Manager: master record of personalized profit centers and cost centers 

Within each hierarchy you can specify which objects are to be displayed as additional subnodes for an 

object in the hierarchy. 

Activities 

Modify the standard settings in the following cases: 

- You do not want to use one of the hierarchies (for example, for internal orders). If no top object is 

found for this hierarchy, then it is not necessary for you to deactivate it. The system automatically 

does not display it. 

- You want to display subnodes that are deactivated in the standard system. For example, if internal 

orders are to be displayed under the profit centers. 

- You do not want to display all subnodes. For example, if no orders are to be displayed under the cost 

centers. 

- You do not want to display a hierarchy for a manager. 

- You want only one hierarchy with all objects, instead of individual hierarchies for profit centers, 

costs centers, and so on. Deactivate all hierarchies up to All Objects. 

37.9.4.2.2 Business Add-Ins 

37.9.4.2.2.1 BAdI: Change Hierachy Nodes 

Use 

This Business Add-In (BAdI) belongs to the component Business Package for Manager Self-Service 

(FI) (EP-PCT-MGR-CO) and can be used for all roles that use the Hierarchy. 

With this BAdI you can change the determination of the subnodes for the display in the 

hierarchy. 

Standard settings 

No standard implementation is delivered for this BAdI. It can be multiply used, but is not filter-

dependent. 

Activities 
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After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The 

system displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

In the standard system, a cost center and all internal orders are displayed in whose master record the 

appropriate cost center is defined in the field Responsible cost center. To display internal orders with a 

certain status only, you can use this BAdI to filter out other internal orders. 

37.9.4.2.2.2 BAdI: Change Manager in the Hierarchy 

Use 

This Business Add-In (BAdI) is used in the role Business Unit Analyst (BUA) 2.0. 

You can use this BAdI to determine a manager for a cost center or a profit center for display in the 

hierarchy. Moreover, you can influence how the name of the manager is represented in the hierarchy, in 

the monitors, and in the planning session. 

In the standard system, the manager is determined using the User Responsible field in the master record 

for the cost center or profit center. This is the user name that the user uses to logon to the SAP system. 

The name is taken from the user data and displayed as follows: <Last Name>, <First Name>. 

Standard settings 
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No standard implementation is delivered for this BAdI. The BAdI cannot be used more than once and 

does not depend on filter settings. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

You want to derive the manager from the User Responsible field in the master record of your cost 

centers or profit centers. This is a simple text field. You create a BAdI implementation that uses this text 

to display this user as manager in the hierarchy. 

To display the default code, choose Goto -> Default Code -> Display. 

37.9.4.3 Key Figures and Budget Monitor 

37.9.4.3.1 Cost Center Monitor 

37.9.4.3.1.1 Edit Administration Rules for Cost Center Variances 

Use 
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As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are 

named as follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.4.3.1.2 Edit Administration Rules for Cost Center Line Items 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 
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- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.4.3.1.3 Execute Evaluation for Critical Cost Center Variances 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 559 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.4.3.1.4 Execute Evaluation for Cost Center Line Items 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 
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37.9.4.3.1.5 Delete Cost Center Line Items from Display Set 

Use 

When a user confirms a posting in the monitor, the posting disappears from the monitor and is written to a 

separate database table so that it does not reappear in the monitor after the data is updated. In this IMG 

activity you can delete the entries from the table with the confirmed postings. All postings that were made 

before the current evaluation date of the rule are deleted. 

If after deletion of this table the evaluation date of the rule is reset to an earlier date, the postings will 

reappear in the monitor. 

37.9.4.3.1.6 Display Rules for Cost Center Variances per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.4.3.1.7 Display Rules for Cost Center Line Items per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 
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Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.4.3.2 Internal Order Monitor 

37.9.4.3.2.1 Edit Administration Rules for Order Variances 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 
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Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.4.3.2.2 Edit Administration Rules for Order Line Items 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 563 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.4.3.2.3 Execute Evaluation for Critical Order Variances 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.4.3.2.4 Execute Evaluation for Order Line Items 

Use 
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In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.4.3.2.5 Delete Order Line Items from Display Set 

Use 

When a user confirms a posting in the monitor, the posting disappears from the monitor and is written to a 

separate database table so that it does not reappear in the monitor after the data is updated. In this IMG 

activity you can delete the entries from the table with the confirmed postings. All postings that were made 

before the current evaluation date of the rule are deleted. 

If after deletion of this table the evaluation date of the rule is reset to an earlier date, the postings will 

reappear in the monitor. 

37.9.4.3.2.6 Display Rules for Order Variances per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 
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could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.4.3.2.7 Display Rules for Order Line Items per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 
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37.9.4.3.3 Profit Center Monitor 

37.9.4.3.3.1 Edit Administration Rules for Profit Center Variances 

Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.4.3.3.2 Edit Administration Rules for Profit Center Line Items 
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Use 

As an administrator, you edit rules in this IMG activity that control when an alert is displayed in the 

monitor. You can create, change, and delete rules and copy them to other users. 

When you create a rule, you enter the rule condition and the objects to which the rule applies. 

You have the following options when copying rules to other users: 

- Copy to all users 

The system copies the rules to all users for which personalization has been implemented. 

- Copy to other users 

You can specify the users to which the rules should be copied. 

You can define the rules for certain objects you specified as a default (such as cost centers with the Cost 

Center Monitor) or for objects from the personalization data of the user. 

Requirements 

If you want to create or copy rules for objects from a user's personalization data, you must first maintain 

the user's personalization data. 

Activities 

1. Create rules and change them if necessary. 

2. Copy the rules to other users. 

Note: If you copy rules to a large number of users, you should run the job in the background. 

3. To check the status of background jobs, choose System -> Own Jobs . The jobs are named as 

follows: 

- Copy to all users: COPY_RULE_FOR_ALL_USERS 

- Copy to other users: COPY_RULE_FOR_SOME_USERS 

4. If you change a rule and copy it to other users again, the users' old rule is overwritten. 

5. If you delete a rule, the rule is automatically deleted for all users to whom you copied it. 

37.9.4.3.3.3 Execute Evaluation for Critical Profit Center Variances 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 
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You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 

- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.4.3.3.4 Execute Evaluation for Profit Center Line Items 

Use 

In this IMG activity you evaluate the rules defined for the monitor and write the results to a database 

table. The monitor displays the data from this table, enabling faster access to the data than if the rules had 

to be evaluated again for each access. 

You should run the evaluation on a regular basis (preferably daily in an overnight background run) so that 

all users have current data at the start of each day. 

Requirements 

The rules for the monitors have been defined. 

Activities 

1. Enter data as required. 

You can run the evaluation for a single user or all users (enter *). 

You can run the evaluation as a test run first. However, this is only possible for a single user. 

The following time-based selections are available: 
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- Last access after: The evaluation is run for all users who accessed the monitor after the 

specified date. 

- Delete: Last access before: The data records for all users who accessed the monitor before 

the specified date are deleted. Deleting the data records removes them from the database. This 

reduces the data volume and can improve system performance. 

2. Execute rule evaluation or schedule a background job. 

37.9.4.3.3.5 Delete Profit Center Line Items from Display Set 

Use 

When a user confirms a posting in the monitor, the posting disappears from the monitor and is written to a 

separate database table so that it does not reappear in the monitor after the data is updated. In this IMG 

activity you can delete the entries from the table with the confirmed postings. All postings that were made 

before the current evaluation date of the rule are deleted. 

If after deletion of this table the evaluation date of the rule is reset to an earlier date, the postings will 

reappear in the monitor. 

37.9.4.3.3.6 Display Rules for Profit Center Variances per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 
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37.9.4.3.3.7 Display Rules for Profit Center Line Items per User 

Use 

In this IMG activity you can display all of the rules that exist for a user (whether rules created by an 

administrator or the user himself). If necessary, you can also delete individual rule assignments. This 

could be necessary, for instance, if an employee has assumed new responsibilities and some of the rules 

are no longer relevant to the new situation. 

Requirements 

Standard settings 

Activities 

1. Retain the settings under Monitor type and Monitor application. 

2. Enter the user whose rules you want to display. 

3. In the results list of the rule assignments for the user you can delete individual assignments if 

necessary. 

37.9.4.3.4 Key Figure Monitor 

37.9.4.3.4.1 Systems 

37.9.4.3.4.1.1 Define Logical System for Key Figure Values 

Use 

In this IMG activity you define the logical systems from which the key figure values can come. You can 

also specify a description per system. 

The definition is valid for all types of source system. 

Activities 

Define a logical system and specify a description. 
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37.9.4.3.4.1.2 Create RFC Connections 

In this section, you define the technical parameters for the RFC destinations. 

The Remote Function Call (RFC) is controlled by the RFC destination parameters. 

To create an RFC port, the RFC destinations must be assigned. 

The name of the RFC destination should be the same as the logical system name. 

The following types of RFC destinations can be assigned: 

- R/2 connections 

- SAP connections 

- Internal connections 

- Logical destinations 

- CMC connections 

- SNA/CPI-C connections 

- TCP/IP connections 

- ABAP driver connections 

Example 

 1. For an SAP connection, enter the following parameters: 

- Name of RFC destination: S11BSP001 

- Connection type: 3 (for SAP connection) 

- Target system: bspserver01 

- System number: ,11 

- User in target system: CPIC 

- Password, language and target client. 

Standard settings 

No RFC destinations are assigned in the standard system. 

Activities 

1. Select one of the types (for example, SAP connections) and choose Edit -> create; 

2. Enter the parameters required for that type. 

3. For an SAP connection, these are, for example, the name of the RFC destination, the name of the 

partner system, logon parameters (see example). 

Processing RFCs With Errors 
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Since RFC destinations are usually registered in the QOUT Scheduler when you use ALE, it is usually no 

longer necessary to schedule the program RSARFCEX in a background job for the collective processing 

of RFCs with errors. We also recommend that you do not do this. The QOUT Scheduler now repeats the 

execution of RFCs with errors automatically (See transaction SMQ1. For detailed documentation about 

the QOUT Scheduler, see the SAP Library under qRFC (Queued Remote Function Call)). 

In some cases, for example, if there are many RFCs with errors, and they cannot be executed again with 

the QOUT Scheduler, you can start the report RSARFCEX manually. 

Practise handling errors in remote function calls before the function is used productively. 

Further notes 

The 'SAP*' user cannot be used for remote function calls on the target system. 

For connecting to R/2 Systems: 

- Use an R/2 destination to read the users with passwords. The actual communication uses CPI-C. 

- Select 'Unencrypted password' 

Notes on the transport 

The maintenance of the RFC destination is not a part of the automatic Change and Transport System. 

Therefore the setting has to be made manually on all systems. 

37.9.4.3.4.2 Define Key Figure Categories 

Use 

In this IMG activity, you define the key figure categories for the generic key figure monitor. 

The key figure category consists of the ID and the description. You can use the category to group together 

similar key figures for the authorization check. You assign the key figure category in the IMG activity 

Define Key Figures. 

Note the documentation on the authorization objects: 

- Key Figures in Generic Key Figure Monitor (Administrator) 

- Key Figures in Generic Key Figure Monitor (User) 
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37.9.4.3.4.3 Define Intervals for Updating Key Figures 

Use 

In this process step, you define the intervals for key figures. You assign the intervals to the key figures in 

the process step Define Key Figures. 

To determine key figure values, use the report KFM_VALUE_DET_SCHEDULE. This report determines 

all key figure values for an interval. 

Example 

You have created the interval DAILY with description Daily 8:00. You have assigned this interval to the 

key figures Key Figure 1, Key Figure 2, and Key Figure 3. 

To determine the key figure values for Key Figure 1, Key Figure 2, and Key Figure 3 each morning at 

8:00, you must schedule the report KFM_VALUE_DET_SCHEDULE with interval DAILY to be run at 

8:00 every morning. 

37.9.4.3.4.4 Define Key Figures 

Use 

In this IMG activity, you define the key figures for the generic key figure monitor. The key figures and 

their values are displayed for the roles in the portal that use the generic key figure monitor. 

Enter the following data for the key figure: 

- Header Area: 

- Technical Name 

- Name 

- Description 

- Source Data: 

Specify the source system for the key figure and the program that was used to determine the key 

figure values. 

- Format: 

Specify the unit, currency, and format for the key figure. 

- Periods: 

Specify the evaluation period for the key figure, and in which temporal intervals the key figure 

values are to be determined. 
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The settings for the evaluation period also influence how the changes in value are displayed in the 

portal. 

- Other Settings: 

Specify if the key figure can be personalized or not, if comments can be created, and the key figure 

category. 

37.9.4.3.4.5 Define Key Figures that can be Personalized 

37.9.4.3.4.5.1 Define Personalizable SAP BW Key Figures 

Use 

In this process step, you define the connection between key figures in the generic key figure monitor and 

personalization. 

If you want to use key figures that can be personalized, you must make the relevant settings in this 

process step. 

To make the Customizing settings for personalization, see Cross-Application Components -> 

General Application Functions -> Generic Functions of mySAP Suite -> Personalization. 

Example 

You want to display an evaluation for each cost center for each cost center owner. 

You have made the following settings: 

- The key figure has the setting Can be Personalized (Value Determination for each Key 

Figure and User). 

- In report KFM_KF_REPORT_BW_QUERY, you have created a variant that contains the logical 

system name of the SAP BW system, the name of the required BW query, and the name of the BW 

key figures. 

- If value determination is triggered via the report KFM_VALUE_DET_SCHEDULE, then the 

system evaluates the personalization for each user that is using this key figure, and determines the 

value for each user. 

37.9.4.3.4.5.2 Define SAP ERP Key Figures that can be Personalized 

Use 

In this process step, you define the connection between key figures in the generic key figure monitor and 

personalization. 
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If you want to use key figures that can be personalized, you must make the relevant settings in this 

process step. 

To make the Customizing settings for personalization, see Cross-Application Components -> 

General Application Functions -> Generic Functions of mySAP Suite -> Personalization. 

Example 

You want to display an evaluation for each cost center for each cost center owner. 

You have made the following settings: 

- The key figure has the setting Can be Personalized (Value Determination for each Key Figure 

and User). 

- In report Z_COST_CENTER, the selection parameter P_KOSTL specifies for which cost center 

the evaluation is to be carried out. 

- If value determination is triggered via the report KFM_VALUE_DET_SCHEDULE, then the 

system evaluates the personalization for each user that is using this key figure, and determines the 

value for each user. 

37.9.4.3.4.6 Examples for Determination of Key Figure Values 37.9.4.3.4.6.1 

Determination of Key Figure Values from SAP ERP or SAP R/3 

Use 

You can determine key figure values for the key figure monitor using SAP R/3 or SAP ERP reports and 

display them in the Portal. For this, SAP provides two example reports that show you how the 

determination of such key figures can look: 

- Evaluation of capacity load utilization (EPM_CAPLOAD_KPI) 

- Evaluations of manufacturing and/or process orders (EPM_ORDER_KPI) 

- Example of a key figure generating report (KFM_KF_REPORT_EXAMPLE) For more information, 

see the documentation for the individual reports. 

SAP provides the following INCLUDE function modules for key figure determination in customer-

specific programs: 

- INCLUDE kfm_kf_report_top 

- INCLUDE kfm_kf_report_parameters 

- INCLUDE kfm_kf_report_initialization. 
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- INCLUDE kfm_kf_report_selscreen_output 

- INCLUDE kfm_kf_report_at_sel_screen 

- INCLUDE  kfm_kf_report_get_kf_info 

- INCLUDE kfm_kf_report_insert_kf_data 

You can use these INCLUDE function modules to easily create key figure reports. For example, you can 

include them in existing programs at the appropriate places. 

The above INCLUDE function modules are also used in the example reports EPM_CAPLOAD_KPI and 

EPM_ORDER_KPI mentioned above. 

Requirements 

- If you use key figures that can be personalized, you have created data for personalization in 

Customizing. You find Customizing for personalization under Cross-Application Components -> 

General Application Functions -> Generic mySAP Suite Functions -> Personalization. 

- In the work step Define Key Figures you have created a key figure whose value you want to 

determine. You have specified Business Information Warehouse as the Source System Type. 

37.9.4.3.4.6.2 Determination of Key Figure Values from SAP BW 

Use 

For the key figure monitor, you can automatically and regularly determine key figures from the SAP 

Business Information Warehouse (BW) and display them in the Portal. SAP provides the standard report 

KFM_KF_REPORT_BW_QUERY for this purpose. It determines individual key figures from BW data 

sources. 

Requirements 

- If you use key figures that can be personalized, you have created data for personalization in 

Customizing. You find Customizing for personalization under Cross-Application Components -> 

General Application Functions -> Generic mySAP Suite Functions -> Personalization. 

- In the work step Define Key Figures you have created a key figure whose value you want to 

determine. You have specified Business Information Warehouse as the Source System Type. 

- If you want to see the data with the possibility of drill down in addition to determining the key 

figure value, you have created an information consumer pattern for the corresponding SAP BW 

query. If you create an information consumer pattern, see SAP Note 721983. 
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Activities 

1. Create a variant for report KFM_KF_REPORT_BW_QUERY. 

For a key figure that can be personalized, do not specify a value for PARAMETER and SELECT-

OPTIONS, as these values are filled from personalization. 

You define the link between the key figure and the personalization data in the work step Define SAP 

BW Key Figures that can be Personalized. 

2. In the work step  Define Key Figure, enter the Report and the Variant for the key figure in step 1 

in the group box Source Data. In the group box Periodicity, define the interval for value 

determination of the key figures. 

3. For the report KFM_VALUE_DET_SCHEDULE, create a report variant that contains the interval 

for value determination. 

4. Schedule the report KFM_VALUE_DET_SCHEDULE with the newly created variant as a regular 

job. Define the job so that it runs in time spans that correspond to those of the interval. 

37.9.4.3.4.6.3 Determination of Key Figure Values from External System 

Use 

It is also possible to determine key figures values from external systems and display them in the Portal. 

The following RFC functions modules are provided for this: 

- You can use the function module KFM_KF_DEFINITION_GET_RFC to get information about the 

definition of a key figure (such as threshold values, description, and target values) from the SAP 

ERP system. 

- You can use the function module KFM_KF_DB_VALUE_INSERT to transfer key figure values to 

the SAP ERP system. 

You must initiate key figure determination in the external system and start there. If you want the 

determination to occur regularly, you must also configure this in the external system. The SAP ERP 

system only receives the key figure values. 

Requirements 

In the work step Define Key Figure  you have created the key figure for which you want to determine the 

values. You have specified External System as the Source System Type. If necessary enter a URL in 

the URL of External System field for displaying the detailed screen. 

Activities 
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1. To determine information about the key figure, call the function module 

KFM_KF_DEFINITION_GET_RFC with the parameter I_KF_ADM_VAR (technical name of 

key figure). 

2. Perform value determination in the external system. 

3. Call the function module KFM_KF_DB_VALUE_INSERT with the parameters I_KF_ADM_VAR 

and I_KF_VALUE to transfer the key figure values to the SAP ERP system. 

37.9.4.4 Reporting 

37.9.4.4.1 Set Up LaunchPad 

Use 

In this IMG activity, you define applications (links to reports, transactions, URLs and so on) for the 

Launchpad (ABAP) service. 

You can find further informatoin in the SAP Library, under SAP ERP Central Component -> 

Business Packages (Portal Content) -> Business Package for Common Parts -> iViews -> 

Launchpad (ABAP). 

Activities 

When you expand the highest node, you will see the existing folders. You can create all applications 

directly under these folders. The portal displays the content of just one of these folders. 

If you want to further refine the structure of the Launchpad, you can create extra folders under the 

existing ones. In the portal, these folders then serve as headers for the links to the applications. 

To create another folder, select the folder under which you want to create the new one. Choose New 

Folder. Enter a text for the new folder and choose Enter. The folder is added below the selected folder 

To create applications, select the folder under which you want to create the applications and choose  New 

Application.. 

Choose the application type . Further entry fields are displayed, depending on the type you have chosen. 

These entry fields allow you to define and select the application#s parameters. 

If you want to create a description  to be displayed in the portal under the link, choose: @0Q@ with 

quick info Editor for the description. 

If the application type selection results in the System Alias field being displayed, you need to enter a 

system alias . 

The Inactive Applications folder serves to gather applications that are in the portal but should not be 

displayed. These applications are displayed in the portal in a table that the user can see when s/he changes 

the launchpad settings. 

When you transport the Launchpad, you receive two transport requests: 
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- Customizing request: This contains all Launchpad settings. 

- Workbench requests: This contains all Launchpad texts (folder names, link texts and descriptions 

that are displayed in the portal under the relevant links). 

You have to transport both requests. 

If you want to transport the Launchpad texts (folder names, link texts and descriptions for the 

applications) choose Launchpad -> Text Key. The system displays a message with the prefix of the 

technical names under which it stores the texts. The message long text provides further information about 

how to translate these texts. 

37.9.4.5 Planning 

37.9.4.5.1 Compile Planning Activities 

Use 

In this IMG activity, you define applications (links to reports, transactions, URLs and so on) for the 

Launchpad (ABAP) service. 

You can find further informatoin in the SAP Library, under SAP ERP Central Component -> 

Business Packages (Portal Content) -> Business Package for Common Parts -> iViews -> 

Launchpad (ABAP). 

Activities 

When you expand the highest node, you will see the existing folders. You can create all applications 

directly under these folders. The portal displays the content of just one of these folders. 

If you want to further refine the structure of the Launchpad, you can create extra folders under the 

existing ones. In the portal, these folders then serve as headers for the links to the applications. 

To create another folder, select the folder under which you want to create the new one. Choose New 

Folder. Enter a text for the new folder and choose Enter. The folder is added below the selected folder 

To create applications, select the folder under which you want to create the applications and choose  New 

Application.. 

Choose the application type . Further entry fields are displayed, depending on the type you have chosen. 

These entry fields allow you to define and select the application#s parameters. 

If you want to create a description  to be displayed in the portal under the link, choose: @0Q@ with 

quick info Editor for the description. 

If the application type selection results in the System Alias field being displayed, you need to enter a 

system alias . 
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The Inactive Applications folder serves to gather applications that are in the portal but should not be 

displayed. These applications are displayed in the portal in a table that the user can see when s/he changes 

the launchpad settings. 

When you transport the Launchpad, you receive two transport requests: 

- Customizing request: This contains all Launchpad settings. 

- Workbench requests: This contains all Launchpad texts (folder names, link texts and descriptions 

that are displayed in the portal under the relevant links). 

You have to transport both requests. 

If you want to transport the Launchpad texts (folder names, link texts and descriptions for the 

applications) choose Launchpad -> Text Key. The system displays a message with the prefix of the 

technical names under which it stores the texts. The message long text provides further information about 

how to translate these texts. 

37.9.4.6 Internal Service Request 

37.9.4.6.1 Internal Service Request: Overview 

Use 

Internal Service Requests (ISRs) are integrated into various Web applications. Users can send a request in 

a Web application by clicking a pushbutton. For example, a Business Unit Analyst can request a change 

to master data. 

For more information on the ISR scenarios available in the applications of Manager Self-Services or the 

Business Unit Analyst, refer to the SAP Library under Cross-Application Components -> Manager 

Self-Service or Business Unit Analyst. 

The customizing settings for Internal Service Requests are located under Cross-Application 

Components -> Internet/Intranet Services -> Internal Service Request. 

37.9.4.7 Express Planning 

37.9.4.7.1 Define Planning Scenario 

Use 

In this IMG activity you define a planning scenario that you use for planning with Express 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 581 

Planning in the SAP NetWeaver Portal . You can find additional information on using Express Planning 

in the SAP library under Cross-Application Components -> Express Planning. 

For each planning scenario you create at least one Express Planning instance. If you create several 

instances, you can use the planning scenario for more than one planning round. You can additionally 

define a context area in which information for the planner can be displayed in the portal. 

Requirements 

The plan versions defined in the instance are available in the IMG activity Maintain Versions. 

Standard settings 

The planning scenario  Express Planning: Cost Center Planning (0_CC_EXP) is contained in the 

standard delivery, which you can use an example. For additional information on this example, see the 

SAP library under Cross-Application Components -> Express Planning -> Example Scenario for 

Cost Center Planning. 

Activities 

You create a planning scenario under Scenario -> Create. 

Under the Specification Work Area node you can then define the steps and substeps of the planning 

scenario. To do this, place the cursor on the higher-level node and from the context menu choose Insert 

Step/Substep. 

You can also use all steps and substeps across a range of scenarios. When you do this, you have the 

option of either creating the subordinate elements of a scenario again by copying, or including them as a 

reference of the original. 

You make the basic settings for a substep. You use this to include a planning service and define its 

parameters. If you want to change the standard selection of the object types for the planning service, 

enter a personalization dialog at the level of the planning scenario that contains the required object types. 

You can enter an RFC Destination for some substeps. You can specify a different system in the RFC 

destination than the one that is linked in the portal. The planning service then determines the data in the 

system specified in the RFC destination when you execute planning. 

To define an instance for the planning scenario, place the cursor on the Specification Instance node, 

and from the context menu choose Insert Instance. 

Under the Specification Context Area node you can assign steps and substeps of a planning scenario an 

explanatory text, a document or a URL. To create a new entry, place the cursor on the higher-level 

element and from the context menu choose Insert Section/Item. You can change the sequence of the 

context area sections using the arrow keys. 

For additional information regarding the settings options, see either the documentation for the fields, or 

the SAP library under  Cross-Application Components -> Express Planning -> Configuring a 

Planning Scenario.  You can also access this documentation by choosing Help -> Application Help. 

37.9.4.7.2 Define Key Figure Prices 
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Use 

In this IMG activity you can define prices that can be used within Express Planning for the valuation of 

statistical key figures entered. 

To enter prices, the following entries are mandatory: 

- Controlling area that is used to determine the currency and to restrict the validity of key figures and 

cost elements. 

- Key figure for which the valuation is to be made. 

- Cost element to which the valuation is posted (if you use the same cost element for several key 

figures, the individual values are added together). 

With these required entries you can enter general prices in the system that are not specified in greater 

detail with regard to company code, version and also fiscal year and period. 

In addition to these general prices, you can also enter prices in greater detail by specifying one or more 

additional parameters such as the company code. 

If you enter several prices in differing levels of detail for a key figure and cost element then the price used 

for the key figure valuation is the one with the finest granularity (technically the price with the maximum 

number of matching arguments). If, for example, the valuation is to be carried out for a particular period, 

and a price has been defined for this period, then this price is used for the valuation. However, if no price 

has been defined for the period, then the price that has been defined (for example) for the corresponding 

fiscal year is used. For the price determination, this means that the parameters that can be defined for a 

price are gradually made more general. Only if no price can be found at the key figure or cost element 

level in the course of this gradual generalization is the system unable to carry out a key figure valuation. 

You enter the price for a price unit. The price unit frequently has the value 1, but you can also specify 

prices that relate to a particular quantity (for example, price per 100 units) 

37.9.4.7.3 BAdI: Change Room Parameters 

Use 

This Business Add-In (BAdI) is used in the role Business Unit Analyst (BUA) 2.0. In this role you can 

create planning rounds for Express Planning.  In the portal, a room is created for every planning round 

in which you send Express Planning planning tasks to the manager, and can follow the status of these 

planning tasks. 

You can use this BAdI to change the parameters of the planning round or room. The BAdI is called when 

you create a planning round in the portal. 
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Standard settings 

This BAdI is active in the standard SAP system. It cannot be multiply used and is not filter-dependent. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

For more information, see: 

Methods 

Change person responsible 

Change role names 

Change the room parameters 

Change application parameters 

37.9.5 Plant Manager 2.0 (mySAP ERP) 

37.9.5.1 Define Settings for KPI Monitor 

37.9.5.1.1 Systems 
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37.9.5.1.1.1 Define Logical System for Key Figure Values 

Use 

In this IMG activity you define the logical systems from which the key figure values can come. You can 

also specify a description per system. 

The definition is valid for all types of source system. 

Activities 

Define a logical system and specify a description. 

37.9.5.1.1.2 Create RFC Connections 

In this section, you define the technical parameters for the RFC destinations. 

The Remote Function Call (RFC) is controlled by the RFC destination parameters. 

To create an RFC port, the RFC destinations must be assigned. 

The name of the RFC destination should be the same as the logical system name. 

The following types of RFC destinations can be assigned: 

- R/2 connections 

- SAP connections 

- Internal connections 

- Logical destinations 

- CMC connections 

- SNA/CPI-C connections 

- TCP/IP connections 

- ABAP driver connections 

Example 

 1. For an SAP connection, enter the following parameters: 

- Name of RFC destination: S11BSP001 

- Connection type: 3 (for SAP connection) 

- Target system: bspserver01 
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- System number: ,11 

- User in target system: CPIC 

- Password, language and target client. 

Standard settings 

No RFC destinations are assigned in the standard system. 

Activities 

1. Select one of the types (for example, SAP connections) and choose Edit -> create; 

2. Enter the parameters required for that type. 

3. For an SAP connection, these are, for example, the name of the RFC destination, the name of the 

partner system, logon parameters (see example). 

Processing RFCs With Errors 

Since RFC destinations are usually registered in the QOUT Scheduler when you use ALE, it is usually no 

longer necessary to schedule the program RSARFCEX in a background job for the collective processing 

of RFCs with errors. We also recommend that you do not do this. The QOUT Scheduler now repeats the 

execution of RFCs with errors automatically (See transaction SMQ1. For detailed documentation about 

the QOUT Scheduler, see the SAP Library under qRFC (Queued Remote Function Call)). 

In some cases, for example, if there are many RFCs with errors, and they cannot be executed again with 

the QOUT Scheduler, you can start the report RSARFCEX manually. 

Practise handling errors in remote function calls before the function is used productively. 

Further notes 

The 'SAP*' user cannot be used for remote function calls on the target system. 

For connecting to R/2 Systems: 

- Use an R/2 destination to read the users with passwords. The actual communication uses CPI-C. 

- Select 'Unencrypted password' 

Notes on the transport 

The maintenance of the RFC destination is not a part of the automatic Change and Transport System. 

Therefore the setting has to be made manually on all systems. 

37.9.5.1.2 Define Key Figure Categories 

Use 
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In this IMG activity, you define the key figure categories for the generic key figure monitor. 

The key figure category consists of the ID and the description. You can use the category to group together 

similar key figures for the authorization check. You assign the key figure category in the IMG activity 

Define Key Figures. 

Note the documentation on the authorization objects: 

- Key Figures in Generic Key Figure Monitor (Administrator) 

- Key Figures in Generic Key Figure Monitor (User) 

37.9.5.1.3 Define Intervals for Updating Key Figures 

Use 

In this process step, you define the intervals for key figures. You assign the intervals to the key figures in 

the process step Define Key Figures. 

To determine key figure values, use the report KFM_VALUE_DET_SCHEDULE. This report determines 

all key figure values for an interval. 

Example 

You have created the interval DAILY with description Daily 8:00. You have assigned this 

interval to the key figures Key Figure 1, Key Figure 2, and Key Figure 3. 

To determine the key figure values for Key Figure 1, Key Figure 2, and Key Figure 3 each morning at 

8:00, you must schedule the report KFM_VALUE_DET_SCHEDULE with interval DAILY to be run at 

8:00 every morning. 

37.9.5.1.4 Define Key Figures 

Use 
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In this IMG activity, you define the key figures for the generic key figure monitor. The key figures and 

their values are displayed for the roles in the portal that use the generic key figure monitor. 

Enter the following data for the key figure: 

- Header Area: 

- Technical Name 

- Name 

- Description 

- Source Data: 

Specify the source system for the key figure and the program that was used to determine the key 

figure values. 

- Format: 

Specify the unit, currency, and format for the key figure. 

- Periods: 

Specify the evaluation period for the key figure, and in which temporal intervals the key figure 

values are to be determined. 

The settings for the evaluation period also influence how the changes in value are displayed in the 

portal. 

- Other Settings: 

Specify if the key figure can be personalized or not, if comments can be created, and the key figure 

category. 

37.9.5.1.5 Define Key Figures that can be Personalized 

37.9.5.1.5.1 Define Personalizable SAP BW Key Figures 

Use 

In this process step, you define the connection between key figures in the generic key figure monitor and 

personalization. 

If you want to use key figures that can be personalized, you must make the relevant settings in this 

process step. 

To make the Customizing settings for personalization, see Cross-Application Components -> 

General Application Functions -> Generic Functions of mySAP Suite -> Personalization. 

Example 

You want to display an evaluation for each cost center for each cost center owner. 
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You have made the following settings: 

- The key figure has the setting Can be Personalized (Value Determination for each Key 

Figure and User). 

- In report KFM_KF_REPORT_BW_QUERY, you have created a variant that contains the logical 

system name of the SAP BW system, the name of the required BW query, and the name of the BW 

key figures. 

- If value determination is triggered via the report KFM_VALUE_DET_SCHEDULE, then the 

system evaluates the personalization for each user that is using this key figure, and determines the 

value for each user. 

37.9.5.1.5.2 Define SAP ERP Key Figures that can be Personalized 

Use 

In this process step, you define the connection between key figures in the generic key figure monitor and 

personalization. 

If you want to use key figures that can be personalized, you must make the relevant settings in this 

process step. 

To make the Customizing settings for personalization, see Cross-Application Components -> 

General Application Functions -> Generic Functions of mySAP Suite -> Personalization. 

Example 

You want to display an evaluation for each cost center for each cost center owner. 

You have made the following settings: 

- The key figure has the setting Can be Personalized (Value Determination for each Key Figure 

and User). 

- In report Z_COST_CENTER, the selection parameter P_KOSTL specifies for which cost center 

the evaluation is to be carried out. 

- If value determination is triggered via the report KFM_VALUE_DET_SCHEDULE, then the 

system evaluates the personalization for each user that is using this key figure, and determines the 

value for each user. 
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37.9.5.1.6 Examples for Determination of Key Figure Values 37.9.5.1.6.1 

Determination of Key Figure Values from SAP ERP or SAP R/3 

Use 

You can determine key figure values for the key figure monitor using SAP R/3 or SAP ERP reports and 

display them in the Portal. For this, SAP provides two example reports that show you how the 

determination of such key figures can look: 

- Evaluation of capacity load utilization (EPM_CAPLOAD_KPI) 

- Evaluations of manufacturing and/or process orders (EPM_ORDER_KPI) - Example of a key 

figure generating report (KFM_KF_REPORT_EXAMPLE) For more information, see the 

documentation for the individual reports. 

SAP provides the following INCLUDE function modules for key figure determination in customer-

specific programs: 

- INCLUDE kfm_kf_report_top 

- INCLUDE kfm_kf_report_parameters 

- INCLUDE kfm_kf_report_initialization. 

- INCLUDE kfm_kf_report_selscreen_output 

- INCLUDE kfm_kf_report_at_sel_screen 

- INCLUDE  kfm_kf_report_get_kf_info 

- INCLUDE kfm_kf_report_insert_kf_data 

You can use these INCLUDE function modules to easily create key figure reports. For example, you can 

include them in existing programs at the appropriate places. 

The above INCLUDE function modules are also used in the example reports EPM_CAPLOAD_KPI and 

EPM_ORDER_KPI mentioned above. 

Requirements 

- If you use key figures that can be personalized, you have created data for personalization in 

Customizing. You find Customizing for personalization under Cross-Application Components -> 

General Application Functions -> Generic mySAP Suite Functions -> Personalization. 

- In the work step Define Key Figures you have created a key figure whose value you want to 

determine. You have specified Business Information Warehouse as the Source System Type. 
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37.9.5.1.6.2 Determination of Key Figure Values from SAP BW 

Use 

For the key figure monitor, you can automatically and regularly determine key figures from the SAP 

Business Information Warehouse (BW) and display them in the Portal. SAP provides the standard report 

KFM_KF_REPORT_BW_QUERY for this purpose. It determines individual key figures from BW data 

sources. 

Requirements 

- If you use key figures that can be personalized, you have created data for personalization in 

Customizing. You find Customizing for personalization under Cross-Application Components -> 

General Application Functions -> Generic mySAP Suite Functions -> Personalization. 

- In the work step Define Key Figures you have created a key figure whose value you want to 

determine. You have specified Business Information Warehouse as the Source System Type. 

- If you want to see the data with the possibility of drill down in addition to determining the key 

figure value, you have created an information consumer pattern for the corresponding SAP BW 

query. If you create an information consumer pattern, see SAP Note 721983. 

Activities 

1. Create a variant for report KFM_KF_REPORT_BW_QUERY. 

For a key figure that can be personalized, do not specify a value for PARAMETER and SELECT-

OPTIONS, as these values are filled from personalization. 

You define the link between the key figure and the personalization data in the work step Define SAP 

BW Key Figures that can be Personalized. 

2. In the work step  Define Key Figure, enter the Report and the Variant for the key figure in step 1 

in the group box Source Data. In the group box Periodicity, define the interval for value 

determination of the key figures. 

3. For the report KFM_VALUE_DET_SCHEDULE, create a report variant that contains the interval 

for value determination. 

4. Schedule the report KFM_VALUE_DET_SCHEDULE with the newly created variant as a regular 

job. Define the job so that it runs in time spans that correspond to those of the interval. 

37.9.5.1.6.3 Determination of Key Figure Values from External System 

Use 

It is also possible to determine key figures values from external systems and display them in the Portal. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 591 

The following RFC functions modules are provided for this: 

- You can use the function module KFM_KF_DEFINITION_GET_RFC to get information about the 

definition of a key figure (such as threshold values, description, and target values) from the SAP 

ERP system. 

- You can use the function module KFM_KF_DB_VALUE_INSERT to transfer key figure values to 

the SAP ERP system. 

You must initiate key figure determination in the external system and start there. If you want the 

determination to occur regularly, you must also configure this in the external system. The SAP ERP 

system only receives the key figure values. 

Requirements 

In the work step Define Key Figure  you have created the key figure for which you want to determine the 

values. You have specified External System as the Source System Type. If necessary enter a URL in 

the URL of External System field for displaying the detailed screen. 

Activities 

1. To determine information about the key figure, call the function module 

KFM_KF_DEFINITION_GET_RFC with the parameter I_KF_ADM_VAR (technical name of 

key figure). 

2. Perform value determination in the external system. 

3. Call the function module KFM_KF_DB_VALUE_INSERT with the parameters I_KF_ADM_VAR 

and I_KF_VALUE to transfer the key figure values to the SAP ERP system. 

37.9.5.2 Alert Management 

37.9.5.2.1 Alerts for Key Performance Indicators 

Use 

With the Plant Manager and the Production Supervisor roles, you can use alert management: 

If the KPI exceeds the threshold value for the yellow and red areas, you will be alerted. You can use the 

following media to receive an alert: 

- E-mail 

- SMS 

- Fax 
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- Alert monitor on Plant Manager or Production Supervisor page in the portal 

The alert contains information about the KPI (technical name), the value and unit of the KPI, and the date 

and time of the alert. 

SAP provides the following alert categories: 

- SAP_EPM_KPI_ALERT: Alert for KPI 

- SAP_WC_SID_CLT_DUMMY: Alert for machine breakdown (template for creating alerts) 

Requirements 

The following prerequisites must be met for an alert to be dispatched when a KPI exceeds the relevant 

threshold values: 

- You have set up and configured a central alert server (contact your system administrator). 

- The alert category SAP_EPM_KPI_ALERT or SAP_WC_SID_CLT_DUMMY must exist in the 

central alert server system (see IMG activity Define Alert Categories). 

- You have activated one of the alert categories when personalizing the KPI (in the iView, choose KPI 

Watch List in the Portal Personalize KPIs -> Activate Alerts.) 

- You have determined the type of media (E-mail, SMS, FAX, Portal) to be alerted with (in the iView 

Alerts in the Portal, choose  Display Details -> Configuration for Alerts). Note: 

If you have maintained user-specific threshold values the alert is triggered if the KPI exceeds your 

threshold value, or the value lies within each range. 

If you have not defined any user-specific threshold values, an alert is triggered if the company-specific 

threshold values are exceeded, or the value lies in the company-specific range. 

37.9.5.2.2 Define Alert Categories 

Use 

In this IMG activity, you define the alert categories you want. Only carry out this activity if you want to 

use the central Alert Framework. 

Once a new alert category has been defined, you have to specify how the recipients of an alert are to be 

determined, and implement the creation/triggering of an alert from an application. 

Standard settings 
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SAP applications supply a set of alert categories. 

Activities 

1. Maintain the key and the properties of the alert category. 

2. (Optional) Define a container that can hold application-specific attributes. 

3. Maintain the texts for the alert category. 

4. (Optional) Define subsequent activities as hyperlinks/URLs. 

37.9.5.2.3 Example Implementation for Alerts in Manufactuing 

Use 

In the BAdI NOTIF_EVENT_POST you can find an example implementation that you use to perform 

your own implementation of the method CHECK_DATA_AT_POST in the system. 

Content of Example Implementation: 

The SAP system contains the alert category SAP_WC_SID_CLT_DUMMY as a template. This alert 

category is assigned to the role SAP_EPM_PLANT_MANAGER as subscription recipient. All users that 

belong to this role can subscribe to this alert. 

Requirements 

You must extend the alert category with descriptions in your system. 

Example 

You want to configure your own alert category: 

Data in customer system 

- System: ABC 

- Client: 100 

- Work centre: AP_01 

- Customer-specific alert category: SAP_WC_ABC_100_AP_01 

(Customer-specific alert comes from dummy: SAP_WC_SID_CLT_DUMMY) 

When a maintenance notification is saved, it is checked via the BAdI NOTIF_EVENT_POST whether it 

if a malfunction report and the machine breakdown indicator is set and a PP work center is maintained. 

If so, the alert category SAP_WC_ABC_100_AP_01 is called. 
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The data for system ID (SID), client (CLT), and PP work center is calculated dynamically 

(WORKCENTER ID). 

37.9.5.3 Set Up Launchpad for Plant Manager 

Use 

In this IMG activity, you define the applications (links to reports, transactions, URLs) for the Launchpad 

iView . 

For additional information, see the SAP Library under SAP ERP Central Component -> Business 

Packages/Functional Packages -> Business Package for Common Parts -> Launchpad. 

Activities 

1. Select the top node if this has not already been selected. When you do this, other pushbuttons are 

displayed. 

2. You can assign all applications directly to the top node. Alternatively, you can group the launchpad 

by creating new folders. The folders are used in the portal as headers for the links to the 

applications. 

Choose New Folder. Enter a text for the new folder, and choose Enter. The folder is added below 

the top node. 

3. To create applications, select the top node or the folder to which you want to assign the applications, 

and choose New Application. 

4. Enter the required data. 

5. Select the application category. Depending on your selection additional input fields are displayed, 

which you can use to specify or select the parameters of the application. 

6. If you want to enter a description that is displayed in the portal under the link but is to be longer than 

255 characters, choose Editor for Description to the right of the field Descript.. 

7. Enter the System Alias (except for URL). 

The inactive applications folder is used for collecting the applications that are available in the portal, but 

that you do not want to display. These applications are displayed in the portal in a table that the user can 

view when he or she changes the launchpad settings. 

37.9.6 Plant Manager 1.0 (Obsolete) 

37.9.6.1 Systems 
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37.9.6.1.1 Define Logical Systems for KPI Values 

Use 

In this IMG activity, you define from which logical system the KPIs originate. You can also enter a 

description for each system. 

This is valid for all types of source systems. 

Activities 

Define a logical system and enter a description. 

37.9.6.1.2 Create RFC Connections 

In this section, you define the technical parameters for the RFC destinations. 

The Remote Function Call (RFC) is controlled by the RFC destination parameters. 

To create an RFC port, the RFC destinations must be assigned. 

The name of the RFC destination should be the same as the logical system name. 

The following types of RFC destinations can be assigned: 

- R/2 connections 

- SAP connections 

- Internal connections 

- Logical destinations 

- CMC connections 

- SNA/CPI-C connections 

- TCP/IP connections 

- ABAP driver connections 

Example 

 1. For an SAP connection, enter the following parameters: 

- Name of RFC destination: S11BSP001 

- Connection type: 3 (for SAP connection) 

- Target system: bspserver01 
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- System number: ,11 

- User in target system: CPIC 

- Password, language and target client. 

Standard settings 

No RFC destinations are assigned in the standard system. 

Activities 

1. Select one of the types (for example, SAP connections) and choose Edit -> create; 

2. Enter the parameters required for that type. 

3. For an SAP connection, these are, for example, the name of the RFC destination, the name of the 

partner system, logon parameters (see example). 

Processing RFCs With Errors 

Since RFC destinations are usually registered in the QOUT Scheduler when you use ALE, it is usually no 

longer necessary to schedule the program RSARFCEX in a background job for the collective processing 

of RFCs with errors. We also recommend that you do not do this. The QOUT Scheduler now repeats the 

execution of RFCs with errors automatically (See transaction SMQ1. For detailed documentation about 

the QOUT Scheduler, see the SAP Library under qRFC (Queued Remote Function Call)). 

In some cases, for example, if there are many RFCs with errors, and they cannot be executed again with 

the QOUT Scheduler, you can start the report RSARFCEX manually. 

Practise handling errors in remote function calls before the function is used productively. 

Further notes 

The 'SAP*' user cannot be used for remote function calls on the target system. 

For connecting to R/2 Systems: 

- Use an R/2 destination to read the users with passwords. The actual communication uses CPI-C. 

- Select 'Unencrypted password' 

Notes on the transport 

The maintenance of the RFC destination is not a part of the automatic Change and Transport System. 

Therefore the setting has to be made manually on all systems. 

37.9.6.1.3 Define KPI Managing System 

Use 
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In this IMG activity, you determine in which system the KPI is managed. 

Note that you do not have to perform this activity if the KPI managing system is the only source system. 

Activities 

Specify a KPI managing system and enter a description. 

37.9.6.2 KPIs 

37.9.6.2.1 Define Categories for Key Performance Indicators 

Use 

In this IMG activity, you assign a category to the KPIs. Each KPI must be assigned to a category. You 

can use KPIs for the Plant Manager role only when you have assigned a category. 

Note that these categories are valid for only one client. 

Standard settings 

SAP includes the following categories in the standard delivery: 

- General: SAP_GENERAL 

- Operational: SAP_OPERATIONAL 

- Strategic: SAP_STRATEGIC 

You can also create your own categories. 

Activities 

Assign a category to your KPIs. 

37.9.6.2.2 Define Key Performance Indicators 

Use 
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You define key performance indicators (KPI) in this IMG activity. 

You specify the following for each KPI: 

- Technical ID and description 

- KPI type 

- KPI source system 

- Analysis process 

- URL 

- Name of program used to refresh the KPI 

- Variant 

- Target value 

- Unit of measure 

- Currency 

- Threshold values 

- Period 

- Number of periods 

You can find additional information about KPI types, threshold and target values here. 

Activities 

Define your KPIs. 

37.9.6.2.3 Assign KPIs to Users 

Use 

The IMG activity Assign KPIs to Users no longer exists. 

The function was mapped with authorization objects as of Support Package 8. To assign KPIs to users, 

use the following authorization objects: 

- Administrator Authorizations KPIs in the KPI Watch List (CA_KPIADM) - User Authorizations 

Key Figures in the KPI Watch List (CA_KPIUSR) 
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37.9.6.3 Personalization 

37.9.6.3.1 User-Specific Descriptions for Key Performance Indicators 

Use 

In this IMG activity, you can make user-specific settings for KPI IDs. 

You can overwrite and adjust individual descriptions according to the user. You can make these settings 

directly in the portal. 

Before you can make user-specific settings for KPIs, you must have assigned the KPIs to the individual 

users. You can find additional information in the IMG activity Assign KPIs to Users. 

Activities 

To make user-specific settings for KPIs, proceed as follows: 

1. Enter a user. 

2. Choose New Entries. 

3. Enter a KPI and choose Enter. 

The current descriptions for the KPI are displayed. 

4. Adjust the values, if required. 

37.9.6.3.2 User-Specific Threshold Values for Key Performance Indicators 

Use 

In this IMG activity, you can make user-specific settings for the KPI threshold and target values. 

You can make these settings directly in the portal. 

Before you can make user-specific settings for KPIs, you must have assigned the KPIs to the individual 

users. You can find additional information in the IMG activity Assign KPIs to Users. 

Activities 

To make user-specific settings for KPIs, proceed as follows: 
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1. Enter a user. 

2. Choose New Entries. 

3. Enter a KPI and choose Enter. 

The current KPI values are displayed. 

4. Adjust the values, if required. 

37.9.6.4 Examples for Determining KPI Values 

37.9.6.4.1 ERP Key Figures 

Use 

With the Plant Manager role, you can determine key figure indicators (KPI) from the SAP R/3 system and 

display these in the portal. SAP provides examples for KPIs from SAP R/3 that show you how these KPIs 

are determined in the system. 

SAP provides the reports Evaluation for Capacity Load Utilization (EPM_CAPLOAD_KPI) and 

Production Quantity Evaluation (EPM_ORDER_KPI) as examples. To call these reports, choose Tools 

-> ABAP Workbench -> Development -> ABAP Editor (transaction SE38). 

For more information, see the report documentation: - Evaluation for 

Capacity Load Utilization (EPM_CAPLOAD_KPI) - Production 

Quantity Evaluation (EPM_ORDER_KPI). 

Requirements 

So that KPI values are transferred to the data store relevant for the KPI watch list, all KPI-relevant R/3 

reports with the assigned variants must be executed using transaction EPM_REPORT_START, either 

directly or during background processing. 

For customer-specific KPI programs, the standard delivery offers the following INCLUDE modules. 

These can be included in the existing program using the INCLUDE statement, for example. This would 

minimize the work required for implementation. 

- include epm_report_top 

- include epm_report_parameters 

- include epm_report_initialization 

- include epm_report_sel_screen_output 

- include epm_report_at_selection_screen 
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- include epm_report_get_kpi_info 

- include epm_report_insert_kpi_data 

These function modules are also used in the standard reports described above. 

Activities 

If you wish to determine KPI values from R/3 systems in releases older than ECC 500, and transfer these 

to the KPI managing system, you must use the function module EPM_KPI_GET to obtain information 

about the KPI, as well as the function module EPM_KPI_DATA_INSERT to add a new KPI value to a 

KPI. Note parameter I_NO_CHECK_OF_INSERT_CODE. 

Example 

The example program EPM_REPORT_EXAMPLE provides a syntactical and correct basis structure that 

can be used as a template for new KPI reports. 

37.9.6.4.2 Key Performance Indicators (BW) 

Use 

With the Plant Manager role, you can determine key figure indicators (KPI) from the SAP 

Business Information Warehouse (BW), and display these in the portal. SAP provides examples that show 

you how these KPIs are determined from the BW and transferred to the KPI managing system. 

You can use the analysis process (0EPM_BEISPIEL_0PP_C03_Q009) as an example, and can display 

this process in the analysis process designer (transaction RSANWB). 

Here you can find additional information on how KPI values are transferred to the KPI managing system. 

SAP also provides examples on how to display the detail screen for a KPI. Here, the Information 

Consumer Pattern (ICP) is used to display the information in a Web browser, based on a query view. 

You use the ICP (0TPLB_0PP_C03_Q009_ALL_PLANTS2) as an example. To display this example, 

proceed as follows: 

Call up transaction SE38 and start report RS_TEMPLATE_MAINTAIN. On the selection screen, the 

Technical Name of a Template field is displayed. Enter the ICP name 

0TPLB_0PP_C03_Q009_ALL_PLANTS2 and choose @15@ (Execute). 

In the Template Editor, choose @8S@ (Preview in Browser). The ICP is then displayed in the Web 

browser. 

You can choose to display the information in table form or as a diagram. 

The menu bar allows you to execute many other functions (such as exporting to Excel). 
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37.9.6.4.3 Key Performance Indicators (External) 

Use 

With the Plant Manager role, you can also determine key figure indicators (KPI) from external systems 

and display these in the portal. 

You can use two RFC modules to obtain information about the definition of a KPI (such as threshold 

values or the ID), as well as transfer the KPI values determined in the external system to the KPI 

managing R/3 system. 

Example 

To obtain information for a KPI, use the function module EPM_KPI_GET. You must specify the 

technical name of the KPI. 

If you also transfer user or language, the function module returns the personalized and language-

dependent KPI settings. 

You must use the function module EPM_KPI_DATA_INSERT to add a new KPI value to a KPI. You 

must specify the new KPI value along with the technical name of the KPI. 

37.9.6.5 Alert Management 

37.9.6.5.1 Alerts for Key Performance Indicators 

Use 

With the Plant Manager and the Production Supervisor roles, you can use alert management: 

If the KPI exceeds the threshold value for the yellow and red areas, you will be alerted. You can use the 

following media to receive an alert: 

- E-mail 

- SMS 

- Fax 

- Alert monitor on Plant Manager or Production Supervisor page in the portal 

The alert contains information about the KPI (technical name), the value and unit of the KPI, and the date 

and time of the alert. 

SAP provides the following alert categories: 

- SAP_EPM_KPI_ALERT: Alert for KPI 

- SAP_WC_SID_CLT_DUMMY: Alert for machine breakdown (template for creating alerts) 
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Requirements 

The following prerequisites must be met for an alert to be dispatched when a KPI exceeds the relevant 

threshold values: 

- You have set up and configured a central alert server (contact your system administrator). 

- The alert category SAP_EPM_KPI_ALERT or SAP_WC_SID_CLT_DUMMY must exist in the 

central alert server system (see IMG activity Define Alert Categories). 

- You have activated one of the alert categories when personalizing the KPI (in the iView, choose KPI 

Watch List in the Portal Personalize KPIs -> Activate Alerts.) 

- You have determined the type of media (E-mail, SMS, FAX, Portal) to be alerted with (in the iView 

Alerts in the Portal, choose  Display Details -> Configuration for Alerts). 

Note: 

If you have maintained user-specific threshold values the alert is triggered if the KPI exceeds your 

threshold value, or the value lies within each range. 

If you have not defined any user-specific threshold values, an alert is triggered if the company-specific 

threshold values are exceeded, or the value lies in the company-specific range. 

37.9.6.5.2 Define Alert Categories 

Use 

In this IMG activity, you define the alert categories you want. Only carry out this activity if you want to 

use the central Alert Framework. 

Once a new alert category has been defined, you have to specify how the recipients of an alert are to be 

determined, and implement the creation/triggering of an alert from an application. 

Standard settings 

SAP applications supply a set of alert categories. 

Activities 

1. Maintain the key and the properties of the alert category. 

2. (Optional) Define a container that can hold application-specific attributes. 
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3. Maintain the texts for the alert category. 

4. (Optional) Define subsequent activities as hyperlinks/URLs. 

37.9.7 Production Supervisor 

37.9.7.1 Make Settings for Worklist 

37.9.7.1.1 Determine Checks for Executing Operations 

Use 

In this IMG activity, you specify which checks are carried out with regard to the feasibility of operations. 

The checks are specified for an entry consisting of the plant, order type, production supervisor, and MRP 

controller in each case. 

Standard settings 

In the standard SAP system supplied, the following checks are active for all plants, order types, 

production supervisors, and MRP controllers: 

- Missing Part Check 

- Check Whether QM Notifications Exist 

- Check for Work Center Availability The Evaluation of Capacity Availability is not active. 



 

 

 

 


